Configuring Wellfleet Routers
Part No. 110073 A
Configuring Wellfleet Routers

Router Software Version 8.10
Site Manager Software Version 2.10

Part No. 110073 Rev. A
February 1995

Bay Networks
The Merged Company of SynOptics and Wellfleet
This Software License shall govern the licensing of all software provided to licensee by Bay Networks ("Software"). Bay Networks will provide licensee with Software in machine-readable form and related documentation ("Documentation"). The Software provided under this license is proprietary to Bay Networks and to third parties from whom Bay Networks has acquired license rights. Bay Networks will not grant any Software license whatsoever, either explicitly or implicitly, except by acceptance of an order for either Software or for a Bay Networks product ("Equipment") that is packaged with Software. Each such license is subject to the following restrictions:

1. Upon delivery of the Software, Bay Networks grants to licensee a personal, nontransferable, nonexclusive license to use the Software with the Equipment with which or for which it was originally acquired, including use at any of licensee’s facilities to which the Equipment may be transferred, for the useful life of the Equipment unless earlier terminated by default or cancellation. Use of the Software shall be limited to such Equipment and to such facility. Software which is licensed for use on hardware not offered by Bay Networks is not subject to restricted use on any Equipment, however, unless otherwise specified on the Documentation, each licensed copy of such Software may only be installed on one hardware item at any time.

2. Licensee may use the Software with backup Equipment only if the Equipment with which or for which it was acquired is inoperative.

3. Licensee may make a single copy of the Software (but not firmware) for safekeeping (archives) or backup purposes.

4. Licensee may modify Software (but not firmware), or combine it with other software, subject to the provision that those portions of the resulting software which incorporate Software are subject to the restrictions of this license. Licensee shall not make the resulting software available for use by any third party.

5. Neither title nor ownership to Software passes to licensee.

6. Licensee shall not provide, or otherwise make available, any Software, in whole or in part, in any form, to any third party. Third parties do not include consultants, subcontractors, or agents of licensee who have licensee’s permission to use the Software at licensee’s facility, and who have agreed in writing to use the Software only in accordance with the restrictions of this license.
7. Third-party owners from whom Bay Networks has acquired license rights to software that is incorporated into Bay Networks products shall have the right to enforce the provisions of this license against licensee.

8. Licensee shall not remove or obscure any copyright, patent, trademark, trade secret, or similar intellectual property or restricted rights notice within or affixed to any Software and shall reproduce and affix such notice on any backup copy of Software or copies of software resulting from modification or combination performed by licensee as permitted by this license.

9. Licensee shall not reverse assemble, reverse compile, or in any way reverse engineer the Software. [Note: For licensees in the European Community, the Software Directive dated 14 May 1991 (as may be amended from time to time) shall apply for interoperability purposes. Licensee must notify Bay Networks in writing of any such intended examination of the Software and Bay Networks may provide review and assistance.]

10. Notwithstanding any foregoing terms to the contrary, if licensee licenses the Bay Networks product “Site Manager,” licensee may duplicate and install the Site Manager product as specified in the Documentation. This right is granted solely as necessary for use of Site Manager on hardware installed with licensee’s network.

11. This license will automatically terminate upon improper handling of Software, such as by disclosure, or Bay Networks may terminate this license by written notice to licensee if licensee fails to comply with any of the material provisions of this license and fails to cure such failure within thirty (30) days after the receipt of written notice from Bay Networks. Upon termination of this license, licensee shall discontinue all use of the Software and return the Software and Documentation, including all copies, to Bay Networks.

12. Licensee’s obligations under this license shall survive expiration or termination of this license.
Chapter 1
Configuration Manager Overview

Router Configuration Functions ................................................................. 1-1
  Adding Network Interfaces ................................................................. 1-2
  Customizing Network Interfaces ......................................................... 1-2
  Configuring the Router Connection to the Technician Interface .......... 1-3
  Specifying Router Hardware Configuration ...................................... 1-3
  Specifying Administrative Information ........................................... 1-3

Operating Modes ................................................................. 1-4
  Local Mode ........................................................................ 1-6
    Opening a Configuration File .................................................. 1-6
    Specify the Hardware ......................................................... 1-8
    Completing the Configuration ............................................. 1-9
    Saving and Implementing Changes ...................................... 1-9
  Remote Mode ...................................................................... 1-10
    Performing Remote Configuration ...................................... 1-11
  Dynamic Mode .................................................................... 1-13
    Performing Dynamic Configuration .................................... 1-13
    Specifying the Router in Dynamic and Remote Modes ............ 1-14
    Well-Known Connections Feature ....................................... 1-18
Chapter 2
Adding Network Interfaces

Adding a Network Interface Overview ................................................................. 2-2
Specifying Hardware ............................................................................................. 2-3
Configuring the Circuit ......................................................................................... 2-5
   Enabling ATM DXI Services ............................................................................. 2-9
      Enabling Protocols on an ATM DXI Circuit .................................................. 2-9
      Adding PVCs ................................................................................................. 2-10
   Enabling ATM FRE2 Services .......................................................................... 2-14
      Enabling Protocols on an ATM FRE2 Circuit ................................................. 2-14
      Adding VCLs ................................................................................................. 2-14
   Enabling SMDS Services .................................................................................. 2-19
   Enabling SDLC Services .................................................................................... 2-23
   Enabling X.25 Services ..................................................................................... 2-28
      Specifying Packet-Level Parameters ............................................................ 2-28
   Adding New X.25 Network Service Records ..................................................... 2-35
   Enabling Bridging/Routing Services on an X.25 Circuit .................................... 2-38
   Configuring Multiple IP Interfaces Over X.25 Circuits .................................... 2-39

   Enabling Bridging/Routing Services ................................................................ 2-49
      Enabling Bridging Service ............................................................................ 2-51
      Enabling Spanning Tree Service .................................................................. 2-51
      Enabling Internet Protocol Services ............................................................... 2-53
         Enabling Open Shortest Path First Service ............................................... 2-57
Chapter 3
Customizing Line Services

Ethernet Overview .................................................................................................................. 3-1

Token Ring Overview ............................................................................................................. 3-3

FDDI and SMT Overview ........................................................................................................ 3-5
  FDDI Dual Counter-Rotating Ring Architecture ............................................................... 3-6
  FDDI Ring Operation ....................................................................................................... 3-8
    Station Timers ........................................................................................................... 3-9
  FDDI Ring Maintenance ................................................................................................ 3-10

FDDI SMT ............................................................................................................................. 3-10

Accessing Line Services ....................................................................................................... 3-14

Editing E1 Line Details .......................................................................................................... 3-16

Editing Ethernet Line Details ................................................................................................ 3-20

Editing FDDI Line Details ...................................................................................................... 3-24
  Editing FDDI Advanced Attributes ................................................................................. 3-28
  Editing the FDDI SMT Attributes ................................................................................... 3-28
  Editing the FDDI MAC Attributes .................................................................................. 3-34
  Editing the FDDI Path Attributes ................................................................................... 3-36
  Editing the FDDI Port Attributes .................................................................................... 3-39

Editing HSSI Line Details ................................................................................................. 3-41

Editing Synchronous Line Details ......................................................................................... 3-46
  Point-to-Point Address .................................................................................................. 3-56
  KG84A Support ............................................................................................................. 3-64
    Loss of Synchronization .............................................................................................. 3-64
Chapter 4
Configuring MCT1

Adding MCT1 Circuits ................................................................. 4-1
Selecting the Connector ......................................................... 4-2
Setting Clock Parameters ....................................................... 4-2
Setting Port Parameters ........................................................ 4-4
Defining Logical Lines ............................................................ 4-12
Defining a Circuit for Each Logical Line .............................. 4-13
  Grouping Lines into a Multiline Circuit ................................. 4-15
  Naming the Circuit ............................................................... 4-21
  Selecting a Protocol ............................................................. 4-21
Completing the Logical Line Parameters ............................. 4-23
Assigning Timeslots ............................................................... 4-29
Accept the Configuration ....................................................... 4-30
Save Your Changes .............................................................. 4-30
Initiating MCT1 Actions in Dynamic Mode ............................ 4-31
Chapter 5
Configuring MCE1

Adding MCE1 Circuits ................................................................. 5-1
Selecting the Connector ............................................................... 5-2
Setting Clock Parameters ............................................................ 5-2
Setting Port Parameters .............................................................. 5-4
Defining Logical Lines ............................................................... 5-9
Defining a Circuit for Each Logical Line ................................. 5-10
  Grouping Lines into a Multiline Circuit ................................. 5-12
  Naming the Circuit ................................................................. 5-18
  Selecting a Protocol .............................................................. 5-18
Completing the Logical Line Parameters ............................... 5-20
Assigning Timeslots ................................................................. 5-27
Accepting the Configuration .................................................... 5-28
Saving Your Changes ............................................................... 5-29
Initiating MCE1 Actions in Dynamic Mode ......................... 5-29

Chapter 6
Implementing Configuration Changes

Configuration Implementation Overview ................................ 6-1
Saving a Configuration File ...................................................... 6-2
  Saving a Configuration File in Local Configuration Mode ........ 6-2
  Saving a Configuration File in Remote Configuration Mode ...... 6-3
  Saving a Configuration File in Dynamic Configuration Mode ... 6-5
Transferring a Configuration File to the Wellfleet Router .......... 6-6
Rebooting a Wellfleet Router with a Configuration File .......... 6-12
Appendix A
Site Manager Default Settings

Circuit Parameters ................................................................. A-1
WAN Protocol Parameters .................................................... A-14
Bridge Parameters ................................................................. A-30
Native Mode LAN (NML) Parameters ...................................... A-35
IP Parameters .......................................................................... A-35
SNMP Parameters .................................................................... A-42
OSPF Parameters ..................................................................... A-44
BGP and BGP-3 Parameters ................................................... A-47
EGP Parameters ..................................................................... A-48
TCP Parameters ................................................................. A-49
Telnet Parameters ............................................................. A-50
DECnet Parameters .......................................................... A-51
VINES Parameters ............................................................ A-54
AppleTalk Parameters ....................................................... A-56
OSI Parameters ................................................................. A-57
IPX Parameters ................................................................. A-59
XNS Parameters ............................................................... A-62
DLSw Parameters ............................................................. A-64
LNM Parameters .............................................................. A-65
LLC2 Parameters .............................................................. A-66
APPN Parameters ............................................................. A-68
Multiline Feature Parameters ............................................. A-73
Switched Access Services Parameters .............................. A-73
Protocol Prioritization Parameters ................................. A-75
Console Parameters .......................................................... A-75
Figures

Figure 1-1. Wellfleet Site Manager Window .................................................................1-4
Figure 1-2. Edit Bridge Global Parameters Window in Local Mode .............................1-5
Figure 1-3. File Selection Window ...............................................................................1-7
Figure 1-4. Select Router Model Window .....................................................................1-9
Figure 1-5. Router Hardware Configuration in Wellfleet Configuration Manager Window ..................................................1-11
Figure 1-6. Edit Remote Configuration File Window ..................................................1-12
Figure 1-7. Router Connection Options Window ......................................................1-15
Figure 1-8. Well-Known Connections Box ..................................................................1-19
Figure 1-9. Connection List Management Window ...................................................1-20
Figure 1-10. Connections List Options Window .......................................................1-21
Figure 2-1. Wellfleet Configuration Manager Window ..............................................2-3
Figure 2-2. Module List Window ..................................................................................2-4
Figure 2-3. Add Circuit Window ..................................................................................2-5
Figure 2-4. WAN Protocols Window ..........................................................................2-7
Figure 2-5. ATM DXI Interface List Window .............................................................2-10
Figure 2-6. ATM DXI PVC List Window ....................................................................2-11
Figure 2-7. ATM DXI Virtual Circuit Window ............................................................2-12
Figure 2-8. ATM Interface List Window ....................................................................2-15
Figure 2-9. ATM Virtual Channel Link Window .......................................................2-16
Figure 2-10. ATM FRE2 Virtual Channel Link Parameters Window .........................2-17
Figure 2-11. SMDS Configuration Window ...............................................................2-19
Figure 2-12. SDLC Line Parameters Window .............................................................2-23
Figure 2-13. Select Protocols Window .......................................................................2-27
Figure 2-14. X.25 Packet Config Window ..................................................................2-29
Figure 2-15. X.25 Service Configuration Window ....................................................2-35
Figure 2-16. X.25 Service Window .............................................................................. 2-36
Figure 2-17. Selecting the Protocols Add/Delete Function on the X.25 Service Configuration Window ........................................................................ 2-40
Figure 2-18. Select Protocols Window ........................................................................ 2-41
Figure 2-19. IP Configuration Window ....................................................................... 2-41
Figure 2-20. Enter Adjacent Host Window .................................................................. 2-44
Figure 2-21. Selecting the Protocols Edit IP Interfaces Menu ......................................... 2-45
Figure 2-22. IP Interfaces Window .............................................................................. 2-46
Figure 2-23. IP Configuration Window When Adding an IP Interface to an X.25 Circuit .... 2-47
Figure 2-24. Select Protocols Window ........................................................................ 2-49
Figure 2-25. Spanning Tree Autoconfiguration Window ................................................ 2-52
Figure 2-26. IP Configuration Window ....................................................................... 2-54
Figure 2-27. Initial OSPF Global Configuration Window ............................................. 2-57
Figure 2-28. OSPF Primary Log Mask Window ............................................................. 2-62
Figure 2-29. OSPF Backup Log Mask Window .............................................................. 2-64
Figure 2-30. Area Address for Interface Window ............................................................ 2-64
Figure 2-31. EGP Configuration Window .................................................................... 2-66
Figure 2-32. BGP Configuration Window .................................................................... 2-68
Figure 2-33. BGP Peer Window .................................................................................. 2-69
Figure 2-34. Initial IGMP Global Configuration Window ............................................. 2-72
Figure 2-35. Initial DVRMP Base Parameters Window ............................................... 2-74
Figure 2-36. DECnet Phase IV Configuration Window .................................................... 2-78
Figure 2-37. AppleTalk Interface Configuration Window ............................................... 2-81
Figure 2-38. AppleTalk Zone Configuration Window .................................................... 2-85
Figure 2-39. Add AppleTalk Zone Window .................................................................... 2-86
Figure 2-40. Edit AURP Global Parameters Window .................................................... 2-88
Figure 2-41. AT AURP Interface Configuration Window ................................................ 2-90
Figure 2-42. AppleTalk AURP Configuration Window ......................................................... 2-90
Figure 2-43. Source Routing Global Parameters Window ................................................... 2-92
Figure 2-44. Source Routing Interface Parameters Window ............................................... 2-94
Figure 2-45. Source Routing Spanning Tree Autoconfiguration Window ......................... 2-96
Figure 2-46. OSI Configuration Window ............................................................................ 2-100
Figure 2-47. Edit NML Interface Window ........................................................................... 2-103
Figure 2-48. IPX Configuration Window ............................................................................ 2-104
Figure 2-49. XNS Configuration Window ........................................................................... 2-107
Figure 2-50. DLSw Configuration Sequence for Token Ring/802.5 or Other (Except Ethernet) .......................................................................................... 2-111
Figure 2-51. DLSw Configuration Sequence for Ethernet/802.3 or Frame Relay ............. 2-112
Figure 2-52. DLSw Global Parameters Window ................................................................. 2-114
Figure 2-53. Source Route Encapsulation Dialog Box ...................................................... 2-115
Figure 2-54. Frame Relay Mappings Window ................................................................... 2-116
Figure 2-55. LLC2 Frame Relay Mapping Add Window .................................................... 2-117
Figure 2-56. DLSw Slot Configuration Window ............................................................... 2-119
Figure 2-57. Add Slot IP Address Window ........................................................................ 2-119
Figure 2-58. DLSw Peer Configuration Window ............................................................... 2-121
Figure 2-59. Add Peer IP Address Window ....................................................................... 2-121
Figure 2-60. DLSw SAP Configuration Window ............................................................... 2-123
Figure 2-61. Add DLSw Service Access Point Window ..................................................... 2-123
Figure 2-62. Select Protocols Menu Showing LLC2 .......................................................... 2-126
Figure 2-63. Source Route Encapsulation Dialog Box ...................................................... 2-126
Figure 2-64. Frame Relay Mappings Window ................................................................... 2-127
Figure 2-65. LLC2 Frame Relay Mapping Add Window .................................................... 2-128
Figure 2-66. LLC2 Frame Relay Mappings Window with DLCI Added .............................. 2-130
Figure 2-67. Select Protocols Window .............................................................................. 2-132
Figure 2-68. Source Route Encapsulation Dialog Box ...................................................... 2-132
Figure 2-69. APPN Local Node Name Configuration Window ........................................... 2-133
Figure 2-70. APPN Configuration Window ...................................................................... 2-135
Figure 2-71. Adjacent Link Station Dialog Box ................................................................. 2-137
Figure 2-72. Source Route Encapsulation Dialog Box ...................................................... 2-138
Figure 2-73. Source Routing Global Parameters Window .................................................. 2-138
Figure 2-74. Edit SR Interface Window ............................................................................ 2-140
Figure 2-75. APPN Virtual Ring Number Window ............................................................. 2-141
Figure 2-76. SDLC Line Parameters Window .................................................................. 2-143
Figure 2-77. Select Protocols Window ............................................................................. 2-144
Figure 2-78. APPN Local Node Name Configuration Window .......................................... 2-144
Figure 2-79. APPN Configuration Window ...................................................................... 2-146
Figure 2-80. Adjacent Link Station Dialog Box ................................................................. 2-147
Figure 2-81. Multiline Circuit Composed of Three SYNC Lines ....................................... 2-149
Figure 2-82. Multiline Circuit Types .............................................................................. 2-150
Figure 2-83. Add Circuit Window ..................................................................................... 2-153
Figure 2-84. Circuit Definition Window .......................................................................... 2-155
Figure 2-85. Edit Multiline Options Window for Circuit S21 ........................................... 2-156
Figure 2-86. Delete Circuit Window ................................................................................ 2-158
Figure 2-87. Circuit Definition Window .......................................................................... 2-160
Figure 2-88. Moving a Circuit ....................................................................................... 2-162
Figure 2-89. IP Interfaces Window ................................................................................ 2-164
Figure 2-90. IP Configuration Window .......................................................................... 2-165
Figure 2-91. Console Lists Window ................................................................................ 2-167
Figure 2-92. Edit System Description Parameters Window ............................................ 2-175
Figure 3-1. Ethernet and 802.3 Message Formats .............................................................. 3-2
Figure 5-4. Add Circuit Window ................................................................. 5-11
Figure 5-5. MCE1 Logical Lines Window .................................................... 5-12
Figure 5-6. Add Circuit Window ................................................................. 5-13
Figure 5-7. Logical Lines Window with One MCE1 Circuit ......................... 5-14
Figure 5-8. Logical Lines Window with Unused Logical Lines .................... 5-15
Figure 5-9. Select Logical Line Window for Multiline .................................. 5-16
Figure 5-10. Selecting Lines→Change Lines from the Menubar .................. 5-17
Figure 5-11. MCE1 Logical Lines Window with a Multiline Circuit ............... 5-17
Figure 5-12. MCE1 Default Circuit Name .................................................... 5-18
Figure 5-13. WAN Protocols Window for MCE1 .......................................... 5-19
Figure 5-14. Select Protocols Window for MCE1 .......................................... 5-20
Figure 5-15. Logical Lines Window after You Add a Circuit ......................... 5-21
Figure 5-16. MCE1 Timeslots Window ...................................................... 5-28
Figure 5-17. MCE1 Port Parameters Window .............................................. 5-30
Figure 5-18. MCE1 Port Actions Window .................................................... 5-31
Figure 6-1. Router Connection Options Window ......................................... 6-8
Figure 6-2. Router Files Manager Window .................................................. 6-9
Figure 6-3. TFTP Put File Selection Window .............................................. 6-10
Figure 6-4. Boot Router Window ............................................................... 6-12
Figure 6-5. Configuration Manager Window .............................................. 6-14
Figure 6-6. Source Routing Global Profile Window ..................................... 6-15
Figure 6-7. Source Routing Interface Profile Window ................................... 6-16
Figure 6-8. IP Interface Profiles Window .................................................. 6-17
Figure 6-9. SNMP Manager Profiles Window ........................................... 6-18
Figure 6-10. DECnet Interface Profiles Window ......................................... 6-19
Figure 6-11. VINES Interface Profiles Window .......................................... 6-20
Figure 6-12. IPX Interface Profiles Window ................................................................. 6-21
Figure 6-13. AppleTalk Interface Profiles Window .......................................................... 6-22
Figure 6-14. OSI Profiles Window .................................................................................. 6-23
Figure 6-15. X.25 Packet Level Profiles Window ........................................................... 6-24
Figure 6-16. X.25 Service Profile Window ..................................................................... 6-25

Tables

Table 1-1. Router Connection Error Messages ............................................................... 1-24
Table 2-1. Circuit-type Designators in Default Circuit Names ....................................... 2-6
Table 3-1. SMT Frame Class and Type ........................................................................... 3-12
Table 3-2. SMT Connection Policy Values ..................................................................... 3-31
Table A-1. Ethernet Circuit Parameters .......................................................................... A-1
Table A-2. FDDI Circuit Parameters ............................................................................... A-2
Table A-3. FDDI SMT Attributes Parameters ................................................................ A-2
Table A-4. FDDI MAC Attributes Parameters ............................................................. A-2
Table A-5. FDDI Path Attributes Parameters ................................................................ A-3
Table A-6. FDDI Port Attributes Parameters ................................................................ A-3
Table A-7. Synchronous Circuit Parameters .................................................................. A-3
Table A-8. LAPB Parameters ......................................................................................... A-5
Table A-9. Asynchronous Circuit Parameters ................................................................ A-6
Table A-10. T1 Circuit Parameters ................................................................................ A-7
Table A-11. Token Ring Circuit Parameters .................................................................. A-7
Table A-12. MCT1 Set Clock Parameters ..................................................................... A-8
Table A-13. MCT1 Port Parameters ................................................................................ A-8
Table A-14. MCT1 Logical Line Parameters .................................................................. A-9
Table A-15. MCT1 Port Actions Parameters .................................................................. A-10
Table A-16. MCE1 Set Clock Parameters ................................................................. A-10
Table A-17. MCE1 Port Parameters ........................................................................... A-11
Table A-18. MCE1 Logical Line Parameters ............................................................. A-11
Table A-19. MCE1 Port Actions Parameters ............................................................. A-12
Table A-20. HSSI Circuit Parameters ....................................................................... A-13
Table A-21. ISDN Circuit Parameters ....................................................................... A-13
Table A-22. Frame Relay Interface Parameters ....................................................... A-14
Table A-23. Frame Relay PVC Parameters ............................................................... A-15
Table A-24. SMDS Interface Parameters ................................................................. A-15
Table A-25. SDLC Interface Parameters ................................................................. A-16
Table A-26. SDLC Link Station Parameters ............................................................. A-18
Table A-27. X.25 Global Parameters ....................................................................... A-19
Table A-28. X.25 Packet Level Parameters ............................................................. A-20
Table A-29. X.25 Network Service Records Parameters .......................................... A-22
Table A-30. ATM DXI Interface Parameters ............................................................ A-23
Table A-31. ATM DXI Virtual Circuit Parameters ................................................... A-24
Table A-32. ATM DXI PVC List Parameters ............................................................. A-24
Table A-33. ATM FRE2 Interface Parameters ........................................................ A-24
Table A-34. ATM FRE2 Virtual Channel Link Parameters ....................................... A-25
Table A-35. ATM FRE2 Virtual Channel Link Settings ........................................... A-25
Table A-36. ATM/ALC Parameters ......................................................................... A-26
Table A-37. ATM/ALC SAR Traffic Management Parameters .............................. A-26
Table A-38. ATM/ALC Physical Interface Attributes .............................................. A-26
Table A-39. Point-to-Point (PPP) Interface Parameters ........................................ A-27
Table A-40. Point-to-Point (PPP) Line Lists Parameters ........................................ A-28
Table A-41. Wellfleet Compression Protocol (WPC) Circuit Interface Parameters .... A-29
Table A-42. Wellfleet Compression Protocol Line Interfaces Parameters ......................... A-30
Table A-43. Transparent Bridge Global Parameters ......................................................... A-30
Table A-44. Transparent Bridge Interface Parameters ...................................................... A-31
Table A-45. Spanning Tree Global Parameters ................................................................. A-31
Table A-46. Spanning Tree Interface Parameters ............................................................. A-32
Table A-47. Source Routing Global Parameters ............................................................... A-32
Table A-48. Source Routing Interface Parameters ............................................................ A-33
Table A-49. Translation Bridge Global Parameters .......................................................... A-34
Table A-50. Native Mode LAN Services ............................................................................ A-35
Table A-51. IP Global Parameters ..................................................................................... A-36
Table A-52. IP Interface Parameters ................................................................................. A-36
Table A-53. RIP Interface Parameters ............................................................................... A-38
Table A-54. TFTP Parameters ........................................................................................... A-38
Table A-55. RIPSO Parameters ........................................................................................ A-39
Table A-56. BOOTP Relay Agent Interface Parameters ................................................... A-40
Table A-57. IGMP Global Configuration Parameters ......................................................... A-40
Table A-58. DVRMP Base Parameters ............................................................................. A-40
Table A-59. NetBIOS/IP Global Parameters ...................................................................... A-41
Table A-60. NetBIOS/IP Interface Table Parameters ........................................................ A-41
Table A-61. NetBIOS/IP Static Entry Table Parameters .................................................... A-42
Table A-62. SNMP Global Parameters .............................................................................. A-42
Table A-63. SNMP Community Parameters ...................................................................... A-43
Table A-64. SNMP Manager Parameters .......................................................................... A-43
Table A-65. SNMP Threshold Global Parameters ............................................................. A-43
Table A-66. SNMP Threshold Interface Parameters ........................................................ A-43
Table A-67. SNMP Trap Interface Parameters .................................................................. A-44
Table A-68. OSPF Global Parameters ................................................................. A-45
Table A-69. OSPF Area Parameters ................................................................. A-45
Table A-70. OSPF Interface Parameters .......................................................... A-46
Table A-71. OSPF Virtual Interface Parameters ............................................. A-46
Table A-72. BGP Global Parameters ............................................................... A-47
Table A-73. BGP-3 Global Parameters ............................................................. A-47
Table A-74. BGP Peer Parameters ................................................................. A-48
Table A-75. EGP Global Parameters ............................................................... A-49
Table A-76. EGP Neighbor Parameters ......................................................... A-49
Table A-77. TCP Configuration Parameters .................................................. A-50
Table A-78. Telnet Configuration Parameters ............................................... A-50
Table A-79. Telnet Client Global Parameters ................................................ A-51
Table A-80. DECnet Phase IV Global Parameters ......................................... A-52
Table A-81. DECnet Phase IV Interface Parameters ....................................... A-52
Table A-82. DECnet IV to V Transition Parameters ....................................... A-53
Table A-83. VINES Global Parameters .......................................................... A-54
Table A-84. VINES Interface Parameters ...................................................... A-55
Table A-85. AppleTalk Global Parameters ..................................................... A-56
Table A-86. AppleTalk Interface Parameters ................................................ A-56
Table A-87. AURP Global Parameters ............................................................ A-57
Table A-88. AURP Interface Parameters ....................................................... A-57
Table A-89. OSI Global Parameters ............................................................... A-58
Table A-90. OSI Interface Parameters ........................................................... A-59
Table A-91. IPX Global Parameters ............................................................... A-60
Table A-92. IPX Interface Parameters ............................................................ A-61
Table A-93. IPX RIP Parameters ................................................................. A-62
<table>
<thead>
<tr>
<th>Table Reference</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-94</td>
<td>XNS Global Parameters</td>
<td>A-62</td>
</tr>
<tr>
<td>A-95</td>
<td>XNS Interface Parameters</td>
<td>A-62</td>
</tr>
<tr>
<td>A-96</td>
<td>XNS RIP Parameters</td>
<td>A-63</td>
</tr>
<tr>
<td>A-97</td>
<td>DLSw Global Parameters</td>
<td>A-64</td>
</tr>
<tr>
<td>A-98</td>
<td>DLSw Interface Parameters</td>
<td>A-64</td>
</tr>
<tr>
<td>A-99</td>
<td>DLSw SAP Parameters</td>
<td>A-65</td>
</tr>
<tr>
<td>A-100</td>
<td>DLSw Slot Parameters</td>
<td>A-65</td>
</tr>
<tr>
<td>A-101</td>
<td>LNM Global Parameters</td>
<td>A-65</td>
</tr>
<tr>
<td>A-102</td>
<td>LNM Interface Parameters</td>
<td>A-66</td>
</tr>
<tr>
<td>A-103</td>
<td>LLC2 Global Parameters</td>
<td>A-66</td>
</tr>
<tr>
<td>A-104</td>
<td>LLC2 Interface Parameters</td>
<td>A-67</td>
</tr>
<tr>
<td>A-105</td>
<td>APPN Global and Advanced Global Parameters</td>
<td>A-68</td>
</tr>
<tr>
<td>A-106</td>
<td>APPN Interfaces and Ports Parameters</td>
<td>A-69</td>
</tr>
<tr>
<td>A-107</td>
<td>APPN Adjacent Link Station Parameters</td>
<td>A-70</td>
</tr>
<tr>
<td>A-108</td>
<td>APPN Connection Networks and Ports Parameters</td>
<td>A-72</td>
</tr>
<tr>
<td>A-109</td>
<td>APPN Directory Services Parameters</td>
<td>A-73</td>
</tr>
<tr>
<td>A-110</td>
<td>Multiline Parameters</td>
<td>A-73</td>
</tr>
<tr>
<td>A-111</td>
<td>Modem Parameters</td>
<td>A-74</td>
</tr>
<tr>
<td>A-112</td>
<td>Protocol Prioritization Interface Parameters</td>
<td>A-75</td>
</tr>
</tbody>
</table>
If you are responsible for configuring and managing Wellfleet® routers, you need to read this guide. This guide describes how to configure your Wellfleet router so that it runs a default configuration of each protocol that you enable. Refer to this guide for:

- An overview of the Configuration Manager
- Instructions on configuring network interfaces using Site Manager defaults
- An overview of, and instructions on, configuring Multiline
- Instructions on configuring the router's connection to the Technician Interface console
- Instructions on specifying BN administrative information
- Overview of Ethernet, Token Ring, and FDDI and SMT physical-layer protocols
- Instructions on customizing line services
- Instructions on implementing configurations created in local or remote mode, and saving dynamically made changes to a configuration file
- A list of Wellfleet defaults
How to Get Help

Before You Begin

Before using this guide, you must complete the following procedures. For a new router:

- Install the router (refer to Installing and Maintaining BN Routers, Installing and Maintaining ASN Routers, Installing and Starting 8-Port AN Hubs, or Installing and Starting AN Routers)
- Connect the router to the network and create a pilot configuration file (refer to Quick-Starting Wellfleet Routers or Installing and Starting AN Routers)

Make sure you are running the latest version of Wellfleet Site Manager and router software. For instructions, refer to Upgrading Wellfleet Routers from Version 5 to Version 8.10, or Upgrading Wellfleet Routers from Version 8.00 to Version 8.10.

How to Get Help

For additional information or advice, contact the Bay Networks Help Desk in your area:

United States    1-800-2LAN-WAN
Valbonne, France  (33) 92-966-968
Sydney, Australia (61) 2-903-5800
Tokyo, Japan     (81) 3-328-0052

Conventions

angle brackets (< >) Indicate that you choose the text to enter based on the description inside the brackets. Do not type the brackets when entering the command. Example: if command syntax is ping <ip_address>, you enter ping 192.32.10.12

arrow character (➔) Separates menu and option names in instructions. Example: Protocols➔AppleTalk identifies the AppleTalk option in the Protocols menu.
brackets ([ ])  Indicate optional elements. You can choose none, one, or all of the options.

user entry text  Denotes text that you need to enter. Example: Start up the Windows environment by entering the following after the prompt: **win**

command text  Denotes command names in text. Example: Use the **xmodem** command.

italic text  Indicates variable values in command syntax descriptions, new terms, file and directory names, and book titles.

screen text  Indicates data that appears on the screen. Example: **Set Trap Monitor Filters**

ellipsis points  Horizontal ( . . . ) and vertical ( : ) ellipsis points indicate omitted information.

quotation marks (" ")  Indicate the title of a chapter or section within a book.

vertical line (|)  Indicates that you enter only one of the parts of the command. The vertical line separates choices. Do not type the vertical line when entering the command.

Example: If the command syntax is **show at routes | nets**, you enter either **show at routes** or **show at nets**, but not both.

**Acronyms**

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AARP</td>
<td>AppleTalk Address Resolution Protocol</td>
</tr>
<tr>
<td>ANSI</td>
<td>American National Standards Institute</td>
</tr>
<tr>
<td>APPN</td>
<td>Advanced Peer-to-Peer Networking</td>
</tr>
<tr>
<td>ARP</td>
<td>Address Resolution Protocol</td>
</tr>
<tr>
<td>AS</td>
<td>Autonomous System</td>
</tr>
<tr>
<td>AT</td>
<td>AppleTalk Protocol</td>
</tr>
<tr>
<td>ATM</td>
<td>Asynchronous Transfer Mode</td>
</tr>
<tr>
<td>BDR</td>
<td>Backup Designated Router</td>
</tr>
<tr>
<td>BGP</td>
<td>Border Gateway Protocol</td>
</tr>
<tr>
<td>Acronyms</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>BOFL</td>
<td>Breath of Life message</td>
</tr>
<tr>
<td>BOOTP</td>
<td>Bootstrap Protocol</td>
</tr>
<tr>
<td>CLNP</td>
<td>ConnectionLess Network Protocol</td>
</tr>
<tr>
<td>CMIP</td>
<td>Common Management Information Protocol</td>
</tr>
<tr>
<td>CSMA/CD</td>
<td>Carrier Sense Multiple Access with Collision Detection</td>
</tr>
<tr>
<td>DDP</td>
<td>Datagram Delivery Protocol</td>
</tr>
<tr>
<td>DLCMI</td>
<td>data link control management interface</td>
</tr>
<tr>
<td>DLS</td>
<td>Data Link Switching</td>
</tr>
<tr>
<td>DXI</td>
<td>Data Exchange Interface</td>
</tr>
<tr>
<td>EGP</td>
<td>Exterior Gateway Protocol</td>
</tr>
<tr>
<td>FDDI</td>
<td>Fiber Distributed Data Interface</td>
</tr>
<tr>
<td>FR</td>
<td>Frame Relay protocol</td>
</tr>
<tr>
<td>HDLC</td>
<td>High-level Data Link Control protocol</td>
</tr>
<tr>
<td>HSSI</td>
<td>High Speed Serial Interface</td>
</tr>
<tr>
<td>IEEE</td>
<td>Institute of Electrical and Electronic Engineers</td>
</tr>
<tr>
<td>ILI</td>
<td>intelligent link interface</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>IPX</td>
<td>Internet Packet Exchange (Novell)</td>
</tr>
<tr>
<td>IS-IS</td>
<td>Intermediate System to Intermediate System</td>
</tr>
<tr>
<td>LB</td>
<td>Learning Bridge</td>
</tr>
<tr>
<td>LLC</td>
<td>Logical Link Control</td>
</tr>
<tr>
<td>LSAP</td>
<td>Layer Service Access Point</td>
</tr>
<tr>
<td>MAC</td>
<td>Media Access Control</td>
</tr>
<tr>
<td>MIB</td>
<td>Management Information Base</td>
</tr>
<tr>
<td>MOP</td>
<td>Maintenance Operations Protocol</td>
</tr>
<tr>
<td>MTU</td>
<td>maximum transfer size</td>
</tr>
<tr>
<td>NCP</td>
<td>Network Control Protocol</td>
</tr>
<tr>
<td>NLPID</td>
<td>network layer protocol identifier</td>
</tr>
<tr>
<td>NSAP</td>
<td>Network Service Access Point</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>OSI</td>
<td>Open Systems Interconnection</td>
</tr>
<tr>
<td>OSPF</td>
<td>Open Shortest Path First</td>
</tr>
<tr>
<td>PCM</td>
<td>Physical Connection Management (FDDI)</td>
</tr>
<tr>
<td>PDU</td>
<td>Protocol Data Unit</td>
</tr>
<tr>
<td>PHY</td>
<td>Physical Layer Protocol (FDDI)</td>
</tr>
<tr>
<td>PID</td>
<td>protocol identifier</td>
</tr>
<tr>
<td>PPP</td>
<td>Point-to-Point Protocol</td>
</tr>
<tr>
<td>PVCs</td>
<td>permanent virtual circuits</td>
</tr>
<tr>
<td>RARP</td>
<td>Reverse Address Resolution Protocol</td>
</tr>
<tr>
<td>RIF</td>
<td>Routing Information Field (SR)</td>
</tr>
<tr>
<td>RIP</td>
<td>Routing Information Protocol</td>
</tr>
<tr>
<td>RMT</td>
<td>Ring Management (FDDI)</td>
</tr>
<tr>
<td>QENET</td>
<td>Quad Ethernet Link Module</td>
</tr>
<tr>
<td>SAP</td>
<td>Service Access Point</td>
</tr>
<tr>
<td>SIP</td>
<td>SNMP Interface Protocol</td>
</tr>
<tr>
<td>SMDS</td>
<td>Switched Multimegabit Data Services</td>
</tr>
<tr>
<td>SMT</td>
<td>Station Management (FDDI)</td>
</tr>
<tr>
<td>SNAP</td>
<td>Subnetwork Access Protocol</td>
</tr>
<tr>
<td>SNMP</td>
<td>Simple Network Management Protocol</td>
</tr>
<tr>
<td>SR</td>
<td>Source Routing protocol</td>
</tr>
<tr>
<td>SRM</td>
<td>system resource modules</td>
</tr>
<tr>
<td>STE</td>
<td>Spanning Tree Explorer packet (SR)</td>
</tr>
<tr>
<td>SVCs</td>
<td>switched virtual circuits</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TFTP</td>
<td>Trivial File Transfer Protocol</td>
</tr>
<tr>
<td>TTRT</td>
<td>target token rotation time</td>
</tr>
<tr>
<td>VC</td>
<td>virtual connection</td>
</tr>
<tr>
<td>VINES</td>
<td>Virtual Networking System (Banyan)</td>
</tr>
<tr>
<td>WCP</td>
<td>Wellfleet Compression Protocol</td>
</tr>
<tr>
<td>XB</td>
<td>Translation Bridge</td>
</tr>
</tbody>
</table>
This chapter provides an overview of the Configuration Manager tool. It also describes the router configuration functions you can perform using this tool, explains the three operating modes (local, remote, and dynamic), and how to start and operate the Configuration Manager in each mode.

**Note:** If you are configuring an Access Node (AN)™ or an Access Stack Node (ASN)™ for the first time, you must read *Administering Networks for AN and ASN Routers* before you continue. This manual explains the special considerations for configuring and booting the Access Node and the Access Stack Node.

**Router Configuration Functions**

The Configuration Manager provides remote router configuration functions. Specifically, it allows you to

- Add network interfaces based on defaults to the router.
- Customize network interfaces for your network environment.
- Reconfigure the router's connection to the Technician Interface.
- Specify a router's hardware configuration.
- Specify administrative information about the router.
Adding Network Interfaces

The Configuration Manager simplifies the router configuration process by providing default values for the majority of parameters required to configure an interface. Chapter 2 provides detailed instructions on adding network interfaces. Appendix A lists the Wellfleet router configuration defaults.

Customizing Network Interfaces

The Configuration Manager allows you to customize an interface after you add it to the router by providing management access to all parameters associated with an interface.

These parameters consist of the physical-layer (line) parameters, datalink-layer (circuit) parameters, and network-layer (bridging/routing) parameters. Basically, you can perform the following functions:

- Edit the physical-layer, or line, parameters associated with the interface.
  
  Chapter 3, “Customizing Line Services,” describes how to edit physical-layer parameters.

- Delete and rename circuits, as well as move a circuit to another interface.
  
  Chapter 2, “Adding Network Interfaces,” describes how to delete, rename, and move circuits.

- Add protocols to and delete them from the circuit associated with the interface.
  
  Chapter 2, “Adding Network Interfaces,” describes how to add protocols to and delete them from the circuit associated with an interface.

- Edit bridging and routing protocol parameters.
You can access these parameters on a system-wide or interface-specific basis. Refer to the appropriate protocol-specific guide for instructions on editing bridging and routing protocol parameters.

- Add multiple Internet Protocol (IP) addresses to a single circuit that supports IP.

*Customizing IP Services* describes how to add multiple IP addresses to a single IP circuit.

### Configuring the Router Connection to the Technician Interface

The router’s console port connects the router to the Technician Interface. Site Manager provides default settings for the console configuration; however, you can use the Configuration Manager to access and reconfigure all console parameters.

Chapter 2, “Adding Network Interfaces,” describes how to configure the router’s connection to the Technician Interface.

### Specifying Router Hardware Configuration

In dynamic and remote modes the Configuration Manager does not require you to specify router hardware. In local mode, however, the Configuration Manager requires you to specify the hardware configuration whenever you create a new configuration file.

Chapter 2, “Adding Network Interfaces,” describes how to specify router hardware.

### Specifying Administrative Information

The Configuration Manager allows you to specify a system name, a system contact, and a system location for the router. When you use Site Manager to access the router, Site Manager retrieves the administrative information and displays it in the Wellfleet Site Manager window (Figure 1-1), which appears at Site Manager start-up.
Chapter 2, “Adding Network Interfaces,” describes how to specify administrative information.

![Wellfleet Site Manager Window](image)

**Figure 1-1. Wellfleet Site Manager Window**

**Operating Modes**

The Configuration Manager allows you to perform all configuration functions in one of three modes:

- Local
- Remote
- Dynamic
You specify the operating mode from the Wellfleet Site Manager window (Figure 1-1) by selecting Tools ➔ Configuration Manager and the appropriate operating mode option. When you operate the Configuration Manager in remote or dynamic mode, you configure SNMP options that allow the Configuration Manager to access and control the router.

For each function you can perform, the Configuration Manager displays the same windows in the same sequence regardless of the operating mode. For example, the Configuration Manager displays the same sequence of windows when you configure the Bridge global parameters in local mode as it displays when you configure them in dynamic mode.

The Configuration Mode field in the upper-left corner of each window identifies the Configuration Manager’s current operating mode. For example, Figure 1-2 shows the Edit Bridge Global Parameters window when the Configuration Manager tool is running in local mode.

![Figure 1-2. Edit Bridge Global Parameters Window in Local Mode](image)

The following sections describe each operating mode, as well as how to run and use the Configuration Manager in each mode.
Operating Modes

Local Mode

Use local mode to create or edit a configuration file locally on the Site Manager workstation for later implementation on the router.

Perform the following steps for local configuration:
- Open a configuration file.
- Specify the hardware.
- Complete the configuration.
- Save and implement changes.

Opening a Configuration File

To begin configuring in local mode, open a new or existing configuration file from the File Selection window (Figure 1-3).

From the Wellfleet Site Manager window, select Tools → Configuration Manager → Local File to display the File Selection window.
Opening an Existing Configuration File

To open an existing file, select it and click on the Open File button.

You can select a file and the directory path to it by clicking on the Path List, Directories List, and File List. The Path List shows the path from the root directory to the current directory. Select from the Path List to move up a directory level. The Directories List shows the directories available from the current directory. Select from the Directories List to move down a directory level. The Files List shows files available from the current directory.

Your current selections appear in the Path, Directory, and File boxes at the top of the window. You can edit this information directly by clicking on the appropriate box and entering a path, directory, or file.

Once you select or specify a directory and file, use the buttons on the File Selection window to open or delete a file or to delete a directory.
Operating Modes

Opening a New Configuration File

To open a new file, enter the name in the File box and click on the Open File button.

You can also create a file by entering its name in the Path box at the top of the window and pressing Enter to create it. You can enter a new directory by entering its name in the Path or Directory box and pressing the Enter button.

You must have write-access privileges to the directory where you want to create a configuration file.

Specify the Hardware

Unlike remote and dynamic modes, local mode does not access a router or automatically display the router’s hardware configuration. You enter the router’s hardware configuration when you create a new configuration file or edit a file with hardware changes.

After you open a new file, the Select Router Model window (Figure 1-4) displays the Wellfleet router models.

Select the appropriate router model and then click on the Confirm button.
Configuration Manager Overview

Figure 1-4. Select Router Model Window

After you select a router model, or open an existing file, the Wellfleet Configuration Manager window (Figure 2-1) displays a logical image of the rear panel associated with the router you selected.

At this point, you must specify the router's hardware configuration. For instructions, refer to Chapter 2, “Adding Network Interfaces.”

Completing the Configuration

After specifying the hardware in local mode, use the Configuration Manager to perform all desired router configuration functions (adding and configuring interfaces, and so forth) as documented in subsequent chapters.

Saving and Implementing Changes

When you are finished creating or modifying the configuration file, save the file to the Site Manager workstation. To implement your configuration:
Operating Modes

1. Use the Router File Manager to select TFTP to transfer the configuration file to the router.

2. Use Site Manager to reboot the router with the configuration file.

See Chapter 6, “Implementing Configuration Changes,” for more information.

Remote Mode

Use remote mode if you can access the router over the network, but want to implement the configuration at a later date. In order to run the Configuration Manager in remote mode, you must first configure the router connection options that identify the router you want to configure and that provide Site Manager with an SNMP community that has read/write access to the router.

After you have specified the router connection options and selected the remote operating mode, the Configuration Manager uses SNMP GETs to retrieve and display the router’s hardware configuration in the Wellfleet Configuration Manager window. Optionally, if you specify a configuration file stored in the router’s file system, the Configuration Manager uses TFTP to automatically retrieve that file for local editing. In Figure 1-5, the router administrator has retrieved a configuration file which contains configuration information for the connectors in Slots 2, 3, and 5.

When you save an updated configuration file in remote mode, the Configuration Manager automatically uses TFTP to send the file to the router. You must then use Site Manager to reboot the router with that configuration file in order to implement the configuration.

The next section, “Performing Remote Configuration,” lists the configuration steps you must follow when operating the Configuration Manager in remote mode.
Performing Remote Configuration

To perform remote configuration, complete the following steps:

1. Specify the router you want to configure. Refer to "Specifying the Router in Dynamic and Remote Modes" later in this chapter.

2. When the Configuration Manager returns to the Wellfleet Site Manager window, select Tools → Configuration Manager → Remote File to display the Edit Remote Configuration File window (Figure 1-6).
Operating Modes

Figure 1-6. Edit Remote Configuration File Window

3. To retrieve a file from the router for local editing, complete these steps:
   a. Select the number of the volume (or slot) containing the configuration file.
   b. Click on the Volume box to display the available volumes. The directory of the chosen volume appears in the directory box.
   c. Either type the filename in the Enter file name box or click on the filename in the Directory scroll box.
d. Click on the Open button.

The Configuration Manager uses TFTP to retrieve and display the specified file in the Wellfleet Configuration Manager window; the filename you specified is displayed in the upper-left corner of the window. If the specified file does not exist, the Wellfleet Configuration Manager window displays the hardware configuration and no circuits.

At this point, you can

- Use the Configuration Manager to perform all desired router configuration functions (adding interfaces, configuring interfaces, and so forth).
- Use the Configuration Manager to save the configuration file to the Site Manager workstation.
- Use the Router File Manager to select TFTP to transfer the configuration file to the router.
- Use Site Manager to reboot the router with the configuration file.

**Dynamic Mode**

You use dynamic mode if you can access the router over the network and want to configure the system in real time. In order to run the Configuration Manager in dynamic mode, you must first configure SNMP options that identify the router you want to configure and that provide Site Manager with an SNMP community that has read-write access to the router.

**Performing Dynamic Configuration**

To perform dynamic configuration, complete the following steps:

1. Specify the router you want to configure. Refer to “Specifying the Router in Dynamic and Remote Modes” later in this chapter.

2. Specify the dynamic operating mode by selecting Tools→Configuration Manager→Dynamic in the Wellfleet Site Manager window.
Note: If you used the Technician Interface to set the router to secure mode during the Quick-Start procedure, you will now be prompted for a password. Enter the encryption key that you used when you set this router to secure mode.

The Wellfleet Configuration Manager window appears, displaying the real-time router hardware and software configuration.

3. Perform all desired router configuration functions (for example, adding network interfaces). Refer to later chapters of this book and any of the customizing network protocol books (for example, Customizing DECnet Services).

4. Save the configuration file to the router's file system if you wish to maintain a record of the changes you made. Refer to Chapter 6, “Implementing Configuration Changes,” later in this book.

Specifying the Router in Dynamic and Remote Modes

In order to run the Configuration Manager in dynamic or remote mode, you must first specify the router you wish to configure. You can connect to the router three ways:

- Use the well-known connections feature documented in the next section.

- Select the Connector box from the Wellfleet Site Manager window to display the Router Connection Options window (Figure 1-7).

- Select Options→Router Connection to display the Router Connection Options window.

Connect to the router using the Router Connection Options window, setting all parameters in the window, and clicking on the OK button. Use the Delete button to delete the currently displayed connection.
Edit the parameters in the Router Connection Options window as follows:
Parameter: Node Name/IP Address

Default: None

Options: Valid host name or valid IP address

Function: Specifies the host name or IP address of the Wellfleet router with which you wish to establish a management session.

Instructions: Enter the Wellfleet router’s IP address or host name. You may only use the host name to establish a management session if the host name is included in the workstation’s host file.

MIB Object ID: Not Applicable

Note: The Configuration Manager’s Router Connection Options window does not display the Node Name/IP Address parameter. Each instance of the Configuration Manager tool allows you access to one Wellfleet router only. To configure two Wellfleet routers simultaneously, you must display the Router Connection Options window from the Wellfleet Site Manager window, specify the new Wellfleet router, and then run another instance of the Configuration Manager tool, which automatically communicates with the Wellfleet router.
Parameter: Identity (Community)
  Default: Public
  Options: Any valid SNMP community name
  Function: Specifies the SNMP community name you want Site Manager to use when communicating with the Wellfleet router.
  Instructions: Enter the SNMP community name. The community must have read-write access to the specified Wellfleet router, if you wish to use the Configuration Manager to reconfigure the Wellfleet router.
  MIB Object ID: Not Applicable

Parameter: Timeout (seconds)
  Default: 10 seconds
  Range: 1 to 300 seconds
  Function: Specifies the number of seconds Site Manager waits for a response from the Wellfleet router after it issues an SNMP SET or GET before reissuing the command.
  Instructions: Enter the number of seconds.
  MIB Object ID: Not Applicable
Operating Modes

Parameter: Retries (per request)
Default: 2 attempts
Range: 1 to 32 attempts
Function: Specifies the number of times Site Manager will reissue a command when the Wellfleet router does not respond.
Instructions: Enter the number of times.
MIB Object ID: Not Applicable

Well-Known Connections Feature

The main Wellfleet Site Manager window displays a scroll box entitled Well-Known Connections (Figure 1-8). This scroll box lists the IP addresses of routers you have connected to with this version of Site Manager. Click on the IP address in the box to connect to the router.
Figure 1-8. Well-Known Connections Box

Site Manager lists the IP connections in order of the most recent connection. Every time you make a new connection using the Connection button on the Wellfleet Site Manager window (Figure 1-1) or use the Options→Connection menu, Site Manager automatically adds a new IP address to the list.

The status of the accessibility of the connection to the router is polled at a sample rate you can define. The Well-Known Connections box lists the results of the poll next to the IP address as Up, Down, or Ignore.

If you click on an IP address with a Down status, the Connection List Management window (Figure 1-9) appears.
The window offers four options:

- Try
  Poll again and try to connect now.

- Ignore
  Do not poll this address.

- Delete
  Remove this address from the list in the Well-Known Connections box.

- Cancel
  Return to the prior window without changing anything.

Click on the option you want for this connection. The Site Manager window appears.

Choose Options→Connections List from the Site Manager window to display the Connections List Options window (Figure 1-10). Set the options you want in the Well-Known Connections box.
This window includes the following options:

- **Polling**
  Set this option to Off to disable the testing of the accessibility of the IP addresses. If you set this option to On, Site Manager polls the IP addresses in the Well-Known Connections box to test whether the connections are still accessible.

- **Test Sample**
  Tests one connection or all connections per poll. If you select the One option, each poll tests one connection on the list in sequential order.
Operating Modes

- Test Rate (seconds)
  Enter in seconds how often to poll the IP addresses to test the validity of the connections. The default is 300 seconds.

- Maximum Connections
  Enter the maximum number of IP connections to display in the Well-Known Connections box. Valid entries are 1 to 100. If the entry is less than the number of connections currently in the box, Site Manager will truncate the list from the bottom.

- Connections List Label
  Edit this if you want to change the label (or name) of the Well-Known Connections box.

- Up Label
  Edit this if you want to change the label indicating the status of an accessible IP address in the Well-Known Connections box.

- Down Label
  Edit this if you want to change the label indicating the status of an inaccessible IP address in the Well-Known Connections box.

- Ignore Label
  Edit this if you want to change the label indicating the status of connections to be ignored in the Well-Known Connections box. Site Manager does not poll Ignored connections.

- Sound
  Edit this if you want the Well-Known Connections box to generate no sound, or to sound when
  - A connection is down (the default)
  - Polling occurs (one beep) and polling shows a connection is down (one beep per down connection)
  - There is a change in status

- Auto Scroll
  Edit this if you want an automatic scroll to a down connection in the Well-Known Connections box.

When you have completed your edits in the Connections List Option window, click on OK to implement them.
SNMP SET Error

On occasion you may receive a set error when you try to sign on to a router in dynamic mode. Set errors lock you out of the router for a period of time. A common cause might be another person using a router you are attempting to configure. The system displays the message SNMP General Set Error! Machine is currently locked by Manager (IP Address) or the more general message SNMP set error.

When a set error occurs, wait several minutes and try again. There is a default lock-out time of 2 minutes when a set error occurs.

Router Connection Messages

Site Manager supports three error messages that

☐ Explain why a router connection attempt failed.

☐ Provide information on any adjustments you may need to make in the router connection parameters.

Any of these messages can appear in a pop-up message box in response to a failed connection attempt.

Table 1-1 describes the failure condition that corresponds to each message:
Table 1-1. Router Connection Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Failure Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection failed, SNMP agent not responding. Check IP address and Community. Time-out and Retries may also need to be increased.</td>
<td>The router at the specified IP address did not respond to the connection attempt from your Site Manager workstation.</td>
</tr>
<tr>
<td>WARNING: Site Manager no longer supports the version of software that the router is running. Proceed with caution.</td>
<td>The MIB version of the router at the specified IP address is older than the MIB versions supported by your Site Manager workstation. (There is a backward compatibility problem.)</td>
</tr>
<tr>
<td>WARNING: Site Manager has discovered a forward compatibility situation with the router software. It is recommended that Site Manager be upgraded in order to manage this router properly. Proceed with caution.</td>
<td>The MIB version used by the router at the specified IP address is newer than the MIB versions supported by your Site Manager workstation. (There is a forward compatibility problem.)</td>
</tr>
</tbody>
</table>
Chapter 2
Adding Network Interfaces

This chapter describes how to use the Configuration Manager to perform the following procedures:

- Specify a router's hardware configuration.
- Add network interfaces based on router defaults.
  Defaults are suitable for most networks; however, the Configuration Manager allows you to change (or customize) these settings after you have added the interface. Bay Networks offers protocol-specific guides that provide instructions for customizing network interfaces; refer to these guides as necessary.
- Edit a router's circuits.
- Configure the router's connection to the Technician Interface.
- Specify router administrative information.

This chapter assumes that you are familiar with the Configuration Manager's three operating modes and that the Configuration Manager tool is running on your workstation. Refer to Chapter 1, "Configuration Manager Overview," for information on the three operating modes and for instructions on starting the Configuration Manager tool.

Note: If you are configuring an Access Node (AN) for the first time, you must read Administering Networks for AN and ASN Routers before you continue. This manual explains the special considerations for configuring and booting the AN.
Adding a Network Interface Overview

Depending on the type of network interface you want to add, the Configuration Manager tool requires you to specify only a few WAN and bridging/routing protocol parameters. The tool then provides default settings for the remaining parameters required to configure the interface.

**Note:** You must specify the router’s hardware configuration before adding a network interface when you create a new configuration file in local mode. Refer to the “Specifying Hardware” section later in this chapter for instructions.

Adding a network interface consists of the following two steps:

1. Configuring the circuit
2. Enabling bridging/routing protocols on the circuit

To configure the circuit, you specify the router’s physical network connection by clicking on a graphic of the appropriate connector. The Configuration Manager automatically sets all physical-layer (or line) parameters with default values for that type of connector. Additionally, for all local-area-network (LAN) connectors, the Configuration Manager automatically configures the datalink-layer connection, called a LAN circuit.

If the connector requires a wide area network connection, called a WAN circuit, the Configuration Manager automatically displays a pop-up menu from which you select the appropriate WAN protocol. If you select the ATM DXI, X.25, or Switched Multimegabit Data Service (SMDS) protocol, the Configuration Manager also requires you to set some WAN-protocol-specific parameters.

To enable bridging/routing protocols on the circuit, you select the desired protocols from a pop-up menu that the Configuration Manager displays automatically once the circuit is configured. Based on the protocols you select, the application then displays protocol-specific pop-up windows that prompt you to specify certain parameter values.
Adding Network Interfaces

The Configuration Manager provides default values for the remaining parameters needed to enable the selected bridging/routing protocols on that circuit. Once you have enabled bridging/routing protocols on a circuit, you have configured a network interface.

Specifying Hardware

You specify hardware only in local mode. When running in remote or dynamic mode, the Configuration Manager automatically retrieves the router's hardware configuration and displays it in the Wellfleet Configuration Manager window. When running the application in local mode, you can add hardware to empty slots and change the hardware in occupied slots. The procedure for both is the same.

Note: When you change hardware in a slot containing configured circuits, the Configuration Manager automatically deletes the circuits.

You specify hardware from the Wellfleet Configuration Manager window (Figure 2-1), as follows:

![Configuration Manager Window](Image)

**Figure 2-1. Wellfleet Configuration Manager Window**
Specifying Hardware

1. Under Description, click on the slot for which you want to specify hardware.

2. The Configuration Manager displays the Module List window (Figure 2-2), which lists link modules and their corresponding model numbers.

![Module List Window](image)

Figure 2-2. Module List Window

3. Click on the Link Module you want to insert in the slot.

   If the Link Module is hidden, drag the scroll bar to display it in the window.

4. Click on the OK button.

   The Wellfleet Configuration Manager window reappears, displaying the Link Module you just selected in the slot.
Configuring the Circuit

Note: Refer to Chapter 4 for instructions on adding MCT1 circuits, and refer to Chapter 5 for information on adding MCE1 circuits.

To configure a circuit, begin at the Wellfleet Configuration Manager window (Figure 2-1), and complete the following steps:

1. Click on the Link Module connector you want to connect to the network to display the Add Circuit window (Figure 2-3).

![Add Circuit Window](image)

**Figure 2-3. Add Circuit Window**

The Add Circuit window displays a default circuit name in the Circuit Name box. The default circuit name consists of a circuit type designator (Table 2-1) followed by two sets of numbers that identify the circuit location (the first number is between 1 and 14 and identifies the router slot; the second number is between 1 and 4 and identifies the specific connector in that slot). For example, the circuit name S21 in Figure 2-3 identifies a synchronous circuit in Slot 2 on Communications Port 1.
Table 2-1. Circuit-type Designators in Default Circuit Names

<table>
<thead>
<tr>
<th>Letter Designator</th>
<th>Connector Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Ethernet</td>
</tr>
<tr>
<td>E1</td>
<td>E1</td>
</tr>
<tr>
<td>F</td>
<td>FDDI</td>
</tr>
<tr>
<td>H</td>
<td>HSSI</td>
</tr>
<tr>
<td>MCE1</td>
<td>MCE1</td>
</tr>
<tr>
<td>MCT1</td>
<td>MCT1</td>
</tr>
<tr>
<td>O</td>
<td>Token Ring</td>
</tr>
<tr>
<td>S</td>
<td>Synchronous</td>
</tr>
<tr>
<td>T1</td>
<td>T1</td>
</tr>
</tbody>
</table>

Note: We recommend that you follow the default circuit-naming convention so that circuit types and locations are represented consistently. However, you can assign any circuit name containing up to 15 characters (alphabetical, numerical, underline, or slash) without spaces. Circuit names are case sensitive.

2. Click on the OK button.

   If the connector supports hardware filters, a pop-up window prompts: Do you want to enable Hardware Filters on this circuit? Click on the OK button to enable hardware filters. Otherwise, click on the Cancel button to exit the window.

   — If the selected connector requires a LAN circuit, the Configuration Manager automatically displays the Select Protocols window. Go to the “Enabling Bridging/Routing Services” section for instructions.
Adding Network Interfaces

— If the selected connector is an ISDN connector (such as ISDN1), a dialog box appears, telling you that you can only configure ISDN from the Dialup pull down menu. For information on configuring ISDN services, refer to *Upgrading AN Routers for ISDN Support*, or *Upgrading ASN Routers for ISDN Support*.

— If the selected connector requires a WAN circuit, the Configuration Manager displays the WAN Protocols window (Figure 2-4).

![WAN Protocols Window](image)

**Figure 2-4. WAN Protocols Window**

3. Select the WAN protocol you want to enable on that circuit and click on the OK button.

**Note:** When you select a WAN protocol, note the following:

If you select Frame Relay, PPP, or SMDS on the circuit, protocol prioritization is enabled automatically. For detailed information on protocol prioritization, refer to *Configuring Filter Options on Wellfleet Routers*.
If you select Standard, you cannot change the WAN protocol on this circuit to any of the other protocols later. If you want to enable any other protocol later on this circuit, you must delete the circuit and start over. For instructions on deleting a circuit from the router, refer to the section “Deleting a Circuit from the Router,” later in this chapter.

If you enable a specific WAN protocol on the circuit, the synchronous line parameters are automatically set as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOLF</td>
<td>Disable</td>
</tr>
<tr>
<td>Promiscuous</td>
<td>Enable</td>
</tr>
<tr>
<td>Service</td>
<td>Transparent</td>
</tr>
<tr>
<td>WAN Protocol</td>
<td>Chosen WAN protocol</td>
</tr>
</tbody>
</table>

See “Editing Synchronous Line Details” in Chapter 3 for more information.

If you are configuring a Wellfleet AN or ASN router, the ASYNC option appears in the WAN Protocols window (Figure 2-4). See “Editing Asynchronous Line Details” in Chapter 3 for more information on editing the ASYNC parameters.

If you selected the Standard, PassThru, PPP, or Frame Relay WAN protocol, the Configuration Manager displays the Select Protocols window. Go directly to the “Enabling Bridging/Routing Services” section for instructions.

Otherwise, you must specify a few additional parameters before proceeding to the “Enabling Bridging/Routing Services” section. Depending on the WAN protocol (ATM DXI, ATM FRE2, SMDS, SDLC, or X.25) you selected, you must complete the instructions in one of the following sections before going to the instructions in the “Enabling Bridging/Routing Services” section:
If you selected the ATM DXI protocol, go to the “Enabling ATM DXI Services” section.

If you selected the ATM FRE2 protocol, go to the “Enabling ATM FRE2 Services” section.

If you selected the SMDS protocol, go to the “Enabling SMDS Services” section.

If you selected the SDLC protocol, go to the “Enabling SDLC Services” section.

If you selected the X.25 protocol, go to the “Enabling X.25 Services” section.

Enabling ATM DXI Services

If you enabled ATM DXI on the circuit, the Configuration Manager displays the Select Protocols window.

To enable ATM DXI service on an interface, you

- Enable group protocols
- Add permanent virtual circuits (PVCs)

The following sections describe these tasks.

Enabling Protocols on an ATM DXI Circuit

Enable bridging/routing protocols on the ATM DXI circuit using the following procedure:

1. Select the protocol or protocols you want to enable on this ATM DXI circuit.

2. Click on the OK button when you finish enabling protocols on the ATM DXI circuit.
3. The Configuration Manager displays a protocol-specific window that prompts for additional information (if required). If you need assistance in responding to any queries, refer to the “Enabling Bridging/Routing Services” section of this chapter. When you finish configuring protocols, Site Manager returns to the Configuration Manager window.

Adding PVCs

To add a PVC, complete the following steps:

1. From the Configuration Manager window, select Protocols→ATM DXI→Interfaces to display the ATM DXI Interface List window (Figure 2-5).

![Figure 2-5. ATM DXI Interface List Window]
2. Select the ATM DXI interface to which you want to add PVCs and click on the PVCS button. The system displays the ATM DXI PVC List window (Figure 2-6).

![ATM DXI PVC List Window](image)

**Figure 2-6. ATM DXI PVC List Window**

3. Click on the Add button. The system displays the ATM DXI Virtual Circuit window (Figure 2-7).
4. Enter the virtual path identifier (VPI) and virtual channel identifier (VCI) numbers that you want to use for the PVC. These parameters are affected by the value of the DXI Mode parameter on the ATM DXI Interface List Window (Figure 2-5). Refer to Customizing ATM Services for guidelines.

5. Click on the OK button. The system returns you to the ATM DXI PVC List window (Figure 2-6). The default mode of the PVC you just added is GROUP ACCESS. If you want to change any of the parameters on the ATM DXI PVC List window, refer to Customizing ATM Services for instructions.

6. To add another PVC with the default configuration, repeat Steps 3, 4, and 5. When you are finished adding PVCs, go to Step 7.

7. Click on the Done button on the ATM DXI PVC List window to return to the ATM DXI Interface List window.

8. Click on the Done button on the ATM DXI Interface List window to return to the Configuration Manager window.
<table>
<thead>
<tr>
<th>Parameter:</th>
<th>VPI Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>None</td>
</tr>
<tr>
<td>Range:</td>
<td>0 to 255</td>
</tr>
<tr>
<td>Function:</td>
<td>Identifies the virtual path of the PVC.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>The value of this parameter is affected by the DXI Mode parameter on the ATM DXI Interface List Window (Figure 2-5). If you have selected Mode 1a or 1b for the DXI Mode value, enter a value between 0 and 15. If you chose Mode 2 or 2 Proprietary, enter a value between 0 and 255. Refer to Customizing ATM Services for more information.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.5.9.5.14.1.3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>VCI Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>None</td>
</tr>
<tr>
<td>Range:</td>
<td>32 to 65535</td>
</tr>
<tr>
<td>Function:</td>
<td>Identifies the virtual channel of the PVC.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>The value of this parameter is affected by the DXI Mode parameter on the ATM DXI Interface List Window (Figure 2-5). If you have selected Mode 1a or 1b for the DXI Mode value, enter a value between 32 and 63. If you chose Mode 2 or 2 Proprietary, enter a value between 32 and 65535. Refer to Customizing ATM Services for more information.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.5.9.5.14.1.4</td>
</tr>
</tbody>
</table>
Enabling ATM FRE2 Services

If you enabled ATM FRE2 on the circuit, the Configuration Manager displays the Select Protocols window.

To enable ATM FRE2 service on an interface, you
- Enable group protocols
- Add virtual channel links (VCLs)

The following sections describe these tasks.

Enabling Protocols on an ATM FRE2 Circuit

Enable bridging/routing protocols on the ATM FRE2 circuit using the following procedure:

1. Select the protocol or protocols you want to enable on this ATM FRE2 circuit.
2. Click on the OK button when you finish enabling protocols on the ATM FRE2 circuit.
3. The Configuration Manager displays a protocol-specific window that prompts for additional information (if required). If you need assistance in responding to any queries, refer to the “Enabling Bridging/Routing Services” section of this chapter.

When you finish configuring protocols, Site Manager returns to the Configuration Manager window.

Adding VCLs

To add a VCL, complete the following steps:

1. From the Configuration Manager window, select Protocols → ATM FRE2 → Interfaces to display the ATM Interface List window (Figure 2-8).
2. Select the ATM FRE2 interface to which you want to add VCLs and click on the VCL button. The system displays the ATM Virtual Channel Link window (Figure 2-9).
3. Click on the Add button. The system displays the ATM FRE2 Virtual Channel Link Parameters window (Figure 2-10).
4. Enter the virtual path identifier (VPI) and virtual channel identifier (VCI) numbers that you want to use for the VCL. Refer to *Customizing ATM Services* for guidelines.

5. Click on the OK button. The system returns you to the ATM FRE2 Virtual Channel Link window (Figure 2-9). The default mode of the VCL you just added is GROUP ACCESS. If you want to change any of the parameters on the ATM FRE2 Virtual Channel Link window, refer to *Customizing ATM Services* for instructions.

6. To add another VCL with the default configuration, repeat Steps 3, 4, and 5. When you are finished adding VCLs, go to Step 7.

7. Click on the Done button on the ATM FRE2 Virtual Channel Link window to return to the ATM FRE2 Interface List window.

8. Click on the Done button on the ATM FRE2 Interface List window to return to the Configuration Manager window.
Parameter: VPI Number
Default: None
Range: 0 to 255
Function: Identifies the virtual path of the VCL.
Instructions: Enter a VPI value between 0 and 255. The VPI (virtual path identifier) is part of the cell header. The header can contain a maximum of 8 VPI bits for a UNI (User to Network Interface) connection. This bit range allows for path identifiers between 0 and 255.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.3

Parameter: VCI Number
Default: None
Range: 32 to 65535
Function: Identifies the virtual channel of the VCL.
Instructions: Enter a VCI value between 32 and 65535. The VCI (virtual channel identifier) is part of the cell header. The header can contain a maximum of 16 VCI bits. This bit range allows for path identifiers between 0 and 65535.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.4

Note: Following the recommendation of the ATM Forum, the first five (5) VCI bits of the VCL (that is, identifiers between 0 and 31) are reserved for added functionality.
Enabling SMDS Services

If you specified the SMDS (Switched Multimegabit Data Service) protocol to run on the circuit, the Configuration Manager displays the SMDS Configuration window (Figure 2-11). Refer to the parameter descriptions in this section to specify the required SMDS parameters (Individual Address, Group Address, and ARP Address) and click on the OK button to enable default SMDS service. You can then proceed directly to the "Enabling Bridging/Routing Services" section of this chapter.

![SMDS Configuration Window](Figure 2-11. SMDS Configuration Window)
Parameter: Individual Address

Default: None

Options: A complete SMDS E.164 address specified by the SMDS subscription agreement that you have with your SMDS provider

Function: Provides a MAC-layer address.

Instructions: Enter the complete SMDS E.164 address, for example, C1508234874FFFF.

To configure this parameter for a multigroup configuration, enter this same address in the IP interface parameter MAC Address. If you want to pair your IP interfaces with another MAC address, enter the new address in the IP interface parameter, not in this parameter. The IP parameter value overrides the SMDS parameter.

To configure this parameter for a multinet configuration, enter this same address in the IP interface parameter MAC Address for every IP interface that you want associated with this one address.

For information about IP, refer to Customizing IP Services.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.3.1.5
Parameter: Group Address

Default: None

Options: A complete SMDS E.164 address specified by the SMDS subscription agreement that you have with your SMDS provider.

Function: Provides a MAC-layer multicast address for this SMDS interface.

Instructions: Enter the complete SMDS E.164 group address, for example, E16175552876FFFF.

To configure this parameter for a multigroup configuration, enter this same address in the IP interface parameter SMDS Group Address. If you want to pair your IP interfaces with another SMDS group address, enter the new group address in the IP interface parameter, not in this parameter. The IP parameter value overrides the SMDS parameter value.

To configure this parameter for a multinet configuration, enter this same address in the IP interface parameter SMDS Group Address for every IP interface that you want associated with this one group address.

For information about IP, refer to Customizing IP Services.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.3.1.6
<table>
<thead>
<tr>
<th>Parameter:</th>
<th>ARP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>None</td>
</tr>
<tr>
<td>Options:</td>
<td>A complete SMDS E.164 address specified by the SMDS subscription agreement that you have with your SMDS provider.</td>
</tr>
<tr>
<td>Function:</td>
<td>Provides an address resolution multicast address.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Enter the complete SMDS E.164 address, for example, E16175552876FFFF.</td>
</tr>
</tbody>
</table>

To configure this parameter for a multigroup configuration, enter this same address in the IP interface parameter SMDS ARP Req Address. If you want to pair your IP interfaces with another ARP address, enter the new address in the IP interface parameter, not in this parameter. The IP parameter value overrides the SMDS parameter value.

To configure this parameter for a multinet configuration, enter this same address in the IP interface parameter SMDS ARP Req Address for every IP interface that you want associated with this one address.

For information about IP, refer to *Customizing IP Services*.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.3.1.7
Enabling SDLC Services

If you selected the SDLC option on the WAN Protocols window (Figure 2-4), the Configuration Manager displays the SDLC Line Parameters window (Figure 2-13).

![SDLC Line Parameters Window](image)

**Figure 2-12. SDLC Line Parameters Window**

1. Specify the synchronous line parameters in the SDLC Line Parameters window, as follows:
Parameter: Clock Source

Default: External

Options: External | Internal

Function: Specifies the origin of the synchronous timing signals. If you set this parameter to Internal, this router supplies the required timing signals. If you set this parameter to External, an external network device supplies the required timing signals. In most cases, this parameter should be set to External.

Instructions: Set this parameter to either Internal or External, as appropriate for your network.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.13
Parameter: Internal Clock Speed

Default: 64 KB

Options: 1200 B | 2400 B | 4800 B | 7200 B | 9600 B | 19200 B | 32000 B | 38400 B | 56 KB | 64 KB | 125 KB | 230 KB | 420 KB | 625 KB | 833 KB | 1.25 MB | 2.5 MB | 5 MB

Function: Sets the clock speed of an internally supplied clock when the Clock Source parameter is set to Internal.

Instructions: Click on Values and set the clock speed for the internal clock to the desired data transmission rate across the synchronous line. Depending on the protocols configured on this interface, this value may control internal decision making within the router. In some cases, the router uses this value for route selection. If protocol prioritization is configured, the router uses this parameter to calculate line delay (refer to Configuring Filter Options on Wellfleet Routers for information about protocol prioritization, latency, and queue depth).

The Internal Clock Speed parameter is unavailable when the Clock Source parameter is set to External.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.14
Parameter: Sync Line Coding
Default: NRZ
Options: NRZ | NRZI | NRZI Mark
Function: This parameter specifies the line coding of the physical synchronous line. You can change the value of this parameter to match the line coding of a device at the other end of the line.
This parameter is relevant only for the AN and the ASN.

NRZ
Indicates Non-Return to Zero coding

NRZI
Indicates Non-Return to Zero Inverted coding

NRZI Mark
Indicates Non-Return to Zero Inverted Mark coding.

Instructions: Select the appropriate value for synchronous line coding.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.88

Parameter: Cable Type
Default: Null
Options: Null | RS232 | RS422 | V35 | X21
Function: This parameter is used only for switched-service lines. If the sync port is connected to a dialup device for switch services, use this parameter to specify the cable interface type of the device.

Instructions: Set to reflect the cable interface type being used to connect the dial unit if you are using one.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.83
2. Click on the OK button to display the Select Protocols window (Figure 2-13).

Select either DLSw or APPN as the client protocol to run on the SDLC circuit.

![Select Protocols Window](image)

**Figure 2-13. Select Protocols Window**

If you select either the DLSw or the APPN option, go to the “Enabling Bridging/Routing Services” section in this chapter for information on enabling DLSw and APPN.

For detailed information on customizing SDLC, APPN, and DLSw services on your router, refer to the following manuals:

- *Customizing SDLC Services*
- *Customizing APPN Services*
- *Customizing DLSw Services*
Enabling X.25 Services

Enabling X.25 service on a circuit consists of the following three steps:

- Specifying packet-level parameters
- Adding X.25 service records
- Enabling bridging/routing protocols

The following sections describe how to perform each step.

Specifying Packet-Level Parameters

If you specified that the X.25 protocol run on the circuit, the Configuration Manager displays the X.25 Packet Config window (Figure 2-14). Refer to the parameter descriptions in this section to specify the packet-level parameters. When you are done, click on the Save button to display the X.25 Service Configuration window (Figure 2-15). You add X.25 service records from this window. Refer to the “Adding New X.25 Network Service Records” section for instructions.
Figure 2-14. X.25 Packet Config Window

Caution: After you enable X.25 service on the router, you can edit the default settings for the rest of the X.25 parameters. However, remember that line speed, packet size, and window size all affect packet throughput across the X.25 network. Setting any of these variables too low could cause the router to drop packets. Therefore, use caution when changing the default settings for the following X.25 parameters:

- Max Window Size
- Max Packet Length
- Window Size
Packet Size

See *Customizing X.25 Services* for instructions on editing X.25 parameters.

**Parameter:** Link Address Type

- **Default:** None
- **Options:** DCE | DTE
- **Function:** Specifies whether this interface provides DCE or DTE services.
- **Instructions:** Specify the service type as DCE or DTE.
- **MIB Object ID:** 99999.31.2
Parameter: Network Address Type
Default: None
Options: PDN_Network | DDN_Network | BFE_Network
Function: Specifies the type of X.25 network to which this interface connects, which dictates the format of the local X.121 address.
Instructions: Specify the appropriate format. Then note the following conditions:

- If you specify PDN_Network, then you must enter the local address in X.121 address format, using the PDN X.121 Address parameter.

- If you specify DDN_Network or BFE_Network, then you must enter the local address in IP address format, using the DDN IP Address parameter. The router then translates the address into X.121 format.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.5.1.50

Parameter: PDN X.121 Address
Default: None
Options: Any valid X.121 address
Function: Specifies the X.121 address assigned to this interface. The X.121 address is supplied by the X.25 network service provider.
Instructions: Enter the appropriate X.121 address.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.5.1.52
Parameter: DDN IP Address
Default: None
Options: Any valid IP address
Function: Specifies the IP address assigned to this interface. The router then translates the address into X.121 format and uses it as the local address.

Note that you need to set this parameter only if you set the Network Address Type to DDN_Network or BFE_Network.

Instructions: Enter the appropriate IP address.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.5.1.51

Parameter: Incoming Logical Channel Count
Default: None
Range: 1 to 512
Function: Specifies the number of logical channels that will accept incoming call requests received on this interface.

Instructions: Enter the number of logical channels that will accept incoming call requests received on this interface.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.5.1.36
Parameter: **Incoming LCN Start**

Default: None

Range: 1 to 4096

Function: Specifies the low end of the range of logical channel numbers that the router can assign to logical channels that accept incoming call requests only.

Instructions: Enter the low end of the range of logical channel numbers designated for channels that accept incoming call requests only.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.5.1.37

Parameter: **Bidirectional Logical Channel Count**

Default: None

Range: 1 to 512

Function: Specifies the number of logical channels that will both accept incoming call request packets and transmit outgoing call request packets on this interface.

Instructions: Enter the number of logical channels that will both accept and transmit call request packets on this interface.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.5.1.38
Configuring the Circuit

**Parameter:** Bidirectional LCN Start  
**Default:** None  
**Range:** 1 to 4096  
**Function:** Specifies the low end of the range of logical channel numbers that the router can assign to bidirectional logical channels.  
**Instructions:** Enter the low end of the range of logical channel numbers designated for bidirectional channels.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.9.4.5.1.39

**Parameter:** Outgoing Logical Channel Count  
**Default:** None  
**Range:** 1 to 512  
**Function:** Specifies the number of logical channels that will transmit outgoing call request packets on this interface.  
**Instructions:** Enter the number of logical channels that will transmit call request packets on this interface.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.9.4.5.1.40
Parameter: Outgoing LCN Start

Default: None
Range: 1 to 4096
Function: Specifies the low end of the range of logical channel numbers that the router can assign to logical channels that transmit outgoing call requests only.

Instructions: Enter the low end of the range of logical channel numbers designated for those channels that transmit outgoing calls only.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.5.1.41

Adding New X.25 Network Service Records

You add network service records from the X.25 Service Configuration window (Figure 2-15). Click on the Add button to display the X.25 Service window (Figure 2-16).

Figure 2-15. X.25 Service Configuration Window
Refer to the parameter descriptions in this section to specify the type of X.25 network service you want to add and the parameters associated with that service. When you are done, click on the OK button to return to the X.25 Service window, which now displays the record you just added. At this point you can add another network service record by repeating the instructions in this section, or you can enable bridging/routing services on the X.25 circuit by following the instructions in the next section, “Enabling Bridging/Routing Services on an X.25 Circuit.”

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>None</td>
</tr>
<tr>
<td>Options:</td>
<td>PDN</td>
</tr>
<tr>
<td>Function:</td>
<td>Specifies the type of X.25 service that this interface supplies: PDN, DDN, or point-to-point.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Select PDN for Public Data Network service, DDN for Department of Defense Network service, or PTOPT for point-to-point network service.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.5.9.4.2.1.9</td>
</tr>
</tbody>
</table>
**Parameter:** Remote X.121 Address

- **Default:** None
- **Options:** Any valid X.121 address
- **Function:** Specifies a destination X.121 address reachable over this X.25 interface. You must specify a destination X.121 address if you are configuring PDN or point-to-point services.

**Instructions:** Enter a destination X.121 address.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.9.4.2.1.12

---

**Parameter:** Remote IP Address

- **Default:** 0.0.0.0
- **Options:** Any valid IP address
- **Function:** Specifies a destination IP address reachable over this X.25 interface.

You must specify a remote IP address if you are configuring DDN services. The router translates the remote IP address you specify into an X.121 address so that it can route IP traffic over the network.

**Instructions:** Enter a 32-bit destination IP address in dotted decimal notation format.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.9.4.2.1.13
Configuring the Circuit

Parameter:Connection ID
  Default: 1
  Range: 1 to 255
  Function: When there are multiple point-to-point circuits configured to the same X.121 destination, the connection ID identifies each circuit to the destination.
  Instructions: Assign a unique connection ID for each X.121 connection.
  MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.2.1.11

Enabling Bridging/Routing Services on an X.25 Circuit

After you have added at least one network service record, you can enable bridging/routing protocols on the X.25 circuit.

Note: If you configured multiple DDN or PDN network service records on the X.25 circuit, you only have to enable bridging/routing protocols on that circuit once. However, if you configured multiple PTOP network service records on the X.25 circuit, you have to enable bridging/routing protocols for each PTOP network service record. This is because the router uses a different internal circuit for each PTOP record configured on the circuit.

To begin, select a network service record in the X.25 Service Configuration window and then select Protocols→Add/Delete. The Configuration Manager displays the Select Protocols window, from which you select the bridging/routing protocols you want to enable on that circuit. Click on those protocols, then click on the OK button.
Based on the protocols you select, the application then displays protocol-specific pop-up windows that prompt you to specify certain parameter values. Refer to the "Enabling Bridging/Routing Services" section of this chapter for instructions on setting these parameters. When you have specified the protocol-specific parameters in all pop-up windows, the Configuration Manager returns to the X.25 Service Configuration window.

At this point, you can enable additional bridging/routing protocols on the circuit by repeating the instructions in this section, or you can click on the Done button to exit the window.

**Configuring Multiple IP Interfaces Over X.25 Circuits**

The Wellfleet Configuration Manager allows you to configure multiple IP interfaces on single X.25 PDN circuits. This means that a single X.25 circuit can respond to multiple IP addresses, each on a different subnet, at the same time. This section leads you through the different Configuration Manager screens that display when you configure multiple IP interfaces on a single X.25 circuit. To configure multiple IP address over X.25, perform the following steps:

1. From the X.25 Service Configuration Window (Figure 2-15), select the Protocols→Add/Delete menu, as illustrated in Figure 2-17.
Configuring the Circuit

<table>
<thead>
<tr>
<th>Enable</th>
<th>ENABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>PDN</td>
</tr>
<tr>
<td>Connection ID</td>
<td></td>
</tr>
<tr>
<td>Remote IP Address</td>
<td>192.32.4.121</td>
</tr>
<tr>
<td>Remote X.121 Address</td>
<td>1234</td>
</tr>
<tr>
<td>Broadcast</td>
<td>OFF</td>
</tr>
</tbody>
</table>

**Figure 2-17. Selecting the Protocols Add/Delete Function on the X.25 Service Configuration Window**

When you select the Add/Delete function, the Select Protocols window appears (Figure 2-18).
2. On the Select Protocols Window, select the IP option and click OK. The IP Configuration Window appears (Figure 2-19).

Figure 2-18. Select Protocols Window

Figure 2-19. IP Configuration Window
3. Specify the local IP Address, Subnet Mask, and Transmit Bcast Addr parameters, as follows:

**Parameter:** IP Address
- **Default:** None
- **Options:** Any valid IP address
- **Function:** Assigns a 32-bit IP address to the interface.
- **Instructions:** Enter the IP address of the interface in dotted decimal notation.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.1.4.1.4

**Parameter:** Subnet Mask
- **Default:** None
- **Options:** The Configuration Manager automatically calculates an appropriate subnet mask, depending on the class of the network to which the interface connects. However, you can change the subnet mask with this parameter.
- **Function:** Specifies the network and subnetwork portion of the 32-bit IP address.
- **Instructions:** Either accept the assigned subnet mask, or enter another subnet mask in dotted decimal notation.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.1.4.1.6
**Parameter:** Transmit Bcast Addr  
**Default:** 0.0.0.0  
**Options:** 0.0.0.0 or any valid IP broadcast address  
**Function:** Specifies the broadcast address that this IP subnet uses to broadcast packets.  
Accepting 0.0.0.0 for this parameter specifies that the IP router will use a broadcast address with a host portion of all 1s. Accepting 0.0.0.0 does not configure the router to use the address 0.0.0.0 to broadcast packets. For example, if you have IP address 123.1.1.1 and a subnet mask of 255.255.255.0, accepting the default value 0.0.0.0 configures the IP router to use the address 123.1.1.255 to broadcast packets.  
To set the explicit broadcast address of all 1s, enter 255.255.255.255 for this parameter.

**Instructions:**  
Accept the default, 0.0.0.0, unless the calculated broadcast address (host portion) of all 1s is not adequate. If this is the case, then enter the appropriate IP broadcast address in dotted decimal notation.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.1.4.1.8  

4. When you are finished specifying the parameters on this screen, click OK to display the Enter Adjacent Host window (Figure 2-20).

5. Specify the IP address of the adjacent host.
**Figure 2-20. Enter Adjacent Host Window**

**Parameter:** IP Address  
**Default:** None  
**Options:** The remote IP address displayed on the X.25 Service Configuration window (Figure 2-17).  
**Function:** Assigns a 32-bit IP address to the interface.  
**Instructions:** Enter the IP address of the interface in dotted decimal notation.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.1.4.1.4

6. Click OK to return to the X.25 Service Configuration window (Figure 2-21).

7. Select the Protocols→Edit IP→Interfaces menu to display the IP Interfaces window (Figure 2-22).
Adding Network Interfaces

Figure 2-21. Selecting the Protocols→Edit IP→Interfaces Menu
8. From the IP Interfaces window, click on the Add button to configure additional IP interfaces on the X.25 circuit. The IP Configuration window appears (Figure 2-23).

Note: For information on the parameters appearing in the IP Interfaces window, refer to Customizing IP Services.
9. Specify information for the local IP Address, Configure RIP, and Configure OSPF parameters, as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>None</td>
</tr>
<tr>
<td>Options</td>
<td>Any valid IP address</td>
</tr>
<tr>
<td>Function</td>
<td>Assigns a 32-bit IP address to the interface.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Enter the IP address of the interface in dotted decimal notation.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.5.3.2.1.4.1.4</td>
</tr>
</tbody>
</table>
Parameter: Configure RIP
Default: None
Options: Yes | No
Function: Specifies whether the Routing Information Protocol is to be configured on this interface.
Instructions: Click on Values and specify Yes or No.
MIB Object ID: None

Parameter: Configure OSPF
Default: None
Options: Yes | No
Function: Specifies whether the Open Shortest Path First (OSPF) protocol is to be configured on this interface.
Instructions: Click on Values and specify Yes or No.
MIB Object ID: None

For detailed information on RIP and OSPF, refer to the section in this chapter “Enabling Bridging/Routing Services.”

10. When you have specified the parameters in the IP Configuration window, click on OK. The Enter Adjacent Host window appears (Figure 2-20). Specify the IP address for the remote host, as previously described. If you need to specify additional IP interfaces on the X.25 circuit, click on the Add button in the IP Interfaces window (Figure 2-22) and continue adding IP interfaces until you are finished.
Enabling Bridging/Routing Services

Once a circuit is configured, the Configuration Manager displays the Select Protocols window (Figure 2-24) from which you select the bridging/routing protocols you want to run over that circuit. The window differs slightly according to circuit type, displaying only those protocols that the circuit type supports. In addition, for certain circuit types, the window allows you to select the protocol priority feature (refer to Configuring Filter Options on Wellfleet Routers for instructions for configuring protocol prioritization).

![Select Protocols Window](image)

To enable bridging/routing services, complete the following steps:

1. Select all bridging/routing protocols that you want to enable on the circuit.
2. Click on the OK button.
If you select Spanning Tree, the Configuration Manager automatically enables the Bridge protocol because Spanning Tree is a Bridging service. (Note that Spanning Tree is indented beneath the line containing Bridge.) Similarly, if you select RIP, EGP, OSPF, BGP, RARP, or BOOTP, the Configuration Manager automatically enables IP because these are all IP services. If you select RIP (IPX) or RIP (XNS), IPX or XNS is enabled automatically.

Note: When you choose protocols for a Frame Relay circuit, the protocols you select only apply to PVCs configured for group access mode, the default access mode for Frame Relay PVCs. If you want to select protocols for Frame Relay PVCs in direct or hybrid access mode, Site Manager prompts you for these protocols when you add PVCs to your Frame Relay interface. Do not configure protocols for these access modes when you initially configure a Frame Relay circuit.

For each protocol you select, the Configuration Manager generally displays a protocol-specific configuration window prompting for additional required information. Some protocols (for example, the Bridge, VINES, and NetBIOS) require no additional information to provide default service. In such cases, no pop-up window is displayed.

For each protocol-specific pop-up window that the Configuration Manager displays, you must specify the required configuration information. You then have the option of accepting default values for the remaining parameters needed to enable that protocol on the circuit, or editing these default settings. This guide only provides instructions for accepting default values. If you want to edit the defaults, refer to the appropriate protocol-specific guide for instructions.

To accept default values, click on the OK button in each pop-up window after specifying the required information. The Configuration Manager then displays the pop-up window for the next protocol enabled on the circuit.
The following sections describe how to define all routing and bridging protocols for a circuit. Refer to them as necessary to specify the protocol-specific parameters displayed in each pop-up window. Once you have defined all protocols enabled on the circuit, the Configuration Manager returns to the Wellfleet Configuration Manager window and highlights the connector box to indicate that the interface has been added.

### Enabling Bridging Service

If you enabled the Bridge on the circuit, but did not enable the Spanning Tree algorithm, you need not specify any configuration information. Either the protocol pop-up window for the next enabled protocol appears, or, if only the Bridge is enabled on this circuit, the Wellfleet Configuration Manager window appears.

If you want to edit Bridge parameter defaults, refer to *Customizing Bridging Services* for instructions.

### Enabling Spanning Tree Service

You enable Spanning Tree service from the Spanning Tree Autoconfiguration window (Figure 2-25). Refer to the parameter descriptions in this section to specify the parameters and then click on the OK button. At this point, a pop-up window will prompt Do you want to edit the Spanning Tree Interface Details? Either click on the Cancel button to enable default Spanning Tree service and to display the next protocol-specific pop-up window, or click on the OK button to edit the default values. (Refer to *Customizing Bridging Services* for instructions.)

**Note:** Because the Spanning Tree is global (that is, it runs across all Bridge circuits), the Configuration Manager only displays the Spanning Tree Autoconfiguration window the first time you specify Spanning Tree for the Bridge. After that, you never again specify global Spanning Tree configuration information.
**Parameter:** Bridge Priority  
**Default:** None  
**Range:** 0 to 65535  
**Function:** In conjunction with the Bridge MAC Address parameter, assigns a 64-bit bridge ID to the router. This parameter supplies the most significant 16 bits of the bridge ID, while Bridge MAC Address supplies the remaining (least significant) 48 bits.  

The bridge ID is used by the Spanning Tree in the selection of the root bridge. In selecting the root bridge, the Spanning Tree chooses the bridge with the lowest-number bridge ID. Thus, the lower the value you set for this parameter, the more likely that the router will be selected as the root bridge.

**Instructions:** Enter a decimal value from 0 to 65535.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.2.1.5
Parameter: **Bridge MAC Address**

Default: None

Options: Any valid 48-bit MAC-level address

Function: In conjunction with the Bridge Priority parameter, assigns a 64-bit bridge ID to the router. Bridge Priority supplies the most significant 16 bits of the bridge ID, while this parameter supplies the remaining (least significant) 48 bits.

The bridge ID is used by the Spanning Tree in the selection of the root bridge. In selecting the root bridge, the Spanning Tree chooses the bridge with the lowest number bridge ID. Thus, the lower the setting of Bridge Priority, the more likely that the router will be selected as the root bridge. In the event of equal Bridge Priority values, the value of this parameter determines the bridge’s priority.

Instructions: Enter a 48-bit MAC address expressed as a 12-digit hexadecimal value. We recommend that you set this parameter to the MAC address of one of the router’s Spanning Tree ports, preferably the one with the lowest priority.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.2.1.5

---

**Enabling Internet Protocol Services**

You enable Internet Protocol services from the IP Configuration window (Figure 2-26). Refer to the parameter descriptions in this section to specify the parameters. When you have specified all parameters in the window, you can either click on the OK button to enable default IP services and to display the next protocol-specific pop-up window, or click on the Details button to edit the default values. (Refer to *Customizing IP Services* for instructions.)
### Parameter: IP Address

**Default:** None  
**Options:** Any valid IP address  
**Function:** Assigns a 32-bit IP address to the interface.  
**Instructions:** Enter the IP address of the interface in dotted decimal notation.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.1.4.1.4
**Parameter:** Subnet Mask

**Default:** None

**Options:** The Configuration Manager automatically calculates an appropriate subnet mask, depending on the class of the network to which the interface connects. However, you can change the subnet mask with this parameter.

**Function:** Specifies the network and subnetwork portion of the 32-bit IP address.

**Instructions:** Either accept the assigned subnet mask, or enter another subnet mask in dotted decimal notation.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.1.4.1.6
Parameter: Transmit Bcast Addr

Default: 0.0.0.0

Options: 0.0.0.0 or any valid IP broadcast address

Function: Specifies the broadcast address that this IP subnet uses to broadcast packets.

Accepting 0.0.0.0 for this parameter specifies that the IP router will use a broadcast address with a host portion of all 1s. Accepting 0.0.0.0 does not configure the router to use the address 0.0.0.0 to broadcast packets. For example, if you have IP address 123.1.1.1 and a subnet mask of 255.255.255.0, accepting the default value 0.0.0.0 configures the IP router to use the address 123.1.1.255 to broadcast packets.

To set the explicit broadcast address of all 1s, enter 255.255.255.255 for this parameter.

Instructions: Accept the default, 0.0.0.0, unless the calculated broadcast address (host portion) of all 1s is not adequate. If this is the case, then enter the appropriate IP broadcast address in dotted decimal notation.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.4.1.8

Note: If you chose RIP, EGP, BGP, OSPF, RARP, or BOOTP at the Select Protocols window, the Wellfleet Configuration Manager enables the selected protocol.
Enabling Open Shortest Path First Service

If you enabled OPSF on the interface, the Configuration Manager displays the Initial OSPF Global Configuration window (Figure 2-27) when you exit the IP Configuration window.

Refer to the parameter descriptions in this section to specify the parameters for this window. When you have specified the parameters, click on the OK button to enable default OSPF services and to display the OSPF Area Address for Interface window (Figure 2-30). If you want to edit the default values, refer to Customizing IP Services for instructions.

![Initial OSPF Global Configuration Window](image)

Figure 2-27. Initial OSPF Global Configuration Window
Parameter: Router ID

Default: The IP address of the first OSPF circuit configured on this router

Options: Any IP address, preferably one of the router's IP interface addresses

Function: This IP address uniquely identifies this router in the OSPF domain. By convention, and to ensure uniqueness, one of the router's IP interface addresses should be used as the router ID. The router ID will determine the designated router on a broadcast link if the priority values of the routers being considered are equal. The higher the router ID, the greater its priority.

Instructions: Enter the appropriate IP address in dotted decimal notation. See note below.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.1.4

Note: If both OSPF and BGP are running on the router, then the setting of the OSPF Router ID must be identical to the setting of the BGP Identifier.

Parameter: AS Boundary Router

Default: No

Options: Yes | No

Function: Indicates whether or not this router functions as an AS boundary router. The router can be an AS boundary router if one or more of its interfaces is connected to a non-OSPF network (for example, RIP or EGP).

Instructions: Set this parameter to Yes if this router functions as an AS boundary router. Otherwise, accept the default value, No.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.1.7

Parameter: **Hold Down Timer**

Default: 1  
Range: 0 to 10 seconds  
Function: Prevents the algorithm from running more than once per the value of Hold Down Timer. Its purpose is to free up the CPU. Note that a value of 0 means there is no hold-down time.

Instructions: Either accept the default value of 1 second, or enter a new value.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.1.9

Parameter: **OSPF Slot**

Default: All slots  
Options: Any slot on the Wellfleet router  
Function: Indicates which slot(s) OSPF is eligible to run on. If the slot on which OSPF is running goes down, the Wellfleet router will attempt to run OSPF on another slot you specify with this parameter.

Instructions: Select all of the appropriate slots.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.1.10

**Note:** Use caution when selecting the slot(s) on which OSPF may run. If you choose an empty slot, and it is the only slot you choose, OSPF will not run; if you choose a slot that becomes disabled, and it is the only slot you choose, OSPF will not restart.
## Parameter: Ase Metric Support

**Default:** Disabled  
**Options:** Enabled | Disabled  
**Function:** Specifies whether the new ASE metric support is enabled. The new metric is not compatible with the pre-Version 8.00 ASE metrics. Set this parameter to Disabled if the router is to interoperate with routers running a pre-8.00 OSPF version.

**Instructions:**  
Select Enabled if the router is to use the new metric support.  
Select Disabled if the router is not to use the new metric support.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.3.1.11

## Parameter: Backup Enable

**Default:** Enabled  
**Options:** Enabled | Disabled  
**Function:** Enables or disables the backup OSPF soloist’s backup link state database. When you set this parameter to Disabled, the OSPF backup soloist does not maintain a copy of the OSPF link state database.

**Instructions:**  
Select Enabled to maintain a copy of the OSPF link state database.  
Select Disabled if you do not wish to maintain a copy of the OSPF link state database.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.3.1.12
Parameter: Primary Log Mask

Default: All options enabled

Options: Trace messages
INFO level messages
Debug level messages
OSPF interface state change messages
Nbr state changes
Self-origination of LSAs
Receipt of new LSAs
Changes to OSPF’s routing table
Bad LS requests, Acks, or updates
Receipt of less recent LSAs
Receipt of more recent self-originated LSAs
Receipt of MaxAge LSAs (i.e., LSAs being flushed)

Function: Specifies which OSPF log messages should be logged in the primary log.

Instructions: Highlight the line entry for Primary Log Mask in the Initial OSPF Global Configuration window and click on the Values button. The Primary Log Mask window will appear (Figure 2-28). Choose the log messages that you wish to enter into the primary log by clicking on their buttons. Then click on OK to return to the Initial OSPF Global Configuration window.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.1.13
Enabling Bridging/Routing Services

Figure 2-28. OSPF Primary Log Mask Window
**Parameter:** Backup Log Mask  
**Default:** All options disabled  
**Options:** Trace messages  
INFO level messages  
Debug level messages  
OSPF interface state change messages  
Nbr state changes  
Self-origination of LSAs  
Receipt of new LSAs  
Changes to OSPF’s routing table  
Bad LS requests, Acks, or updates  
Receipt of less recent LSAs  
Receipt of more recent self-originated LSAs  
Receipt of MaxAge LSAs (i.e., LSAs being flushed)

**Function:** Specifies which OSPF log messages the router logs in the backup log.

**Instructions:** Highlight the line entry for Backup Log Mask in the Initial OSPF Global Configuration window and click on the Values button. The Backup Log Mask window will appear (Figure 2-29). Choose the log messages that you want to enter into the backup log by clicking on their buttons. Then click on OK to return to the Initial OSPF Global Configuration window.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.3.1.14
When you click on the OK button on the Initial OSPF Global Configuration window (Figure 2-27), the Area Address for Interface window (Figure 2-30) appears. Refer to the parameter descriptions in this section to specify the parameters for this window. When you have specified the parameters in each window, click on the OK button to display the next protocol-specific pop-up window.
Parameter: Area Address
  Default: None
  Options: Any 4-octet number in dotted decimal notation
  Function: Identifies the OSPF area to which this interface belongs.
  Instructions: Enter the appropriate area ID in dotted decimal notation.
  MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.2.1.4

Note: The backbone area ID is always 0.0.0.0.

Enabling Exterior Gateway Protocol Service

If you enabled EGP on the interface, the Configuration Manager displays the EGP Configuration window (Figure 2-31) when you exit the IP Configuration window. Refer to the parameter descriptions in this section to specify the parameters.

When you have specified all parameters in the window, click on the OK button to enable default EGP services and to display the next protocol-specific pop-up window. If you want to edit the default values, refer to Customizing IP Services for instructions.
Enabling Bridging/Routing Services

Figure 2-31. EGP Configuration Window

Parameter: **Local Autonomous System ID**
- **Default:** None
- **Range:** 1 to 65535
- **Function:** Identifies the local autonomous system (the AS to which this router belongs) by the decimal number assigned by the Network Information Center (NIC). There is no default for this parameter. Its value will be the AS number that you supplied when you first added EGP to this circuit.
- **Instructions:** Enter a value from 1 to 65535.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.4.1.7
Parameter: Remote Peer IP Address
Default: None
Options: Any IP address
Function: Specifies the IP address of the interface that will form an EGP neighbor relationship with this router.
Instructions: Enter the IP address in dotted decimal notation.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.4.3.1.5

Parameter: Gateway Mode
Default: Core
Options: Core | Non Core
Function: Specifies the gateway mode for this EGP neighbor. If you choose Core, the default, the local AS to which this EGP neighbor belongs will act as a transit AS. That is, it will advertise networks that reside within the AS as well as external networks.

If you choose Non Core, the AS to which this EGP neighbor belongs will act as a stub AS. That is, it will only advertise networks that reside within the AS.

Instructions: Set this parameter to either Core or Non Core, depending on how you want this EGP neighbor to function.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.4.3.1.6
Enabling Border Gateway Protocol Services

If you enabled BGP on the interface, the Configuration Manager displays the BGP Configuration window (Figure 2-32) when you exit the IP Configuration window. Refer to the parameter descriptions in this section to specify the parameters. If you want to edit the default values or find information about BGP-3 or BGP-4, refer to *Customizing IP Services* for instructions.

![Figure 2-32. BGP Configuration Window](image)

**Parameter:** Identifier  
**Default:** None  
**Options:** An IP address of one of the IP interfaces on this router  
**Function:** Identifies the BGP router. There is no default for this parameter; however, the address of some valid interface is displayed. You must use the IP address of one of the router’s IP interfaces.  
**Instructions:** Either accept the current BGP identifier, or enter a new IP address. Remember, the BGP identifier must be one of the router’s IP interfaces.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.5.1.1.4
Adding Network Interfaces

**Note:** If both OSPF and BGP are running on the router, then the OSPF router ID must be identical to the BGP identifier.

**Parameter:** Local AS

- **Default:** None
- **Range:** 1 to 65535
- **Function:** Identifies the autonomous system to which this BGP router belongs.
- **Instructions:** Enter a value from 1 to 65535.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.2.5.1.1.5

When you have specified all parameters in the window, click on the OK button. The BGP Peer window appears (Figure 2-33). Refer to the parameter descriptions in this section to specify the BGP peer. When you are finished, click on the OK button to enable default BGP services and to display the next protocol-specific pop-up window. If you want to edit the default values, refer to *Customizing IP Services* for instructions.

![BGP Peer Window](image)

**Figure 2-33. BGP Peer Window**
### Enabling Bridging/Routing Services

<table>
<thead>
<tr>
<th><strong>Parameter:</strong></th>
<th><strong>Peer Address</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default:</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Options:</strong></td>
<td>Any IP address</td>
</tr>
<tr>
<td><strong>Function:</strong></td>
<td>Specifies the IP address of the interface on the remote side of this BGP peer connection.</td>
</tr>
<tr>
<td><strong>Instructions:</strong></td>
<td>Enter the IP address of the BGP peer in dotted decimal notation. If the peer is in a remote AS, the address must be on the same subnet as the local interface.</td>
</tr>
<tr>
<td><strong>MIB Object ID:</strong></td>
<td>1.3.6.1.4.1.18.3.5.3.2.5.1.2.1.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Parameter:</strong></th>
<th><strong>Peer AS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default:</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Range:</strong></td>
<td>1 to 65535</td>
</tr>
<tr>
<td><strong>Function:</strong></td>
<td>Identifies the autonomous system to which the BGP router at the remote end of this BGP connection belongs.</td>
</tr>
<tr>
<td><strong>Instructions:</strong></td>
<td>Enter the appropriate autonomous system number.</td>
</tr>
<tr>
<td><strong>MIB Object ID:</strong></td>
<td>1.3.6.1.4.1.18.3.5.3.2.5.1.2.1.10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Parameter:</strong></th>
<th><strong>Local Address</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default:</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Options:</strong></td>
<td>Any IP address</td>
</tr>
<tr>
<td><strong>Function:</strong></td>
<td>Specifies the IP address of the interface on the local side of this BGP peer connection.</td>
</tr>
<tr>
<td><strong>Instructions:</strong></td>
<td>Enter the appropriate IP address in dotted decimal notation.</td>
</tr>
<tr>
<td><strong>MIB Object ID:</strong></td>
<td>1.3.6.1.4.1.18.3.5.3.2.5.1.2.1.4</td>
</tr>
</tbody>
</table>
Enabling NetBIOS

If you selected the NetBIOS option on the circuit, you need not specify any NetBIOS-specific configuration information. In cases where you are configuring IP and NetBIOS for the first time on a circuit, the IP Configuration window (Figure 2-26) appears where you specify the IP-specific parameters; IP Address, Subnet Mask, and Transmit Bcast Addr. If you want to edit NetBIOS parameters, refer to *Customizing IP Services* for instructions.

Enabling IGMP and DVRMP

If you enabled IGMP and DVRMP on the interface, the Configuration Manager displays the Initial IGMP Global Configuration window (Figure 2-34) and the Initial DVRMP Base Parameters window (Figure 2-35) when you exit the IP Configuration window. Refer to the parameter descriptions in this section to specify the parameters. If you want to edit the default values or find information about IGMP and DVRMP, refer to *Customizing IP Services* for instructions.

IGMP Global Configuration Parameters

Figure 2-34 illustrates the Initial IGMP Global Configuration window. A description of the parameters displayed in this window follows.
Enabling Bridging/Routing Services

**Figure 2-34. Initial IGMP Global Configuration Window**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Enabled</td>
</tr>
<tr>
<td>Options</td>
<td>Enabled</td>
</tr>
<tr>
<td>Function</td>
<td>Enables or disables this IGMP record.</td>
</tr>
<tr>
<td>Instructions</td>
<td>If you have configured IGMP on this router, use this parameter to disable it.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.5.3.13.1.2</td>
</tr>
</tbody>
</table>

Enable

Estimated Groups

Configuration Mode: local
SNMP Agent: LOCAL FILE

Values...
Help...
**Parameter:** Estimated Groups  
**Default:** 20 groups  
**Options:** 5 to 65535 groups  
**Function:** Specifies the estimated number of groups that be used through this router.  
**Instructions:** Determine the approximate number of groups and enter the value. This is to allow the router to utilize memory efficiently; exceeding this size during an operation will not cause an error but may cause the router to consume more memory than is required.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.13.1.4

**DVMRP Base Parameters**

Figure 2-35 illustrates the Initial IGMP Global Configuration window. A description of the parameters displayed in this window follows.
**Parameter:** Enable

**Default:** Enabled

**Options:** Enabled | Disabled

**Function:** Enables and disables DVMRP support on the router.

**Instructions:** To disable DVMRP once you have configured it on the router, specify Disabled.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.12.1.2
Parameter: **Full Update Rate**  
Default: 60 seconds  
Options: 10 to 2048 seconds  
Function: Specifies, in seconds, how often routing messages containing complete routing tables are sent.  
Instructions: Determine the full update rate you require and specify a value.  
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.12.1.4

Parameter: **Triggered Update Rate**  
Default: 5 seconds  
Options: 2 or more seconds  
Function: Specifies, in seconds, the minimum amount of time between triggered updates.  
Instructions: Triggered updates are sent in the period between full updates. Issuing a full update starts the triggered update timer. Therefore, the triggered update rate you specify must be shorter than the full update rate you have specified with the Full Update rate parameter.  
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.12.1.5

Parameter: **Leaf Timeout**  
Default: 200 seconds  
Options: 25 to 4096 seconds  
Function: Specifies, in seconds, a value for the virtual hold down timer.  
Instructions: Determine the virtual hold down timer interval you require and specify a value.  
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.12.1.6
**Parameter:** Neighbor Timeout  
**Default:** 140 seconds  
**Options:** 40 to 8192 seconds  
**Function:** Specifies, in seconds, how long a connection with a router neighbor is considered active without confirmation (that is, without receiving a probe or a report from the neighbor).  
**Instructions:** Determine a neighbor timeout period and specify a value.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.12.1.7

**Parameter:** Route Expiration Timeout  
**Default:** 200 seconds  
**Options:** 20 to 4096 seconds  
**Function:** Specifies, in seconds, how long a route is considered valid without confirmation.  
**Instructions:** Enter a value that represents the duration of time this route will be used before confirmation is required.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.12.1.8
**Parameter:** Garbage Timeout  
**Default:** 340 seconds  
**Options:** 40 to 8192 seconds  
**Function:** Specifies, in seconds, the duration of time that this route will be included in routing tables before confirmation is required.  
**Instructions:** Enter a Garbage Timeout value that is greater than the value you specified for Route Expiration Timeout.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.12.1.9

**Parameter:** Estimated Routes  
**Default:** 25 routes  
**Options:** An integer of 10 or greater  
**Function:** Specifies the estimated number of routes per slot.  
**Instructions:** Enter a value that the router can use for pre-allocating routing tables. Note that routes are kept on a per-source network basis, independent of multicast groups. This number must include a route for every local area network that has a CCT configured for multicasting. This is to allow the router to utilize memory efficiently; exceeding this size during operation will not cause an error but may cause the router to consume more memory than is required.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.3.12.1.10
Enabling DECnet Phase IV Services

You enable DECnet Phase IV services from the DECnet Phase IV Configuration window (Figure 2-36). Refer to the parameter descriptions in this section to specify the parameters. When you have specified all parameters in the window, you can either click on the OK button to enable default DECnet Phase IV services and to display the next protocol-specific pop-up window, or click on the Details button to edit the default values; refer to Customizing DECnet Services for instructions.

Figure 2-36. DECnet Phase IV Configuration Window
**Parameter:** Area ID  
**Default:** None  
**Range:** 1 to 63  
**Function:** Specifies a unique DECnet Phase IV Area ID for this circuit.  
The area ID is the first six bits of a DECnet Phase IV node address. You specify the area ID on a circuit-by-circuit basis; that is, a single router can have individual circuits residing in different areas.

**Instructions:** Enter the area ID assigned to this circuit.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.2.3.1.1

**Parameter:** Node ID  
**Default:** None  
**Range:** 1 to 1023  
**Function:** Specifies a unique intra-area DECnet Phase IV node ID for this circuit.  
The node ID is the last 10 bits of a DECnet Phase IV node address.

Note that if individual circuits on a router reside in different areas, then each circuit can have a different node address.

**Instructions:** Enter the node ID assigned to the router.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.2.3.1.2
Enabling VINES Services

If you enabled VINES on the circuit, and the line type of that circuit is anything except synchronous, you need not specify any configuration information in order to enable default VINES service. Click on the Cancel button in the pop-up window that prompts Do you want to edit the VINES interface details?

If, however, you enabled VINES support on a synchronous line, you must specify the clocking source for the synchronous line (internal or external).

Refer to Chapter 3, “Customizing Line Services,” for instructions on setting this parameter.

If you want to edit the default values, click on the OK button and refer to Customizing VINES Services for instructions.

Enabling AppleTalk Services

If you enable AppleTalk routing services on an interface, the AppleTalk Interface Configuration window appears (Figure 2-37).
Adding Network Interfaces

Specify whether this interface functions as a *seed* router or a *nonseed* router. A seed router supplies the Network Start, Network End, Default Zone, and Zone List information for all other nonseed routers on this network. Each network must contain at least one seed router.

A nonseed router acquires its Network Start, Network End, Default Zone, and Zone List information from the other seed routers on the network.

- To configure a seed router interface, specify the Network Start, Network End, and Default Zone and Zone List (if multiple zones are to be configured on this interface), as described below, then click on the Apply button, followed by the Done button.

- To configure a nonseed router interface, simply accept all of the default parameters and click on the Done button.
For information on customizing AppleTalk routing services, see *Customizing AppleTalk Services.*

**Parameter:** Network Start  
**Default:** 0  
**Range:** 0 to 65279  
**Function:** Specifies the lower boundary (minimum) of the range of network numbers available for use by nodes on the network to which this interface connects.

This parameter's setting determines whether this interface functions as a seed or nonseed router.

**Instructions:** To configure this interface as a nonseed router, accept the default, 0.

To configure this interface as a seed router, specify this parameter as follows:

— If this is the only seed router on the network, determine the network range for this interface, and enter the lower boundary network number.

— If there are already seed routers on the network, enter the *same* Network Start value that is configured on all other seed routers.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.4.3.1.13

**Note:** If you specify a Network Start other than the default, 0, then 1) the router automatically becomes a seed router and 2) you must also specify values for the Network End and Default Zone parameters.
Parameter: Network End

Default: 0

Range: 0 to 65279

Function: Specifies the upper boundary (maximum) of the range of network numbers available for use by nodes on the network to which this interface connects.

You use this parameter in conjunction with the Network Start parameter to help define a seed router. *If you have not specified a Network Start for this interface, this parameter is ignored.*

Instructions: If this interface is configured as a nonseed router, then accept the default, 0.

If this interface is configured as a seed router, then specify the Network End as follows:

- If this is the only seed router on the network, determine the network range for this interface, and enter the upper boundary network number.

- If there are already seed routers on the network, enter the *same* Network End value that is configured on all other seed routers.

MIB Object ID: 1.3.6.1.4.1.18.3.5.4.3.1.14
Parameter: Default Zone

Default: None

Options: Any valid zone name

Function: Specifies the name of the default zone to which all new nodes are assigned when they first start up on this network.

This parameter is used in conjunction with the Network Start and Network End parameters to help define a seed router. If you have not specified a Network Start for this interface, this parameter is ignored.

Instructions: If this interface is configured as a nonseed router, then simply leave this field blank.

If this interface is configured as a seed router, then specify the Default Zone as follows:

— If this is the only seed router on the network, enter any valid Default Zone name.

— If there are already seed routers on the network, enter the same Default Zone name as is configured on all other seed routers.

A valid zone name can consist of up to a maximum of 32 characters and can include any character (except the asterisk [*] character). See the instructions below for using nonprintable characters in the Default Zone name.

MIB Object ID: 1.3.6.1.4.1.18.3.5.4.3.1.15
Configuring the Zone List

To configure a Zone List, you must add zone(s) to the list. Complete the following steps:

1. Click on the Zone List button in the AppleTalk Interface Configuration window (Figure 2-37).

   The AppleTalk Zone Configuration window appears (Figure 2-38).

   ![AppleTalk Zone Configuration Window](image)

   **Figure 2-38. AppleTalk Zone Configuration Window**

2. Click on the Add button.

   The Add AppleTalk Zone window appears (Figure 2-39).
Enabling Bridging/Routing Services

AppleTalk Zone Configuration

Configuration Mode: local
SNMP Agent: LOCAL FILE

Zone Name: 2ndfloor

Figure 2-39. Add AppleTalk Zone Window

3. Enter a name for the zone in the Zone Name box and click on the OK button.
   
   You are returned to the AppleTalk Zone Configuration window.

4. Either repeat Steps 2 and 3 for each zone you want to add, or click on the Done button to exit the window.

Note: The default zone should not appear in the Zone List.

Using Nonprintable Characters in AppleTalk Zone Names

Using nonprintable characters in AppleTalk zone names requires some additional steps. Enter nonprintable characters into the Default Zone parameter or Zone Name parameter as follows:

1. Access the Configuration Manager tool in local or remote mode.

Note: You cannot enter nonprintable characters if you are using dynamic configuration mode.
2. Type `\xx`, where `xx` represents the two hexadecimal-digit representation of each nonprintable character as shown in the character set mapping used in AppleTalk. (Refer to the Character Set Mapping table in *Inside AppleTalk, Second Edition*, copyright 1990, Apple Computer, Inc., Cupertino, CA 95014.) The router counts the `\xx` as a single character.

Type two backslashes (`\\`) to indicate a literal backslash. The router counts `\` as a single character.

3. Select Apply.

4. Save the configuration.

5. Transfer the configuration file to the router, using the Router Files Manager tool if the Configuration Manager is in local configuration mode.

6. Reboot the router with the new configuration file.

**Warning** Nonprintable characters in these parameters appear as different characters when you transfer the file to the router and re-open it using the Configuration Manager. SNMP translates the characters when transferring the configuration to Site Manager.

To edit Default Zone or Zone List parameters where you previously saved nonprintable characters, overtype the zone name and retype the nonprintable characters, following the six steps in this section.
Configuring AURP

Before configuring AURP on a router, you must configure AppleTalk on at least one of the router's circuits. Once you have configured at least one AppleTalk interface, you can use AURP to create a wide area link between two or more AppleTalk networks.

To configure AURP global parameters, begin at the Wellfleet Configuration Manager window and proceed as follows:

1. Select the Protocols→AppleTalk→AURP→Global option.
   
   The Edit AURP Global Parameters window appears (Figure 2-40).

2. Set the Enable parameter to Enable.

3. Enter the appropriate IP address (using dotted decimal notation) in the Local IP Address field.

   Click on the OK button to exit the window and save your changes when you are finished.

![Edit Apple AURP Global Parameters](image)

Figure 2-40. Edit AURP Global Parameters Window
**Parameter:** Enable  
**Default:** Enable  
**Options:** Enable | Disable  
**Function:** Enables or disables AURP on the router.  
**Instructions:** Set to Enable to globally enable AURP.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.4.8.2

**Parameter:** Local IP Address  
**Default:** None  
**Options:** Any valid 32-bit IP address in dotted decimal notation  
**Function:** Identifies an IP interface on the router. This is the IP interface used for AURP.  
**Instructions:** Enter the IP address of the interface on this router that AURP should use.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.4.8.5

To configure the AURP connection, enter the IP address for the remote peer from the AppleTalk AURP Interface Configuration window. To configure this parameter, begin at the Wellfleet Configuration Manager window and proceed as follows:

1. Select the Protocols→AppleTalk→AURP→Interfaces option to display the AT AURP Interface Configuration window (Figure 2-41).
Enabling Bridging/Routing Services

2-90

Figure 2-41. AT AURP Interface Configuration Window

2. Click on the Add button.
   The AppleTalk AURP Configuration window appears (Figure 2-42).

Figure 2-42. AppleTalk AURP Configuration Window

3. Enter the appropriate IP address in the Remote AURP IP Address field and click on OK.
The AT AURP Interface Configuration window reappears.

4. Repeat Steps 2 and 3 to add additional remote peers to the AURP connection.

5. Click on the Done button to exit the window.

For information on customizing AURP service or configuring AURP zone filter lists, refer to *Customizing AppleTalk Services*.

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Remote AURP IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>None</td>
</tr>
<tr>
<td>Options:</td>
<td>Any valid 32-bit IP address</td>
</tr>
<tr>
<td>Function:</td>
<td>Identifies the peer’s IP address for the AURP connection.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Enter an IP address using dotted decimal notation.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.5.4.9.1.14</td>
</tr>
</tbody>
</table>

**Enabling Source Routing Services**

If you enabled source routing on the circuit, but did not enable the SR Spanning Tree or Translate/LB algorithms, you enable source routing from the Source Routing Global Parameters window (Figure 2-43) and the Source Routing Interface Parameters window (Figure 2-44).

Refer to the parameter descriptions in this section to specify the source routing bridge internal LAN ID and the source routing bridge ID on the Source Routing Global Parameters window.
Enabling Bridging/Routing Services

**Note:** Because source routing is global (that is, it runs across all the Bridge circuits), the Configuration Manager only displays the Source Routing Global Parameters window the first time you specify source routing for the bridge. If you have previously specified source routing for this bridge, this window will not appear.

![Source Routing Global Parameters Window](image)

**Figure 2-43. Source Routing Global Parameters Window**
**Parameter:** SR Bridge Internal LAN ID  
**Default:** 0x0  
**Range:** 0x1 to 0xffff  
**Function:** Specifies this bridge's internal LAN ID.  
**Instructions:** Assign an internal LAN ID that is unique among all other internal LAN IDs, group LAN IDs, and ring IDs in the network.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.1.2.1.4

**Note:** You cannot use the value 0x0 that appears initially in the SR Bridge Internal LAN ID parameter box. You must specify a value for this parameter that is within the given range.

**Parameter:** SR Bridge ID  
**Default:** 0x0  
**Range:** 0x1 to 0x0f  
**Function:** Specifies this bridge's bridge ID and identifies the Wellfleet source routing bridges in the network.  
**Instructions:** Assign the same bridge ID to all Wellfleet source routing bridges in the network (unless two bridges operate in parallel; see note below). The bridge ID must be unique among any other non-Wellfleet bridge IDs in the network.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.1.2.1.5
Enabling Bridging/Routing Services

**Note:** You cannot use the value 0x0 that appears initially in the SR Bridge ID parameter box. You must specify a value for this parameter that is within the given range.

If two Wellfleet source routing bridges operate in parallel, then you must assign a different bridge ID to one of the bridges. You must also specify the bridge ID in the Bridge Entry list for all other Wellfleet source routing bridges in the network. (See *Customizing Bridging Services* for more information.)

![Figure 2-44. Source Routing Interface Parameters Window](image)
After you specify the required parameters in the Source Routing Global Parameters window, the Source Routing Interface Parameters window appears. Refer to the parameter description in this section to specify the source routing ring number. You also can edit source routing interface defaults from this window. If you do want to edit these default values, refer to Customizing Bridging Services for instructions. Otherwise, click on the OK button.

**Parameter:** Source Routing Ring Number

- Default: 0x0
- Range: 0 to 0x0fff
- Function: Identifies the ring number (ring ID) of this source routing circuit.
- Instructions: Assign a ring number (ring ID) to this source routing circuit that is unique among any other ring IDs, group LAN IDs, or internal LAN IDs in the network.
- MIB Object ID: 1.3.6.1.4.1.18.3.5.1.1.2.2.1.6

**Note:** You cannot use the value 0x0 that appears initially in the Source Routing Ring Number parameter box. You must specify a value for this parameter that is within the given range.

### Enabling Source Routing Spanning Tree Service

When you select the Spanning Tree option that is directly under the Source Routing option, you will automatically enable source routing. This Spanning Tree protocol cannot run without source routing enabled.

If you have not yet enabled source routing on any circuit, the first window to appear is the Source Routing Global Parameters window (Figure 2-43). If you have enabled source routing on some other circuit, the first window to appear will be the Source Routing Interface Parameters window (Figure 2-44).
Refer to "Enabling Source Routing Services" earlier in this chapter to configure the necessary source routing parameters.

After you configure the interface parameters and click on OK in the Source Routing Interface Parameters window, the Source Routing Spanning Tree Autoconfiguration window (Figure 2-45) appears. Refer to the parameter descriptions in this section to specify the Bridge Priority and Bridge MAC Address parameters and then click on the OK button. At this point, a pop-up window will prompt Do you want to edit the Source Route Spanning Tree Interface Details? Either click on the Cancel button to enable default Spanning Tree service and to display the next protocol-specific pop-up window, or click on the OK button to edit the default values. (Refer to Customizing Bridging Services for instructions.)

While these parameters have the same names and functions as for Spanning Tree service under bridging, they need to be set independently for Spanning Tree service under source routing.

Figure 2-45. Source Routing Spanning Tree Autoconfiguration Window
Note: Because the Spanning Tree is global (that is, it runs across all Source Routing circuits), the Configuration Manager only displays the Spanning Tree Autoconfiguration window the first time you specify Spanning Tree for source routing. After that, you never again specify global spanning tree configuration information. If you have previously specified Spanning Tree for source routing, this window will not appear.

**Parameter:** Bridge Priority

- **Default:** None
- **Range:** 0 to 65535
- **Function:** In conjunction with the Bridge MAC Address parameter, assigns a 64-bit bridge ID to the router. This parameter supplies the most significant 16 bits of the bridge ID, while Bridge MAC Address supplies the remaining (least significant) 48 bits.

The Spanning Tree uses the bridge ID to select the root bridge. In selecting the root bridge, the Spanning Tree chooses the bridge with the lowest-number bridge ID. Thus, the lower the value of this parameter, the more likely that the router will be selected as the root bridge.

- **Instructions:** Enter a decimal value from 0 to 65535.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.1.2.1.33
**Parameter:** Bridge MAC Address  
**Default:** None  
**Options:** Any valid 48-bit MAC-level address  
**Function:** In conjunction with the Bridge Priority parameter, assigns a 64-bit bridge ID to the router. Bridge Priority supplies the most significant 16 bits of the bridge ID, while this parameter supplies the remaining (least significant) 48 bits.

The Spanning Tree uses the bridge ID to select the root bridge. In selecting the root bridge, the Spanning Tree chooses the bridge with the lowest-number bridge ID. Thus, the lower the value of Bridge Priority, the more likely that the router will be selected as the root bridge. In the event of equal bridge priority values, the Bridge MAC Address value determines the bridge's priority.

**Instructions:** Enter a 48-bit MAC address expressed as a 12-digit hexadecimal value. You should set this parameter to the MAC address of one of the router's Spanning Tree ports, preferably the one with the lowest priority.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.1.2.1.33

**Enabling Source Routing Translate/LB Service**

When you select the Translate/LB option that is directly under the Source Routing option, you will automatically enable source routing. The Translate/Learning Bridge protocol cannot run without source routing enabled.

If you have not yet enabled source routing on any circuit, the first window to appear is the Source Routing Global Parameters window (Figure 2-43). If you have enabled source routing on some other circuit, the first window to appear will be the Source Routing Interface Parameters window (Figure 2-44).
Refer to “Enabling Source Routing Services” earlier in this chapter to configure the necessary source routing parameters.

**Enabling Source Routing Translate/LB Spanning Tree Service**

When you select the Span Tree option that is directly under the Translate/LB option, you will automatically enable source routing and translate/LB. This Spanning Tree protocol cannot run without source routing and translate/learning bridge enabled.

If you enabled the Source Routing Translate/LB Spanning Tree service on the circuit, the Spanning Tree Autoconfiguration window (Figure 2-25) appears. Refer to the section “Enabling Spanning Tree Service” earlier in this chapter for instructions on setting these parameters.

**Note:** Because the Spanning Tree is global (that is, it runs across all Bridge circuits), the Configuration Manager only displays the Spanning Tree Autoconfiguration window the first time you specify Spanning Tree for the bridge. If you have previously specified Spanning Tree for this bridge, this window will not appear.

After you have set the bridge parameters, set the source routing parameters. Refer to “Enabling Source Routing Services” earlier in this chapter to configure these parameters. Refer to Figures 2-43 and 2-44 for examples of the windows.
Enabling OSI Services

You enable OSI services from the OSI Configuration window (Figure 2-46). Refer to the parameter description in this section to specify the router ID. When you are finished, click on the OK button. A pop-up window appears, prompting do you want to edit the OSI interface details? click on the Cancel button to enable default OSI services and to display the next protocol-specific pop-up window, or click on the OK button to edit the default values. Refer to Customizing OSI Services for instructions.

![OSI Configuration Window](image)

Figure 2-46. OSI Configuration Window
Parameter: Router ID

Default: Variable

Options: Any valid system ID. The router ID must be exactly 6 bytes.

Function: Identifies the router within its local area.

The system ID is the ID portion of the router's NSAP address. (See Customizing OSI Services for more information.)

Instructions: You specify a router ID only the first time you configure an OSI interface. Site Manager uses this router ID for any additional OSI interfaces you configure. Enter a system ID in hexadecimal format. The router ID must be exactly 6 bytes.

Note the following guidelines:

— Every router in a domain must have a unique system ID. Using a router's MAC address for its system ID ensures this.

— If this router is located in an area that also supports DECnet Phase IV End Systems, then the system ID must be within the DECnet Phase IV legal range (that is, 0x1 to 0x3ff hexadecimal).

MIB Object ID: 1.3.6.1.4.1.18.3.5.6.1.6
Enabling Bridging/Routing Services

**Parameter:** Area Address

**Default:** None

**Options:** Any valid OSI address in hexadecimal notation

**Function:** Identifies the OSI area to which this interface belongs.

**Instructions:** Enter the appropriate area ID in hexadecimal notation.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.6.1.16

### Creating an NML Port

To create a Native Mode LAN port, use the following procedure:

1. Select the circuit to which you want to add the NML protocol.
   
   Depending on the configuration of the circuit, the WAN Protocols window may or may not appear (Figure 2-4). If it appears, click on the OK button.

2. The Select Protocols window appears (Figure 2-24).

3. Select the Native Mode LAN protocol. Site Manager automatically selects the Bridge protocol.

4. Click on the OK button. The Configuration Manager displays a pop-up window with the message Do you want to edit the NML interface details?

5. Click on the OK button. The Configuration Manager displays the Edit NML Interface window (Figure 2-47).
Enabling IPX Services

You enable IPX services from the IPX Configuration window (Figure 2-48). Refer to the parameter descriptions in this section to specify the parameters. When you have specified all parameters in the window, you can either click on the OK button to enable default IPX services and to display the next protocol-specific pop-up window, or click on the Details button to edit the default values. Refer to Customizing IPX Services for instructions.

### Figure 2-48. Edit NML Interface Window

6. For instructions on editing NML parameters and assigning an access list to a port, refer to Customizing Bridging Services.
Enabling Bridging/Routing Services

Figure 2.48. IPX Configuration Window

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Network Address (hex)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>None</td>
</tr>
<tr>
<td>Options</td>
<td>Any valid IPX network address</td>
</tr>
<tr>
<td>Function</td>
<td>Assigns an IPX address to the interface.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Enter the IPX address of the interface in hexadecimal notation.</td>
</tr>
</tbody>
</table>

If you are configuring an IPX interface that will either implement IPX WAN or run over PPP, then you must enter a zero for this parameter.

If you are attempting to establish a connection to a Series 5 Wellfleet router, or a router that does not implement IPX WAN or PPP, then you must enter a non-zero network address (for example, the network address of the link).

MIB Object ID: 1.3.6.1.4.1.18.3.5.5.4.1.6
Note: You can change the value of the Network Address parameter as long as the IPX Configuration window remains in the workstation display. However, once you save the contents of this window, the Network Address parameter appears only in the list of IPX interfaces in the IPX option configuration screens. You cannot edit the Network Address parameter in any option configuration screen. To change the network address of a specific IPX interface, you must delete the interface from its circuit, then add the interface again to the same circuit, this time specifying the desired (changed) network address.

Parameter: Configure RIP
Default: Depends on whether you have RIP configured
Options: Yes | No
Function: Indicates whether you have RIP configured on that interface.
Instructions: The Wellfleet Configuration Manager sets the default value for this parameter based on your selection in the Select Protocols window. You can, however, change the value of this parameter as long as the IPX Configuration window remains in the workstation display.

MIB Object ID: 99999.6.2
Parameter: Configured Encaps
Default: None (media dependent)
Options: Ethernet | LSAP | Novell | SNAP | PPP
Function: Specifies the encapsulation methods available for each link layer type (for example, Ethernet or Token Ring).

Instructions: Select the encapsulation method you need to use. Ensure that the encapsulation method matches that of the clients and servers on the same network.

MIB Object ID: 1.3.6.1.4.1.18.3.5.5.4.1.9

If you are configuring IPX on a circuit using the PPP or the Frame Relay WAN protocols, the IPX Configuration window displays the IPXWAN Enable parameter. To edit this parameter, the Network Address parameter must be set to 0.

Parameter: IPXWAN Enable
Default: Disable
Options: Enable/Disable
Function: Enables or disables IPXWAN on a PPP or a Frame Relay IPX circuit.

Instructions: Set the Network Address parameter to 0, click on Values and select Enable or Disable.

MIB Object ID: 1.3.6.1.4.1.18.3.5.5.4.1.32
Enabling XNS Services

You enable XNS services from the XNS Configuration window (Figure 2-49). Refer to the parameter descriptions in this section to specify the parameters. When you have specified all parameters in the window, you click on the OK button to enable default XNS services and to display the next protocol-specific pop-up window. If you want to edit the default values, refer to Customizing XNS Services for instructions.

Parameter: Network Address (hex)
Default: None
Options: Any valid XNS network address
Function: Assigns an XNS address to the interface.
Instructions: Enter the XNS address of the interface in hexadecimal notation.
MIB Object ID: 1.3.6.1.4.1.18.3.5.10.3.1.6
Parameter: **Base Host Number**

Default: The Configuration Manager automatically generates a unique 6-byte host number from the Wellfleet router’s serial number if you do not enter a value. (The automatically generated number is not displayed.)

Options: Any host number

Function: Sets a host ID and source MAC address for all slots. By means of this parameter, XNS interfaces configured on any slot in the node share the same host ID and source MAC address.

Instructions: Do not enter a number in this box if you want the Configuration Manager to generate a host number automatically or if the interface is on a Token Ring circuit and you are setting the Token Ring Mac Address Select parameter to Boxwide. Enter the MAC address in hexadecimal notation only if the interface is on a Token Ring circuit and you are setting the Token Ring MAC Address Select parameter to Cnfg. Refer to the section “Configuring a MAC Address on a Token Ring Interface” in Customizing XNS Services for more information about this parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.5.10.1.4

Note: If you already have XNS configured on the router, this field does not appear.
Adding Network Interfaces

**Parameter:** Configure RIP  
**Default:** Depends on whether you have RIP configured  
**Options:** Yes | No  
**Function:** Indicates whether you have RIP configured on that interface.  
**Instructions:** The Wellfleet Configuration Manager sets the default value for the Configure RIP parameter based on your selection in the Select Protocols window. You can, however, change the value of this parameter as long as the XNS Configuration window remains in the workstation display.  
**MIB Object ID:** 99999.7.3

**Note:** If you already have XNS configured on the router, this field does not appear.

**Parameter:** Implementation  
**Default:** Xerox  
**Options:** Xerox  
**Function:** Specifies the version of XNS you want to add to this circuit. At this time, your only option is Xerox.  
**Instructions:** Accept the default value.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.10.1.6
Enabling Bridging/Routing Services

Note: You can change the value of the Network Address, Base Host Number, and Implementation parameters as long as the XNS Configuration window remains in the workstation display. However, once you save the contents of this window, these parameters appear only in the list of XNS interfaces in the XNS option configuration screens. You cannot edit the Network Address parameter in any option configuration screen. To change the network address of a specific XNS interface, you must delete the interface from its circuit, then add the interface again to the same circuit, this time specifying the desired (changed) network address.

Enabling DLSw Services

You select DLSw on the Select Protocols window (Figure 2-24). (See "Enabling Bridging/Routing Services" earlier in this chapter.) From this starting point, the steps you take to enable DLSw services depend on whether you are enabling it for the first or a subsequent time and whether you are enabling it on Token Ring/802.5 (or other) or on Ethernet/802.3 or Frame Relay.

Figure 2-50 illustrates the steps for configuring DLSw for Token Ring (or other) networks. Figure 2-51 illustrates the steps for configuring DLSw for Ethernet/802.3 or Frame Relay.
Adding Network Interfaces

Begin Configuration

Are you defining the first DLSw interface on the router?

Yes

Select a circuit:
Token Ring/802.5 or other
(except Ethernet/802.3 or Frame Relay)

Configure source routing
global parameters

Configure source routing
interface parameters

Configure DLSw
global parameters

Define DLSw slots

Define DLSw peers

Define DLSw SAP addresses

Site Manager automatically enables global TCP services
if not already enabled.

Site Manager automatically enables a DLSw interface
on the selected circuit.

(End of mandatory configuration steps)

Key:

Configuration path for the first DLSw interface on the router.

Configuration path for the second and subsequent DLSw interface on the router.

Figure 2-50. DLSw Configuration Sequence for Token Ring/802.5 or Other
(Except Ethernet)
Enabling Bridging/Routing Services

Begin Configuration

Are you defining the first DLSw interface on the router?

Yes

Select a circuit:
Ethernet/802.3 or Frame Relay

Configure DLSw global parameters

No (subsequent DLSw interface)

Configure source routing global parameters

Use source route encapsulation?

Yes

Configure source routing interface parameters

No

Enter Frame Relay mapping information

Define DLSw slots

Define DLSw peers

Define DLSw SAP addresses

Site Manager automatically enables global TCP services if not already enabled.

Site Manager automatically enables a DLSw interface on the selected circuit.

(Configuration path for the first DLSw interface on the router.)

(Configuration path for the second and subsequent DLSw interface on the router.)

(End of mandatory configuration steps)

Key:

⇒ Configuration path for the first DLSw interface on the router.

⇒ Configuration path for the second and subsequent DLSw interface on the router.

Figure 2-51. DLSw Configuration Sequence for Ethernet/802.3 or Frame Relay
DLSw and Other Protocols

DLSw works in conjunction with other protocols, including:

- **IP**
  
  You must configure the IP addresses of the slots and network access points assigned to DLSw. You can do this either before or after you follow the DLSw procedure. See “Enabling Internet Protocol Services” earlier in this chapter for instructions on adding IP addresses.

- **TCP**
  
  The initial configuration of DLSw automatically enables global TCP services if they are not already enabled.

- **Source Routing Bridge**
  
  When you add DLSw to a Token Ring circuit, source routing is also added. You add Source Routing Global Parameters and you edit the Source Routing Interface window as noted in the following sections.

- **LLC2**
  
  LLC2 is automatically added when you add DLSw to a circuit.

- **SDLC**
  
  If you specified SDLC from the WAN Protocols window (Figure 2-4), Site Manager prompts you to add a client protocol, either DLSw or APPN.

DLSw Initial Configuration

In the initial configuration of DLSw, you use Site Manager windows to:

- Set the DLSw global parameters (for Ethernet and Frame Relay without source routing bridge [SRB] encapsulation).

- Add Source Routing global Parameters (Token Ring or other, or if you choose to use SRB encapsulation on Ethernet or Frame Relay).

- Enter Frame Relay mapping information (Ethernet and Frame Relay without SRB encapsulation).
Enabling Bridging/Routing Services

☑ Set slot IP addresses.
☑ Add peer IP addresses.
☑ Add service access points (SAPs).

Setting the DLSw Global Parameters

Enter a value for the IP Virtual Ring parameter in the DLSw Global Parameters window (Figure 2-52).

![DLSw Global Parameters Window](image)

Figure 2-52. DLSw Global Parameters Window
Parameter: IP Virtual Ring

Default: None

Range: 1 to 4095

Function: Use this parameter to specify a virtual ring number for the TCP/IP network cloud.

Instructions: Enter any valid ring number. The number should match the ring number chosen by other DLSw peers on the same network cloud. Make sure that the number is unique among any other Ring IDs, Group LAN IDs, or Internal LAN IDs assigned in the network.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.5.1.5

When finished, click on the OK button to enable the DLSw global parameters.

Specifying Source Routing Bridge Encapsulation

The Source Routing Encapsulation dialog box (Figure 2-53) allow you to specify the type of encapsulation formats to be used on Ethernet/802.3 and Frame Relay interfaces running DLSw. Select Cancel if you are configuring standard LLC over Ethernet, or if you are configuring Frame Relay using the RFC 1490 Routing Standard. Click on OK if you want to configure Wellfleet proprietary SRB over Ethernet or Frame Relay using the RFC 1490 Bridging Standard.

Figure 2-53. Source Route Encapsulation Dialog Box
Adding Source Routing Parameters

When you add DLSw to a Token Ring circuit, you first set the Source Routing global parameters. If you have not yet enabled source routing on any circuit, the first window to appear is the Source Routing Global Parameters window (Figure 2-43). If you have enabled source routing on some other circuit, the first window to appear will be the Source Routing Interface Parameters window (Figure 2-44).

Refer to “Enabling Source Routing Services” earlier in this chapter to configure the necessary Source Routing parameters.

The Ethernet configuration does not require the source routing steps.

Mapping Frame Relay Addresses

If you are configuring Ethernet or Frame Relay without SRB, the Frame Relay Mappings window appears (Figure 2-54).
Select Add. The LLC2 Frame Relay Mapping Add window appears (Figure 2-55).

![Figure 2-55. LLC2 Frame Relay Mapping Add Window](image)

Specify the DLCI, Remote MAC and Local MAC parameters, as follows:

**Parameter:** DLCI  
**Default:** None  
**Range:** Standard Data Link Connection Identifier numbers  
**Function:** This parameter provides the number of the virtual circuit to which the local or remote MAC address will be mapped.  
**Instructions:** Enter a decimal DLCI number assigned by your system administrator or Frame Relay provider.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.6.9.1.3
Parameter: Remote MAC

Default: None

Range: Standard MSB Token Ring MAC addresses

Function: This parameter provides the remote MAC address, mapping outgoing requests specifying it to the DLCI value. The Remote MAC address must be unique, with only DLCI mapping for a specific MAC address.

Instructions: If you need to specify the real hardware address of the host, enter it as an octal string.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.6.9.1.5

Parameter: Local MAC

Default: None

Range: Standard MSB Token Ring MAC addresses

Function: This parameter provides the local MAC address, mapping incoming requests on this DLCI to that address. The Local MAC address must be unique, with only DLCI mapping for a specific MAC address.

Instructions: If the incoming connections are valid, enter the MAC address of the recipient.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.6.9.1.4

After specifying the DLCI, Remote MAC, and Local MAC parameters, click on OK. The Configuration Manager returns to the Frame Relay Mappings window showing the selected circuit.
Adding Slot IP Addresses

The DLSw Slot Configuration window (Figure 2-56) displays a list of the slot IP addresses you have added.

![DLSw Slot Configuration Window](image)

**Figure 2-56. DLSw Slot Configuration Window**

Click on the Add button to add a slot IP address. The second DLSw Slot Configuration window appears (Figure 2-57).

![Add Slot IP Address Window](image)

**Figure 2-57. Add Slot IP Address Window**

Enter the appropriate slot value and its IP address. Use the following parameter descriptions for guidelines.
Enabling Bridging/Routing Services

**Parameter:** Slot

Default: None

Range: 1 to 14

Function: Specifies the slot number associated with the Token Ring or Ethernet interface over which DLSw is running.

Instructions: Enter a slot number that is valid for running DLSw, considering the model of router and the slots that Link Modules can occupy. You should only enter slots running DLSw.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.5.3.1.2

**Parameter:** IP Address

Default: None

Options: Any IP address specified in dotted decimal notation

Function: Specifies where the TCP connection for DLSw terminates. If a circuitless IP address is configured, use that address for this parameter. If not, use a unique IP address that exists on the router for each slot running DLSw. The address cannot be reused on another slot.

Instructions: Enter the appropriate IP address.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.5.3.1.3

Click on the OK button when you are finished.

You are returned to the DLSw Slot Configuration window. Repeat the instructions in this section for each slot you want to add.

Click on the Done button when you are finished adding slots.
Adding DLSw Peer IP Addresses

The DLSw Peer Configuration window (Figure 2-58) displays a list of the peer IP addresses you have added.

![DLSw Peer Configuration Window](image)

**Figure 2-58. DLSw Peer Configuration Window**

Click on the Add button to add a peer IP address to the DLSw Peer Configuration window (Figure 2-59).

![Add Peer IP Address Window](image)

**Figure 2-59. Add Peer IP Address Window**

Enter the appropriate peer IP address. Use the parameter descriptions as a guide.
Enabling Bridging/Routing Services

**Parameter:** Peer IP Address

- **Default:** None
- **Options:** Any valid, 32-bit IP address of the form: network.host (using dotted decimal notation)
- **Function:** Specifies the IP address of a remote DLSw peer. Once added to the DLSw peer table, this address defines a “configured peer” on the local router. Configured peers receive all DLSw-related broadcast frames for a given router or network processor.
- **Instructions:** Enter the IP address at which the configured peer will receive all DLSw-related broadcast frames.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.5.1.3

Click on the OK button to accept the peer IP address and to display the first DLSw Peer Configuration window. Add additional peers by clicking on the Add button and repeating the procedure as many times as needed.

Click on the Done button in the DLSw Peer Configuration window when you are finished adding peers.

**Adding a Service Access Point (SAP)**

The DLSw SAP Configuration window (Figure 2-60) displays SAP configuration information and lists the SAP addresses that you have configured.
Click on the Add button to add a Service Access Point. The second DLSw SAP Configuration window appears (Figure 2-61).

Enter the appropriate SAP value, referring to the parameter description that follows as a guide.
Enabling Bridging/Routing Services

Parameter: SAP

Default: None

Options: Any valid SAP address (in hexadecimal, decimal or octal format)

Function: Specifies a Service Access Point that you want to terminate locally, to establish end-to-end communication between SNA and/or NetBIOS endstations in your network.

The SAP entries for SNA are 0x04, 0x08, and 0x0c. The SAP entry for NetBIOS is 0xf0.

Instructions: Enter the valid SAP address you want to terminate with DLSw.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.5.4.1.2

Click on the OK button when you are finished.

You are returned to the DLSw SAP Configuration window. Repeat the instructions in this section as needed.

Click on the Done button when you are finished adding SAPs.

The main Configuration Manager screen appears. You are now finished with your initial installation of DLSw. If you have not already configured the IP addresses of the slots and connection to the IP network, add them now.

Subsequent DLSw Configuration

You select DLSw on the Protocol Selection window (see “Enabling Bridging/Routing Services” earlier in this chapter). From this starting point, enabling DLSw services follows a simpler procedure than the initial configuration. Figure 2-50 and Figure 2-51 illustrate these procedures.

Once you select DLSw on an Ethernet circuit, no further steps are needed.
Adding Network Interfaces

When you select DLSw on a Token Ring circuit, the Source Routing Edit Interface window appears. Refer to “Enabling Source Routing Services” earlier in this chapter to configure the window (Figure 2-44). Click on the OK button to accept the SR Edit Interface window.

The main Configuration Manager screen appears. You are now finished with your initial installation of DLSw. If you have not already configured the IP addresses of the slots and connection to the IP network, add them now.

Enabling LNM Servers

If you enabled LNM servers on the circuit, you need not specify any configuration information. The system software provides default LAN Manager/LSS service. To change operating parameters of the default service, refer to Customizing LNM Services.

Enabling LLC2 Services

If you enabled LLC2 on the circuit, you need not specify any configuration information. The system software provides default LLC (LLC1 and LLC2) services. To change operating parameters of the default service, refer to Customizing LLC Services.

Enabling LLC2 Services over Native Frame Relay

If you are configuring and enabling Frame Relay on LLC2 media, Configuration Manager displays a set of screens that allow you to start LLC2 and related services such as APPN and DLSw. Perform the following steps.

1. Select Frame Relay from the WAN Protocols menu and click on OK. The Select Protocols menu appears (Figure 2-62).
Enabling Bridging/Routing Services

Figure 2-62. Select Protocols Menu Showing LLC2

2. Select APPN or DLSw or both. Selecting APPN or DLSw automatically selects LLC2 as well. Click OK. The Source Route Encapsulation dialog box appears (Figure 2-63).

Figure 2-63. Source Route Encapsulation Dialog Box

3. Select Cancel. This selects native (routed) Frame Relay for LLC2.
4. If you selected APPN on the Select Protocols window (Figure 2-62), Configuration Manager displays the APPN Configuration window. Specify the APPN local node name and click OK. (Refer to the section “Enabling APPN over LLC2 Interfaces” for information.)

5. Specify the DLCI and SAP address for this interface. (Refer to the section “Enabling APPN over LLC2 Interfaces” for information.)

6. When the Adjacent Link Station dialog box appears, click on Cancel.

7. If you selected DLSw, the DLSw Global Parameters window appears (Figure 2-52). Specify the IP Virtual Ring parameter and click on OK. (Refer to “Enabling DLSw Services” for information.)

8. The Source Route Encapsulation dialog box appears (Figure 2-63). Click on Cancel. The Frame Relay Mappings window appears (Figure 2-61).

![LLC2 Frame Relay Mappings](image)

Figure 2-64. Frame Relay Mappings Window
9. Select Add. The LLC2 Frame Relay Mapping Add window appears (Figure 2-65).

![LLC2 Frame Relay Mapping Add Window](image)

Figure 2-65. LLC2 Frame Relay Mapping Add Window

Specify the DLCI, Remote MAC, and Local MAC parameters, as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>DLCI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>None</td>
</tr>
<tr>
<td>Range</td>
<td>Standard Data Link Connection Identifier numbers.</td>
</tr>
<tr>
<td>Function</td>
<td>This parameter provides the number of the virtual circuit to which the local or remote MAC address will be mapped.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Enter a decimal DLCI number assigned by your system administrator or Frame Relay provider.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.5.1.6.9.1.3</td>
</tr>
</tbody>
</table>
### Parameter: Remote MAC
- **Default:** None
- **Range:** Standard MSB Token Ring MAC addresses
- **Function:** This parameter provides the remote MAC address, mapping outgoing requests specifying it to the DLCI value. The Remote MAC address must be unique, with only DLCI mapping for a specific MAC address.
- **Instructions:** If you need to specify the real hardware address of the host, enter it as an octal string.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.6.9.1.5

### Parameter: Local MAC
- **Default:** None
- **Range:** Standard MSB Token Ring MAC addresses
- **Function:** This parameter provides the local MAC address, mapping incoming requests on this DLCI to that address. The Local MAC address must be unique, with only DLCI mapping for a specific MAC address.
- **Instructions:** If the incoming connections are valid, enter the MAC address of the recipient.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.6.9.1.4

10. After specifying the DLCI, Remote MAC, and Local MAC parameters, click on OK. Configuration Manager returns to the Frame Relay Mappings window showing the selected circuit (Figure 2-66).
Figure 2-66. LLC2 Frame Relay Mappings Window with DLCI Added

11. Select Apply.

12. If you have more mappings to do, repeat Steps 7 through 9. Otherwise, select Done. You return to the series of layered windows.

13. Fill in any subsequent DLSw layered windows. Refer to the section “Enabling DLSw Services” or “Enabling APPN Services” for detailed information on these services. For each window, select Done or OK as necessary.
If you selected APPN for either an LLC2 or SDLC interface, you can enable APPN services on your router in any one of the following ways:

- APPN on LLC2 media, including Ethernet, Token Ring, and Frame Relay
- APPN on LLC2 using Source Routing Bridge (SRB) encapsulation formats over Ethernet, FDDI, SMDS, Frame Relay, and Point-to-Point (PPP)
- APPN on SDLC links in point-to-point and multipoint networks

Enabling APPN over LLC2 Interfaces

When you configure APPN on LLC2 interfaces, such as Ethernet and Token Ring, the Wellfleet Configuration Manager requests Media Access Control (MAC) and Service Access Point (SAP) addresses. On synchronous interfaces where you are configuring APPN over Frame Relay, Configuration Manager requests a Data Link Connection Identifier (DLCI) address and a SAP address.

To enable APPN on Ethernet, Token Ring, or Wellfleet synchronous interfaces using Frame Relay, perform the following steps:

1. Start at the Select Protocols window (Figure 2-67). Scroll down the Select Protocols window and select the APPN option. Configuration Manager automatically selects the LLC2 option.
Enabling Bridging/Routing Services

2-132

2. Click OK. The “Use Source Route Encapsulation?” dialog box appears (Figure 2-68).

Figure 2-67. Select Protocols Window

Figure 2-68. Source Route Encapsulation Dialog Box
3. Select Cancel if you are configuring standard LLC over Ethernet, or if you are configuring Frame Relay using the RFC 1490 Routing Standard. If you want to configure Wellfleet proprietary SRB over Ethernet, or Frame Relay using the RFC 1490 Bridging Standard, click on OK and refer to the next section, “Enabling APPN Over LLC2 Interfaces Using SRB” for information on the additional screens that appear. In this example, click Cancel. The APPN Local Node Name Configuration window appears (Figure 2-69).

![APPN Configuration Window](image)

**Figure 2-69. APPN Local Node Name Configuration Window**

4. At the APPN Configuration window, specify the Local Node Name parameter, as follows:
Parameter: Local Node Name
Default: None
Options: Any valid name with up to 17 characters in the format <NETID.CPNAME>, where NETID is the global network name with up to 8 characters followed by a period, and CPNAME is the control point name with up to 8 characters.
Function: The Local Node Name parameter identifies the unique name of the network and the Wellfleet router node name.
Instructions: Enter the node name by first specifying up to 8 characters in the network ID name, type a period, then enter a control point name with up to 8 characters. Names must be specified in uppercase characters only and must start with a non-numeric character. Blank spaces (leading, trailing, and embedded) are not allowed in the node name. For example, NETWORKA.SYSTEMA is a valid entry for the Local Node Name parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.5.14.1.1.4

5. Click OK to add the Local Node Name. The APPN Configuration window appears (Figure 2-70).
6. Specify the MAC Address and SAP parameters, as follows:

**Parameter:** MAC Address

- **Default:** None
- **Options:** Any unique 48-bit 12-digit hexadecimal MAC-level address
- **Function:** Specifies a unique MAC-level address for this port connecting the adjacent link station
- **Instructions:** Enter a 12-digit hexadecimal MAC-level address in most significant bit (MSB) non-canonical format, regardless of the media.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.14.1.3.1.38
Enabling Bridging/Routing Services

**Parameter:** SAP (hex)

- **Default:** None
- **Options:** Any unique service access point (SAP) 2-digit hexadecimal value, typically 04.
- **Function:** Specifies a service access point (SAP) address that lets multiple applications and protocol entities in a single computer share a MAC address.
- **Instructions:** Enter a 2-digit hexadecimal value.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.14.1.3.1.38

If you are configuring a Wellfleet synchronous interface (a connector labeled COM# on the Wellfleet Configuration Manager window in Figure 2-1) with the Frame Relay protocol, the APPN Configuration Window displays the Data Link Connection Identifier (DLCI) parameter instead of the MAC Address parameter. The DLCI is the Frame Relay permanent virtual circuit (PVC) identification number. The Frame Relay network uses the DLCI to direct basic data flow. Specify the DLCI parameter as follows:

**Parameter:** DLCI

- **Default:** None
- **Options:** Valid range changes based on the Frame Relay address length as follows:

<table>
<thead>
<tr>
<th>Address Length</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Byte</td>
<td>16-1007</td>
</tr>
<tr>
<td>3 Byte</td>
<td>1024-64511</td>
</tr>
<tr>
<td>4 Byte</td>
<td>131072-8257535</td>
</tr>
</tbody>
</table>

- **Function:** This number is the PVC identification number that the Frame Relay network uses to direct data.
- **Instructions:** Enter a decimal number within the valid range.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.14.1.3.1.38
7. Click the OK button on the APPN Configuration Manager window. The Adjacent Link Station dialog box appears (Figure 2-71).

![Site Manager](image)

**Figure 2-71. Adjacent Link Station Dialog Box**

8. If you wish to configure APPN adjacent link station parameters at this time, refer to *Customizing APPN Services*. Otherwise, click the Cancel button and proceed to Chapter 3 for information on configuring APPN.

**Enabling APPN over LL2 Interfaces using SRB**

If you are configuring LLC2 interfaces such as Ethernet, FDDI, SMDS, Frame Relay, and Point-to-Point (PPP) and you want to use source routing bridge (SRB) encapsulation formats, select the appropriate connector and protocols as described in the previous section. For Ethernet (Wellfleet proprietary SRB over Ethernet) and Frame Relay (RFC1490 Bridging Standard), start at the Source Route Encapsulation Dialog Box (Figure 2-72) and proceed as follows:
Enabling Bridging/Routing Services

![Source Route Encapsulation Dialog Box](image)

**Figure 2-72. Source Route Encapsulation Dialog Box**

1. Click the OK button. The Source Routing Global Parameters window appears (Figure 2-73).

![Source Routing Global Parameters Window](image)

**Figure 2-73. Source Routing Global Parameters Window**
2. Edit the parameters in the Source Routing Global Parameters window. The SR Bridge Internal LAN ID and the SR Bridge ID are mandatory parameters that you must specify before you can proceed.

**Parameter: SR Bridge Internal LAN ID**
- **Default:** 0x1
- **Range:** 0x1 to 0x0ff
- **Function:** Specifies this bridge's internal LAN ID.
- **Instructions:** Assign an internal LAN ID that is unique among all other internal LAN IDs and ring IDs in the network.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.1.2.1.4

**Parameter: SR Bridge ID**
- **Default:** 0x1
- **Range:** 0x1 to 0x0f
- **Function:** Specifies this bridge's bridge ID and identifies the Wellfleet source routing bridges in the network.
- **Instructions:** Assign the same value to all Wellfleet source routing bridges in the network (unless two bridges operate in parallel; see the following note). The SR bridge ID must be unique among any other third-party bridge IDs in the network.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.1.2.1.5

For details on how to configure the source routing parameters on this window, refer to *Customizing Bridging Services*.

3. When you have specified the parameters on the Source Routing Global Parameters window, click the OK button. The Edit SR Interface window appears (Figure 2-74).
Enabling Bridging/Routing Services

![Edit SR Interface Window](image)

Figure 2-74. Edit SR Interface Window

4. Edit the parameters in the Edit SR Interface window. The Source Routing Ring Number is the only parameter that you must specify before you can proceed.
Parameter: Source Routing Ring Number

Default: 0x0
Range: 0x0 to 0xffff
Function: Identifies the ring number (ring ID) of this source routing circuit.

Instructions: Assign a ring number (ring ID) to this source routing circuit that is unique among any other ring IDs, group LAN IDs, or internal LAN IDs in the network.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.1.2.2.1.6

For details on how to configure the source routing parameters on this window, refer to Customizing Bridging Services.

5. When you have specified the parameters on the Edit SR Interface window, click the OK button. The APPN Virtual Ring Number window appears (Figure 2-75).

![APPN Virtual Ring Number Window](image)

Figure 2-75. APPN Virtual Ring Number Window

6. Edit the Virtual Ring Number parameter, as follows:
Enabling Bridging/Routing Services

**Parameter:** Virtual Ring Number (hex)

- **Default:** None
- **Range:** 1 to 4095

**Function:** Specifies the unique SRB ring number to be used by APPN if the encapsulation technique is SRB. It must be unique in the SRB network. This means that Virtual Ring Number must be different than the ring IDs specified in the SRB configuration, as well as different from other Wellfleet routers running APPN on LLC2/SRB media.

**Instructions:** Specify the unique LLC ring number in the range 1 to 4095.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.6.2.25

7. Click the OK button. If this is the first interface for which you are configuring APPN, the APPN Local Node Name Configuration window appears (Figure 2-69). If this is not the first interface for which you are configuring APPN, the Adjacent Link Station Dialog Box appears (Figure 2-71). Refer to these figures for information on completing the remaining APPN configuration steps.

**Enabling APPN Interfaces over SDLC**

If you are configuring APPN on synchronous interfaces (COM1, COM2, etc.) using the SDLC protocol, Configuration Manager displays the SDLC Line Parameters window (Figure 2-76).
1. Edit the Clock Source, Internal Clock Speed, Sync Line Coding, and Cable Type parameters. Refer to "Configuring the Circuit" for information on enabling SDLC services and the parameters on the SDLC Line Parameters window.
2. Click the OK button to display the Select Protocols window (Figure 2-77).

![Select Protocols Window](image)

**Figure 2-77. Select Protocols Window**

3. Select APPN and click OK. If this is the first interface for which you are configuring APPN, the APPN Local Node Name Configuration window appears (Figure 2-78). Otherwise, the APPN Configuration window appears (Figure 2-79).

![APPN Configuration Window](image)

**Figure 2-78. APPN Local Node Name Configuration Window**
4. At the APPN Local Node Name Configuration window, specify the Local Node Name parameter, as follows:

Parameter: Local Node Name

Default: None

Options: Any valid name with up to 17 characters in the format <NETID.CPNAME>, where NETID is the global network name with up to 8 characters followed by a period, and CPNAME is the control point name with up to 8 characters.

Function: The Local Node Name parameter identifies the unique name of the network and the Wellfleet router node name.

Instructions: Enter the node name by first specifying up to 8 characters in the network ID name, type a period, then enter a control point name with up to 8 characters. Names must be specified in uppercase characters only and must start with a non-numeric character. Blank spaces (leading, trailing, and embedded) are not allowed in the node name. For example, NETWORKA.SYSTEMA is a valid entry for the Local Node Name parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.5.14.1.4

5. Click OK to add the Local Node Name. The APPN Configuration window appears (Figure 2-79).
6. Specify the SDLC address for the interface, as follows:

**Parameter:** SDLC Address (hex)

**Default:** None

**Options:** Any unique 2-digit hexadecimal SDLC-level address.

**Function:** Specifies a unique SDLC address for this circuit.

**Instructions:** Enter a 2-digit hexadecimal address.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.14.1.3.1.38
7. Click the OK button on the APPN Configuration Manager window. The Adjacent Link Station dialog box appears (Figure 2-80).

![Site Manager dialog box](image)

Figure 2-80. Adjacent Link Station Dialog Box

8. If you wish to configure APPN adjacent link station parameters at this time, refer to *Customizing APPN Services*.

**Enabling Data Compression Services**

If you are configuring a Wellfleet router for PPP operations and if you want to enable the Wellfleet Compression Protocol (WCP), select WCP option from the WAN Protocols window (Figure 2-4). WCP operates on ISDN and all standard synchronous interfaces. For detailed information on customizing data compression services on Wellfleet routers, refer to *Customizing Data Compression Services*.

**Note:** WCP is not supported on MCT1, MCE1, and multiline circuits.
About the Multiline Feature

Multiline is a feature that increases the throughput of circuits. It allows you to configure a single circuit consisting of one or more WAN data paths. A data path is a logical point-to-point channel. It can be a permanent physical line or a dial-up physical line; you can group up to 31 physical lines. It can also be a virtual circuit connection. Multiline can also be used with Frame Relay group mode. For more information on using Multiline with Frame Relay, refer to *Customizing Frame Relay Services*.

The advantages of using the Multiline feature over a single path are:

- It provides a greater degree of fault tolerance.
  
  With Multiline, there are multiple data paths configured for a single circuit. Therefore, if one data path becomes disabled, traffic can be sent over another data path. As a result, there is greater fault tolerance.

- It provides greater bandwidth between two sites.
  
  Because there are multiple data paths per circuit, there is more bandwidth assigned to the circuit than if it was a uni-line circuit with just one data path. Therefore, the Multiline circuit is able to handle higher volumes of traffic.

As an example of how Multiline is useful, consider the following. Suppose that your network has two sites connected by Wellfleet routers, one in New York City and one in Los Angeles (Figure 2-81). These two sites have a particularly high volume of traffic transmitted between them, and that the traffic transmitted between these two sites is imperative to the operation of your business.

It would be advantageous for you to create a Multiline circuit between these two sites to facilitate the large amount of traffic, and to decrease the chance of traffic loss due to connection failure. If the network topology is as it appears in the example in Figure 2-81, you could group the three synchronous lines into one Multiline circuit.
Multiline Support

Multiline is supported over the following types of media: Wellfleet Standard SYNC, T1/E1, MCT1, MCE1, Frame Relay (if the data paths are configured with the same Frame Relay addressing), PPP, and HSSI.

Multiline Circuit Types

There are two types of Multiline circuits:

- A circuit distributed over several physical lines
- A circuit on one physical line with several separately addressable data paths
In Figure 2-82, Multiline Circuit A groups three synchronous lines into one circuit. Multiline Circuit B consists of just one physical synchronous line, but has three separately addressable data paths associated with it.

**Figure 2-82. Multiline Circuit Types**

A Multiline circuit reacts to these individual data paths coming up and going down by adding to and subtracting from its pool of active data paths, and can operate with some of its data paths down.

**Grouping Data Paths**

The data paths that together make up a Multiline circuit must share the same bandwidth, MTU, and encapsulation method. T1, E1, MCT1, MCE1, HSSI, and Wellfleet Standard SYNC lines share the same encapsulation method. This means that you can group any of these lines to form a Multiline circuit as long as they share the same bandwidth and MTU.

Frame Relay and PPP each have unique encapsulation methods. You cannot mix these line types with any other line type when you create a Multiline circuit.
Multiline Traffic Distribution

There are two ways a Multiline circuit distributes outbound traffic over its data paths. It can use address-based selection (this is the default), or it can use random selection.

Address-based selection

This option determines the appropriate data path for outbound traffic based on the source and destination address in individual packets. For any given address pair, the same data path will always be chosen.

Multiline automatically determines whether the packet is to be routed or bridged, and then uses the appropriate address. It uses the routing-level addresses for traffic to be routed, and the MAC-level addresses for traffic to be bridged.

This option ensures that all outbound traffic to a certain endstation travels on the same data path, and therefore ensures sequentiality of packets. For protocols that are intolerant of receiving packets out of sequence, this is the best choice. This is also the default.

Note that this option does not always result in even distribution across all data paths in a Multiline circuit.

Note: Address-based selection cannot be used with Frame Relay in Group or Hybrid mode. Traffic distribution is automatically changed to random selection.

Random-selection

This option determines the data path for outbound traffic based on a randomly assigned number. For each outbound packet, Multiline generates a random number. This number determines which data path will be used to send this particular packet.
Note: This option provides even distribution across all active data paths in the topology. However, packets traveling on different paths can arrive at their destination out of sequence. Some protocols cannot tolerate packets arriving out of sequence, and as a result, you can experience poor performance or failures. Use this option only when it is acceptable for packets to arrive out of sequence.

Configuring Multiline

The way that you configure a Multiline circuit depends on what it is that you are grouping.

- For information on how to group up to 16 physical synchronous lines into a Multiline circuit, follow the directions in the appropriate following section, either “Grouping Physical Synchronous Lines into a Multiline Circuit,” or “Adding Physical Synchronous Lines to a Circuit.”

- For information about how to use Multiline with Frame Relay, refer to the section “Grouping PVCs for Multipath Mode” in Customizing Frame Relay Services.

Grouping Physical Synchronous Lines into a Multiline Circuit

To group any physical synchronous lines into a Multiline circuit, begin at the Wellfleet Configuration Manager window, and complete the following steps.

1. Double-click on the Link Module connector that you want to connect to the network to display the Add Circuit window (Figure 2-83).

   The Link Module connector that you select must be of type E1, T1, MCT1, MCE1, HSSI, or Synchronous.
2. Click on the other connector(s) that you want to group with the first connector.

These connectors must also be of type E1, T1, MCT1, MCE1, HSSI, or Synchronous.
3. Click on the OK button.

The connectors that you have selected are now grouped and saved under a single circuit name. For example, in Figure 2-83, the lines connecting to COM1, COM2, and COM3 now form one circuit called S21, which distributes traffic based on address pairs. To change the traffic distribution method, refer to the section “Changing the Traffic Distribution Method.”

4. Add the necessary protocols to this circuit.

Refer to the section “Enabling Bridging/Routing Services” earlier in this chapter for instructions.

Adding Physical Synchronous Lines to a Circuit

To add a physical synchronous line to a synchronous line that has already been configured with protocols (is now a circuit), you must first be sure that the lines you intend to group share the same encapsulation method and MTU. If they do, begin at the Wellfleet Configuration Manager window, and complete the following steps.

1. Double-click on the connector of the circuit to which you want to add lines.

2. Click on the Edit Circuit button in the Edit Connector window.

The Circuit Definition window appears (Figure 2-84).
3. Click on the connectors that you want to add to the circuit.
   For example, in Figure 2-84, COM2 has been selected to be added to circuit S21.

4. Select Lines ➔ Change Lines.
   The lines are now grouped as one circuit. The default traffic distribution method is address-based. If you want to change the traffic distribution method, refer to the section “Changing the Traffic Distribution Method.”

5. Select File ➔ Exit to exit this window.
Changing the Traffic Distribution Method

All Multiline circuits, by default, distribute traffic based on address pairs. If you want to change the traffic distribution method, begin at the Wellfleet Configuration Manager window, and complete the following steps.

1. Double-click on one of the connectors belonging to the Multiline circuit you want to edit.
2. Click on the Edit Circuit button in the Edit Connector window.
3. Select Lines→Multiline from the menu bar.

The Edit Multiline Options window for this circuit appears (Figure 2-85).

4. Edit the Data Path Chooser parameter to reflect the appropriate traffic distribution method for this circuit.
5. Click on the OK button when you are finished.

Figure 2-85. Edit Multiline Options Window for Circuit S21
Parameter: Data Path Chooser
Default: Address Based
Options: Address Based | Random
Function: Specifies how this Multiline circuit will distribute outbound traffic over its data paths. The default value is Address Based, which means that traffic between the same source and destination address pair will always be sent over the same data path. This method ensures sequentiality.

If you select Random, the data path used to send outbound traffic is based on a randomly assigned number. For each outbound packet, Multiline generates a random number. This number determines which data path will be used to send this particular packet. This method ensures even distribution among the data paths in a Multiline circuit, but does not ensure sequentiality.

Instructions: Either accept the current value, or set this parameter to another value.

MIB Object ID: 1.3.6.1.4.1.18.3.5.1.4.1.1.23

Editing Circuits

The following six sections describe how to edit circuits. The Configuration Manager allows you to

- Delete a circuit from the router.
  Refer to the section “Deleting a Circuit from the Router” for instructions.

- Rename a circuit.
  Refer to the section “Renaming a Circuit” for instructions.

- Add protocols to a circuit.
  Refer to the section “Adding Protocols to a Circuit” for instructions.
Editing Circuits

- Move a circuit.
  Refer to the section "Moving a Circuit" for instructions.
- Assign additional IP addresses to a circuit.
  Refer to the section "Assigning an Additional IP Address to a Circuit" for instructions.
- Delete protocols from a circuit.
  Refer to the section "Deleting Protocols from a Circuit" for instructions.

Deleting a Circuit from the Router

You can delete circuits from the router. When you delete a circuit from the router, you remove all line and protocol information from the circuit. You will need to go through the process for adding network interfaces if you want to redefine this circuit.

To delete a circuit from the router, begin at the Wellfleet Configuration Manager window and complete the following steps:

1. Select Circuits→Delete Circuit.
   The Circuit List window appears.
2. Select the circuit you want to delete from list of the circuits.
3. Click on the Delete button.
   The Delete Circuit window appears (Figure 2-86), with the circuit you selected specified.

![Figure 2-86. Delete Circuit Window](image-url)
4. Click on the Delete button.

   The circuit is deleted from the router, and no longer appears in the Circuit List window.

   Repeat Steps 1 through 4 for each circuit that you want to delete from the router.

**Renaming a Circuit**

To rename a circuit on the router, begin at the Wellfleet Configuration Manager window and complete the following steps:

1. Select Circuits ➔ Edit Circuits.

   The Circuit List window appears.

2. Select the circuit that you want to rename from the list of circuits.

3. Click on the Edit button; the Circuit Definition window appears (Figure 2-87).
4. Enter a new name for this circuit in the Circuit Name box.
5. Select Lines→Change Lines; the circuit’s new name is saved.

Follow Steps 1 through 5 for each circuit that you want to rename.
6. Select File→Exit to exit this window when you are finished.

**Adding Protocols to a Circuit**

To add protocols to a circuit, begin at the Wellfleet Configuration Manager window and complete the following steps:

1. Select the Circuits→Edit Circuits option.

   The Circuit List window appears.

2. Select the circuit to which you want to add protocols.
3. Click on the Edit button.
   The Circuit Definition window appears.

4. Select Protocols→Add/Delete; the Select Protocols window appears (Figure 2-24).

5. Select the protocols that you want to add to this circuit; then click on the OK button.
   For each protocol you add, the Configuration Manager displays a configuration window prompting you to define each protocol you enabled on the circuit.

6. Define each protocol you added to the circuit. To do this, refer to the corresponding section(s) earlier in this chapter.
   Repeat Steps 1 through 6 for each circuit to which you want to add protocols.

Moving a Circuit

Moving a Circuit

Once you have configured a circuit on a network interface, you can move the circuit to another network interface. When you move a circuit to a different type of network interface (for example, when you move an Ethernet circuit to an FDDI network interface connector), the Configuration Manager notes the type of connector for the circuit interface, and automatically provides the appropriate line detail parameters.

To move a circuit, begin at the Wellfleet Configuration Manager window and complete these steps.

1. Select Circuits→Edit Circuit.
   The Circuit List window appears.

2. Select the circuit that you want to move from the list of circuits.

3. Click on the Edit button.
   The Circuit Definition window appears (Figure 2-88). The name of the circuit you want to move appears in the Circuit Name box, and the connector for the circuit interface is highlighted.
4. Click on the circuit's connector.

The circuit is removed from the connector, and the connector is no longer highlighted.

5. Click on the connector for the circuit interface.

The connector you chose is now highlighted, indicating that the circuit now connects to it. For example, in Figure 2-88, Circuit S32 was moved to the connector COM1.

At this point, you may want to rename the circuit if you think the old circuit name may cause some confusion. To do this, enter a new name in the Circuit Name box.
Adding Network Interfaces

   All circuit moves are reflected in the Wellfleet Configuration Manager window. Follow Steps 1 through 6 for each circuit that you want to move.

7. Select File→Exit to exit this window when you are done.

Changing Network Addresses on a Circuit

Site Manager allows you to change network addresses on a circuit by using the Configuration Change Utility. For information on this utility, see the section “Configuration Change Utility” in Chapter 5.

Assigning an Additional IP Address to a Circuit

Wellfleet IP routing supports Multinet. Multinet allows you to assign multiple IP addresses to a single circuit; thus, one circuit can support multiple IP network interfaces. Each IP address on a Multinet circuit must belong to a unique network/subnet. You cannot have two interfaces on the same subnet.

For more information about Multinet, see the section “Multinet” in Customizing IP Services.

You can assign as many IP addresses as you desire to a circuit. To assign additional IP addresses to a circuit, begin at the Wellfleet Configuration Manager window and complete the following steps:

1. Select Circuits→Edit Circuits.
   The Circuit List window appears.

2. Select the circuit to which you want to assign an additional IP address, then click on the Edit button.
   The Circuit Definition window appears (Figure 2-87).

   The IP Interfaces window appears (Figure 2-89).
Figure 2-89. IP Interfaces Window

4. Click on the Add button.

   The IP Configuration window appears (Figure 2-90).
Adding Network Interfaces

**IP CONFIGURATION**

**Configuration Mode:** local

**SNMP Agent:** LOCAL FILE

**IP Address**

Configure RIP

Configure OSPF

![Figure 2-90. IP Configuration Window](image)

5. Enter the IP address you want to assign to this circuit in the IP Address box.

6. Click on the OK button.

You are returned to the IP Interfaces window. The address you just assigned to the specified circuit appears in the Interfaces scroll box.

Follow Steps 1 through 6 for each IP address you want to add to a circuit.

**Deleting Protocols from a Circuit**

To delete protocols from a circuit, begin at the Wellfleef Configuration Manager window and complete the following steps:

1. Select Circuit→Edit Circuits.
   
   The Circuit List window appears.

2. Select the circuit from which you want to delete protocols.

3. Click on the Edit button; the Circuit Definition window appears (Figure 2-87).

4. Select Protocols→Add/Delete; the Select Protocols window appears (Figure 2-24).
5. Deselect the protocols that you want to delete from this circuit by clicking on the boxes beside those protocols.

6. Click on the OK button.

You are returned to the Circuit Definition window. The protocols you just deleted no longer appear in the Protocols scroll box.

Follow Steps 1 through 6 for each circuit from which you want to delete protocols.

Configuring the Console Port for the Technician Interface

This section describes how to configure the console port to connect the router to the Wellfleet Technician Interface. Configure the console port by editing parameters in the Console Lists window (Figure 2-91). Display this window by clicking on the Console button in the Wellfleet Configuration Manager window (Figure 2-1).
The Console Lists window displays the router’s console ports. Console ports are the physical ports on a router for system input/output. The number of ports depends on the router model. For example, the Wellfleet AFN™ router has two console ports, labeled Console and Modem.

Select a console port from the Console Lists window and then edit its parameters. After you are finished, click on the Apply button to save your changes. When you are done with all ports, click on the Done button to exit the window and save your changes.
Configuring the Console Port for the Technician Interface

**Parameter:** Enable

**Default:** Enable (first port)
Disable (other ports)

**Options:** Enable | Disable

**Function:** Enables or disables the serial ports. The first port on a router is enabled by default. The other ports on routers with multiple ports are disabled by default.

**Instructions:** Select the status of the serial port.

**MIB Object ID:** 1.3.6.1.4.1.18.3.3.2.11.1.1.2

**Parameter:** Port Type

**Default:** TI

**Options:** TI

**Function:** Configures the port for the Technician Interface.

**Instructions:** Select the port type.

**MIB Object ID:** 1.3.6.1.4.1.18.3.3.2.11.1.1.7

**Parameter:** Baud Rate

**Default:** 9600

**Options:** 9600 | 4800 | 2400 | 1200 | 600 | 300

**Function:** Specifies the rate of data transfer between the console and the router.

**Instructions:** Set according to your console requirements.

**MIB Object ID:** 1.3.6.1.4.1.18.3.3.2.11.1.1.8
### Adding Network Interfaces

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Port Data Bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>8</td>
</tr>
<tr>
<td>Options:</td>
<td>7</td>
</tr>
<tr>
<td>Function:</td>
<td>Specifies the number of bits in each ASCII character received or transmitted by the router.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Set according to your console requirements.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.3.2.11.1.1.9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Port Parity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>None</td>
</tr>
<tr>
<td>Options:</td>
<td>None</td>
</tr>
<tr>
<td>Function:</td>
<td>Enables or disables data error detection for each character transmitted or received.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Set according to your console requirements. Odd or Even enables data error detection. None disables data error detection.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.3.2.11.1.1.10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Stop Bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>1 bit</td>
</tr>
<tr>
<td>Options:</td>
<td>1</td>
</tr>
<tr>
<td>Function:</td>
<td>Specifies the number of bits that follow each ASCII character received or transmitted by the router.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Set according to your console requirements.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.3.2.11.1.1.11</td>
</tr>
</tbody>
</table>
### Configuring the Console Port for the Technician Interface

#### Parameter: Modem Enable
- **Default:** Disable
- **Options:** Enable | Disable
- **Function:** Specifies whether the terminal is connected directly or via a modem to the Technician Interface.
- **Instructions:** Select Enable if the terminal is connected via a modem to the Technician Interface. Select Disable if the terminal is connected directly to the Technician Interface.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.3.2.11.1.1.12

#### Parameter: Lines Per Screen
- **Default:** 24
- **Range:** 5 to 100 inclusive
- **Function:** Specifies the maximum number of lines displayed on the console screen.
- **Instructions:** Set according to your console requirements.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.3.2.11.1.1.13
Parameter: More Enable

Default: Enable
Options: Enable | Disable
Function: Specifies whether the Technician Interface pauses after the screen fills with data.
Instructions: Select Enable to configure the Technician Interface to pause after the screen fills with data. Select Disable to configure the Technician Interface not to pause after the screen fills with data.
MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.14

Parameter: Prompt

Default: $
Options: Any string of up to 19 keyboard characters except for control key sequences.
Function: Specifies the text used as a prompt on your console screen. Place quotes around any spaces you want to include in the text.
Instructions: Accept the default or enter a different text string.
MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.15
Configuring the Console Port for the Technician Interface

Parameter: **Login Timeout**

Default: 1
Range: 1 to 99 (99 indicates infinity)
Function: Specifies the number of minutes allowed in which to press the Enter key after the Login: prompt appears. This parameter is valid only when Modem Enable is set to Enable.

Instructions: Accept the default or enter a new timeout value.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.16

Parameter: **Password Timeout**

Default: 1
Range: 1 to 99 (99 indicates infinity)
Function: Specifies the number of minutes allowed in which to press the Enter key after the Password: prompt appears. This parameter is valid only when Modem Enable is set to Enable.

Instructions: Accept the default or enter a new timeout value.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.17

Parameter: **Command Timeout**

Default: 15
Range: 1 to 99 (99 indicates infinity)
Function: Specifies the number of minutes allowed in which to press the Enter key after the prompt. This parameter is valid only when Modem Enable is set to Enable.

Instructions: Accept the default or enter a new timeout value.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.18
Parameter: Login Retries

Default: 3

Range: 1 to 99 (99 indicates infinity)

Function: Specifies the maximum number of login attempts when Modem Enable is set to Enable.

Instructions: Accept the default or enter a new retry value.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.19

Parameter: Initial Search Path

Default: None

Options: None

Function: Sets the Path environmental variable that defines the path to the location of autoscript files.

Instructions: Enter the path to the directory where the autoscript files are located.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.28
Parameter: Manager Auto Script  
Default: None  
Options: None  
Function: Defines the manager's login script file, which is automatically executed for each login.  
Instructions: Enter the name of the login script file for the manager.  
MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.29

Parameter: User Auto Script  
Default: None  
Options: None  
Function: Defines the user's login script file, which is automatically executed for each login.  
Instructions: Enter the name of the login script file for the user.  
MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.30

Parameter: Force User Logout Enable  
Default: Disable  
Options: Enable | Disable  
Function: Enabling this option forces the user to log out if he or she tries to escape from the autoscript.  
Instructions: Select Enable to force the user to log out if an attempt is made to escape the autoscript.  
MIB Object ID: 1.3.6.1.4.1.18.3.3.2.11.1.1.31
Specifying Administrative Information

This section describes how to use the Configuration Manager to specify a system name, contact, and location for the router. When you access the router from the Wellfleet Site Manager window, the application automatically retrieves this administrative information and displays it in the Wellfleet Site Manager window.

You specify router administrative information in the Edit System Description Parameters window (Figure 2-92). To display this window, select Platform→Edit System Information from the Wellfleet Configuration Manager window. Enter the required information, then click on the OK button to exit the window and save the administrative information.

A description of each parameter follows.

![Edit System Description Parameters Window](image)

Figure 2-92. Edit System Description Parameters Window
Parameter: **System Name**
- Default: None
- Options: Any name
- Function: Identifies this router.
- Instructions: Enter the appropriate name for this router.
- MIB Object ID: 1.3.6.1.4.1.18.3.3.1.5

Parameter: **System Contact**
- Default: None
- Options: Any person
- Function: Provides the name of the person to contact regarding issues with this router.
- Instructions: Enter the name of the contact person, and possibly a way to contact that person.
- MIB Object ID: 1.3.6.1.4.1.18.3.3.1.4

Parameter: **System Location**
- Default: None
- Options: Any place
- Function: Identifies the physical location of this router.
- Instructions: Enter a location description for this router.
- MIB Object ID: 1.3.6.1.4.1.18.3.3.1.6
This chapter provides an overview of the following physical-layer protocols, and describes how to edit them:

- Ethernet
- Token Ring
- FDDI and SMT

It also describes how to edit T1, E1, HSSI, synchronous, and asynchronous line service parameters. For information about Multichannel T1 (MCT1) and Multichannel E1 (MCE1) link modules, see Chapters 4 and 5.

If you prefer, go directly to the section entitled “Accessing Line Services,” which explains how to access the circuit for which you want to edit line services. It also directs you to the appropriate section for instructions on how to edit the line service parameters.

**Ethernet Overview**

Ethernet is a 10MB/s local area network that uses the Carrier Sense Multiple Access with Collision Detection (CSMA/CD) protocol to control access to the medium. Endstations use CSMA/CD to monitor the medium and wait until it is idle before transmitting data. If multiple stations transmit simultaneously, a collision occurs and each endstation waits a random amount of time before attempting to transmit again.
There are actually two MAC-layer frame format specifications used on Ethernet. The first specification is called Ethernet, and the second, standardized by the IEEE, is called 802.3. One way that they differ is in message format (Figure 3-1). Note that the Ethernet message does not include a Length field in the MAC-layer header. Instead, it includes a Type field, indicating which higher-layer protocol is used in the Data field.

<table>
<thead>
<tr>
<th>Dest Addr.</th>
<th>Source Addr.</th>
<th>Type</th>
<th>Data</th>
<th>CRC</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Dest Addr.</th>
<th>Source Addr.</th>
<th>Length</th>
<th>Data</th>
<th>CRC</th>
</tr>
</thead>
</table>

**Figure 3-1. Ethernet and 802.3 Message Formats**

An Ethernet LAN can use thick or thin Ethernet (coaxial cable), or twisted-pair cable. Thick and thin Ethernet LANs are arranged in a bus topology. Devices are attached directly to the backbone (Figure 3-2).

**Figure 3-2. Sample Ethernet LAN, Bus Topology**
An Ethernet LAN using twisted-pair cable is arranged in a star topology. Devices are connected to a central concentrator (Figure 3-3).

![Sample Ethernet LAN, Star Topology](image)

**Figure 3-3. Sample Ethernet LAN, Star Topology**

Data sent over an Ethernet LAN is transmitted in all directions; therefore, every device connected to the LAN sees the data. Each device checks each data unit to see if the destination address matches its own address. If the addresses match, the device accepts and processes the packet. If they do not match, it disregards the packet.

**Token Ring Overview**

Token Ring is a 4- or 16-MB/s, token-passing, baseband LAN that operates in a ring topology. Token Ring conforms to the IEEE 802.5 standard. A 4-MB/s Token Ring LAN uses shielded or unshielded twisted-pair cable.

Stations on a Token Ring network attach to the network using a Media Attachment Unit (MAU). Although the Token Ring is logically a ring, it is physically a star, with devices radiating from each MAU (Figure 3-4).
MAUs are connected to each other using Ring In (RI) and Ring Out (RO) ports. The connection between two MAUs must always be between an RI port and an RO port; you cannot connect an RI to an RI port, or an RO to an RO port. To complete the ring, all RI and RO ports must be connected (Figure 3-4).

Devices on a Token Ring network get access to the media through token passing. The devices pass the token around the ring until one of them needs to transmit data. That device takes the token and replaces it with a frame. This frame is passed from one device to the next device until it reaches its destination. As the frame passes through the intended recipient, the recipient sets certain bits in the frame to indicate that the frame was received. The original sender of the frame strips the frame data off of the ring and issues a new token.
FDDI and SMT Overview

Fiber Distributed Data Interface (FDDI) is a set of ANSI/ISO standards that define a 100-MB/s, timed-token-passing LAN. FDDI is suitable for workgroup, backbone, and back-end network configurations that require high bandwidth and performance. It uses a dual counter-rotating ring topology for fault recovery and sophisticated encoding techniques to ensure data integrity. Up to 500 nodes can be connected per FDDI LAN. The FDDI standard specifies that the total length of the fiber-optic cabling used to connect the nodes may not exceed 200 km, or 100 km per ring.

The FDDI standards consist of the following entities:
- Physical Layer Medium Dependent (PMD)
- Physical Layer Protocol (PHY)
- Media Access Control (MAC)
- Station Management (SMT)

The PMD standard defines the physical characteristics of the media interface connectors and the cabling, and the services necessary for transmitting signals between nodes.

The PHY standard defines the rules for encoding and framing data for transmission, clocking requirements, and line states.

The MAC standard defines the FDDI timed-token protocol, frame and token construction and transmission on the FDDI ring, and ring initialization and fault isolation.

The SMT standard defines the protocols for managing the PMD, the PHY, and the MAC components of FDDI. The SMT protocols monitor and control the activity of each node on the ring.

Figure 3-5 shows the relationship of the four FDDI standards.
FDDI Dual Counter-Rotating Ring Architecture

FDDI LANs are constructed of two independent, counter-rotating rings, a primary ring and a secondary ring. Data flows in opposite directions on the rings. Both rings can carry data; however, in high-bandwidth applications, Bay Networks specifies that the primary ring be used for data transmission and the secondary ring as a backup.

The counter-rotating ring architecture provides protection against loss of data flow in the event of a node failure, a link failure, or the failure of both the primary and secondary links between any two nodes. If a node or both the primary and secondary links fail, the ring is restored by wrapping one ring to the other around the faulty component. When a wrap occurs, the dual-ring architecture changes to a single-ring architecture. When the problem is corrected, the architecture reverts to that of the dual-ring.

Figure 3-6 shows how the primary ring wraps to the secondary ring when both rings are broken.
Figure 3-6. Primary Ring Wrapping to Secondary Ring When Both Rings Disabled

Figure 3-7 shows how the primary ring wraps to the secondary ring on the nodes on either side of the disabled node.
FDDI and SMT Overview

Figure 3-7. Primary Ring Wrapping to Secondary Ring When Node Disabled

FDDI Ring Operation

An FDDI ring consists of nodes connected in a ring architecture by link segments. There are two classes of nodes: stations (a node with no master ports), and concentrators (a node with master ports). The FDDI standards define two types of stations: Single Attachment Station (SAS) and Dual Attachment Station (DAS). The SAS connects to only one ring; it cannot wrap the ring in case of a fault. The DAS connects to both the primary and the secondary rings. The Wellfleet router is an example of a DAS.

Before data can be transmitted on the FDDI ring, the nodes attached to the ring must establish connections with their neighbors. The Connection Management (CMT) portion of SMT controls this process, as described in the section “FDDI SMT” later in this chapter.
After the connections between nodes have been established, nodes negotiate the target token rotation time (TTRT), using the *claim token process*. The TTRT is the value used by the MAC sublayer to time its operations. The claim token process determines which node initializes the ring (generates the token). The node with the lowest bid for the TTRT wins the right to generate the token.

After a node has initialized the ring, the ring begins to operate in *steady state*. In steady state, the nodes exchange frames using the *timed-token protocol* (TTP). The TTP defines how the TTRT is set, the length of time a node can hold the token, and how a node initializes the ring. The ring remains in steady state until a new claim token process is initiated (for example, when a new node joins the ring).

The nodes pass the token from one node to another on the FDDI ring. A node on the ring captures the token when it wants to transmit data. The node then transmits data to its downstream neighbor. Each node reads and repeats frames as it receives them. If a node detects an error in a frame, the node sets an error indicator. The sending node releases the token back onto the ring for use by another node when it has sent all of its frames, or exhausted its available transmission time. When a frame initiated from a node returns, the node removes the frame from the ring.

**Station Timers**

Each node uses three timers to regulate its operation in the ring:

- Token rotation timer (TRT)
- Token-holding timer (THT)
- Valid transmission timer (TVX)

The TRT times the period between the receipt of tokens. TRT is set to varying values, depending on the state of the ring. During steady-state operation, the TRT expires when the TTRT has been exceeded.

The THT controls the length of time that a node can hold the token in order to transmit frames. The value of THT is the difference between the arrival of the token and the TTRT.
The TVX times the period between valid transmissions on the ring. When the node receives a valid frame or token, the TVX is reset. If the TVX expires, the node starts a ring initialization sequence to restore the ring to proper operation.

**FDDI Ring Maintenance**

Each node is responsible for monitoring the integrity of the ring. By using the TVX, nodes can detect a break in ring activity. If the interval between token receptions exceeds the value set in the TVX, an error condition is reported and the claim process is initiated to restore ring operation.

If a token cannot be generated, the node that detected the problem initiates *beacon* frames. Beacon frames indicate to the other nodes that the ring is broken. If the beacon transmission exceeds the value set in the stuck-beacon timer (controlled by the Ring Management [RMT] portion of SMT), RMT attempts to restore the ring to normal operation. If the ring is not returned to normal operation in a specified period of time, RMT initiates a *trace*. A trace is a diagnostic function used to isolate a fault on the ring. For more information about RMT, see the next section.

**FDDI SMT**

The Wellfleet router supports Version 7.2 of the SMT protocol. SMT is a low-level protocol that manages the FDDI functions provided by the PMD, the PHY, and the MAC. SMT can be used only on a single FDDI LAN and can manage only the FDDI components and functions within a node.

SMT contains three components:
- Connection Management (CMT)
- Ring Management (RMT)
- SMT frame services
The CMT component of SMT inserts and removes stations at the PHY level and connects PHYs and MACs with a node. It uses trace diagnostics to identify and isolate a faulty component. It manages the physical connection between adjacent PHYs, including establishing the connection, testing the quality of the link before the connection is established, and continuously monitoring link errors once the ring is operational.

The RMT component of SMT receives status information from the MAC and CMT, reporting this information to SMT and higher-level processes (for example, SNMP). It detects stuck beacon conditions and duplicate addresses, and determines when the MAC is available for transmitting frames. Duplicate addresses prevent the proper operation of the ring.

SMT frame services allow for the management and control of the FDDI network and the nodes on the network. Different SMT frame classes and types implement these services. Frame class identifies the function that the frame performs. Frame type specifies whether the frame is an announcement, a request, or a response to a request. FDDI SMT frames are limited to a single FDDI ring. The frames cannot move across wide area networks or across multiple FDDI rings. The frames do not manage functions outside of FDDI.

Table 3-1 shows the SMT frames supported on the Wellfleet router.
Table 3-1. SMT Frame Class and Type

<table>
<thead>
<tr>
<th>Frame Class</th>
<th>Frame Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Neighbor Information Frames (NIF)</td>
<td>Request/Response</td>
</tr>
<tr>
<td>Status Information Frames (SIF)</td>
<td>Response</td>
</tr>
<tr>
<td>Echo Frames (ECF)</td>
<td>Response</td>
</tr>
<tr>
<td>Request Denied Frames (RDF)</td>
<td>Response</td>
</tr>
<tr>
<td>Status Report Frames (SRF)</td>
<td>Announcement</td>
</tr>
<tr>
<td>Parameter Management Frames (PMF) Get PMF only</td>
<td>Response</td>
</tr>
</tbody>
</table>

*Neighbor Information Frames* identify the upstream and downstream neighbors of each node. After the nodes learn the addresses of their upstream neighbors, you can use the addresses to create a logical map showing the order in which nodes appear in the token path. A Wellfleet station will issue a response to the sender of a NIF frame and will generate NIF requests as part of the neighbor notification process.

*Status Information Frames* exchange information about each node, including the status of each port in the node. You can use SIFs to create a physical map showing the position of each station in the FDDI network. There are two types of SIFs:

- SIF configuration frames, which show the configuration information of a node.
- SIF operation frames, which show the operational information of a node. A Wellfleet station will issue a response to the sender of a SIF request frame.
*Echo Frames* verify that nodes on an FDDI network can communicate with each other. Echo frames are used to test connectivity only. A node sends an echo request (which is a directed packet) to another FDDI node. The receiver of the echo request copies the data contained in the information field of the frame and transmits an echo response frame back to the originator of the echo request. A Wellfleet station will issue a response to the sender of an Echo request frame.

*Request Denied Frames* deny requests from the network. If the SMT agent receives a frame with an unsupported SMT version or an unknown frame type, it sends a Request Denied frame. A Wellfleet station will issue an RDF Response frame.

*Status Report Frames* allow the Status Report protocol to report node conditions and events. A *condition* is when a node enters a specific state (for example, duplicate address detected). An *event* is an immediate occurrence (for example, the generation of a trace). A Wellfleet station will issue an SRF announcement frame.

*Parameter Management Frames* allow the Parameter Management protocol to manage an FDDI node. A management station performs operations on the MIB attributes of a node by exchanging frames between the management station and the FDDI node. To get an attribute, the management station initiates a PMF Get Request frame. The FDDI node to which the PMF Get Request frame was sent responds by initiating a PMF Get Response frame. A Wellfleet station will issue a response to the sender of a PMF Get request frame.
Accessing Line Services

To customize line services, start at the Wellfleet Configuration Manager window and complete the following steps:

1. Select Circuits ➔ Edit Circuits.

   The Circuit List window appears.

2. Select the circuit for which you wish to edit line service parameters.

3. Click on the Edit button; the Circuit Definition window appears (Figure 3-8).

![Circuit Definition Window](image)

**Figure 3-8. Circuit Definition Window**

4. Select Lines ➔ Edit Lines; the Edit Lines window appears (Figure 3-9).

   This window lists the existing lines by slot number and connector.
5. Select the circuit for which you want to edit line service parameters and click on the Edit button.

In this example, the line connected to COM2 in Slot 2 is selected. Depending on the type of circuit that you selected in Step 2, the Configuration Manager displays the appropriate window that allows you to modify the circuit’s line details.

6. Set each of the parameters as appropriate on the line detail window that appears.

The following sections describe how to edit line detail parameters. Refer only to the section that corresponds to the type of circuit you are editing.

Repeat Steps 1 through 6 for each circuit that needs line detail modification.
Editing E1 Line Details

If the line you want to edit is an E1 line, the Configuration Manager displays the E1 Line Entry window (Figure 3-10). Complete the following steps:

![E1 Line Entry Window](image_url)

Figure 3-10. E1 Line Entry Window
1. Enter or select new values for the E1 line service parameters that you want to edit, referring to the descriptions following this procedure for guidelines.

2. If you want to edit synchronous line parameters, click on the Sync Details button. Refer to the section “Editing Synchronous Line Details” in this chapter for instructions.

3. Click on the OK button.

**Parameter:** Enable

Default: Enable

Options: Enable | Disable

Function: Enables or disables the E1 line.

Instructions: Set to Disable if you want to disable the E1 line.

MIB Object ID: 1.3.6.1.4.1.18.3.4.11.1.2

**Parameter:** HDB3S Support

Default: Disable

Options: Disable | Enable

Function: Enables or disables High-Density Bipolar Coding (a mechanism to maintain sufficient ones density within the E1 data stream).

Instructions: Enable or disable this parameter, depending on the ability of the associated E1 equipment to support HDB3S.

MIB Object ID: 1.3.6.1.4.1.18.3.4.11.1.7
Parameter: Clock Mode

Default: Internal

Options: Internal | Slave | Manual

Function: Specifies the source of the E1 transmit clock.

Internal specifies that the E1 transmit clock is internally generated; Slave specifies that the E1 transmit clock is externally generated (that is, the transmit clock is derived from the incoming data stream); Manual specifies that the clock source is hardware configured (that is, the source of the transmit clock is determined by jumpers on the E1 link module). Refer to Installing and Maintaining BN Routers or Installing and Maintaining ASN Routers for information on Link Module hardware configuration.

Instructions: Select the clocking mode, making certain that the associated E1 equipment is configured in a complementary fashion.

MIB Object ID: 1.3.6.1.4.1.18.3.4.11.1.8
Parameter: Mini Dacs

Default: Idle
Options: Idle | Data | Voice | Circuit 1 | Circuit 2
Function: Assigns each E1 channel to a specific function.
Instructions: Assign each of the 31 E1 channels as required.

I
 Makes the channel idle

D
 Assigns the channel to data passthrough (E1 connector to E1 connector)

V
 Assigns the channel to voice passthrough (E1 connector to E1 connector)

Circuit 1
 Assigns the channel to the first E1 connector

Circuit 2
 Assigns the channel to the second E1 connector

MIB Object ID: 1.3.6.1.4.1.18.3.4.11.1.9

Note: 1) The first E1 channel is reserved for signaling. You must define the remaining 31 channels.

2) Data and voice passthrough require that identical channels be assigned to data or voice on both E1 connectors. For example, if the first E1 connector allocates channels 2 through 8 to voice passthrough and channels 9 through 16 to data passthrough, the second E1 connector must also allocate channels 2 through 8 to voice and 9 through 16 to data passthrough.
3) E1 channels cannot be allocated to both E1 circuits. For example, if channels 17 through 25 are allocated to circuit 1 on the first E1 connector, the second E1 connector must make these channels idle or allocate them to circuit 2.

**Editing Ethernet Line Details**

If the line you selected to edit is an Ethernet line, the Configuration Manager now displays the Ethernet Line Entry window (Figure 3-11).

![Ethernet Line Entry Window](image)

**Figure 3-11. Ethernet Line Entry Window**

Complete the following steps:

1. Enter or select new values for the Ethernet line detail parameters you want to edit, referring to the descriptions following this procedure for guidelines.
2. Click on the OK button.
Customizing Line Services

**Parameter:** Enable

Default: Enable

Options: Enable | Disable

Function: Enables and disables this Ethernet line.

Instructions: Set this parameter to either Enable or Disable for this line.

MIB Object ID: 1.3.6.1.4.1.18.3.4.1.1.2

**Parameter:** BOFL (Breath of Life) Enable

Default: Enable

Options: Enable | Disable

Function: When set to Enable, BOFL specifies the sending of Breath of Life messages from this system to everyone on the local network. These messages signify that the Ethernet line is up and functioning normally.

Instructions: Set to Enable or Disable, depending on whether you want this system to issue Breath of Life messages over this line.

MIB Object ID: 1.3.6.1.4.1.18.3.4.1.1.7

Note: We recommend that BOFL be enabled.
Parameter: **BOFL Timeout**

Default: 5 seconds

Range: 1 to 60 seconds

Function: Specifies the time between transmissions of Breath of Life messages from this Ethernet interface. Timeout will occur if five periods elapse without a successful frame transmission. When timeout occurs, the Ethernet interface will be disabled and re-enabled automatically. For example, if you set this parameter to 5 seconds, then the interface must successfully transmit a frame within 25 seconds. Timeout occurs in 25 seconds.

Instructions: This parameter is valid only if BOFL Enable is set to Enable.

Instructions: Either accept the default BOFL timeout of 5 seconds, or specify a new value.

MIB Object ID: 1.3.6.1.4.1.18.3.4.1.1.8
Customizing Line Services

Parameter: **Hardware Filter**

Default: Disable (the default is changed to Enable when you add a circuit and reply OK to the prompt Do you want to enable Hardware Filters on this circuit?)

Options: Enable | Disable

Function: When this parameter is set to Enable, the Link Module filtering hardware, if present, does not allow local frames to be copied into system memory. In essence, the filtering hardware drops local frames at the interface. Bridging software performance is improved because it no longer requires resources to receive and reject those frames.

Local frames contain both destination and source MAC addresses that have been learned on the interface. The bridge software teaches the hardware filter which MAC addresses are local to an interface. To drop a frame, the hardware filter must have already learned its destination and source addresses from the bridge software. Otherwise, the frame is copied into system memory and processed by the bridge software.

Instructions: Set to Enable only if the bridge is enabled and the Link Module is supplied with hardware filters.

MIB Object ID: 1.3.6.1.4.1.18.3.4.1.1.29
Editing FDDI Line Details

If the line you selected to edit is an FDDI line, the Configuration Manager displays the FDDI Line Entry window (Figure 3-12).

![Figure 3-12. FDDI Line Entry Window](image)

Complete the following steps:

1. Enter or select new values for the FDDI line detail parameters you want to edit, referring to the descriptions following this procedure for guidelines.

2. Either click on the OK button, or, if you want to edit FDDI Advanced Attributes, click on the Expert button.
**Parameter:** Enable

Default: Enable

Options: Enable | Disable

Function: Enables or disables the FDDI circuit for the selected connector.

Instructions: Set to Disable if you want to disable the FDDI circuit for the selected connector.

MIB Object ID: 1.3.6.1.4.1.18.3.4.4.1.2

---

**Parameter:** BOFL Enable

Default: Enable

Options: Enable | Disable

Function: Enables or disables Breath of Life polling.

Instructions: When set to Enable, this parameter disables the LLC interface if the FDDI becomes non-operational (the link is unavailable), and if the LLC Data Enable parameter is set to Enable and the BOFL timer has expired (see “Editing the FDDI MAC Attributes”). When set to Disable, this parameter terminates the LLC interface immediately after the link becomes unavailable.

Instructions: Accept the default, Enable, or set to Disable.

MIB Object ID: 1.3.6.1.4.1.18.3.4.4.1.7

**Note:** We recommend that you enable BOFL.
Parameter: BOFL Timeout

Default: 3 seconds

Range: 0 to 3600 seconds

Function: Specifies the value (in seconds) of the BOFL timer if BOFL is enabled and the link becomes unavailable.

Instructions: Either accept the default value, 3 seconds, or specify a new value.

MIB Object ID: 1.3.6.1.4.1.18.3.4.4.1.8

Note: This parameter is valid only if BOFL Enable is set to Enable.
### Parameter: Hardware Filter

**Default:** Disable (the default is changed to Enable when you add a circuit and reply OK to the prompt Do you want to enable Hardware Filters on this circuit?)

**Options:** Enable | Disable

**Function:** When this parameter is set to Enable, the Link Module filtering hardware, if present, does not allow local frames to be copied into system memory. In essence, the filtering hardware drops local frames at the interface. Bridging software performance is improved because it no longer requires resources to receive and reject those frames.

Local frames contain both destination and source MAC addresses that have been learned on the interface. The bridge software teaches the hardware filter which MAC addresses are local to an interface. To drop a frame, the hardware filter must have already learned its destination and source addresses from the bridge software. Otherwise, the frame is copied into system memory and processed by the bridge software.

**Instructions:** Set to Enable only if the bridge is enabled and the Link Module is supplied with hardware filters.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.4.1.36
Editing FDDI Advanced Attributes

To edit the SMT, MAC, Path, or Port Attributes, click on the Expert button in the FDDI Line Entry window (Figure 3-12). The Configuration Manager displays the FDDI Advanced Attributes window (Figure 3-13). Follow the instructions in the subsequent sections: “Editing the FDDI SMT Attributes,” “Editing the FDDI MAC Attributes,” “Editing the FDDI Path Attributes,” or “Editing the FDDI Port Attributes.”

![FDDI Advanced Attributes Window](image)

**Figure 3-13. FDDI Advanced Attributes Window**

**Note:** Changing any of the FDDI Advanced Attributes parameters will affect the operation of your FDDI network. You should understand how each of these parameters can be used to improve network performance before you modify any of them.

Editing the FDDI SMT Attributes

To edit the SMT attributes, complete the following steps:

1. Click on the SMT Attributes button in the FDDI Advanced Attributes window (Figure 3-13).

   The Configuration Manager displays the FDDI SMT Attributes window (Figure 3-14).
Customizing Line Services

Figure 3-14. FDDI SMT Attributes Window

2. Enter or select new values for the FDDI SMT parameters you want to edit, referring to the descriptions following this procedure for guidelines.

3. Click on the OK button.
Parameter: **Connection Policy**

Default: 0xff65

Range: 0x0 to 0xffff

Function: Provides a hexadecimal equivalent of a 16-bit status word that specifies the connection policies requested at the FDDI station.

A station sets the corresponding policy for each of the connection types that it *wants to reject*. The policy descriptor takes the form “rejectX-Y” where X denotes the physical connection (PC) type of the local port, and Y denotes the PC type of the neighbor port.

X and Y can take the following values:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Indicates that the port is a dual-attachment station or concentrator that attaches to the primary IN and the secondary OUT when attaching to the dual FDDI ring</td>
</tr>
<tr>
<td>B</td>
<td>Indicates that the port is a dual-attachment station or concentrator that attaches to the secondary IN and the primary OUT when attaching to the dual FDDI ring</td>
</tr>
<tr>
<td>S</td>
<td>Indicates a port in a single-attachment station or concentrator</td>
</tr>
<tr>
<td>M</td>
<td>Indicates a port in a concentrator that serves as a master to a connected station or concentrator</td>
</tr>
</tbody>
</table>
Instructions: The value of the status word is a sum that initially takes the value zero (all bits set to 0); then for each of the connection policies you want the node to reject, you add 2 raised to a power to the sum. This is equivalent to setting a bit to 1 for each policy that you want the node to reject. Table 3-2 lists the powers and the bits. Figure 3-15 shows the default connection policy.

Instructions: Set the status word value to reflect local connection policies.

MIB Object ID: 1.3.6.1.4.1.18.3.4.4.1.30

Note: The setting of a particular connection does not necessarily mean that the connection will be rejected. The SMT standard requires that both sides of the connection must agree to reject, or else both sides must accept the connection. The SMT standard requires that Bit 15 (rejectM-M) must be set.

Table 3-2. SMT Connection Policy Values

<table>
<thead>
<tr>
<th>Policy</th>
<th>Power or Bit Number</th>
<th>Policy</th>
<th>Power or Bit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>rejectA-A</td>
<td>0</td>
<td>rejectS-A</td>
<td>8</td>
</tr>
<tr>
<td>rejectA-B</td>
<td>1</td>
<td>rejectS-B</td>
<td>9</td>
</tr>
<tr>
<td>rejectA-S</td>
<td>2</td>
<td>rejectS-S</td>
<td>10</td>
</tr>
<tr>
<td>rejectA-M</td>
<td>3</td>
<td>rejectS-M</td>
<td>11</td>
</tr>
<tr>
<td>rejectB-A</td>
<td>4</td>
<td>rejectM-A</td>
<td>12</td>
</tr>
<tr>
<td>rejectB-B</td>
<td>5</td>
<td>rejectM-B</td>
<td>13</td>
</tr>
<tr>
<td>rejectB-S</td>
<td>6</td>
<td>rejectM-S</td>
<td>14</td>
</tr>
<tr>
<td>rejectB-M</td>
<td>7</td>
<td>rejectM-M</td>
<td>15</td>
</tr>
</tbody>
</table>
Parameter: T_Notify Timeout
Default: 22 (seconds)
Range: 2 to 30 seconds
Function: Specifies the interval between successful iterations of the Neighbor Notification Protocol.
Instructions: The Neighbor Notification protocol 1) determines the MAC address of the FDDI upstream and downstream neighbor, 2) detects duplicate MAC addresses on the ring, and 3) generates periodic "keep-alive" traffic that verifies the local MAC transmit and receive paths.
Instructions: Accept the default value of 22 seconds or specify a new value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.4.1.31

Figure 3-15. Connection Policy Status Word
Parameter: **Trace Max Expiration (ms)**

Default: 7000 milliseconds (7 seconds)

Range: 6001 to 256000 milliseconds

Function: The maximum propagation time for a trace on an FDDI topology. The value is stored in milliseconds.

Instructions: Enter a value between 6001 and 256000. We recommend using the default value of 7000 milliseconds.

MIB Object ID: 1.3.6.1.4.1.18.3.4.15.1.3.1.15

Parameter: **Status Report Protocol**

Default: Enable

Options: Enable | Disable

Function: Specifies whether the node will generate Status Report Frames (SRF) for its implemented events (for example, high bit errors, topology changes, trace status events, MAC frame error condition, port LER condition, and MAC duplicate address condition).

Instructions: Accept the default, Enable, if you want the node to generate SRFs; specify Disable if you do not want the node to generate SRFs. We recommend using the default, Enable, to ensure that your FDDI network is ANSI compliant.

MIB Object ID: 1.3.6.1.4.1.18.3.4.15.1.3.1.14
Parameter: Duplicate Address Protocol
Default: Enable
Options: Enable | Disable
Function: Implements an optional ANSI duplicate address test involving periodic transmission of NSA NIF frames addressed to the source.
Instructions: Accept the default, Enable, if you want the duplicate address test implemented. Specify Disabled if you do not want the duplicate address test implemented.
MIB Object ID: 1.3.6.1.4.1.18.3.4.15.1.3.1.18

Parameter: User Data
Default: None
Range: 1 to 32 alphanumeric characters
Function: Allows you to enter additional information about the router. This information gets attached to the SIF frames.
Instructions: Enter up to 32 alphanumeric characters.
MIB Object ID: 1.3.6.1.4.1.18.3.4.15.1.3.1.8

Editing the FDDI MAC Attributes

To edit the MAC attributes, complete the following steps:

1. Click on the MAC Attributes button in the FDDI Advanced Attributes window (Figure 3-13).

   The Configuration Manager displays the FDDI MAC Attributes window (Figure 3-16).
2. Enter or select new values for the FDDI MAC parameter, referring to the description following this procedure for guidelines.

3. Click on the OK button.

**Parameter:** LLC Data Enable

- **Default:** Enable
- **Options:** Enable | Disable
- **Function:** Specifies whether the MAC is available for the transmission and reception of Logical Link Control (LLC) Protocol Data Units (PDUs). If you accept the default, Enable, the interface to the MAC entity will be available for the exchange of PDUs between the MAC and the local LLC entity when the ring becomes operational. Setting this attribute has no effect on the transfer and reception of the MAC or SMT frame types.

- **Instructions:** Accept the default, Enable, if you want the MAC available for transmitting and receiving LLC PDUs; specify Disable if you do not want the MAC available for transmitting and receiving LLC PDUs.

- **MIB Object ID:** 13.6.1.4.1.18.3.4.15.2.3.1.17
Editing the FDDI Path Attributes

To edit the path attributes, complete the following steps:

1. Click on the Path Attributes button in the FDDI Advanced Attributes window (Figure 3-13).

   The Configuration Manager displays the FDDI Path Attributes window (Figure 3-17).

   ![FDDI Path Attributes Window](image)

   **Figure 3-17. FDDI Path Attributes Window**

2. Enter or select new values for the FDDI Path parameters you want to edit, referring to the descriptions following this procedure for guidelines.

3. Click on the OK button.
Parameter: **Tvx Lower Bound (ms)**

Default: 2.5 milliseconds

Range: Variable. The value must be greater than zero and less than the value of Requested TTRT (ms) and less than or equal to 5.2 milliseconds, whichever value is lower. For example, if the value of Requested TTRT (ms) is 165 milliseconds, the value for Tvx Lower Bound (ms) must be less than or equal to 5.2 milliseconds (Figure 3-18).

Function: Allows you to specify the minimum time value of the Valid Transmission Timer (Tvx).

Instructions: Accept the default value of 2.5 ms or specify a new value in milliseconds.

MIB Object ID: 1.3.6.1.4.1.18.3.4.15.3.3.1.5

![Figure 3-18. Example of Range of Values for Tvx Lower Bound](image)
**Parameter:** T\_Max Lower Bound (ms)

**Default:** 165 milliseconds

**Range:** 10 to 1336.9344 milliseconds

**Function:** Allows you to specify the maximum time value of TTRT. The value must be greater than or equal to 10 ms, greater than or equal to the value of the requested TTRT, and less than or equal to 1336.9344 milliseconds (Figure 3-19).

**Instructions:** Accept the default value of 165 milliseconds or specify a new value in milliseconds.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.15.3.3.1.6

---

**Requested TTRT**

<table>
<thead>
<tr>
<th>T_Max Lower Bound</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 ms</td>
</tr>
</tbody>
</table>

*Figure 3-19. Example of Range of Values for T\_Max Lower Bound*
Parameter: Requested TTRT (ms)

Default: 165 milliseconds

Range: Variable. This value must be greater than the value specified for Tvx Lower Bound (ms) and less than or equal to the value specified for T_Max Lower Bound (ms) (Figure 3-20).

Function: Specifies the target token rotation time carried in claim frames issued by the FDDI station.

Instructions: Accept the default of 165 milliseconds or enter a new value in milliseconds.

MIB Object ID: 1.3.6.1.4.1.18.3.4.4.1.32

<table>
<thead>
<tr>
<th>Tvx Lower Bound</th>
<th>Requested TTRT</th>
<th>T_Max Lower Bound</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ms</td>
<td></td>
<td>1336.9344 ms</td>
</tr>
</tbody>
</table>

Figure 3-20. Example of Range of Values for Requested TTRT

Editing the FDDI Port Attributes

To edit the port attributes, complete the following steps:

1. Click on the Port Attributes button in the FDDI Advanced Attributes window (Figure 3-13).

   The Configuration Manager displays the FDDI Port Attributes window (Figure 3-21).
2. Select the port you want to configure (A or B).

3. Enter or select new values for the FDDI Port parameters you want to edit, referring to the descriptions following this procedure for guidelines.

4. Click on the Apply button to save your changes.

   Repeat Steps 1 through 4 to configure the other port if you wish.

5. Click on the Done button to return to the FDDI Advanced Attributes window (Figure 3-13)
Customizing Line Services

Parameter: LER Cutoff

Default: 7
Range: 4 to 15
Function: Specifies the link error rate estimate at which a link connection is broken. It ranges from $10^{-4}$ to $10^{-15}$ and is reported as the absolute value of the base 10 logarithm.

Instructions: Accept the default value of 7 or specify a new value.

MIB Object ID: 1.3.6.1.4.1.18.3.4.15.4.3.1.17

Parameter: LER Alarm

Default: 8
Range: 4 to 15
Function: Specifies the link error rate estimate at which a link connection generates an alarm. It ranges from $10^{-4}$ to $10^{-15}$ and is reported as the absolute value of the base 10 logarithm of the estimate.

Instructions: Accept the default value of 8 or specify a new value.

MIB Object ID: 1.3.6.1.4.1.18.3.4.15.4.3.1.18

Editing HSSI Line Details

If the line you select to edit is a high-speed serial interface line, the Configuration Manager displays the HSSI Line Entry window (Figure 3-22).
Complete the following steps:

1. Enter or select new values for the HSSI line detail parameters you want to edit.
   Refer to the descriptions following this procedure for guidelines.

2. Click on the OK button.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>Enable</td>
</tr>
<tr>
<td>Options:</td>
<td>Enable</td>
</tr>
<tr>
<td>Function:</td>
<td>Enables or disables this HSSI line.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Set this parameter to either Enable or Disable for this line.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.4.7.1.2</td>
</tr>
</tbody>
</table>
Parameter: BOFL

Default: Enable

Options: Enable | Disable

Function: Enables the transmission of proprietary Ethernet-encapsulated Breath of Life messages over a point-to-point connection between the local router and a remote peer.

The exchange of BOFL messages provides a level of confidence in the point-to-point connection. With BOFL enabled, the router sends periodic keep-alive messages to the remote peer.

Instructions: Set to Enable or Disable, depending on whether you want to transmit BOFL messages over this HSSI interface. If you enable BOFL locally, the remote peer must also be configured to enable BOFL Frequency.

MIB Object ID: 1.3.6.1.4.1.18.3.4.7.1.7

Note: We recommend that you enable BOFL for point-to-point connections between Wellfleet peers. However, if such a connection is accomplished through a wide-area transport service such as Frame Relay or SMDS, BOFL must be disabled.
**Parameter:** BOFL Frequency

*Default:* 1 (second)

*Range:* 1 to 60 seconds

*Function:* Specifies the interval in seconds between BOFL transmissions. This parameter is valid only if BOFL is set to Enable.

After sending a BOFL message, the router starts a timer that has a value equal to 5 times the setting of BOFL Frequency. If a BOFL message is not received from the remote peer before the expiration of the timer, the router takes the HSSI circuit down, and then attempts to restart it.

*Instructions:* Either accept the default, 1 second, or specify a new value, making certain that both ends of the point-to-point connection are configured with the same value.

*MIB Object ID:* 1.3.6.1.4.1.18.3.4.7.1.8

---

**Parameter:** MTU (Maximum Transfer Unit)

*Default:* 4608 bytes

*Range:* 3 to 4608 bytes

*Function:* Specifies the buffer size for the HSSI port and, by extension, the largest frame that can be transmitted or received across the HSSI port.

*Instructions:* Set this parameter to a value appropriate for your network.

*MIB Object ID:* 1.3.6.1.4.1.18.3.4.7.1.9
Parameter: WAN Protocol

Default: None
Options: Standard | PassThru | PPP | SMDS | Frame Relay
Function: Indicates which WAN protocol has been enabled on this HSSI circuit.
Instructions: Accept the current value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.7.1.12

Parameter: Transmission Interface

Default: DS3
Options: DS1 | DS3
Function: When SMDS or Frame Relay is configured on this HSSI circuit, specifies whether the local management interface (LMI) employs a DS1 MIB (specified by RFC 1232) or a DS3 MIB (specified by RFC 1233).
Instructions: Select on the basis of the carrier services (DS1 at 1.54 MB/s or DS3 at 44.736 MB/s) provided by the attached DCE device.
MIB Object ID: 1.3.6.1.4.1.18.3.4.7.1.13

Note: This parameter is meaningful only when SMDS or Frame Relay is configured across the HSSI interface and when LMI is enabled. The HSSI driver provides no support for either the DS1 or DS3 MIB. Rather, the external DCE (for example, a DL3200 SMDS CSU/DSU from Digital Link) may provide MIB support. In instances where Frame Relay or SMDS and LMI are configured across the HSSI interface, this parameter specifies the appropriate MIB for use by the LMI.
Parameter: **External Clock Speed**

Default: 46359642 (44.736 MB/s)

Range: 307200 to 52638515

Function: Specifies the bandwidth provided by the HSSI channel.

Instructions: Set the parameter to a value that equals or approximates the data transmission rate across the HSSI.

MIB Object ID: 1.3.6.1.4.1.18.3.4.7.1.14

**Note:** The HSSI specification requires that the DCE provide a transmit clock that times data transfer across the DTE/DCE interface. The value you set for External Clock Speed does not actually affect hardware initialization. It is used by some routing protocol software for route selection.

Parameter: **CRC Size**

Default: 32-bit

Options: 16-bit | 32-bit

Function: Specifies an error detection scheme. You may choose either 16-bit (standard CCITT) or 32-bit (extended) to detect errors in the packet.

Instructions: Set this parameter to either 16-bit or 32-bit, making certain that the remote end of the HSSI connection is configured for the same value.

MIB Object ID: 1.3.6.1.4.1.18.3.4.7.1.15

**Editing Synchronous Line Details**

If the line you want to edit is a synchronous line, the Configuration Manager now displays the Edit SYNC Parameters window (Figure 3-23).
Figure 3-23. Edit SYNC Parameters Window

Complete the following steps:

1. Enter or select new values for the line detail parameters you want to edit.
   Refer to the descriptions following this procedure for guidelines.

2. Click on the OK button.

On Wellfleet AN or ASN routers, if you selected a connector and configured it for the X.25 protocol, you can select the LAPB button to edit the Link Access Procedure Balanced protocol parameters. The LAPB button only appears if you selected X.25 from the WAN Protocols Window (Figure 2-4). For detailed information on the LAPB parameters, refer to the section “Link Access Procedure Balanced Protocol.”
**Parameter:** Enable

Default: Enable
Options: Enable | Disable
Function: Enables and disables this synchronous line.
Instructions: Set this parameter to either Enable or Disable for this line.
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.2

**Parameter:** BOFL

Default: Enable
Options: Enable | Disable
Function: BOFL enables the transmission of proprietary Breath of Life messages *over a point-to-point connection* between the local router and a remote peer.

The exchange of BOFL messages provides a level of confidence in the point-to-point connection. With BOFL enabled, the router sends periodic *keep-alive* messages to the remote peer.

Instructions: Set to Enable or Disable, depending on whether you want to transmit BOFL messages over this synchronous interface. If you enable BOFL locally, the remote peer must also be configured to enable BOFL.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.7

*Note:* We recommend that you enable BOFL for point-to-point connections between Wellfleet peers. However, if such a connection is accomplished through a wide-area transport service such as Frame Relay, X.25 or SMDS, BOFL *must* be disabled.
**Parameter:** BOFL Timeout

Default: 5 seconds
Range: 1 to 60 seconds

Function: Specifies the time between transmissions of Breath of Life messages from this synchronous interface. Timeout will occur if five periods elapse without both a successful frame transmission and a successful reception. When timeout occurs, the synchronous line will be disabled and re-enabled automatically.

For example, if you set this parameter to 5 seconds, then the interface must successfully transmit and receive a frame within 25 seconds. Timeout occurs in 25 seconds.

This parameter is valid only if BOFL is set to Enable.

Instructions: Either accept the default, 5 seconds, or specify a new value.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.8

---

**Parameter:** MTU (Maximum Transfer Unit)

Default: 1600 bytes
Range: 3 to 4608 bytes

Function: Specifies the largest amount of data that can be transferred across this network in one frame.

Instructions: Set this parameter to a value appropriate for your network. For X.25, MTU should be at least 5 bytes more than the maximum packet size for the packet level.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.9
Parameter: Promiscuous  
Default: Disable  
Options: Enable | Disable  
Function: Specifies whether address filtering based on the local and remote address is enabled. If you set this parameter to Enable, all frames are received. If you set this parameter to Disable, only frames destined for this local address are received.  
Instructions: Set this parameter to Enable or Disable.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.11

Parameter: Clock Source  
Default: External  
Options: External | Internal  
Function: Specifies the origin of the synchronous timing signals. If you set this parameter to Internal, this router supplies the required timing signals. If you set this parameter to External, an external network device supplies the required timing signals. In most cases, this parameter should be set to External.  
Instructions: Set this parameter to either Internal or External, as appropriate for your network.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.13
Parameter: **Internal Clock Speed**

Default: 64 KB

Options: 1200 B | 2400 B | 4800 B | 7200 B | 9600 B |
19200 B | 32000 B | 38400 B | 56 KB | 64 KB |
125 KB | 230 KB | 420 KB | 625 KB | 833 KB |
1.25 MB | 2.5 MB | 5 MB

Function: Sets the clock speed of an internally supplied clock when the Clock Source parameter is set to Internal.

Instructions: Click on Values and set the clock speed for the internal clock to the desired data transmission rate across the synchronous line. Depending on the protocols configured on this interface, this value may control internal decision making within the router. In some cases, the router uses this value for route selection. If protocol prioritization is configured, the router uses this parameter to calculate line delay (refer to *Configuring Filter Options on Wellfleet Routers* for information about protocol prioritization, latency, and queue depth).

The Internal Clock Speed parameter is non-settable when the Clock Source parameter is set to External.

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.14
Parameter: **IExternal Clock Speed**  
Default: 64102  
Range: 1200 to 6000000 bits per second  
Function: Sets the clock speed of an externally supplied clock when the Clock Source parameter is set to External.

Instructions: Set the clock speed for the external clock to the data transmission rate that most closely corresponds to the speed of the external clock. Depending on the protocols configured on this interface, this value may control internal decision making within the router. In some cases, the router uses this value for route selection. If protocol prioritization is configured, the router uses this parameter to calculate line delay (refer to *Configuring Filter Options on Wellfleet Routers* for information about protocol prioritization, latency, and queue depth).

The External Clock Speed parameter is non-settable when the Clock Source parameter is set to Internal.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.93
<table>
<thead>
<tr>
<th><strong>Parameter:</strong></th>
<th><strong>Signal Mode</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default:</strong></td>
<td>Balanced</td>
</tr>
<tr>
<td><strong>Options:</strong></td>
<td>Balanced</td>
</tr>
<tr>
<td><strong>Function:</strong></td>
<td>Specifies balanced or unbalanced transmission. Balanced transmission uses two conductors to carry signals; unbalanced uses one conductor to carry a signal, with a ground providing the return path.</td>
</tr>
<tr>
<td><strong>Instructions:</strong></td>
<td>Set this parameter to either Balanced or Unbalanced, based on the signaling mode of the connected device.</td>
</tr>
<tr>
<td><strong>MIB Object ID:</strong></td>
<td>1.3.6.1.4.1.18.3.4.5.1.15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Parameter:</strong></th>
<th><strong>RTS Enable</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default:</strong></td>
<td>Disable</td>
</tr>
<tr>
<td><strong>Options:</strong></td>
<td>Enable</td>
</tr>
<tr>
<td><strong>Function:</strong></td>
<td>Enables or disables the detection of RTS signals on this interface.</td>
</tr>
<tr>
<td><strong>Instructions:</strong></td>
<td>Set this parameter to Enable if the connected device (for example, a modem) uses RTS/CTS flow control.</td>
</tr>
<tr>
<td><strong>MIB Object ID:</strong></td>
<td>1.3.6.1.4.1.18.3.4.5.1.16</td>
</tr>
</tbody>
</table>
**Parameter:** Burst Count

**Default:** Enable

**Options:** Enable | Disable

**Function:** Specifies single or multiple DMA burst cycles. If you set this parameter to Enable, the chip performs eight-word bursts. If you set this parameter to Disable, single-word cycles are performed.

**Instructions:** Set this parameter to Enable to perform eight-word bursts. Set this parameter to Disable to perform single-word bursts.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.17

**Note:** Burst Count is a performance-tuning parameter. It should be enabled except in certain cases with DSDE (5430 - Dual Sync, Dual Enet) and DSE (5420 - Dual Sync, Single Enet) Link Modules. It should be disabled if excessive TxUflo or RxOflo errors occur on the Ethernet ports. If both SYNC ports are configured, Burst Count should be disabled first on the SYNC interface that is either running at a lower clock speed or carries lower priority traffic.

The only configurations for which both SYNC interfaces should have Burst Count disabled are DSDE configurations with both Ethernet interfaces configured. In these configurations, both SYNC interfaces should have Burst Count disabled if disabling Burst Count on only one interface does not eliminate the excessive TxUflo or RxOflo errors on the two Ethernet interfaces.
**Parameter:** Service  
**Default:** LLC1  
**Options:** Transparent | LLC1 | LAPB  
**Function:** Specifies the link-level protocol for this circuit. If you set this parameter to Transparent, then raw HDLC (high-level datalink control) mode is in effect. LLC1 specifies connectionless datagram service; it prefixes the HDLC address and control fields to the frame.  
**Instructions:** Set this parameter as appropriate for this circuit. If X.25 is enabled on this line, you must set this parameter to LAPB.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.18

**Parameter:** Transmit Window Size  
**Default:** 1  
**Range:** 1 to 7  
**Function:** Controls the number of I frames that can be transmitted without acknowledgment.  
**Instructions:** Either accept the default value, or enter a new value.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.27
Editing Synchronous Line Details

Parameter: Minimum Frame Spacing
Default: 1 (flag)
Range: 1 to 32 flags
Function: Specifies the number of flags that are transmitted between adjacent frames.
Instructions: Set this parameter to the appropriate number of flags.
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.29

Point-to-Point Address

According to convention, one end of a point-to-point circuit is designated DCE and is assigned an address of 01; the other end of the circuit is designated DTE and is assigned an address of 03.

Conventional addressing, however, is inadequate in the case of multiple communication channels enabled by a common satellite link (Figure 3-24). As shown, a common satellite relay-link provides a virtual point-to-point link between routers A and X, B and Y, and C and Z.
The worst-case scenario consists of routers A, B, and C being designated as DCE (address = 01), and routers X, Y, and Z being designated as DTE (address = 03). If A transmits a frame across the virtual point-to-point circuit to X, the satellite broadcast is monitored not only by X (the intended recipient), but also by Y and Z. Because X, Y, and Z all perceive a properly addressed frame, all three accept delivery and attempt to process the frame contents, with unpredictable results.

You can avoid such confusion by assigning unique addresses to each end of a point-to-point circuit. If you set unique addresses for Local Address and Remote Address, you must then also specify an address for each end of the circuit. Make sure to reverse the local and remote address when you configure the other end of the point-to-point circuit.
Parameter: Local Address

Default: 7
Range: 1 to 255

Function: Specifies the 1-byte HDLC address of this synchronous interface. When you address data sent to this interface, use this HDLC address.

Instructions: Set this parameter to the local HDLC address you want. Enter 1 for a DCE and 3 for a DTE. All other addresses are considered explicit addresses. To select an Explicit value, enter that value.

Site Manager assumes the values you enter are decimal. If you want to enter a hexadecimal value, preface the value with a Ox, for example, Ox10. If you configure X.25 on this synchronous line, the local HDLC address must be either 1 (DCE) or 3 (DTE).

MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.30
Customizing Line Services

**Parameter:** Remote Address

- **Default:** 7
- **Range:** 1 to 255
- **Function:** Specifies the 1-byte HDLC address of the remote synchronous interface. When you address data sent from this interface to the remote end interface, use this HDLC address.

- **Instructions:** Set this parameter to the HDLC address of the remote synchronous interface. Enter 1 for a DCE and 3 for a DTE. All other addresses are considered explicit addresses. To select any explicit value, enter the value.

  Site Manager assumes the values you enter are decimal. If you want to enter a hexadecimal value, preface the value with a 0x, for example, 0x10. If you configure X.25 on this synchronous line, the local HDLC address must be either 1 (DCE) or 3 (DTE).

- **MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.31

**Note:** Make certain to reverse local and remote address values when you configure the device at the other end of the point-to-point circuit.
Parameter: **WAN Protocol**
- Default: None
- Options: Standard | Pass Thru | PPP | SMDS | Frame Relay | X.25 | ATM DXI | LAPB
- Function: Indicates which WAN protocol has been enabled on this synchronous circuit.
- Instructions: Accept the current value.
- MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.34

Parameter: **Pass Thru Local Address**
- Default: None
- Options: Any unique MAC address
- Function: Assigns a MAC address to the local interface. This address becomes the source address of packets that are bridged to the destination MAC address. You assign the destination address with Pass Thru Remote Address.
- Instructions: Enter the unique MAC address that you want to assign to the local interface.
- MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.32

**Note:** Make certain to reverse the local and remote MAC addresses at the remote sync passthrough interface.
Parameter: Pass Thru Remote Address
Default: None
Options: Any unique MAC address
Function: Assigns a MAC address to the remote interface. This address becomes the source address of packets that are bridged to the destination MAC address. You assign the destination address with Pass Thru Local Address.
Instructions: Enter a unique MAC address to be assigned to the remote interface.
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.33

Note: Make certain to reverse the local and remote MAC addresses at the remote sync passthrough interface.

Parameter: CRC Size
Default: 16-bit
Options: 16-bit | 32-bit
Function: Specifies an error detection scheme. You can chose either 16-bit (standard) or 32-bit (extended) frame check sequence (FCS) to detect errors in the packet.
Instructions: Set this parameter to either 16 bit or 32 bit.
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.35
### Parameter: Sync Media Type

**Default:** 1  
**Options:** 1 (default) | 2 (T1) | 3 (E1) | 4 (Raise DTR) | 5 (V.25bis)  
**Function:** Specifies the media type.  
**Instructions:** Set this parameter to 2 for T1 lines, 3 for E1 lines, 4 for Raise DTR, or 5 for V.25bis. Otherwise, accept the default value of 1.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.54

### Parameter: Sync Polling

**Default:** Disable  
**Options:** Enable | Disable  
**Function:** Indicates whether the Data Set Ready (DSR) signal will be monitored. If you set this parameter to Enable, the sync driver will be enabled when the DSR is detected. When the DSR is no longer detected, the driver will be disabled. This parameter should be enabled only if you will be using dialup services.  
**Instructions:** Either accept the default, or set this parameter to Enable.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.76
<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Sync Line Coding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>NRZ</td>
</tr>
<tr>
<td>Options:</td>
<td>NRZ</td>
</tr>
<tr>
<td>Function:</td>
<td>This parameter specifies the line coding of the physical synchronous line. You can change the value of this parameter to match the line coding of a device at the other end of the line. This parameter is relevant only for the AN and the ASN.</td>
</tr>
</tbody>
</table>

**NRZ**
- Indicates Non-Return to Zero coding

**NRZI**
- Indicates Non-Return to Zero Inverted coding

**NRZI Mark**
- Indicates Non-Return to Zero Inverted Mark coding.

<table>
<thead>
<tr>
<th>Instructions:</th>
<th>Select the appropriate value for synchronous line coding.</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.4.5.1.88</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>BOD Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status:</td>
<td>Reserved for future use</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>BOD Exam Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status:</td>
<td>Reserved for future use</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>BOD Full Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status:</td>
<td>Reserved for future use</td>
</tr>
</tbody>
</table>
Editing Synchronous Line Details

**Parameter:** BOD Recover Threshold  
**Status:** Reserved for future use

**Parameter:** BOD Periods to Fail  
**Status:** Reserved for future use

**KG84A Support**

KG84A is a cryptographic device used to secure data transmitted over a point-to-point synchronous line.

Wellfleet KG84A support allows the router to use the encryption services of a KG84A device. In a KG84A configuration, the KG84A device is usually placed between the router and a modem. The KG84A device acts as the DCE for the attached router. Another KG84A device must be located at the other end of the point-to-point connection so that encrypted data can be decrypted (Figure 3-25).

![Figure 3-25. KG84A Network Configuration](image)

**Loss of Synchronization**

The Wellfleet router attaches to the KG84A device via a modified V.35 synchronous cable. The encryption/decryption process is usually transparent to the router. However, occasionally two KG84A devices can lose cryptographic synchronization. When this occurs, the modified cable allows the router to initiate a cryptographic resynchronization. The modified cable also allows the router to detect and monitor the local KG84A device resynchronization, whether the resynchronization is initiated locally or by a remote KG84A device.
The router detects the loss of synchronization between KG84A devices by monitoring the number of Frame Check Sequence (FCS) errors and valid frames received. If the router detects FCS errors, and it does not receive a valid frame within a configurable amount of time, the router software requests resynchronization. The router also requests resynchronization if it determines that the previous resynchronization request did not complete before a configurable timer expires.

The network administrator can also force a resynchronization of the local KG84A device by pressing its RESYNC button. The router can detect this type of remote resynchronization also, and can request a new resynchronization if one does not complete in the configured time period.

Configure KG84A support on synchronous lines that connect to KG84A cryptographic devices.

**Note:** For the following four parameters to have any meaning, the RTS Enable parameter must be set to KG84A Enable.

**Parameter:** KG84A Cycle

- **Default:** 100 ms
- **Options:** 5 | 10 | 25 | 50 | 100 | 200 | 500
- **Function:** Specifies the length, in milliseconds, of the timer cycle. This cycle value is used by the timers on the other KG84A devices on the network. This also becomes the polling cycle for monitoring FCS errors.
- **Instructions:** Accept the default value or select one of the valid options.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.67
Parameter: KG84A Sync Loss Interval
  Default: 50 cycles
  Options: 2 | 5 | 10 | 25 | 50 | 100 | 200 | 500
  Function: Specifies how many cycles the router should wait after detecting an FCS error to receive a valid frame before declaring that a loss of synchronization has occurred.
  Instructions: Accept the default value or select one of the valid options.
  MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.68

Parameter: KG84A Remote Resync Wait
  Default: 200 cycles
  Options: 2 | 5 | 10 | 25 | 50 | 100 | 200 | 500
  Function: This parameter specifies the number of cycles that the router waits for the remote KG84A to complete a resynchronization operation, once synchronization is lost and a remotely initiated resynchronization has been detected, before the router software determines that the resynchronization failed and initiates another resynchronization.
  Instructions: Configure this parameter with different settings at each end of the point-to-point link to avoid a possible race condition.
  MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.69

Note: If the network administrator presses the RESYNC button on the local KG84A device, the router responds as if it were a remotely initiated resynchronization.
### Customizing Line Services

**Parameter:** KG84A Sync Pulse  
Default: 10 ms  
Range: 2 to 4096  
Function: The router uses the RTS signal of the V.35 interface, which is wired to the KG84A device’s SYNC signal via a special cable, to initiate KG84A resynchronization. This parameter specifies the number of milliseconds that the SYNC signal retains its high value.  
Instructions: Accept the default value, or enter one of the valid options.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.70

### Parameter: Network Link Level  
Default: NET2  
Options: NET2 | GOSIP | SYNC_TYPE_C03  
Function: Indicates the link-level for this synchronous point-to-point connection. The default is NET2. Change this parameter to GOSIP when this synchronous point-to-point connection is part of a GOSIP-compliant network (such as DOD). Change this parameter to SYNC_TYPE_C03 when you are running X.25 on a sync board with the MK 5025 C03 chip.  
Instructions: Either accept the default, NET2, or select GOSIP or SYNC_TYPE_C03.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.81
Parameter: Retry Count
Default: 16 attempts
Range: 1 to 64 attempts
Function: Indicates the number of retransmission attempts allowed per frame before a line is declared down.
Instructions: Either accept the default, or enter a number between 1 and 64.
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.19

Parameter: Link Idle Timer
Default: 9 seconds
Range: 1 to 9999 seconds
Function: Indicates the number of seconds before a line is determined to be idle. An idle line is disabled.
Instructions: Either accept the default value of 9 seconds, or enter a new value between 1 and 9999.
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.20

Parameter: Extended Control (S and I frames)
Default: Disable
Options: Enable | Disable
Function: Allows the control fields of all S and I frames to become two octets in length instead of one. Numbering of all I frames becomes module 128 instead of module 8.
Instructions: Either accept the default, Disable, or set to Enable.
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.24
**Parameter:**  Idle RR Frames  
**Default:**  Off  
**Options:**  On | Off  
**Function:**  Indicates whether or not a Receiver Ready (RR) signal is sent when the Link Idle Timer expires.  
**Instructions:**  Either accept the default, Off, or set to On if you want RRs sent.  
**MIB Object ID:**  1.3.6.1.4.1.18.3.4.5.1.61

**Parameter:**  Cable Type  
**Default:**  Null  
**Options:**  Null | RS232 | RS422 | V35 | X21  
**Function:**  This parameter is used only for switched-service lines. If the sync port is connected to a dialup device for switch services, use this parameter to specify the cable interface type of the device.  
**Instructions:**  Set to reflect the cable interface type being used to connect the dial unit if you are using one.  
**MIB Object ID:**  1.3.6.1.4.1.18.3.4.5.1.83
**Parameter:** Retry Timer

**Default:** 3 seconds

**Range:** 1 to 9999 seconds

**Function:** Indicates the timeout in seconds for a response to be heard from the link. Link control frames are sent at the expiration of this timer value. The frames will be resent up to the value of Retry Count, at which time the link will be disconnected.

**Instructions:** Either accept the current value, or enter a new value.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.21

**Parameter:** Extended Address

**Default:** Disable

**Options:** Enable | Disable

**Function:** Controls length determination of the address field. When this parameter is enabled, the first bit of the address field will be tested to determine the length of the address field, in octets.

**Instructions:** Either accept the current value, or enter a new value.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.5.1.22
Customizing Line Services

Parameter: Remote Loopback Detection
  Default: Disable
  Options: Enable | Disable
  Function: Enables or disables Remote Loopback Detection. If BOFL is enabled, the device driver detects when it is receiving its own BOFL packets and disables the interface assuming that the link has been put into loopback.
  Instructions: Click on Values and select Enable or Disable
  MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.91

Link Access Procedure Balanced Protocol

The LAPB protocol is a version of the HDLC protocol. Wellfleet routers use the services of LAPB to initialize the link between itself and the local DCE device, and to frame X.25 data packets before transmitting them to the DCE. The LAPB information field contains the X.25 packets. Once an X.25 packet reaches the destination router, the LAPB protocol strips away the LAPB frame and delivers the packet to the network layer for further processing.

For detailed information on LAPB and X.25, refer to Customizing X.25 Services.

From the Edit Sync Parameters window (Figure 3-23) for an X.25 port on a Wellfleet AN or ASN router, select the LAPB button to display the LAPB Edit Parameters window (Figure 3-26).
Editing Synchronous Line Details

**Parameter:** Enable

**Default:** Enable
**Options:** Enable | Disable
**Function:** Globally enables or disables LAPB services.
**Instructions:** Select disable to disable LAPB services.
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.8.1.2
**Parameter:** Station Type

- **Default:** DTE
- **Options:** DTE | DCE | DXE
- **Function:** Identifies the station type, that is, whether the device is a DTE or DCE, for this interface.
- **Instructions:** If your device is data terminal equipment, select **DTE**. If your device is data communications equipment, select **DCE**. If you do not want to assign a specific station type, and instead, want the network to determine the station type, choose **DXE**. This value indicates that the router is in unassigned mode; it is neither a DTE nor DCE. If you select DXE, the router will send an exchange identification (XID), but negotiation has yet to take place.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.8.1.7

**Parameter:** Control Field

- **Default:** Modulo 8
- **Options:** Modulo 8 | Modulo 128
- **Function:** Specifies the desired window size, or modulo, of the sequence numbering the router uses to number frames.
- **Instructions:** Select the appropriate size for your configuration.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.8.1.8
### Parameter: Max N1 Frame Size (octets)

- **Default:** 1600
- **Range:** 3 to 4500

**Function:** Specifies the frame size, in terms of number of bytes, for a frame that the router or network transmits. This number excludes flags and 0 bits inserted for transparency.

**Instructions:** Select the frame size that suits your network configuration.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.8.1.9

---

### Parameter: Window Size

- **Default:** 7
- **Range:** 1 to 127

**Function:** Specifies the default transmit and receive window size for the interface. This value is the maximum number of unacknowledged sequence frames that may be outstanding from the router or the network at any one time.

**Instructions:** Enter the appropriate window size for your configuration.

**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.8.1.10
**Parameter:** Max N2 Retries  
**Default:** 10  
**Range:** 1 to 64  
**Function:** Determines the value of the N2 retry count, which is the number of retransmission attempts that the router tries, per frame, before it considers the line to be down. The retry count is the maximum attempts following the expiration of the T1 timer.  
**Instructions:** Specify the number of times you want the router to try to retransmit.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.8.1.11

**Parameter:** Max T1 Acknowledge Timer (seconds)  
**Default:** 3 seconds  
**Range:** 1 to 9999 seconds  
**Function:** Specifies the maximum time, in seconds, that the router waits for an acknowledgment of a frame that it has sent to the network.  
**Instructions:** Enter the amount of time you would like the router to wait for a frame acknowledgment from the network.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.5.1.8.1.12
## Editing Synchronous Line Details

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Max T2 Acknowledge Delay Timer (seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>1 second</td>
</tr>
<tr>
<td>Range:</td>
<td>1 to 9999 seconds</td>
</tr>
<tr>
<td>Function:</td>
<td>Specifies the time, in seconds, that the router waits before sending an acknowledgment for a sequenced frame. A value of one means that the router does not delay before generating an acknowledgment.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Enter the amount of time that you want the router to wait before acknowledging a frame.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.5.1.8.1.13</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Max T3 Disconnect Timer (seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>60 seconds</td>
</tr>
<tr>
<td>Range:</td>
<td>1 to 9999 seconds</td>
</tr>
<tr>
<td>Function:</td>
<td>This timer specifies the time, in seconds, that the router waits before determining that the link is disconnected. A value of one indicates that once the router completes the frame exchange to bring down the link, it considers the link disconnected.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Enter the amount of time that you want the router to wait before the router decides that the link is down.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.5.1.8.1.14</td>
</tr>
</tbody>
</table>
Parameter: **Initiate Link Setup Action**

- Default: Active
- Options: Active | Passive
- Function: Identifies whether or not the router initiates link setup or waits for the network to initiate.

  Instructions: Enter Active, if you want the router to initiate link setup or Passive, if you want the network to initiate link setup.

  MIB Object ID: 1.3.6.1.4.1.18.3.5.1.8.1.16

Parameter: **Enable Rx/Tx of XID Frames**

- Default: Enable
- Options: Enable | Disable
- Function: Enables or disables the transmission and reception of test exchange identification (XID) frames by the router.

  Instructions: Select Enable to allow the router to send XID frames. Select Disable to prevent the router from sending XID frames.

  MIB Object ID: 1.3.6.1.4.1.18.3.5.1.8.1.17
Parameter:  Idle RR Frames  
Default:  OFF  
Options:  ON | OFF  
Function:  Enables or disables the transmission and receipt of Receiver Ready (RR) frames during periods when there are no information frame exchanges. When ON, an RR is transmitted when no traffic is present on the physical media.  
Instructions:  Click on Values and select ON or OFF.  
MIB Object ID:  1.3.6.1.4.1.18.3.5.1.8.1.40

Parameter:  Command/Response Address  
Default:  DTE  
Options:  DTE | DCE  
Function:  Specifies the local command or response address, which is the DTE or DCE value expressed as a single octet.  
Instructions:  Enter DTE, for the DTE address or DCE, for the DCE address.  
MIB Object ID:  1.3.6.1.4.1.18.3.5.1.8.1.18
Customizing Line Services

Parameter: WAN Protocol
- Default: Standard
- Options: Standard | X.25
- Function: Specifies the WAN protocol you want to run on this interface.
- Instructions: Choose which WAN protocol you want the router to run.
- MIB Object ID: 1.3.6.1.4.1.18.3.5.1.8.1.20

Editing Asynchronous Line Details

If you selected the ASYNC protocol from the WAN Protocols window (Figure 2-4) for a communications port line on a Wellfleet AN or ASN router, the Configuration Manager displays the Edit ASYNC Parameters window (Figure 3-27).
Editing Asynchronous Line Details

Figure 3-27. Edit ASYNC Parameters Window

Complete the following steps:

1. Enter or select new values for the asynchronous line detail parameters you want to edit.
   Refer to the descriptions following this procedure for guidelines.
2. Click on the OK button.
### Customizing Line Services

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable</strong></td>
<td>Enables or disables ASYNC on the router.</td>
</tr>
<tr>
<td>Default: Enable</td>
<td></td>
</tr>
<tr>
<td>Options: Enable</td>
<td></td>
</tr>
<tr>
<td><strong>MTU</strong></td>
<td>Specifies the maximum transfer unit (MTU) size (in bytes) for the transmission control protocol (TCP) request buffer size.</td>
</tr>
<tr>
<td>Default: 1000 bytes</td>
<td></td>
</tr>
<tr>
<td>Range: 3 to 1580 bytes</td>
<td></td>
</tr>
<tr>
<td><strong>Start Protocol</strong></td>
<td>Specifies the start mode for the ASYNC TCP connection.</td>
</tr>
<tr>
<td>Default: Answer</td>
<td></td>
</tr>
<tr>
<td>Options: Loop</td>
<td></td>
</tr>
<tr>
<td>Options: Originate</td>
<td></td>
</tr>
<tr>
<td>Options: Answer</td>
<td></td>
</tr>
</tbody>
</table>

**MIB Object ID:**
- Enable: 1.3.6.1.4.1.18.3.4.3.1.2
- MTU: 1.3.6.1.4.1.18.3.4.3.1.7
- Start Protocol: 1.3.6.1.4.1.18.3.4.3.1.9
Parameter: Remote IP Address
   Default: None
   Options: Any valid 32-bit IP address in dotted decimal notation.
   Function: Specifies a remote TCP host to which this router will communicate using ASYNC. The Remote IP Address is only used when the Start Protocol parameter is set Originate.
   Instructions: Enter a valid IP address in dotted decimal notation.
   MIB Object ID: 1.3.6.1.4.1.18.3.4.3.1.26

Parameter: Remote Port
   Default: 7
   Range: 1 to 65535
   Function: Specifies a remote port for the TCP connection.
   Instructions: Enter a remote port number. The Remote Port number is only used when the Start Protocol parameter is set Originate.
   MIB Object ID: 1.3.6.1.4.1.18.3.4.3.1.27

Parameter: Local Port
   Default: 2100
   Range: 1 to 65535
   Function: Specifies a local port on the router for ASYNC communications.
   Instructions: Enter a local port number. The Local Port number is only used when the Start Protocol parameter is set to Answer.
   MIB Object ID: 1.3.6.1.4.1.18.3.4.3.1.28
**Parameter:** Baud Rate  
**Default:** 9600  
**Options:** 300 | 1200 | 2400 | 4800 | 9600 | 19200  
**Function:** Specifies the ASYNC line speed.  
**Instructions:** Select the appropriate line speed for this configuration.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.3.1.29

**Parameter:** Idle Timer  
**Default:** 20  
**Range:** 1 to 300 seconds  
**Function:** Specifies the ASYNC idle timer in seconds.  
**Instructions:** Enter an appropriate idle timer value in seconds.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.3.1.30

**Parameter:** Receive Window  
**Default:** 4096  
**Range:** 512 to 65535 bytes  
**Function:** Specifies the size of the TCP receive window for received ASYNC packets.  
**Instructions:** Enter a positive value in the range 512 to 65535.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.3.1.31
Editing Asynchronous Line Details

**Parameter:** TCP KeepAlive

**Default:** 8

**Range:** 3 to 180 seconds

**Function:** Specifies the frequency of keep alive message transmissions (in seconds) that the local TCP uses when sending the messages to the remote TCP.

**Instructions:** Specify a positive value in the range 3 to 180 seconds. The router uses the TCP KeepAlive parameter with the TCP Inactive Limit parameter. When the local TCP sends out a TCP keep alive message, it expects an acknowledgment (ACK) from the remote TCP. The ACK then resets the inactive limit timer.

If the local TCP does not receive the ACK from the remote TCP before the TCP Inactive Limit parameter expires, the TCP connection is disabled. To prevent an error or alarm condition, set the TCP Inactive Limit with a value that allows enough time for multiple TCP keep alive messages.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.3.1.35
Parameter: TCP Inactive Limit
Default: 300
Range: -65536 to 65535 seconds
Function: Specifies the maximum inactivity timer in seconds. When the inactive limit parameter expires, the TCP connection between the router and the remote TCP host is lost. The TCP Inactive Limit parameter is used with the TCP KeepAlive parameter setting.

Instructions: Enter a value in the range -65536 to 65536 or accept the default value (300). To prevent a TCP connection loss, set the TCP Inactive Limit with a value that allows enough time for multiple TCP keep alive messages and ACKs from the remote TCP host. Refer to the TCP KeepAlive parameter for information.

If the port is listening (TCP KeepAlive) for an incoming connection, you can specify a negative TCP Inactive Limit value to mark the connection as inactive and defer resetting the connection until a connection request is received.

MIB Object ID: 1.3.6.1.4.1.18.3.4.3.1.36

Parameter: Cfg TxQ Length
Default: None
Range: 1 to 255 bytes
Function: Specifies the maximum transmit queue length in bytes. This parameter reduces the size of the driver transmit queue if the transmit queue is larger than this configuration.

Instructions: Enter a value in the range 1 to 255.

MIB Object ID: 1.3.6.1.4.1.18.3.4.3.1.37
Parameter: **Cfg RxQ Length**

Default: None
Range: 1 to 255 bytes
Function: Specifies the maximum receive queue length in bytes. This parameter reduces the size of the driver receive queue if the receive queue is larger than this configuration.

Instructions: Enter a value in the range 1 to 255.
MIB Object ID: 1.3.6.1.4.1.18.3.4.3.1.38

---

**Editing T1 Line Details**

If the line you selected to edit is a T1 line, the Configuration Manager displays the T1 Line Entry window (Figure 3-28).

![T1 Line Entry Window](image)

**Figure 3-28. T1 Line Entry Window**
Complete the following steps:

1. Enter or select new values for the T1 service parameters you want to edit, referring to the descriptions following this procedure for guidelines.

2. If you want to edit synchronous line parameters, click on the Sync Details button. Refer to the section “Editing Synchronous Line Details” in this chapter for details.

3. Click on the OK button.

**Parameter: Enable**

- Default: Enable
- Options: Enable | Disable
- Function: Enables or disables the T1 line.
- Instructions: Set to Disable if you want to disable the T1 line.
- MIB Object ID: 1.3.6.1.4.1.18.3.4.10.1.2

**Parameter: Frame Type**

- Default: ESF
- Options: ESF | D4
- Function: Selects either ESF (extended super frame) or D4 framing format. D4 transmits super frames consisting of 12 individual super frames. ESF, in contrast, transmits super frames consisting of 24 individual D4 frames and provides enhanced signaling and synchronization.
- Instructions: Select ESF or D4, based on the frame format required by the associated T1 equipment.
- MIB Object ID: 1.3.6.1.4.1.18.3.4.10.1.7
Parameter: B8ZS Support

Default: Disable

Options: Disable | Enable

Function: Enables or disables Binary 8 Zeros Suppression (a mechanism to maintain sufficient ones-density within the T1 data stream).

Instructions: Enable or disable, based on the ability of the associated T1 equipment to support B8ZS.

MIB Object ID: 1.3.6.1.4.1.18.3.4.10.1.9

Parameter: Line Buildout

Default: 1 foot

Range: 1 to 655 feet

Function: Conditions router signals to mitigate attenuation.

Instructions: Because signal attenuation correlates with the physical length of the T1 line, enter the approximate length of the cable connecting the router and the associated T1 equipment.

MIB Object ID: 1.3.6.1.4.1.18.3.4.10.1.8
Parameter: Clock Mode

Default: Internal

Options: Internal | Slave | Manual

Function: Specifies the source of the T1 transmit clock.

Internal specifies that the T1 transmit clock is internally generated; Slave specifies that the T1 transmit clock is externally generated (that is, the transmit clock is derived from the incoming data stream); Manual specifies that the clock source is hardware configured (that is, the source of the transmit clock is determined by jumpers on the T1 link module).

Instructions: Select the clocking mode, making certain that the associated T1 equipment is configured in a complementary fashion.

Refer to Installing and Maintaining BN Routers for information on Link Module hardware configuration.

MIB Object ID: 1.3.6.1.4.1.18.3.4.10.1.10
Parameter:  Mini Dacs

Default:  Idle

Options:  Idle | Data | Voice | Circuit 1 | Circuit 2

Function:  Assigns each T1 channel to a specific function.

Instructions:  Assign each of the 24 DS1 channels as required.

I
  Makes the channel idle

D
  Assigns the channel to data passthrough (T1 connector to T1 connector)

V
  Assigns the channel to voice passthrough (T1 connector to T1 connector)

Circuit 1
  Assigns the channel to the first T1 circuit

Circuit 2
  Assigns the channel to the second T1 circuit

MIB Object ID:  1.3.6.1.4.1.18.3.4.10.1.11

Note:  1) Data and voice passthrough require that identical channels be assigned to data or voice on both T1 connectors. For example, if the first T1 connector allocates channels 1 through 8 to voice passthrough and channels 9 through 16 to data passthrough, the second T1 connector must also allocate channels 1 through 8 to voice and 9 through 16 to data passthrough.

2) T1 channels cannot be allocated to both T1 circuits. If channels 17 through 24 are allocated to circuit 1 on the first T1 connector, the second T1 connector must make these channels idle or allocate them to circuit 2.
Editing Token Ring Line Details

If the line you select to edit is a Token Ring line, the Configuration Manager displays the Token Ring Line Entry window (Figure 3-29).

![Token Ring Line Entry Window](image)

**Figure 3-29. Token Ring Line Entry Window**

Complete the following steps:

1. Enter or select new values for the Token Ring parameters you want to edit, referring to the descriptions following this procedure for guidelines.
2. Click on the OK button.
Parameter: Enable
Default: Enable
Options: Enable | Disable
Function: Enables or disables the Token Ring circuit.
Instructions: Set to Disable if you want to disable the Token Ring circuit.
MIB Object ID: 1.3.6.1.4.1.18.3.4.2.1.2

Parameter: MAC Address Override
Default: None
Options: Any valid 48-bit MAC level address
Function: Enables the assignment of a user-specified MAC address.
Instructions: If you want to specify a MAC level address (for example, to avoid host number conflicts on a directly connected IPX or XNS network), enter the 48-bit MAC address in MSB format. For example, enter 0x followed by twelve hexadecimal digits.

If you want the router to generate a MAC level address for this Token Ring interface, ignore this parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.4.2.1.9

Note: If you enter a MAC address at MAC Address Override, you must set MAC Address Select to CNFG.
**Parameter:** MAC Address Select

**Default:** PROM

**Options:** BOXWIDE | PROM | CNFG

**Function:** Determines the source of the MAC address.

**Instructions:** Enter BOXWIDE if you want the Token Ring interface to use a MAC address generated automatically from the router’s serial number.

Enter PROM if you want the Token Ring interface to use a MAC address read from programmable read-only memory on the Token Ring link module.

Enter CNFG if you explicitly assigned a MAC address at the MAC Address Override parameter.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.2.1.10

---

**Parameter:** Speed

**Default:** 16 MB/s

**Options:** 16 MB/s | 4 MB/s

**Function:** Specifies the speed of the Token Ring media.

**Instructions:** Enter the ring speed.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.2.1.11

---

**Note:** If you select 16 MB/s, the router enables the Early Token Release protocol, which is used extensively on 16 MB/s media. In the unlikely event that you want to disable Early Token Release over 16MB/s Token media, you can do so through the Early Token Release parameter.
Parameter: Early Token Release
Default: Enable
Options: Enable | Disable
Function: Indicates whether the token can be released back onto the ring before all data is copied by the recipient. This parameter is enabled only when Speed is set to 16 MB/s.
Instructions: Accept the current value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.2.1.12

Editing ATM FRE2 Line Details

If you select an ATM FRE2 line to edit, the Configuration Manager displays the Edit ATM /ALC Parameters window (Figure 3-30).

Note: You must edit ATM DXI line details using synchronous parameters. Refer to “Editing Synchronous Line Details” earlier in this chapter.
Customizing Line Services

![Edit ATM/ALC Parameters Window](image)

Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable
Data Path Notify
Data Path Notify Timeout

Figure 3-30. Edit ATM/ALC Parameters Window

Complete the following steps:

1. Enter or select new values for the ATM line detail parameters you want to edit, referring to the descriptions following this procedure for guidelines.

2. Either click on the OK button, or click on the Traffic or Physical button to edit those attributes.
Parameter: Enable
Default: Enable
Options: Enable | Disable
Function: Enables or disables the ATM circuit for the selected connector.
Instructions: Accept the default, Enable, if you want the selected connector to remain enabled. Set to Disable if you want to disable the ATM circuit for the selected connector.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.1.1.2

Parameter: Data Path Notify
Default: Enable
Options: Enable | Disable
Function: Enables or disables the Data Path Notify function for the selected connector. This function, when enabled, disables the data path interface when the physical interface becomes non-operational.
Instructions: Accept the default, Enable, if you want Site Manager to disable the data path interface when the physical interface becomes non-operational. Set to Disable if you do not want Site Manager to disable the data path interface when the physical interface becomes non-operational.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.1.1.14
Parameter: Data Path Notify Timeout

Default: 3 seconds
Range: 0 to 3600 seconds
Function: Specifies the number of seconds to wait before implementing the Data Path Notify function. When the Data Path Notify function is enabled, Site Manager sets a timer to this value when the state of the physical interface transitions from operational to non-operational.

Instructions: Either accept the default value, 3 seconds, or specify a new value.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.1.1.15

Editing the ATM Traffic Attributes

To edit the ATM Traffic attributes, complete the following steps:

1. Click on the Traffic button in the Edit ATM/ALC Parameters window (Figure 3-30).

The Configuration Manager displays the ATM /ALC SAR Traffic Management Attributes window (Figure 3-31).
2. Enter or select new values for the ATM/ALC SAR Traffic Management parameters you want to edit, referring to the descriptions following this procedure for guidelines.

3. Click on the OK button.
**Parameter:**  Peak Cell Rate (Cells/Sec)

**Default:**  235849

**Range:**  1 to 235849 (100 Mb/s multimode fiber-optic cable); 1 to 365566 (SONET/SDH)

**Function:**  Specifies the upper traffic limit, in cells/second, that the ATM connection can submit.

**Instructions:**  How you set the peak cell rate depends on:

- The optical transmission rate of your ATM device (235894 cells/sec [100 Mbps] maximum for 100 Mb/s fiber, 365566 cells/sec [155 Mbps] maximum for SONET/SDH)

- The amount of traffic you expect on a particular VCL

- What rate you desire for each VCL

After you determine the transmission rate of your ATM device, you can set peak cell rates within the ranges mentioned above.

**MIB Object ID:**  1.3.6.1.4.1.18.3.4.23.2.9.1.5
**Parameter:** Sustainable Cell Rate (Cells/Sec)

**Default:** 235849

**Range:** 1 to 235849 (100 Mb/s multimode fiber-optic cable); 1 to 365566 (SONET/SDH)

**Function:** Specifies the upper limit of the ATM connection conforming average rate. The "average rate" equals the total number of cells transmitted divided by the "duration of the connection."

**Instructions:** By using the SCR, you can define the future cell flow of a VCL in greater detail than by just using the PCR.

Specifying the SCR controls the rate over time — not at a specific instant of time — and can help you more efficiently utilize your network resources. When setting the SCR, keep the following in mind:

- The SCR is essentially a future average. By setting the SCR you are specifying the cell rate, over time, to which you want the VCL to conform.

- To be useful, the SCR must not exceed the PCR.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.23.2.9.1.6
Parameter: Maximum Burst Size (Cells/Sec)

Default: 40

Range: 1 to 65535

Function: The MBS is the maximum length of a cell stream on a given VCL. In other words, the MBS specifies the maximum number of sequential cells allowed on a VCL, at the peak cell rate, before the VCL must relinquish bandwidth to other VCLs.

Instructions: We recommend a conservative value to start.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.9.1.7

Editing the ATM Physical Attributes

Note: You only need to edit ATM Physical Attributes when configuring a SONET OC-3 line.

To edit the ATM Physical attributes, complete the following steps:

1. Click on the Physical button in the Edit ATM/ALC Parameters window (Figure 3-30).

   The Configuration Manager displays the ATM/ALC Physical Interface Attributes window (Figure 3-32).
Editing ATM FRE2 Line Details

Figure 3-32. ATM/ALC Physical Interface Attributes Window

2. Enter or select a new value for the ATM/ALC Physical Interface parameter, referring to the description following this procedure for guidelines.

3. Click on the OK button.

**Parameter:** Framing Mode

- **Default:** None
- **Options:** SDH | SONET
- **Function:** Specifies either SDH or SONET Framing Mode.
- **Instructions:** Set to either SDH or SONET.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.4.23.2.11.1.4
**Parameter: Scrambling**  
Default: Enable  
Options: Enable | Disable  
Function: Enabling the scrambler/descrambler randomizes cell payload sufficiently to guarantee cell synchronization. If disabled, cell synchronization problems may result.  
Instructions: Click on Values and select Enable or Disable.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.11.1.5

**Parameter: Loop Back**  
Default: Disable  
Options: Enable | Disable  
Function: When enabled, the framer device will be internally configured so that the transmitter loops to the receiver. Loop Back is a diagnostic tool to determine data flow to the transmitter and back through the receiver.  
Instructions: Click on Values and select Enable or Disable.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.11.1.7

**Parameter: Cell Insertion**  
Default: Unassigned  
Options: Idle | Unassigned  
Function: In the absence of user cells, the framer device fills idle bandwidth with either idle or unassigned cells.  
Instructions: Click on Values and select Idle or Unassigned.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.11.1.49
Chapter 4
Configuring MCT1

This chapter documents how to use the Configuration Manager to add an MCT1 circuit to a Wellfleet router with an installed Multichannel T1 Link Module.

Adding MCT1 Circuits

The Configuration Manager window (Figure 2-1) displays a slot with an MCT1 module and its associated connectors. To add circuits, proceed with the following steps:

- Select the connector
- Set clock parameters
- Set port parameters
- Define logical lines
- Define a circuit for each logical line
- Complete the logical line parameters
- Assign timeslots
- Accept the configuration
- Save your changes

Note: In local mode you need to add an initial hardware configuration. See the "Specifying Hardware" section of Chapter 2.
Selecting the Connector

Click on the MCT1 connector in the Configuration Manager window (Figure 2-1) to begin the process of adding an MCT1 port. See Chapter 2 for more information on the Configuration Manager window and connectors.

Setting Clock Parameters

The Clock Parameters window (Figure 4-1) appears after you click on the connector. The clock parameters define the timing sources that apply globally for all ports and DS0 timeslots supported by the MCT1 Link Module in the current slot.

There is one clock chip on the Link Module that applies to all ports. If a port is already configured, the clock parameters set for the first port apply to all subsequent ports.

![Figure 4-1. MCT1 Clock Parameters Window](image)

Click on OK to accept the default values or modify the clock parameters according to the descriptions that follow.
Parameter: Primary Clock

Default: Port 1 Ext Loop

Options: Internal | Port 1 Ext Loop | Port 2 Ext Loop | Auxiliary Ext

Function: Identifies the primary source of the transmit timing used by the single port on the MCT1-1 Link Module and both ports on the MCT1-2 Link Module.

Internal
   Generated by the clock chip on the Link Module.

Port 1 Ext Loop
   Generated by the signal coming in from Port 1.

Port 2 Ext Loop
   Generated by the signal coming in from Port 2.

Auxiliary Ext
   Generated from an external source using the DB9 interface.

The internal and external clock source options, include loop timing from either port or an auxiliary timing source using the DB9 connector.

Instructions: Specify the source of the primary transmit clock.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.1.1.4
Parameter: Secondary Clock

Default: Internal

Options: Internal | Port 1 Ext Loop | Port 2 Ext Loop | Auxiliary Ext

Function: Identifies the secondary source of the transmit timing used by the single port on the MCT1-1 Link Module and both ports on the MCT1-2 Link Module only if the primary clock becomes unavailable.

- **Internal**
  Generated by the clock chip on the Link Module.

- **Port 1 Ext Loop**
  Generated by the signal coming in from Port 1.

- **Port 2 Ext Loop**
  Generated by the signal coming in from Port 2.

- **Auxiliary Ext**
  Generated from an external source using the DB9 interface.

The internal and external clock source options, include loop timing from either port or an auxiliary timing source using the DB9 connector.

Instructions: Specify the source of the secondary transmit clock.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.1.1.5

---

**Setting Port Parameters**

The MCT1 Port Parameters window (Figure 4-2) appears after you accept the clock parameters.
Configuring MCT1

![MCT1 Port Parameters Window](image)

**Figure 4-2. MCT1 Port Parameters Window**

The port parameters apply to each of the 24 DS0 channels provided by an individual MCT1 port (connector). Click on OK to accept the default values, or modify the port parameters according to the descriptions that follow.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Enable/Disable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>Enable</td>
</tr>
<tr>
<td>Options:</td>
<td>Enable</td>
</tr>
<tr>
<td>Function:</td>
<td>Enables or disables the MCT1 port.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Set to Disable only if you want to disable the MCT1 port.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.4.9.3.1.2</td>
</tr>
</tbody>
</table>
**Parameter:** Maximum Transfer Unit

**Default:** 1600 (bytes)

**Range:** 3 to 4608

**Function:** Specifies the Transmit/Receive buffer size, which determines the largest frame that can be transmitted or received across this port on the MCT1 Link Module. Frames larger than the maximum transfer unit are discarded.

**Instructions:** Enter the maximum transfer unit.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.3.1.5

**Parameter:** Line Type

**Default:** ESF

**Options:** Unframed T1 | ESF | SF/D4

**Function:** Selects either ESF or SF/D4 framing format.

*Unframed T1*
Use only during BERT mode to match the line type.

*ESF*
Transmits super frames consisting of 24 individual SF/D4 frames and provides enhanced signaling and synchronization.

*SF/D4*
Transmits super frames consisting of 12 individual frames.

**Instructions:** Select ESF or SF/D4, based on the frame format required by the associated T1 equipment.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.4.1.6
**Parameter:** Line Coding

**Default:** B8ZS

**Options:** AMI | B8ZS

**Function:** Selects a line coding method.

AMI line coding is bipolar: a binary 0 is transmitted as zero volts and a binary 1 is transmitted as either a positive or negative pulse, opposite in polarity to the previous pulse. (When configured for AMI line coding, the MCT1 Link Module remains synchronized upon receiving up to 45 consecutive zeros.)

B8ZS line coding replaces a block of 8 consecutive binary zeros with an 8-bit B8ZS code containing bipolar violations in the 4th and 7th bit positions of the substituted code. In the receive direction, the B8ZS code is detected and replaced with 8 consecutive binary zeros.

**Instructions:** Specify the line coding method.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.4.1.7
Parameter: Signal Level

Default: 0.0 dB
Options: -15 dB | -7.5 dB | 0.0 dB | 0.5 dB | 0.8 dB | 1.1 dB | 1.5 dB

Function: Specifies the T1 transmit power level in terms of decibels.

The DS1 values of -15 and -7.5 decibels (dB) are long haul and are determined by the carrier if 0.0 dB is not sufficient.

The DSX1 values of 0.0, 0.5, 0.8, 1.1, and 1.5 decibels are short haul and correlate with cable length as follows:

0.0 dB ----> 0 to 133 feet
0.5 dB ----> 133 to 266 feet
0.8 dB ----> 266 to 399 feet
1.1 dB ----> 399 to 533 feet
1.5 dB ----> 533 to 655 feet

Instructions: Specify the decimal level according to the length of the cable or as determined by the carrier.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.3.1.6
Parameter: Setup Alarm Threshold
Default: 2 seconds
Range: 2 to 10 seconds
Function: Specifies the time interval (in seconds) during which a performance defect or anomaly will be tolerated. If the performance defect or anomaly is still present at the expiration of the time interval specified by this parameter, MCT1 records a performance failure and logs an event message.

Instructions: Set the timer value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.3.1.7

Parameter: Clear Alarm Threshold
Default: 2 Seconds
Range: 2 to 10 Seconds
Function: Specifies the clear time (in seconds) for performance failure conditions. If the defect or anomaly clears in the time interval specified by this parameter, MCT1 records a performance cleared condition and logs an event message.

Instructions: Set the timer value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.3.1.8
**Parameter:** FDL Configuration  
Default: ANSI 403  
Options: ANSI 403 | AT&T 54016 | None  
Function: Selects a Facility Data Link (FDL) mode. The default, ANSI 403 Mode, conforms with the 1989 ANSI T1.403 specification (*Carrier-to-Customer Installation DS1 Metallic Interface*); 54016 conforms with the 1989 AT&T specification (*Requirements for Interfacing Digital Terminal Equipment to Services Employing the Extended Superframe Format*). Facility Data Link is used only when the T1 line is configured with an ESF line type.  
Instructions: Specify the operational mode.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.4.1.14

**Parameter:** Remote FDL HDLC Address Mode  
Default: BY  
Options: AZ | BY  
Function: Selects the BY or AZ FDL address mode. This determines whether the near-end FDL will respond to HDLC address AZ or BY in the FDL messages from the far-end.  
Instructions: Specify the address mode.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.3.1.9
**Parameter:** Accept Loopback Request  
Default: Enable  
Options: Enable | Disable  
Function: Enables and disables loop-up and loop-down code detection circuitry in the MCT1 Link Module. If this parameter is enabled, this interface accepts and complies with requests to go into loopback mode from a far-end device.  
Instructions: Enable or disable local loopback.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.3.1.10
Parameter: Loopback Configuration

Default: No Loopback
Options: No Loopback | Payload Loopback | Line Loopback

Function: Forces the DS1 interface into loopback. The far-end or intermediate equipment then performs diagnostics on the network between that equipment and the DS1 interface. After testing, set this parameter to No Loopback to return the interface to a normal operating mode.

No Loopback
Returns the interface to non-loopback operation.

Payload Loopback
The received signal at this interface is looped through the device. Typically the received signal is looped back for re-transmission after it has passed through the device's framing function.

Line Loopback
The received signal at this interface does not go through the framing device (minimum penetration) but is looped back out.

Instructions: Select the loopback configuration option.
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.4.1.10

Defining Logical Lines

A single MCT1 port supports up to 24 logical lines (logical paths for data communications on a physical connection). Each logical line supports one circuit.
The MCT1 Logical Lines window (Figure 4-3) appears after you complete the Port Parameters window (Figure 4-2). Use the Logical Lines window to add a logical line. Then add the circuit for the line, modify the line parameters, and assign timeslots to the logical line.

![Slot 3, MCT1-1 Logical Lines](image)

**Figure 4-3. Logical Lines Window before You Add a Logical Line**

Click on the Add button to add the first logical line.

**Defining a Circuit for Each Logical Line**

When you add a logical line, the Add Circuit window (Figure 4-4) automatically appears so that you can add a circuit to the line.

Use the circuit windows to
- Group lines into a Multiline circuit, if desired
- Name the circuit
Adding MCT1 Circuits

- Select a protocol
- Save the circuit

![Add Circuit Window]

Configuration Mode: local
SNMP Agent: LOCAL FILE

Circuit Name: MCT1-31-1

Select lines from available connectors:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Connectors</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>□ NONE</td>
</tr>
<tr>
<td>4</td>
<td>□ NONE</td>
</tr>
<tr>
<td>3</td>
<td>□ MCT1-2</td>
</tr>
<tr>
<td>2</td>
<td>□ NONE</td>
</tr>
<tr>
<td>1</td>
<td>□ CONSOLE</td>
</tr>
</tbody>
</table>

Color Key:
Available
Selected

[OK]  [Cancel]

Figure 4-4. Add Circuit Window
Configuring MCT1

Grouping Lines into a Multiline Circuit

This section shows you how to group multiple MCT1 unused logical lines into one Multiline circuit. (An unused logical line is similar to an unused synchronous port, such as COM1, COM2, etc.) All logical lines in Multiline group have the same circuit name.

If you do not want to group the MCT1 logical lines into a Multiline circuit, proceed to the next section, “Naming the Circuit.”

If you are adding an MCT1 Multiline circuit, follow these steps:

1. Add the first MCT1 logical line that you want to group into a Multiline circuit by following the steps in the previous sections “Selecting the Connector,” “Setting Clock Parameters,” and “Setting Port Parameters.” When you set these parameters, the MCT1 Logical Lines window appears (Figure 4-5).
2. Click on the Add button to display the Add Circuit window (Figure 4-6).

![Add Circuit Window](image)

3. Click on the OK button. The WAN Protocols window appears. Select Standard or PPP and click on the OK button.

4. The Select Protocols window appears. Select the protocol(s) to run on this circuit and perform the appropriate configuration for that protocol using the windows that appear. When you are finished, you are returned to the MCT1 Logical Lines window showing the first MCT1 circuit (Figure 4-7).
5. To create unused logical lines, click on the Add button to display the Add Circuit window. From this window, click Cancel. You are returned to the MCT1 Logical Lines window. The unused logical line will be the next available logical line, represented by a number between 1 and 24. Repeat this Add and Cancel operation for each unused logical line that you want to create. Figure 4-8 illustrates the MCT1 Logical Lines window with multiple unused logical lines.
6. From the MCT1 Logical Lines window, highlight the logical line that has a circuit associated with it that you want to include in multiline group. Click on Circuit to display the Circuit Definition window. Click on the connector that has the unused logical line(s). This displays the Select Logical Line window (Figure 4-9).
7. Click on the logical line that you want to multiline and then click on OK. From this window, select Lines→Change Lines from the menu bar. Then, select Lines→Change Lines once again to see if the Multiline option highlighted and available for this circuit, as illustrated in Figure 4-10. You can repeat this step for each unused logical line on that connector. These lines are now grouped as one circuit.
Adding MCT1 Circuits

8. Select File→Exit to return to the MCT1 Logical Lines window. Figure 4-11 illustrates a Multiline grouping. Notice that all logical lines have the same circuit name, MCT1-51-1.
Please go to the section “Completing the Logical Line Parameters” to edit the logical line parameters and to assign timeslots to each logical line.

**Naming the Circuit**

The Add Circuit window displays a default circuit name. Figure 4-12 shows the circuit name in detail. The default name identifies the circuit type (MCT1), the physical connector (slot and number), and the number of the logical line on the MCT1 port associated with the circuit.

**Note:** The Configuration Manager assigns MCT1 logical line numbers sequentially from 1 to 24.

You can change the circuit name by clicking on the circuit name box and typing in a new name. When you are done, click on OK to accept the Add Circuit window and to display the protocol selection window.

**Selecting a Protocol**

Depending on your configuration, the system prompts you to enter WAN and LAN protocols.

The WAN Protocols window (Figure 4-13) appears after you click on OK on the Add Circuit window. Select a WAN protocol. Refer to “Configuring the Circuit” in Chapter 2 for more information about selecting WAN protocols.
Figure 4-13. WAN Protocols Window for MCT1

The Select Protocols window (Figure 4-14) appears after you click on OK on the WAN Protocol window. Select the protocol for the circuit and then configure the protocol. Refer to “Enabling Bridging/Routing Services” and “Enabling Internet Protocol (IP) Services” in Chapter 2 for instructions.
Completing the Logical Line Parameters

After you finish adding a circuit to a logical line, the MCT1 Logical Lines window (Figure 4-15) reappears with the circuit name displayed next to each logical line and default values displayed for the highlighted logical line parameter.
In order to modify a logical line's parameter, first select the logical line from the logical line list. When you complete the modifications to the parameters, click on the Apply button to implement them.

The parameter descriptions are as follows:

**Parameter:** Enable/Disable  
**Default:** Enable  
**Options:** Enable | Disable  
**Function:** This variable turns the logical line on or off.  
**Instructions:** Set to Disable only if you want to disable the logical line.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.2
### Configuring MCT1

**Parameter:** Breath of Life (BOFL) Enable/Disable  
**Default:** Enable  
**Options:** Enable | Disable  
**Function:** Selects the BOFL parameter. When you set this parameter to Enable, a BOFL packet is sent out on the wire as often as specified by the BOFL Period parameter.  
**Instructions:** Set to Disable only if you want to end transmitting BOFL packets.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.8

**Parameter:** BOFL Timeout (seconds)  
**Default:** 5  
**Range:** 1 to 60 seconds  
**Function:** Indicates the time period between Breath of Life packets.  
**Instructions:** Set the time between BOFL packets in seconds.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.9
### Parameter: Fractional Loopback

**Default:** Disable  
**Options:** Enable | Disable  
**Function:** Puts the circuit into diagnostic loopback mode, where any incoming data is “turned around” and transmitted across the circuit. You can put any logical line on this MCT1 port into fractional loopback (where data coming into that logical line from the wire is mirrored back to the wire).

**Instructions:** Select Enable only if you want the port in loopback mode.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.10

### Parameter: WAN Protocol

**Default:** Standard  
**Options:** Standard | PassThru | PPP | SMDS | Frame Relay  
**Function:** Specifies the WAN protocols for this logical line.

**Instructions:** Select the WAN protocol.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.14

### Parameter: Service

**Default:** LLC1  
**Options:** Transparent | LLC1  
**Function:** Sets the HDLC service type for this line. Transparent is basic HDLC mode. LLC1 will prefix the HDLC address and control fields to the frame.

**Instructions:** Select the logical line HDLC service.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.15
Parameter: Local HDLC Address

Default: 7
Options: 1 to 255
Function: Specifies the 1-byte HDLC address of this synchronous interface. When you address data sent to this interface, use this HDLC address.

Instructions: Set this parameter to the local HDLC address you want. Enter 1 for a DCE and 3 for a DTE. All other addresses are considered explicit addresses. To select an Explicit value, enter that value.

Site Manager assumes the values you enter are decimal. If you want to enter a hexadecimal value, preface the value with a 0x, for example, 0x10. If you configure X.25 on this synchronous line, the local HDLC address must be either 1 (DCE) or 3 (DTE).

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.16
Parameter: **Remote HDLC Address**

Default: 7

Range: 1 to 255

Function: Specifies the 1-byte HDLC address of the remote synchronous interface. When you address data sent from this interface to the remote end interface, use this HDLC address.

Instructions: Set this parameter to the HDLC address of the remote synchronous interface. Enter 1 for a DCE and 3 for a DTE. All other addresses are considered explicit addresses. To select any explicit value, enter the value.

Site Manager assumes the values you enter are decimal. If you want to enter a hexadecimal value, preface the value with a 0x, for example, 0x10. If you configure X.25 on this synchronous line, the local HDLC address must be either 1 (DCE) or 3 (DTE).

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.17

Parameter: **Rate Adaptation**

Default: 56 K LSB

Options: 64 K | 56 K MSB | 56 K LSB

Function: Determines the number of bits and their bit positions within the timeslot. The 64-K selection uses all 8 bits in the timeslot. The two 56-K selections use 7 of the 8 bits in the timeslot. 56-K MSB does not use the most significant bit and 56-K LSB does not use the least significant bit in the timeslot.

Instructions: Select the line rate adaptation.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.18
Configuring MCT1

Parameter: InterFrame Time Fill Character

Default: Flags
Options: Flags | Idles
Function: Specifies the interframe time-fill pattern to be transmitted across this circuit. Flags selects an 0x7E pattern (01111110); Idles selects an 0xFF pattern (11111111).

Instructions: Set the line interframe time-fill character.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.19

Parameter: CRC Size

Default: 16-bit CRC
Options: 32-bit CRC | 16-bit CRC
Function: Specifies the Cyclic Redundancy Check (CRC) type. With 16-bit CRC selected, the MCT1 appends a 16-bit CRC to the transmitted frames, and performs a 16-bit CRC on received frames. With 32-bit CRC selected, the MCT1 appends a 32-bit CRC to transmitted frames, and performs a 32-bit CRC on received frames.

Instructions: Set the CRC size.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.20

Assigning Timeslots

After you set up the logical line, you assign the timeslots (also called channels or DS0s) to it.
Click on the Timeslots button on the Logical Lines window to display the MCT1 Timeslots window (Figure 4-16). A graphical representation of the 24 timeslots appears. Click on the box for the Logical Line to display a list of configured circuits for that timeslot. Select a logical line to assign to the timeslot. Click on the OK button when you are finished assigning timeslots to return to the Logical Lines window (Figure 4-15).

![Edit Slot 2, MCT1-1 Timeslots](image)

Figure 4-16. MCT1 Timeslots Window

**Accept the Configuration**

Save the changes you have made to the Logical Lines window by clicking on the Done button.

**Save Your Changes**

The Configuration Manager window appears after you click on Done on the Logical Lines window. Select File→Save before exiting to save the changes to your configuration file.
Initiating MCT1 Actions in Dynamic Mode

While in dynamic mode, you can use the Configuration Manager to trigger MCT1 port actions to test the quality of the line. MCT1 line tests include

- Transmitting specific codes to the remote end of the MCT1 connection
- Introducing deliberate error patterns into the transmitted BERT (Bit Error Rate Test) bit stream

All actions are MCT1 port-specific. For example, a send loopback action is transmitted across a specific port; a BERT reset action resets the port-specific series of BERT counters.

You can review the results of your actions by using the Statistics Manager function of the Configuration Manager to review the BERT statistics. For more information on the Statistics Manager, refer to Managing Wellfleet Routers.

**Warning**  Initiating line tests affects all logical lines associated with that port for the duration of the testing.
To initiate MCT1 actions, click on the Port Details button on the Logical Lines window (Figure 4-15) to display the MCT1 Port Parameters window (Figure 4-17). Then, click on the Line Tests button (dynamic mode only) to display the MCT1 Port Actions window (Figure 4-18).

![MCT1 Port Parameters Window](image)

Figure 4-17. MCT1 Port Parameters Window
Configuring MCT1

Figure 4.18. MCT1 Port Actions Window

**Caution:** Select one action at a time and then click on the Apply button. Wait until the MCT1 Port Actions window has been refreshed before issuing another action.

When you are finished with the Port Actions window, click on the Done button. You are returned to the MCT1 Port Configuration window. All changes applied to the port while in the Port Actions window are effective only while the window is active. When you exit the window using the Done button, all port settings revert to the original port settings.

The parameter descriptions for these port actions follow.
**Initiating MCT1 Actions in Dynamic Mode**

**Parameter:** BERT Mode Enable

- **Default:** Disable
- **Options:** Enable | Disable
- **Function:** Selecting Enable activates BERT mode. You do not have to enable BERT mode to perform non-BERT activities on this window, such as loop actions.
- **Instructions:** To enter BERT mode, select Enable and click on Apply.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.8.2.1.6

**Parameter:** BERT Send Alarm

- **Default:** Disable
- **Options:** AIS (Blue Alarm) | Yellow Alarm | Disable
- **Function:** Specifies the type of alarm signal to be generated while in BERT mode. Select Disable to disable the generation of alarm messages. Select AIS (Blue Alarm) or Yellow Alarm to transmit the corresponding alarm.
- **Instructions:** Select an alarm generation option and click on Apply.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.8.2.1.22
Parameter: **BERT Test Pattern**

Default: All Ones

Options: 0s | Ones | QRSS | 2e15 | 2e15 INV | 2e20 | 2e23 | 2e23 INV

Function: Specifies the bit pattern transmitted during BERT diagnostics. When a port is in BERT mode, it is capable of generating patterns such as all 1s, all 0s, or a QRSS (quasi-random signal sequence) pattern.

Instructions: Select a test pattern and click on Apply.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.2.1.21
Parameter: Line Type

Default: None
Options: Unframed T1 | SF/D4 | ESF
Function: Selects Unframed T1, SF/D4, or ESF framing format.

Unframed T1
Use only during BERT mode to match the line type.

SF/D4
Transmits super frames consisting of 12 individual frames.
If this option is chosen, the FDL port actions do not apply and their buttons are not seen on the MCT1 Port Actions Window (Figure 4-18).

ESF
Transmits super frames consisting of 24 individual SF/D4 frames and provides enhanced signaling and synchronization.

Instructions: Select ESF or SF/D4 based on the frame format required by the associated T1 equipment.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.2.1.9
**Parameter:** Line Coding  
Default: None  
Options: AMI | B8ZS  
Function: Selects a line coding method.

AMI line coding is bipolar, where a binary 0 is transmitted as zero volts and a binary 1 is transmitted as either a positive or negative pulse, opposite in polarity to the previous pulse. (When configured for AMI line coding, the MCT1 Link Module remains in synchronization upon receiving up to 45 consecutive zeros.)

B8ZS (binary eight zeros substitution) line coding replaces a block of 8 consecutive binary zeros with an 8-bit B8ZS code containing bipolar violations in the 4th and 7th bit positions of the substituted code. In the receive direction, the B8ZS code is detected and replaced with 8 consecutive binary zeros. Note: other options do not apply to MCT1.

**Instructions:** Specify the line coding method.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.8.2.1.10
Initiating MCT1 Actions in Dynamic Mode

**Parameter:** Signal Level

Default: None

Options: -15 dB | -7.5 dB | 0.0 dB | 0.5 dB | 0.8 dB | 1.1 dB | 1.5 dB

Instructions: Specifies the T1 transmit power level in terms of decibels (dBs).

The DS1 values of -15 and -7.5 dBs are long haul and are determined by the carrier if 0.0 dB is not sufficient.

The DSX1 values of 0.0, 0.5, 0.8, 1.1, and 1.5 decibels are short haul and correlate with cable length as follows:

- 0.0 dB ——> 0 to 133 feet
- 0.5 dB ——> 133 to 266 feet
- 0.8 dB ——> 266 to 399 feet
- 1.1 dB ——> 399 to 533 feet
- 1.5 dB ——> 533 to 655 feet

Instructions: Specify the decimal level according to the length of the cable or as determined by the carrier.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.2.1.15

**Parameter:** Reset BERT Counters

Default: Reset

Options: None

Function: Resets all counters to zero while the router is in BERT mode.

Instructions: Select this action to reset the counters and click on Apply.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.3
<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Insert 1 Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>Insert</td>
</tr>
<tr>
<td>Options:</td>
<td>None</td>
</tr>
<tr>
<td>Function:</td>
<td>While the router is in BERT mode, inserts a single (non-repeating) error into the bit stream.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Select this action to insert a single error and click on Apply.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Insert 1 Error/K</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>Insert</td>
</tr>
<tr>
<td>Options:</td>
<td>None</td>
</tr>
<tr>
<td>Function:</td>
<td>While the router is in BERT mode, inserts an error into every thousandth position within the bit stream.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Select this action to start the insertion of errors and click on Apply.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Insert 1 Error/1M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>Insert</td>
</tr>
<tr>
<td>Options:</td>
<td>None</td>
</tr>
<tr>
<td>Function:</td>
<td>While the router is in BERT mode, initiates the introduction of a deliberate error into every millionth position within the bit stream.</td>
</tr>
<tr>
<td>Instructions:</td>
<td>Select this action to start the insertion of errors and click on Apply.</td>
</tr>
<tr>
<td>MIB Object ID:</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.6</td>
</tr>
<tr>
<td>Parameter</td>
<td>Disable Insert Error</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Default</td>
<td>Disable</td>
</tr>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Function</td>
<td>Terminates the introduction of deliberate errors into the transmitted bit stream.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Select this action and click on Apply to stop a previous insertion of errors.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Loop Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Transmit</td>
</tr>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Function</td>
<td>Sends a loop-up code to the remote end.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Select this action to send a loop-up code.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Loop Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Transmit</td>
</tr>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Function</td>
<td>Sends a loop-down code to the remote end.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Select this action to send a loop-down code.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.7</td>
</tr>
</tbody>
</table>
Parameter: FDL Payload Loop
Default: Transmit
Options: None
Function: Transmits a payload loopback activate code to the remote end.
Instructions: Select this action.
MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.8

Parameter: FDL Disable Payload Loop
Default: Transmit
Options: None
Function: Transmits a payload loopback deactivate code to the remote end.
Instructions: Select this action.
MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.8

Parameter: FDL Line Loop CI
Default: Transmit
Options: None
Function: Transmits a line loopback activate code (format CI) to the remote end.
Instructions: Select this action to transmit a CI loopback.
MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.8
Initiating MCT1 Actions in Dynamic Mode

**Parameter:** FDL Line Loop IA
- Default: Transmit
- Options: None
- Function: Transmits a line loopback activate code (format IA) to the remote end.
- Instructions: Select this action.
- MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.8

**Parameter:** FDL Line Loop IB
- Default: Transmit
- Options: None
- Function: Transmits a line loopback activate code (format IB) to the remote end.
- Instructions: Select this action.
- MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.8

**Parameter:** FDL Disable Line Loop
- Default: Transmit
- Options: None
- Function: Transmits a line loopback deactivate code to the remote end.
- Instructions: Select this action.
- MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.8
<table>
<thead>
<tr>
<th><strong>Parameter:</strong></th>
<th>FDL Disable All</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default:</strong></td>
<td>Transmit</td>
</tr>
<tr>
<td><strong>Options:</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Function:</strong></td>
<td>Transmits a loopback deactivate code to deactivate all types of FDL-initiated loopbacks.</td>
</tr>
<tr>
<td><strong>Instructions:</strong></td>
<td>Select this action.</td>
</tr>
<tr>
<td><strong>MIB Object ID:</strong></td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.8</td>
</tr>
</tbody>
</table>
This chapter documents how to use the Configuration Manager to add an MCE1 circuit to a Wellfleet router with an installed Multichannel E1 Link Module.

Adding MCE1 Circuits

The Configuration Manager window (Figure 2-1) displays a slot with an MCE1 module and its associated connectors. To add circuits, proceed with the following steps:

- Select the connector
- Set clock parameters
- Set port parameters
- Define logical lines
- Define a circuit for each logical line
- Complete the logical line parameters
- Assign timeslots
- Accept the configuration
- Save your changes

Note: In local mode you need to add an initial hardware configuration. See the "Specifying Hardware" section of Chapter 2.
Selecting the Connector

Click on the MCE1 connector in the Configuration Manager window (Figure 2-1) to begin the process of adding an MCE1 port. See Chapter 2 for more information on the Configuration Manager window and connectors.

Setting Clock Parameters

The Clock Parameters window (Figure 5-1) appears after you click on the connector. The clock parameters define the timing sources that apply globally for all ports and DS0 timeslots supported by the MCE1 Link Module in the current slot.

There is one clock chip on the Link Module that applies to all ports. If a port is already configured, the clock parameters set for the first port apply to all subsequent ports.

![Edit Slot 3 DS1/E1 Clock Parameters](image)

**Figure 5-1. MCE1 Clock Parameters Window**

Click on OK to accept the default values or modify the clock parameters according to the descriptions that follow.
Parameter: Primary Clock

Default: Port 1 Ext Loop

Options: Internal | Port 1 Ext Loop | Port 2 Ext Loop | Auxiliary Ext

Function: Identifies the primary source of the transmit timing used by the single port on the MCE1-1 Link Module and both ports on the MCE1-2 Link Module.

Internal
   Generated by the clock chip on the Link Module.

Port 1 Ext Loop
   Generated by the signal coming in from Port 1.

Port 2 Ext Loop
   Generated by the signal coming in from Port 2.

Auxiliary Ext
   Generated from an external source using the BNC connector.

The internal and external clock source options, include loop timing from either port or an auxiliary timing source using the BNC connector.

Instructions: Specify the source of the primary transmit clock.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.1.1.4
Parameter: **Secondary Clock**  
Default: Internal  
Options: Internal | Port 1 Ext Loop | Port 2 Ext Loop | Auxiliary Ext  
Function: Identifies the secondary source of the transmit timing used by the single port on the MCE1-1 Link Module and both ports on the MCE1-2 Link Module only if the primary clock becomes unavailable.  
**Internal**  
Generated by the clock chip on the Link Module.  
**Port 1 Ext Loop**  
Generated by the signal coming in from Port 1.  
**Port 2 Ext Loop**  
Generated by the signal coming in from Port 2.  
**Auxiliary Ext**  
Generated from an external source using the BNC connector.  

The internal and external clock source options, include loop timing from either port or an auxiliary timing source using the BNC connector.  

Instructions: Specify the source of the secondary transmit clock.  
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.1.1.5

**Setting Port Parameters**

The MCE1 Port Parameters window (Figure 5-2) appears after you accept the clock parameters.
Figure 5-2. MCE1 Port Parameters Window

The port parameters apply to each of the 31 DS0 channels provided by an individual MCE1 port (connector). Click on OK to accept the default values, or modify the port parameters according to the descriptions that follow.
Adding MCE1 Circuits

**Parameter:** Enable/Disable

- **Default:** Enable
- **Options:** Enable | Disable
- **Function:** Enables or disables the MCE1 port.
- **Instructions:** Set to Disable only if you want to disable the MCE1 port.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.3.1.2

**Parameter:** Line Type

- **Default:** E1
- **Options:** E1 | E1 CRC | E1 MF | E1 CRC MF
- **Function:** Selects E1, E1 CRC, E1 MF, or E1 CRC MF framing format.
- **Instructions:** Select E1, E1 CRC, E1 MF, or E1 CRC MF, based on the frame format required by the associated E1 equipment.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.4.1.6
Parameter: Line Coding  
Default: HDB3  
Options: AMI | HDB3  
Function: Selects a line coding method.
AMI line coding is bipolar: a binary 0 is transmitted as zero volts and a binary 1 is transmitted as either a positive or negative pulse, opposite in polarity to the previous pulse. (When configured for AMI line coding, the MCE1 Link Module remains synchronized upon receiving up to 45 consecutive zeros.)

HDB3 (High-Density Bipolar Coding) line coding maintains sufficient ones density within the E1 data stream. It replaces a block of 8 consecutive binary zeros with an 8-bit HDB3 code containing bipolar violations in the 4th and 7th bit positions of the substituted code. In the receive direction, the HDB3 code is detected and replaced with 8 consecutive binary zeros.

Instructions: Specify the line coding method.
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.4.1.7
**Parameter:** Setup Alarm Threshold  
**Default:** 2 seconds  
**Range:** 2 to 10 seconds  
**Function:** Specifies the time interval (in seconds) during which a performance defect or anomaly will be tolerated. If the performance defect or anomaly is still present at the expiration of the time interval specified by this parameter, MCE1 records a performance failure and logs an event message.

**Instructions:** Set the timer value.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.3.1.7

**Parameter:** Clear Alarm Threshold  
**Default:** 2 Seconds  
**Range:** 2 to 10 Seconds  
**Function:** Specifies the clear time (in seconds) for performance failure conditions. If the defect or anomaly clears in the time interval specified by this parameter, MCE1 records a performance cleared condition and logs an event message.

**Instructions:** Set the timer value.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.3.1.8
**Parameter:** International Bit  
**Default:** Disable  
**Options:** Enable/Disable  
**Function:** Specifies if the international bit should be set in the E1 frame.  
**Instructions:** Select Enable to set the international bit, or select Disable.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.3.1.16

**Defining Logical Lines**

A single MCE1 port supports up to 31 logical lines (logical paths for data communications on a physical connection). Each logical line supports one circuit.

The MCE1 Logical Lines window (Figure 5-3) appears after you complete the Port Parameters window (Figure 5-2). Use the Logical Lines window to add a logical line. Then add the circuit for the line, modify the line parameters, and assign timeslots to the logical line.
Adding MCE1 Circuits

Figure 5-3. Logical Lines Window before You Add a Logical Line

Click on the Add button to add the first logical line.

Defining a Circuit for Each Logical Line

When you add a logical line, the Add Circuit window (Figure 5-4) automatically appears so that you can add a circuit to the line.

Use the circuit windows to

- Group lines into a Multiline circuit, if desired
- Name the circuit
- Select a protocol
- Save the circuit

---

**Configuring MCE1**

- Select a protocol
- Save the circuit

---

**Figure 5-4. Add Circuit Window**

<table>
<thead>
<tr>
<th>Slot</th>
<th>Connectors</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>XCVR2</td>
</tr>
<tr>
<td>4</td>
<td>NONE</td>
</tr>
<tr>
<td>3</td>
<td>MCE1-2</td>
</tr>
<tr>
<td>2</td>
<td>TOKEN4</td>
</tr>
<tr>
<td>1</td>
<td>CONSOLE</td>
</tr>
</tbody>
</table>

- Select lines from available connectors:

**Color Key:**
- Available
- Selected

---

**SNMP Agent:** LOCAL FILE

**Circuit Name:** MCE1-31-2
Adding MCE1 Circuits

Grouping Lines into a Multiline Circuit

This section shows you how to group multiple MCE1 unused logical lines into one Multiline circuit. (An unused logical line is similar to an unused synchronous port, such as COM1, COM2, etc.) All logical lines in Multiline group have the same circuit name.

If you do not want to group the MCE1 logical lines into a Multiline circuit, proceed to the next section, “Naming the Circuit.”

If you are adding an MCE1 Multiline circuit, follow these steps:

1. Add the first MCE1 logical line that you want to group into a Multiline circuit by following the steps in the previous sections “Selecting the Connector,” “Setting Clock Parameters,” and “Setting Port Parameters.” When you set these parameters, the MCE1 Logical Lines window appears (Figure 5-5).

![MCE1 Logical Lines Window](image)

Figure 5-5. MCE1 Logical Lines Window
2. Click on the Add button to display the Add Circuit window (Figure 5-6).

![](image)

**Figure 5-6. Add Circuit Window**

3. Click on the OK button. The WAN Protocols window appears. Select Standard or PPP and click on the OK button.

4. The Select Protocols window appears. Select the protocol(s) to run on this circuit and perform the appropriate configuration for that protocol using the windows that appear. When you are finished, you are returned to the MCE1 Logical Lines window showing the first MCE1 circuit (Figure 5-7).
5. To create unused logical lines, click on the Add button to display the Add Circuit window. From this window, click Cancel. You are returned to the MCE1 Logical Lines window. The unused logical line will be the next available logical line, represented by a number between 1 and 31. Repeat this Add and Cancel operation for each unused logical line that you want to create. Figure 5-8 illustrates the MCE1 Logical Lines window with multiple unused logical lines.
6. From the MCE1 Logical Lines window, highlight the logical line that has a circuit associated with it that you want to include in multiline group. Click on Circuit to display the Circuit Definition window. Click on the connector that has the unused logical line(s). This displays the Select Logical Line window (Figure 5-9).
Adding MCE1 Circuits

Figure 5-9. Select Logical Line Window for Multiline

7. Click on the logical line that you want to multiline and then click on OK. From this window, select Lines→Change Lines from the menu bar. Then, select Lines→Change Lines once again to see if the Multiline option highlighted and available for this circuit, as illustrated in Figure 5-10. You can repeat this step for each unused logical line on that connector. These logical lines are now grouped as one circuit.
Configuring MCE1

8. Select File→Exit to return to the MCE1 Logical Lines window. Figure 5-11 illustrates a Multiline grouping. Notice that all logical lines have the same circuit name, MCE1-51-1.

Figure 5-10. Selecting Lines→Change Lines from the Menubar

Figure 5-11. MCE1 Logical Lines Window with a Multiline Circuit
Please go to the section “Completing the Logical Line Parameters” to edit the logical line parameters and to assign timeslots to each logical line.

**Naming the Circuit**

The Add Circuit window displays a default circuit name. Figure 5-12 shows the circuit name in detail. The default name identifies the circuit type (MCE1), the physical connector (slot and number), and the number of the logical line on the MCE1 port associated with the circuit.

**Note:** The Configuration Manager assigns MCE1 logical line numbers sequentially from 1 to 31.

You can change the circuit name by clicking on the circuit name box and typing in a new name. When you are done, click on OK to accept the Add Circuit window and to display the protocol selection window.

**Selecting a Protocol**

Depending on your configuration, the system prompts you to enter WAN and LAN protocols.

The WAN Protocols window (Figure 5-13) appears after you click on OK on the Add Circuit window. Select a WAN protocol. Refer to “Configuring the Circuit” in Chapter 2 for more information about selecting WAN protocols.
Figure 5-13. WAN Protocols Window for MCE1

The Select Protocols window (Figure 5-14) appears after you click on OK on the WAN Protocol window. Select the protocol for the circuit and then configure the protocol. Refer to “Enabling Bridging/Routing Services” and “Enabling Internet Protocol (IP) Services” in Chapter 2 for instructions.
Completing the Logical Line Parameters

After you finish adding a circuit to a logical line, the MCE1 Logical Lines window (Figure 5-15) reappears with the circuit name displayed next to each logical line and default values displayed for the highlighted logical line parameter.
In order to modify a logical line's parameter, first select the logical line from the logical line list. When you complete the modifications to the parameters, click on the Apply button to implement them.

The parameter descriptions are as follows:

**Parameter:** Enable/Disable  
**Default:** Enable  
**Options:** Enable | Disable  
**Function:** This variable turns the logical line on or off.  
**Instructions:** Set to Disable only if you want to disable the logical line.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.2
Parameter: Breath of Life (BOFL) Enable/Disable

Default: Enable
Options: Enable | Disable
Function: Selects the BOFL parameter. When you set this parameter to Enable, a BOFL packet is sent out on the wire as often as specified by the BOFL Period parameter.

Instructions: Set to Disable only if you want to end transmitting BOFL packets.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.8

Parameter: BOFL Timeout (seconds)

Default: 5
Range: 1 to 60 seconds
Function: Indicates the time period between Breath of Life packets.

Instructions: Set the time between BOFL packets in seconds.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.9
**Parameter:** Fractional Loopback  
**Default:** Disable  
**Options:** Enable | Disable  
**Function:** Puts the circuit into diagnostic loopback mode, where any incoming data is “turned around” and transmitted across the circuit. You can put any logical line on this MCE1 port into fractional loopback; (where data coming into that logical line from the wire is mirrored back to the wire).  
**Instructions:** Select Enable only if you want the port in loopback mode.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.10

**Parameter:** WAN Protocol  
**Default:** Standard  
**Options:** Standard | PPP | SMDS | Frame Relay  
**Function:** Specifies the WAN protocols for this logical line.  
**Instructions:** Select the WAN protocol.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.14

**Parameter:** Service  
**Default:** LLC1  
**Options:** Transparent | LLC1  
**Function:** Sets the HDLC service type for this line. Transparent is basic HDLC mode. LLC1 will prefix the HDLC address and control fields to the frame.  
**Instructions:** Select the logical line HDLC service.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.15
Parameter: Local HDLC Address

Default: 7

Range: 1 to 255

Function: Specifies the 1-byte HDLC address of this synchronous interface. When you address data sent to this interface, use this HDLC address.

Instructions: Set this parameter to the local HDLC address you want. Enter 1 for a DCE and 3 for a DTE. All other addresses are considered explicit addresses. To select an Explicit value, enter that value.

Site Manager assumes the values you enter are decimal. If you want to enter a hexadecimal value, preface the value with a `0x`, for example, `0x10`. If you configure X.25 on this synchronous line, the local HDLC address must be either 1 (DCE) or 3 (DTE).

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.6.1.16
**Parameter:** Remote HDLC Address  
**Default:** 7  
**Options:** 1 to 255  
**Function:** Specifies the 1-byte HDLC address of the remote synchronous interface. When you address data sent from this interface to the remote end interface, use this HDLC address.  
**Instructions:** Set this parameter to the HDLC address of the remote synchronous interface. Enter 1 for a DCE and 3 for a DTE. All other addresses are considered explicit addresses. To select any explicit value, enter the value.

Site Manager assumes the values you enter are decimal. If you want to enter a hexadecimal value, preface the value with a 0x, for example, 0x10. If you configure X.25 on this synchronous line, the local HDLC address must be either 1 (DCE) or 3 (DTE).

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.17

**Parameter:** Rate Adaptation  
**Default:** 64 K LSB  
**Options:** 64 K | 56 K MSB | 56 K LSB  
**Function:** Determines the number of bits and their bit positions within the timeslot. The 64-K selection uses all 8 bits in the time slot. The two 56-K selections use 7 of the 8 bits in the timeslot. 56-K MSB does not use the most significant bit and 56-K LSB does not use the least significant bit in the timeslot.  
**Instructions:** Select the line rate adaptation.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.18
### Parameter: InterFrame Time Fill Character

**Default:** Flags

**Options:** Flags | Idles

**Function:** Specifies the interframe time-fill pattern to be transmitted across this circuit. Flags selects an 0x7E pattern (0 1 1 1 1 1 0); Idles selects an 0xFF pattern (1 1 1 1 1 1 1).

**Instructions:** Set the line interframe time-fill character.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.19

### Parameter: CRC Size

**Default:** 16-bit CRC

**Options:** 32-bit CRC | 16-bit CRC

**Function:** Specifies the Cyclic Redundancy Check (CRC) type. With 16-bit CRC selected, the MCE1 appends a 16-bit CRC to the transmitted frames, and performs a 16-bit CRC on received frames. With 32-bit CRC selected, the MCE1 appends a 32-bit CRC to transmitted frames, and performs a 32-bit CRC on received frames.

**Instructions:** Set the CRC size.

**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.6.1.20
Assigning Timeslots

After you set up the logical line, you assign the timeslots (also called channels or DSOs) to it.

Click on the Timeslots button on the Logical Lines window to display the MCE1 Timeslots window (Figure 5-16). A graphical representation of the 31 timeslots appears. Click on the box for the Logical Line to display a list of configured circuits for that timeslot. Select a logical line to assign to the timeslot. Click on the OK button when you are finished assigning timeslots to return to the Logical Lines window (Figure 5-15).

Note: Timeslot 16 is unavailable when the Line Type parameter in the MCE1 Port Parameters window (Figure 5-17) is either E1 MF or E1 CRCMF.
Adding MCE1 Circuits

Figure 5-16. MCE1 Timeslots Window

Accepting the Configuration

Save the changes you have made to the Logical Lines window by clicking on the Done button.
Saving Your Changes

The Configuration Manager window appears after you click on Done on the Logical Lines window. Select File→Save before exiting to save the changes to your configuration file.

Initiating MCE1 Actions in Dynamic Mode

While in dynamic mode, you can use the Configuration Manager to trigger MCE1 port actions to test the quality of the line. MCE1 line tests include

- Transmitting specific codes to the remote end of the MCE1 connection
- Introducing deliberate error patterns into the transmitted BERT (Bit Error Rate Test) bit stream

All actions are MCE1 port-specific. For example, a BERT reset action resets the port-specific series of BERT counters.

You can review the results of your actions by using the Statistics Manager function of the Configuration Manager to review the BERT statistics. For more information on the Statistics Manager, refer to Managing Wellfleet Routers.

Warning  Initiating line tests affects all logical lines associated with that port for the duration of the testing.
To initiate MCE1 actions, click on the Port Details button on the Logical Lines window (Figure 5-15) to display the MCE1 Port Parameters window (Figure 5-17). Then, click on the Line Tests button (dynamic mode only) to display the MCE1 Port Actions window (Figure 5-18).

![Edit Slot 3, MCE1-1 Port Parameters](image)

Figure 5-17. MCE1 Port Parameters Window
### MCE1 Port Actions Window

**Caution:** Select one action at a time and then click on the Apply button. Wait until the MCE1 Port Actions window has been refreshed before issuing another action.

When you are finished with the Port Actions window, click on the Done button. You are returned to the MCE1 Port Configuration window. All changes applied to the port while in the Port Actions window are effective only while the window is active. When you exit the window using the Done button, all port settings revert to the original port settings.

The parameter descriptions for these port actions follow.
Parameter: **BERT Mode Enable**

Default: Disable

Options: Enable | Disable

Function: Selecting Enable activates BERT mode. You do not have to enable BERT mode to perform non-BERT activities on this window, such as loop actions.

Instructions: To enter BERT mode, select Enable and click on Apply.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.2.1.6

Parameter: **BERT Send Alarm**

Default: Disable

Options: AIS (Blue Alarm) | Yellow Alarm | Disable

Function: Specifies the type of alarm signal to be generated while in BERT mode. Select Disable to disable the generation of alarm messages. Select AIS (Blue Alarm) or Yellow Alarm to transmit the corresponding alarm.

Instructions: Select an alarm generation option and click on Apply.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.2.1.22
### BERT Test Pattern

**Parameter:** BERT Test Pattern  
**Default:** All Ones  
**Options:** 0s | Ones | QRSS | 2e15 | 2e15 INV | 2e20 | 2e23 | 2e23 INV  
**Function:** Specifies the bit pattern transmitted during BERT diagnostics. When a port is in BERT mode, it is capable of generating patterns such as all 1s, all 0s, or a QRSS (quasi-random signal sequence) pattern.  
**Instructions:** Select a test pattern and click on Apply.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.8.2.1.21

### International Bit

**Parameter:** International Bit  
**Default:** Enable  
**Options:** Enable/Disable  
**Function:** Specifies if the international bit should be set in the E1 frame.  
**Instructions:** Select Enable to set the international bit, or select Disable.  
**MIB Object ID:** 1.3.6.1.4.1.18.3.4.9.3.1.16
### Parameter: Line Coding

- **Default:** None
- **Default:** HDB3
- **Options:** AMI | HDB3
- **Function:** Selects a line coding method.

AMI line coding is bipolar: a binary 0 is transmitted as zero volts and a binary 1 is transmitted as either a positive or negative pulse, opposite in polarity to the previous pulse. (When configured for AMI line coding, the MCE1 Link Module remains synchronized upon receiving up to 45 consecutive zeros.)

HDB3 (High-Density Bipolar Coding) line coding maintains sufficient ones density within the E1 data stream. It replaces a block of 8 consecutive binary zeros with an 8-bit HDB3 code containing bipolar violations in the 4th and 7th bit positions of the substituted code. In the receive direction, the HDB3 code is detected and replaced with 8 consecutive binary zeros.

- **Instructions:** Specify the line coding method.
- **MIB Object ID:** 1.3.6.1.4.1.18.3.4.8.2.1.10
Parameter: **Line Type**

Default: None

Options: E1 | E1 CRC | E1 MF | E1 CRC MF |

UNFRAMED E1

Function: Selects E1, E1 CRC, E1 MF, or E1 CRC MF framing format.

Instructions: Select E1, E1 CRC, E1 MF, E1 CRC MF, or UNFRAMED E1 based on the frame format required by the associated E1 equipment. MF framing is not supported using BERT.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.2.1.9

Parameter: **Reset BERT Counters**

Default: Reset

Options: None

Function: Resets all counters to zero while the router is in BERT mode.

Instructions: Select this action to reset the counters and click on Apply.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.3

Parameter: **Insert 1 Error**

Default: Insert

Options: None

Function: While the router is in BERT mode, inserts a single (non-repeating) error into the bit stream.

Instructions: Select this action to insert a single error and click on Apply.

MIB Object ID: 1.3.6.1.4.1.18.3.4.8.3.1.6
## Initiating MCE1 Actions in Dynamic Mode

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Insert 1 Error/K</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Insert</td>
</tr>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Function</td>
<td>While the router is in BERT mode, inserts an error into every thousandth position within the bit stream.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Select this action to start the insertion of errors and click on Apply.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Insert 1 Error/1M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Insert</td>
</tr>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Function</td>
<td>While the router is in BERT mode, initiates the introduction of a deliberate error into every millionth position within the bit stream.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Select this action to start the insertion of errors and click on Apply.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Disable Insert Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Disable</td>
</tr>
<tr>
<td>Options</td>
<td>None</td>
</tr>
<tr>
<td>Function</td>
<td>Terminates the introduction of deliberate errors into the transmitted bit stream.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Select this action and click on Apply to stop a previous insertion of errors.</td>
</tr>
<tr>
<td>MIB Object ID</td>
<td>1.3.6.1.4.1.18.3.4.8.3.1.6</td>
</tr>
</tbody>
</table>
Chapter 6
Implementing Configuration Changes

This chapter tells you how to use the Configuration Manager and the Router Files Manager to implement configuration changes.

Configuration Implementation Overview

A local or remote configuration file has no effect until you reboot the router using the configuration file.

You must save changes you make dynamically to a configuration file and then reboot the router with that file to make these changes permanent. If you reboot the router without saving the dynamic changes to a configuration file, the changes are lost.

In general, implementing configuration changes consists of four steps:
1. Saving the configuration file locally
   You only save dynamically made changes to a config file when you want to maintain a permanent record of the changes.
2. Transferring the configuration file to the router using TFTP
3. Rebooting the router with the configuration file
4. Using the Configuration Manager Change utility
Note: When you save a configuration file that was created in local mode, it is saved to the Site Manager workstation. Therefore, you must transfer the file to the router in order to reboot the router with it. When you save a configuration file that was created in remote mode, the file is transferred directly to the router. Use the procedures identified in this chapter when saving files in remote configuration mode or transferring files to the router to avoid corrupting the config file on the router.

If the router has a non-volatile file system (NVFS), you boot the router with the router software image for your specific router platform (for example, \texttt{bn.exe} in the BN, \texttt{asn.exe} in the ASN) and a configuration file residing on a volume you specify. The volume in this case is the slot location of one file system on the router. Each router equipped with an NVFS is shipped with at least one volume. The default volume is displayed in the Boot and File Management windows. These windows allow you to change the volume from which to boot.

If the router has a DOS file system, you boot from the volume named \texttt{A}.

Saving a Configuration File

The Configuration Manager does not create the configuration file until you save the configuration information you specified. The three sections that follow describe how to save a configuration file locally, remotely, or dynamically. Refer to the appropriate section, depending on the configuration option you selected when you started the Configuration Manager.

Saving a Configuration File in Local Configuration Mode

This section describes how to save a configuration created or modified in local mode to a file on the Site Manager workstation.
Implementing Configuration Changes

**Note:** If Site Manager is in local configuration mode, and you want to store the configuration you have just created or modified to a file on the router, follow the instructions in this section to store the file locally. Then follow the instructions in the section “Transferring a Configuration File to the Wellfleet Router.”

To save your file, begin at the Wellfleet Configuration Manager window and complete the following steps.

1. Save the configuration file to the same directory in which Site Manager is located, or to another directory:
   - Select File→Save to save to the same directory.
   - Otherwise, select File→Save As. The Save Configuration File window appears. Specify the appropriate directory by clicking on the Volume button and dragging to the volume of your choice. Then click on the Save button.

2. Click on the OK button when the File Saved pop-up window appears.

Select File→Exit if you want to exit the Wellfleet Configuration Manager window. You are returned to the Wellfleet Site Manager window.

Refer to the section, “Transferring a Configuration File to the Wellfleet Router,” if you want to transfer the configuration file to the router. You must do this if you want to boot the router with this file.

**Saving a Configuration File in Remote Configuration Mode**

This section describes how to save a configuration created or modified in remote configuration mode to a file on the router.
Saving a Configuration File

Warning

Ensure that you have sufficient free space on the router’s memory card or disk before using the Router Files Manager TFTP command to transfer a file to it, or when saving a file in Configuration Manager remote mode. When you use the File→Save or File→Save As options in remote configuration mode, the configuration is automatically transferred to the router’s file system. The destination system in a file transfer automatically overwrites any file already on its volume that has the same filename. If enough space does not exist on the file system for the new file, and the new file has the same name as an old file, the old file will be destroyed and the new file will be corrupt. This is because TFTP copies the new file over the old and runs out of space before completing the copy. Be sure to follow the instructions in this section to avoid corrupting the config file in the router if the Configuration Manager is in remote mode.

The recommended procedure for saving a config file created or modified in remote configuration mode is

1. If the file system on the router is an NVFS, compact the memory card to optimize the available space as follows:
   a. Select Tools→Router Files Manager in the Wellfleet Site Manager window.
      The Wellfleet File System Manager window appears.
   b. Select Commands→Compact.
   c. Click on the OK button in the Confirmation window. (If the file system on the router is DOS, disregard this step.)

2. Select File→Save As from the Wellfleet Configuration Manager window.
3. The Save Configuration File window displays an Enter File name box.

4. Enter a new filename, such as `temp`, and click on the Save button. Do *not* use the filename `config`.

5. Click on the OK button when the File Saved pop-up window appears.

You replace an old configuration file with a new one as follows:

1. Verify the integrity of the new file first by booting with that file (refer to the section "Rebooting a Wellfleet Router with a Configuration File" later in this chapter).

2. Verify that there is enough space on the volume for another copy by selecting Tools→Router Files Manager in the Wellfleet Site Manager window.

   The Wellfleet File System Manager window displays the files, file sizes, and available free space. The contiguous free space displayed in this window applies only to memory cards.

3. Ensure that there is enough space on the volume for the file.

   *DOS Instructions:* Ensure that the space occupied by the new file is not larger than the available free space.

   *NVFS Instructions:* Ensure that the space occupied by the new file is not larger than the contiguous free space.

4. If enough space is available, copy the file to the old filename. Refer to *Managing Wellfleet Routers* for detailed file management instructions.

**Saving a Configuration File in Dynamic Configuration Mode**

If you made changes to the currently active configuration file in the dynamic configuration mode, you may save these changes to a file on the router's file system. This preserves the current configuration file, yet gives you the option to reboot the router with these changes later. When you save these changes, the file is saved directly to the router.
Transferring a Configuration File to the Wellfleet Router

To save your changes, start at the Wellfleet Configuration Manager window, and complete the following steps:

1. Select File→Save As.

   The Save Configuration File window displays an Enter File name box.

2. Enter a new filename to save the configuration file on the router, using the following format:

   filename.cfg

   where filename is the name you are assigning this file, and cfg specifies the file type.

3. If the file system on the router is an NVFS, and the volume (slot location of the memory card on the router) that appears in the Volume box is not the volume to which you want to save this file, click on the Volume box and select an alternate volume. Otherwise, go to the next step.

4. Click on the Save button.

5. Click on the OK button when the File Saved pop-up window appears.

If you want to reboot the router with the file you just created and saved, refer to the section “Rebooting a Wellfleet Router with a Configuration File” for instructions.

Transferring a Configuration File to the Wellfleet Router

The Router Files Manager allows you to transfer files between the Site Manager workstation and any Wellfleet router using TFTP. You must transfer a configuration file that has been configured and saved in local mode to the router before you can reboot the router with it.
Warning  The destination system in a file transfer automatically overwrites any file already on its volume that has the same filename. If enough space does not exist on the file system for the new file, and the new file has the same name as an old file, the old file will be destroyed and the new file will be corrupted. This is because TFTP copies the new file over the old and runs out of space before completing the copy. Be sure to follow the instructions in this section to avoid corrupting the config file.

Transferring files from the Site Manager workstation to a router involves the following steps:

1. Choosing the router to which you want to transfer the file.
2. Examining the existing filenames on the router destination volume.
3. Verifying the existence of adequate free space on the destination volume.
4. Transferring the file to the destination volume.

To choose the router to which you want to transfer the file, follow these steps from the Router Files Manager window:

1. Select Options→Router Connection from the Router Files Manager window.
   The Router Connection Options window appears (Figure 6-1).
2. Enter the IP address of the router and click on OK.
Figure 6-1. Router Connection Options Window

You should choose a filename that is unique to the router when transferring the file. The names of the files currently on the router are displayed in the Router Files Manager window (Figure 6-2).
You must make sure that the router destination volume has enough
space available for the file you transfer. The Router Files Manager
window shows the available free space and contiguous free space on
the router. For a DOS file system, use the number of bytes displayed
for available free space. For an NVFS file system, use the number of
bytes displayed for contiguous free space.

If the file system on the router is an NVFS, compact the memory card
to optimize the available space as follows:

1. Select Commands ➔ Compact in the Router Files Manager window.
2. Click on the OK button on the Confirmation window.

To transfer a file from the Site Manager workstation to the router, select File→TFTP→Put File(s) from the Router Files Manager window. The TFTP Put File Selection window appears (Figure 6-3).

![TFTP Put File Selection Window](image)

Figure 6-3. TFTP Put File Selection Window

1. In the Path box, enter the pathname of the directory on the Site Manager workstation that contains the file you want to transfer. The files in that directory appear in the Files window. You may transfer more than one file at a time.

2. In the Files window, click on the files that you want to transfer to the router. Then click on Add. The selected files appear in the Files To Put window.
If you inadvertently add files that you do not want to transfer to the router, select those files in the Files To Put window and click on Remove.

3. Repeat Steps 1 and 2 to select files from other directories that you want to transfer to the router.

4. If you want to send files to only one router, click on No in the Multiple Routers field. The Router Files Manager transfers the selected files to the router to which you are currently connected.

Refer to Managing Wellfleet Routers for information on transferring files to multiple routers.

5. Click on OK.

During the file transfer operation, the Router Files Manager displays a message in the window indicating which file is currently being transferred, and the address of the router that is receiving the files. When the transfer is complete, the TFTP Put File Selection window closes and you return to the Router Files Manager window.

Now that you have transferred your configuration file to the router, you can reboot the router with it. The next section provides instructions.

You replace an old configuration file with a new one as follows:

1. Verify the integrity of the new file first by booting with that file.

2. Verify that there is enough space on the volume for another copy by selecting Tools → Router Files Manager from the Wellfleet Site Manager window.

The Router Files Manager window displays the files, file sizes, and available free space. The contiguous free space displayed in this window applies only to memory cards.

3. Ensure that there is enough space on the volume for the file.

DOS Instructions: Ensure that the space occupied by the new file is not larger than the available free space.

NVFS Instructions: Ensure that the space occupied by the new file is not larger than the contiguous free space.
4. If enough space is available, copy the file to the old filename. Refer to *Managing Wellfleet Routers* for detailed file management instructions.

**Rebooting a Wellfleet Router with a Configuration File**

After you save a configuration file to the router, you implement the configuration by rebooting the router with that configuration file. You begin from the Wellfleet Site Manager window and proceed as follows:

1. Select Administration→Boot Router.

The Boot Router window appears (Figure 6-4). The default volume is displayed next to the Boot Image file (`bn.exe`) and default configuration file (`config`). The default volume is the first available memory access card (indicated by slot number) on a router with an NVFS or volume A on a router with a DOS file system.

Refer to Step 2 if you want to boot from the default volumes and configuration file.

![Boot Router Window](image)

**Figure 6-4. Boot Router Window**

If the router has multiple volumes, you can select one volume from which to read the router software image and another from which to read the configuration file, as follows:

a. Click on the rectangle adjacent to the Boot Image volume number.
Implementing Configuration Changes

A pop-up window displays the available volumes containing the router software image.

b. Click on the number of the slot from which you want to boot.

The pop-up window closes and the new slot number is displayed next to Boot Image.

c. Click on the rectangle adjacent to the Configuration slot number.

A pop-up window displays the available slots containing the configuration file.

d. Click on the number of the slot you want to configure from.

The pop-up window closes and the new slot number is displayed.

Enter the configuration filename in the Configuration filename box if you want to configure from an alternative file. When you select the Boot button, the router boots using the router software image and configuration files in the volumes displayed.

2. Click on the Boot button.

The router boots using the router software image and the configuration file you specified.

**Note:** The router software image and configuration file revert to their respective default volumes and filenames (*boot.exe* or *ace.out* and *config*) after every boot. To change the default boot or configuration file, back up the old default file, using the copy option; then overwrite the old default file with the new default file, using the copy option.

After you successfully reboot the router with a configuration file, and it is up and running on your network, it is actively routing and bridging traffic.
Configuration Change Utility

The Configuration Change utility is a Site Manager feature that enables you to change an existing configuration file so that it operates on an identical router model. You can develop a standard configuration file, apply it to applicable routers, and then customize as needed.

A series of windows prompt you for the information necessary to move a configuration file to an identical router without having to create the configuration from scratch. This utility is helpful in configuring multiple routers.

Protocols that are not configured are skipped in the window sequence.

Basic Operation

In local mode, select File→Profiler from the Wellfleet Configuration Manager window (Figure 6-5). The Configuration Change utility displays windows with the parameters to edit for each configured protocol.

![Configuration Manager Window](image)

Figure 6-5. Configuration Manager Window
The following sections summarize the windows that can appear for each protocol. The parameters to be edited on each window are documented in the section on the corresponding protocol elsewhere in this manual.

**Source Routing Global Profile**

The Source Routing Global Profile window (Figure 6-6) displays the Source Routing Bridge Internal LAN ID. Edit this parameter, as needed.

![Source Routing Global Profile Window](image)

**Source Routing Interface Profile Window**

The Source Routing Interface Profile window (Figure 6-7) displays the Source Routing Ring Number. Edit this parameter, as needed.
IP Interface Profiles Window

The IP Interface Profiles window (Figure 6-8) lists all IP interfaces in the configuration. Add a new IP address and edit the Subnet Mask and Broadcast Address parameters, as needed. If you change an IP address in this window, the system modifies all related objects with the old address to reflect the new IP address.
Implementing Configuration Changes

SNMP Manager Profiles Window

The SNMP Manager Profiles window (Figure 6-9) lists all SNMP managers in the current configuration. Edit the Trap Port and Trap Types fields for the selected SNMP manager, as needed.
The DECnet Interface Profiles window (Figure 6-10) displays the New Area ID and the New Node ID. Edit these parameters, as needed.
The VINES Interface Profiles window (Figure 6-11) lists the following parameters:

- SMDS Broadcast
- Frame Relay Broadcast
- Configured MAC Addresses

Edit any of these parameters, as needed.
The IPX Interface Profiles window (Figure 6-12) lists the New Network Address. Edit this parameter, as needed.
Implementing Configuration Changes

The AppleTalk Interface Profiles window (Figure 6-13) lists the following parameters:

- Network Start
- Network End
- Default Zone
- Network ID
- Node ID

Edit any of these parameters, as needed.
The OSI Profiles Window

The OSI Profiles window (Figure 6-14) lists the following parameters to enter in hex format:

- Router ID
- Area Address

Edit any of these parameters, as needed.
Implementing Configuration Changes

The X.25 Packet Level Profiles window (Figure 6-15) displays the following X.25 packet level parameters:

- Network Address Type
- PDN X.121 Address
- DDN IP Address
- Incoming Logical Channel Count
- Incoming LCN Start
- Bidirectional Logical Channel Count
- Bidirectional LCN Start
- Outgoing Logical Channel Count
- Outgoing LCN Start

Edit any of these parameters, as needed.
The X.25 Service Profile window (Figure 6-16) displays the following X.25 service-level parameters:

- Connection ID
- Remote IP Address
- Remote X.121 Address

Edit any of these parameters, as needed.
Implementing Configuration Changes

Connection ID
Remote IP Address  192.32.156.1
Remote X.121 Address  234

Figure 6-16. X.25 Service Profile Window
Appendix A
Site Manager Default Settings

This appendix lists the default settings for Site Manager. Use the Configuration Manager to edit any of the Site Manager default settings listed here.

Circuit Parameters

Site Manager supports Ethernet, FDDI, synchronous, asynchronous, E1, T1, Token Ring, MCT1, MCE1, HSSI, and ISDN circuits. The following sections describe the Site Manager default parameter settings for these circuits.

Table A-1.  Ethernet Circuit Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Timeout</td>
<td>5 s</td>
</tr>
<tr>
<td>Hardware Filter</td>
<td>Disable (this default is changed to Enable if you add a circuit and reply OK to the prompt Do you want to enable Hardware Filters on this circuit?)</td>
</tr>
</tbody>
</table>
## Table A-2. FDDI Circuit Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Timeout</td>
<td>3 s</td>
</tr>
<tr>
<td>Hardware Filter</td>
<td>Disable (this default is changed to Enable if you add a circuit and reply OK to the prompt Do you want to enable Hardware Filters on this circuit?)</td>
</tr>
</tbody>
</table>

## Table A-3. FDDI SMT Attributes Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Policy</td>
<td>0xff65</td>
</tr>
<tr>
<td>T_Notify Timeout (s)</td>
<td>22 s</td>
</tr>
<tr>
<td>Trace Max Expiration (ms)</td>
<td>7000 ms (7 s)</td>
</tr>
<tr>
<td>Status Report Protocol</td>
<td>Enable</td>
</tr>
<tr>
<td>Duplicate Address Protocol</td>
<td>Enable</td>
</tr>
<tr>
<td>User Data</td>
<td>None</td>
</tr>
</tbody>
</table>

## Table A-4. FDDI MAC Attributes Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>LLC Data Enable</td>
<td>Enable</td>
</tr>
</tbody>
</table>
### Table A-5. FDDI Path Attributes Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tvx Lower Bound (ms)</td>
<td>2.5 ms</td>
</tr>
<tr>
<td>T_Max Lower Bound (ms)</td>
<td>165 ms</td>
</tr>
<tr>
<td>Requested TTRT (ms)</td>
<td>165 ms</td>
</tr>
</tbody>
</table>

### Table A-6. FDDI Port Attributes Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>LER Cutoff</td>
<td>7</td>
</tr>
<tr>
<td>LER Alarm</td>
<td>8</td>
</tr>
</tbody>
</table>

### Table A-7. Synchronous Circuit Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL</td>
<td>Enable (Disable if X.25 is enabled)</td>
</tr>
<tr>
<td>BOFL Timeout</td>
<td>5 s</td>
</tr>
<tr>
<td>MTU (Maximum Transfer Unit)</td>
<td>1600 B</td>
</tr>
<tr>
<td>Promiscuous</td>
<td>Disable</td>
</tr>
<tr>
<td>Clock Source</td>
<td>External</td>
</tr>
<tr>
<td>Internal Clock Speed</td>
<td>64 KB</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-7. Synchronous Circuit Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Clock Speed</td>
<td>64102 B</td>
</tr>
<tr>
<td>Signal Mode</td>
<td>Balanced</td>
</tr>
<tr>
<td>RTS Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>Burst Count</td>
<td>Enable</td>
</tr>
<tr>
<td>Service</td>
<td>LLC1 (LAPB if X.25 is enabled)</td>
</tr>
<tr>
<td>Transmit Window Size</td>
<td>1</td>
</tr>
<tr>
<td>Minimum Frame Spacing</td>
<td>1 flag</td>
</tr>
<tr>
<td>Local Address</td>
<td>Explicit (DCE or DTE if X.25 is enabled)</td>
</tr>
<tr>
<td>Remote Address</td>
<td>Explicit (DCE or DTE if X.25 is enabled)</td>
</tr>
<tr>
<td>WAN Protocol</td>
<td>None</td>
</tr>
<tr>
<td>Pass Thru Local Address</td>
<td>None</td>
</tr>
<tr>
<td>Pass Thru Remote Address</td>
<td>None</td>
</tr>
<tr>
<td>CRC Size</td>
<td>16-bit</td>
</tr>
<tr>
<td>Sync Media Type</td>
<td>1</td>
</tr>
<tr>
<td>Sync Polling</td>
<td>Disable</td>
</tr>
<tr>
<td>KG84A Cycle</td>
<td>100 ms</td>
</tr>
<tr>
<td>KG84A Sync Loss Interval</td>
<td>50 cycles</td>
</tr>
<tr>
<td>KG84A Remote Sync Wait</td>
<td>200 cycles</td>
</tr>
<tr>
<td>KG84A Sync Pulse</td>
<td>10 ms</td>
</tr>
<tr>
<td>Network Link Level</td>
<td>NET2</td>
</tr>
<tr>
<td>Retry Count</td>
<td>16 attempts</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-7. Synchronous Circuit Parameters (*continued*)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Idle Timer</td>
<td>9 s</td>
</tr>
<tr>
<td>Extended Control (S and I frames)</td>
<td>Disable</td>
</tr>
<tr>
<td>Idle Receiver Ready (RR) Frames</td>
<td>Off</td>
</tr>
<tr>
<td>Cable Type</td>
<td>Null</td>
</tr>
<tr>
<td>Retry Timer</td>
<td>3 s</td>
</tr>
<tr>
<td>Extended Address</td>
<td>Disable</td>
</tr>
<tr>
<td>Remote Loopback Detection</td>
<td>Disable</td>
</tr>
</tbody>
</table>

Table A-8. LAPB Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Station Type</td>
<td>DTE</td>
</tr>
<tr>
<td>Control Field</td>
<td>Modulo 8</td>
</tr>
<tr>
<td>Max N1 Frame Size (octets)</td>
<td>1600</td>
</tr>
<tr>
<td>Max Unacknowledged Sequence Frames</td>
<td>7</td>
</tr>
<tr>
<td>N2 Retries</td>
<td>10</td>
</tr>
<tr>
<td>Max T1 Acknowledge Timer (s)</td>
<td>3 s</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-8. LAPB Parameters (continued)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max T2 Acknowledge Delay Timer (s)</td>
<td>1 second</td>
</tr>
<tr>
<td>Max T3 Disconnect Timer (s)</td>
<td>60 s</td>
</tr>
<tr>
<td>Initiate Link Setup Action</td>
<td>Active</td>
</tr>
<tr>
<td>Enable Rx/Tx of XID Frames</td>
<td>Enable</td>
</tr>
<tr>
<td>Idle RR Frames</td>
<td>OFF</td>
</tr>
<tr>
<td>Command/Response Address</td>
<td>DTE</td>
</tr>
<tr>
<td>WAN Protocol</td>
<td>Standard</td>
</tr>
</tbody>
</table>

### Table A-9. Asynchronous Circuit Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>MTU</td>
<td>1000 B</td>
</tr>
<tr>
<td>Start Protocol</td>
<td>Answer</td>
</tr>
<tr>
<td>Remote IP Address</td>
<td>None</td>
</tr>
<tr>
<td>Remote Port</td>
<td>7</td>
</tr>
<tr>
<td>Local Port</td>
<td>2100</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Idle Timer</td>
<td>20</td>
</tr>
<tr>
<td>Receive Window</td>
<td>4096</td>
</tr>
<tr>
<td>TCP KeepAlive</td>
<td>8</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-9.  Asynchronous Circuit Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP Inactive Limit</td>
<td>300</td>
</tr>
<tr>
<td>Cfg Transmit Queue (TxQ) Length</td>
<td>None</td>
</tr>
<tr>
<td>Cfg Receive Queue (RxQ) Length</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-10.  T1 Circuit Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Frame Type</td>
<td>ESF</td>
</tr>
<tr>
<td>B8ZS Support</td>
<td>Disable</td>
</tr>
<tr>
<td>Line Buildout</td>
<td>1 ft</td>
</tr>
<tr>
<td>Clock Mode</td>
<td>Internal</td>
</tr>
<tr>
<td>Mini Dacs</td>
<td>Idle</td>
</tr>
</tbody>
</table>

Table A-11.  Token Ring Circuit Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>MAC Address Override</td>
<td>None</td>
</tr>
<tr>
<td>MAC Address Select</td>
<td>Boxwide</td>
</tr>
</tbody>
</table>

continued on the next page
Table A-11. Token Ring Circuit Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>16 MB/s</td>
</tr>
<tr>
<td>Early Token Release</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-12. MCT1 Set Clock Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Clock</td>
<td>Port 1 Ext Loop</td>
</tr>
<tr>
<td>Secondary Clock</td>
<td>Internal</td>
</tr>
</tbody>
</table>

Table A-13. MCT1 Port Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>MTU Size</td>
<td>1600 B</td>
</tr>
<tr>
<td>Line Type</td>
<td>ESF</td>
</tr>
<tr>
<td>Line Coding</td>
<td>B8ZS</td>
</tr>
<tr>
<td>Signal Level</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Setup Alarm Threshold</td>
<td>2 s</td>
</tr>
<tr>
<td>Clear Alarm Threshold</td>
<td>2 s</td>
</tr>
<tr>
<td>FDL Configuration</td>
<td>ANSI T1.403</td>
</tr>
<tr>
<td>Remote FDL HDLC Address Mode</td>
<td>BY</td>
</tr>
</tbody>
</table>

continued on the next page
### Table A-13. MCT1 Port Parameters (continued)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Local Loopback</td>
<td>Enable</td>
</tr>
<tr>
<td>Loopback Configuration</td>
<td>No Loopback</td>
</tr>
</tbody>
</table>

### Table A-14. MCT1 Logical Line Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Timeout</td>
<td>5 s</td>
</tr>
<tr>
<td>Fractional Loopback</td>
<td>Disable</td>
</tr>
<tr>
<td>WAN Protocol</td>
<td>Standard</td>
</tr>
<tr>
<td>Service</td>
<td>LLC1</td>
</tr>
<tr>
<td>Local HDLC Address</td>
<td>7</td>
</tr>
<tr>
<td>Remote HDLC Address</td>
<td>7</td>
</tr>
<tr>
<td>Rate Adaptation</td>
<td>56 K LSB</td>
</tr>
<tr>
<td>InterFrame Time Fill Character</td>
<td>Flags</td>
</tr>
<tr>
<td>CRC Size</td>
<td>16-bit</td>
</tr>
</tbody>
</table>

*continued on the next page*
## Table A-15. MCT1 Port Actions Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Type</td>
<td>None</td>
</tr>
<tr>
<td>Line Coding</td>
<td>None</td>
</tr>
<tr>
<td>Signal Level</td>
<td>None</td>
</tr>
<tr>
<td>Reset BERT Counters</td>
<td>Reset</td>
</tr>
<tr>
<td>Loop Up</td>
<td>Transmit</td>
</tr>
<tr>
<td>Loop Down</td>
<td>Transmit</td>
</tr>
<tr>
<td>FDL Payload Loop</td>
<td>Transmit</td>
</tr>
<tr>
<td>FDL Disable Payload Loop</td>
<td>Transmit</td>
</tr>
<tr>
<td>FDL Line Loop CI</td>
<td>Transmit</td>
</tr>
<tr>
<td>FDL Line Loop IA</td>
<td>Transmit</td>
</tr>
<tr>
<td>FLD Line Loop IB</td>
<td>Transmit</td>
</tr>
<tr>
<td>FDL Disable Line Loop</td>
<td>Transmit</td>
</tr>
<tr>
<td>FDL Disable All</td>
<td>Transmit</td>
</tr>
</tbody>
</table>

## Table A-16. MCE1 Set Clock Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Clock</td>
<td>Port 1 Ext Loop</td>
</tr>
<tr>
<td>Secondary Clock</td>
<td>Internal</td>
</tr>
</tbody>
</table>
### Table A-17. MCE1 Port Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Line Type</td>
<td>E1</td>
</tr>
<tr>
<td>Line Coding</td>
<td>HDB3</td>
</tr>
<tr>
<td>Setup Alarm Threshold</td>
<td>2 s</td>
</tr>
<tr>
<td>Clear Alarm Threshold</td>
<td>2 s</td>
</tr>
<tr>
<td>International Bit</td>
<td>Disable</td>
</tr>
</tbody>
</table>

### Table A-18. MCE1 Logical Line Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Timeout</td>
<td>5 s</td>
</tr>
<tr>
<td>Fractional Loopback</td>
<td>Disable</td>
</tr>
<tr>
<td>WAN Protocol</td>
<td>Standard</td>
</tr>
<tr>
<td>Service</td>
<td>LLC1</td>
</tr>
<tr>
<td>Local HDLC Address</td>
<td>7</td>
</tr>
<tr>
<td>Remote HDLC Address</td>
<td>7</td>
</tr>
<tr>
<td>Rate Adaptation</td>
<td>64 K LSB</td>
</tr>
<tr>
<td>InterFrame Time Fill Character</td>
<td>Flags</td>
</tr>
</tbody>
</table>
Table A-18. MCE1 Logical Line Parameters (continued)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRC Size</td>
<td>16-bit</td>
</tr>
<tr>
<td>MTU Size</td>
<td>1600</td>
</tr>
</tbody>
</table>

Table A-19. MCE1 Port Actions Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>BERT Mode Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>BERT Send Alarm</td>
<td>Disable</td>
</tr>
<tr>
<td>BERT Test Pattern</td>
<td>Ones</td>
</tr>
<tr>
<td>International Bit</td>
<td>Enable</td>
</tr>
<tr>
<td>Line Coding</td>
<td>None</td>
</tr>
<tr>
<td>Line Type</td>
<td>None</td>
</tr>
<tr>
<td>Auto Ebit</td>
<td>Enable</td>
</tr>
<tr>
<td>Reset BERT Counters</td>
<td>Reset</td>
</tr>
<tr>
<td>Insert 1 Error</td>
<td>Insert</td>
</tr>
<tr>
<td>Insert 1 Error/1K</td>
<td>Insert</td>
</tr>
<tr>
<td>Insert 1 Error/1M</td>
<td>Insert</td>
</tr>
<tr>
<td>Disable Insert Error</td>
<td>Disable</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL</td>
<td>Enable</td>
</tr>
<tr>
<td>BOFL Frequency</td>
<td>1 s</td>
</tr>
<tr>
<td>MTU (Maximum Transfer Unit)</td>
<td>4495 B</td>
</tr>
<tr>
<td>WAN Protocol</td>
<td>None</td>
</tr>
<tr>
<td>Transmission Interface</td>
<td>DS3</td>
</tr>
<tr>
<td>External Clock Speed</td>
<td>46359642 (44.736 MB/s)</td>
</tr>
<tr>
<td>CRC Size</td>
<td>32-bit</td>
</tr>
</tbody>
</table>

**Table A-21. ISDN Circuit Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Type</td>
<td>BRIVN3</td>
</tr>
<tr>
<td>Local Phone Number</td>
<td>None</td>
</tr>
<tr>
<td>Local Phone Extension</td>
<td>None</td>
</tr>
<tr>
<td>Acceptable LAPD MTUs</td>
<td>400 B</td>
</tr>
<tr>
<td>BRI Timer Timeout</td>
<td>10 s</td>
</tr>
<tr>
<td>BRI B Channel Loopback</td>
<td>Disable</td>
</tr>
<tr>
<td>Configuration Type</td>
<td>BRIVN3</td>
</tr>
</tbody>
</table>

*continued on the next page*
**WAN Protocol Parameters**

This section describes the Site Manager default parameter settings for the Frame Relay, SMDS, SDLC, X.25, ATM DXI, ATM FRE2, and Point-to-Point (PPP) protocols, including the Wellfleet Compression Protocol (WCP).

**Table A-22. Frame Relay Interface Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Mgmnt Type</td>
<td>ANSI T1 617D</td>
</tr>
<tr>
<td>Address</td>
<td>Addr Q922</td>
</tr>
<tr>
<td>Address Length</td>
<td>2 B</td>
</tr>
<tr>
<td>Polling Interval</td>
<td>10 s</td>
</tr>
<tr>
<td>Full Enquiry Interval</td>
<td>6</td>
</tr>
<tr>
<td>Error Threshold</td>
<td>3</td>
</tr>
<tr>
<td>Monitored Events</td>
<td>4</td>
</tr>
<tr>
<td>Multicast</td>
<td>Enable</td>
</tr>
<tr>
<td>Congestion Control</td>
<td>Disable</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-22. Frame Relay Interface Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Congestion Timer</td>
<td>1 s</td>
</tr>
<tr>
<td>Congestion Counter</td>
<td>20 notifications</td>
</tr>
</tbody>
</table>

### Table A-23. Frame Relay PVC Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circuit State Set</td>
<td>Active</td>
</tr>
<tr>
<td>Multicast</td>
<td>Unicast</td>
</tr>
<tr>
<td>Mode</td>
<td>Group Access</td>
</tr>
<tr>
<td>Congestion Control</td>
<td>Inherit</td>
</tr>
<tr>
<td>Congestion Timer</td>
<td>1 s</td>
</tr>
</tbody>
</table>

### Table A-24. SMDS Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Individual Address</td>
<td>None</td>
</tr>
<tr>
<td>Group Address</td>
<td>None</td>
</tr>
<tr>
<td>ARP Address</td>
<td>None</td>
</tr>
<tr>
<td>Heartbeat Poll</td>
<td>Disable</td>
</tr>
<tr>
<td>Heartbeat Poll Interval</td>
<td>10 s</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-24. SMDS Interface Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heartbeat Poll Down Count</td>
<td>3 messages</td>
</tr>
<tr>
<td>LMI Network Mgmt</td>
<td>Disable</td>
</tr>
<tr>
<td>Congestion Counter</td>
<td>20 notifications</td>
</tr>
</tbody>
</table>

### Table A-25. SDLC Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Port Name</td>
<td>None</td>
</tr>
<tr>
<td>Line Type</td>
<td>Leased</td>
</tr>
<tr>
<td>Topology</td>
<td>PTOP (Point-to-Point)</td>
</tr>
<tr>
<td>No Activity Timer</td>
<td>15 s</td>
</tr>
<tr>
<td>Poll List Traversal Time</td>
<td>20 tenths of a second</td>
</tr>
<tr>
<td>Initial Flow Control Credit</td>
<td>7</td>
</tr>
<tr>
<td>Idle Line Timer</td>
<td>10000 ms</td>
</tr>
<tr>
<td>Idle Retry Limit</td>
<td>64</td>
</tr>
<tr>
<td>Non-Productive Timer</td>
<td>1000 ms</td>
</tr>
<tr>
<td>Non-productive Retry Limit</td>
<td>6400</td>
</tr>
<tr>
<td>Port Write Timer</td>
<td>10000 ms</td>
</tr>
<tr>
<td>Port Write Retry Limit</td>
<td>64</td>
</tr>
<tr>
<td>Link Connection Timer</td>
<td>10000 ms</td>
</tr>
</tbody>
</table>

*continued on the next page*
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Connection Retry Limit</td>
<td>64</td>
</tr>
<tr>
<td>Primary Full Duplex</td>
<td>True</td>
</tr>
<tr>
<td>Secondary Full Duplex</td>
<td>True</td>
</tr>
<tr>
<td>Enable Reject Frame</td>
<td>True</td>
</tr>
<tr>
<td>Port Type</td>
<td>Leased</td>
</tr>
<tr>
<td>Max XID Size</td>
<td>256</td>
</tr>
<tr>
<td>Max Frame Retransmit Count</td>
<td>5</td>
</tr>
<tr>
<td>Max Frame Size</td>
<td>PDU2057</td>
</tr>
<tr>
<td>DLC Name</td>
<td>None</td>
</tr>
<tr>
<td>Local CP Type</td>
<td>Network</td>
</tr>
<tr>
<td>Link Station Role</td>
<td>Primary</td>
</tr>
<tr>
<td>Port Number</td>
<td>1</td>
</tr>
<tr>
<td>Link Station Address</td>
<td>None</td>
</tr>
<tr>
<td>Total Link Station Limit</td>
<td>4</td>
</tr>
<tr>
<td>Inbound Link Station Limit</td>
<td>2</td>
</tr>
<tr>
<td>Outbound Link Station Limit</td>
<td>2</td>
</tr>
<tr>
<td>Support Negotiable Connect</td>
<td>True</td>
</tr>
<tr>
<td>Receive Buffer Pool Size</td>
<td>7</td>
</tr>
<tr>
<td>Enable Stats Collection</td>
<td>False</td>
</tr>
</tbody>
</table>
Table A-26. SDLC Link Station Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Station Address</td>
<td>None</td>
</tr>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Group Address</td>
<td>0</td>
</tr>
<tr>
<td>Link Station Role</td>
<td>Primary</td>
</tr>
<tr>
<td>Max PDU Size</td>
<td>None</td>
</tr>
<tr>
<td>Required Reply Timer</td>
<td>10 tenths of a second</td>
</tr>
<tr>
<td>Max Un-Acked In Frames</td>
<td>7</td>
</tr>
<tr>
<td>Max Un-Acked Out Frames</td>
<td>7</td>
</tr>
<tr>
<td>Window Size</td>
<td>8</td>
</tr>
<tr>
<td>Transmit Retry SEQ's</td>
<td>20</td>
</tr>
<tr>
<td>Retry SEQ's Interval</td>
<td>2 s</td>
</tr>
<tr>
<td>Max Retry SEQ's to Frame</td>
<td>4</td>
</tr>
<tr>
<td>Max Time in RNR State</td>
<td>3 min</td>
</tr>
<tr>
<td>Initial Contact Timer</td>
<td>4000 ms</td>
</tr>
<tr>
<td>Initial Contact Retry Limit</td>
<td>4</td>
</tr>
<tr>
<td>Slow Poll Contact Timer</td>
<td>4000 ms</td>
</tr>
<tr>
<td>Slow Poll Retry Limit</td>
<td>4</td>
</tr>
<tr>
<td>Retransmit DISC Timer</td>
<td>4000 ms</td>
</tr>
<tr>
<td>Retransmit DISC Retry Limit</td>
<td>4</td>
</tr>
<tr>
<td>Slow Poll List Timer</td>
<td>4000 ms</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-26. SDLC Link Station Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slow Poll List Retry Limit</td>
<td>4</td>
</tr>
<tr>
<td>Time on Slow Poll List</td>
<td>4000 ms</td>
</tr>
<tr>
<td>Max Times on Slow Poll List</td>
<td>4000</td>
</tr>
<tr>
<td>Retry Count to Failure</td>
<td>400</td>
</tr>
<tr>
<td>Busy Link Station Limit</td>
<td>400</td>
</tr>
<tr>
<td>Max Wait for RR</td>
<td>1500 ms</td>
</tr>
<tr>
<td>Group Address Name</td>
<td>None</td>
</tr>
<tr>
<td>Pre-Activation Poll Frame</td>
<td>XID</td>
</tr>
<tr>
<td>Send Poll on I-Frame</td>
<td>True</td>
</tr>
<tr>
<td>Link Station Name</td>
<td>None</td>
</tr>
<tr>
<td>Link Station Flow Control</td>
<td>False</td>
</tr>
<tr>
<td>Adjacent Node Type</td>
<td>None</td>
</tr>
<tr>
<td>Support SIM/RIM</td>
<td>False</td>
</tr>
</tbody>
</table>

Table A-27. X.25 Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
</tbody>
</table>
## Table A-28. X.25 Packet-Level Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Network Address Type</td>
<td>None</td>
</tr>
<tr>
<td>PDN X.121 Address</td>
<td>None</td>
</tr>
<tr>
<td>DDN IP Address</td>
<td>None</td>
</tr>
<tr>
<td>Sequence Size</td>
<td>MOD8</td>
</tr>
<tr>
<td>Restart Procedure Type</td>
<td>DTE_Restart (for DTE)/DCE_Restart (for DCE)</td>
</tr>
<tr>
<td>Default Tx/Rx Window Size</td>
<td>2</td>
</tr>
<tr>
<td>Default Tx/Rx Pkt Length</td>
<td>128</td>
</tr>
<tr>
<td>Incoming Logical Count</td>
<td>0</td>
</tr>
<tr>
<td>Incoming LCN Start</td>
<td>0</td>
</tr>
<tr>
<td>Bidirectional Logical Channel Count</td>
<td>0</td>
</tr>
<tr>
<td>Bidirectional LCN Start</td>
<td>0</td>
</tr>
<tr>
<td>Outgoing Logical Channel Count</td>
<td>0</td>
</tr>
<tr>
<td>Outgoing LCN Start</td>
<td>0</td>
</tr>
<tr>
<td>T1 Timer</td>
<td>60 s</td>
</tr>
<tr>
<td>T2 Timer</td>
<td>180 s</td>
</tr>
<tr>
<td>T3 Timer</td>
<td>200 ms</td>
</tr>
<tr>
<td>T4 Timer</td>
<td>200 ms</td>
</tr>
<tr>
<td>Flow Control Negotiation</td>
<td>Off</td>
</tr>
</tbody>
</table>
Table A-28. X.25 Packet-Level Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Window Size</td>
<td>2</td>
</tr>
<tr>
<td>Max Packet Length</td>
<td>128</td>
</tr>
<tr>
<td>Tx/Rx Throughput Class</td>
<td>3</td>
</tr>
<tr>
<td>Throughput Class Negotiation</td>
<td>Off</td>
</tr>
<tr>
<td>Max Throughput Class</td>
<td>19200</td>
</tr>
<tr>
<td>Network User Identification</td>
<td>Off</td>
</tr>
<tr>
<td>Incoming Calls Accept</td>
<td>On</td>
</tr>
<tr>
<td>Outgoing Calls Accept</td>
<td>On</td>
</tr>
<tr>
<td>Fast Select Accept</td>
<td>Off</td>
</tr>
<tr>
<td>Reverse Charge Accept</td>
<td>Off</td>
</tr>
<tr>
<td>Fast Select</td>
<td>Off</td>
</tr>
<tr>
<td>Reverse Charging</td>
<td>Off</td>
</tr>
<tr>
<td>CUG Selection</td>
<td>Null</td>
</tr>
<tr>
<td>CUG Outgoing Access</td>
<td>Null</td>
</tr>
<tr>
<td>CUG Bilateral Selection</td>
<td>Null</td>
</tr>
<tr>
<td>RPOA Selection</td>
<td>Off</td>
</tr>
<tr>
<td>Charging Information</td>
<td>Off</td>
</tr>
<tr>
<td>Transit Delay</td>
<td>Off</td>
</tr>
<tr>
<td>Full Addressing</td>
<td>On</td>
</tr>
<tr>
<td>Acceptance Format</td>
<td>Basic (2)</td>
</tr>
<tr>
<td>Release Format</td>
<td>Basic (2)</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-28. X.25 Packet-Level Parameters (continued)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCITT Conformance</td>
<td>DXE1988</td>
</tr>
<tr>
<td>Network Standard</td>
<td>None</td>
</tr>
<tr>
<td>Statistics Computation</td>
<td>Enable</td>
</tr>
</tbody>
</table>

### Table A-29. X.25 Network Service Records Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Type</td>
<td>None</td>
</tr>
<tr>
<td>Connection ID</td>
<td>1</td>
</tr>
<tr>
<td>Remote IP Address</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Remote X.121 Address</td>
<td>None</td>
</tr>
<tr>
<td>Broadcast</td>
<td>Off</td>
</tr>
<tr>
<td>Max Connections</td>
<td>2</td>
</tr>
<tr>
<td>Precedence</td>
<td>Off</td>
</tr>
<tr>
<td>Max Idle (Mins)</td>
<td>2</td>
</tr>
<tr>
<td>Call Retry</td>
<td>60</td>
</tr>
<tr>
<td>Flow Facility</td>
<td>Default</td>
</tr>
<tr>
<td>Window Size</td>
<td>2</td>
</tr>
<tr>
<td>Packet Size</td>
<td>128</td>
</tr>
<tr>
<td>Fast Select Request</td>
<td>Off</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-29.  X.25 Network Service Records Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Select Accept</td>
<td>Off</td>
</tr>
<tr>
<td>Reverse Charge Request</td>
<td>Off</td>
</tr>
<tr>
<td>Reverse Charge Accept</td>
<td>Off</td>
</tr>
<tr>
<td>DDN BFE</td>
<td>Disable</td>
</tr>
<tr>
<td>User Facility (hex)</td>
<td>None</td>
</tr>
<tr>
<td>CUG Facility Format</td>
<td>None</td>
</tr>
<tr>
<td>CUG Facility Type</td>
<td>Normal</td>
</tr>
<tr>
<td>CUG Number</td>
<td>0</td>
</tr>
</tbody>
</table>

Table A-30.  ATM DXI Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Interface Description</td>
<td>None</td>
</tr>
<tr>
<td>DXI Mode</td>
<td>Mode 1A</td>
</tr>
<tr>
<td>Max # VCs</td>
<td>512</td>
</tr>
<tr>
<td>Multi Protocol Encapsulation</td>
<td>RFC 1483 Style MPE</td>
</tr>
<tr>
<td>CS PDU Encapsulation</td>
<td>AAL5 Encapsulation</td>
</tr>
<tr>
<td>Multicast</td>
<td>Disable</td>
</tr>
<tr>
<td>LMI Enable</td>
<td>Disable</td>
</tr>
</tbody>
</table>
Table A-31. ATM DXI Virtual Circuit Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>VPI Number</td>
<td>None</td>
</tr>
<tr>
<td>VCI Number</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-32. ATM DXI PVC List Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Mode</td>
<td>Group Access</td>
</tr>
<tr>
<td>Multi Protocol Encapsulation</td>
<td>RFC 1483 Style MPEm (hybrid or direct)</td>
</tr>
<tr>
<td>CS PDU Encapsulation</td>
<td>AAL5 Encapsulation (hybrid or direct)</td>
</tr>
<tr>
<td>Multicast</td>
<td>Unicast (hybrid or direct)</td>
</tr>
</tbody>
</table>

Table A-33. ATM FRE2 Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative State</td>
<td>UP</td>
</tr>
</tbody>
</table>
Table A-34. ATM FRE2 Virtual Channel Link Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>VPI Number</td>
<td>None</td>
</tr>
<tr>
<td>VCI Number</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-35. ATM FRE2 Virtual Channel Link Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCL Mode</td>
<td>GROUP ACCESS</td>
</tr>
<tr>
<td>Administrative State</td>
<td>UP</td>
</tr>
<tr>
<td>Xmit Peak Cell Rate (Cells/Sec)</td>
<td>4716</td>
</tr>
<tr>
<td>Xmit Sustainable Cell Rate (Cells/Sec)</td>
<td>4716</td>
</tr>
<tr>
<td>Xmit Burst Size (Cells/Sec)</td>
<td>40</td>
</tr>
<tr>
<td>AAL Type</td>
<td>AAL5 Encapsulation</td>
</tr>
<tr>
<td>Maximum AAL CPCS Transmit SDU Size</td>
<td>4500</td>
</tr>
<tr>
<td>Maximum AAL CPCS Receive Size</td>
<td>4500</td>
</tr>
<tr>
<td>Data Encapsulation Type</td>
<td>RFC 1483</td>
</tr>
</tbody>
</table>
### Table A-36. ATM/ALC Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Data Path Notify</td>
<td>Enable</td>
</tr>
<tr>
<td>Data path Notify Timeout</td>
<td>3</td>
</tr>
</tbody>
</table>

### Table A-37. ATM/ALC SAR Traffic Management Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Cell Rate</td>
<td>235849</td>
</tr>
<tr>
<td>Sustainable Cell Rate</td>
<td>235849</td>
</tr>
<tr>
<td>Maximum Burst Size</td>
<td>40</td>
</tr>
</tbody>
</table>

### Table A-38. ATM/ALC Physical Interface Attributes

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Framing Mode</td>
<td>Unassigned</td>
</tr>
<tr>
<td>Scrambling</td>
<td>Enable</td>
</tr>
<tr>
<td>Loop Back</td>
<td>Disable</td>
</tr>
<tr>
<td>Cell Insertion</td>
<td>Unassigned</td>
</tr>
</tbody>
</table>
Table A-39. Point-to-Point (PPP) Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Enable</td>
<td>If you enabled IP support on this interface, then Site Manager automatically sets IP Enable to Enable. Otherwise, the default is Disable.</td>
</tr>
<tr>
<td>OSI Enable</td>
<td>If you enabled OSI support on this interface, then Site Manager automatically sets OSI Enable to Enable. Otherwise, the default is Disable.</td>
</tr>
<tr>
<td>XNS Enable</td>
<td>If you enabled XNS Enable on this interface, then Site Manager automatically sets XNS Enable to Enable. Otherwise, the default is Disable.</td>
</tr>
<tr>
<td>DECnet IV Enable</td>
<td>If you enabled DECnet IV support on this interface, then Site Manager automatically sets DECnet IV Enable to Enable. Otherwise, the default is Disable.</td>
</tr>
<tr>
<td>AppleTalk Enable</td>
<td>If you enabled AppleTalk support on this interface, then Site Manager automatically sets AppleTalk Enable to Enable. Otherwise, the default is Disable.</td>
</tr>
<tr>
<td>IPX Enable</td>
<td>If you enabled IPX support on this interface, then Site Manager automatically sets IPX Enable to Enable. Otherwise, the default is Disable.</td>
</tr>
<tr>
<td>Bridge Enable</td>
<td>If you enabled Bridging on this interface, then Site Manager automatically sets this parameter to Enable. Otherwise, the default is Disable.</td>
</tr>
</tbody>
</table>

continued on the next page
### Table A-39. Point-to-Point (PPP) Interface Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>WCP Enable</td>
<td>If you enabled the Wellfleet Compression Protocol on this interface, then Site Manager automatically sets this parameter to Enable. Otherwise the default is Disable.</td>
</tr>
<tr>
<td>VINES Enable</td>
<td>If you enabled VINES support on this interface, Site Manager automatically sets VINES Enable to Enable. Otherwise, the default is Disable.</td>
</tr>
<tr>
<td>Remote IP Address</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>IPX Network Number</td>
<td>None</td>
</tr>
<tr>
<td>IPX Remote Node Number</td>
<td>None</td>
</tr>
<tr>
<td>Remote AppleTalk Node</td>
<td>None</td>
</tr>
<tr>
<td>AppleTalk Routing Protocol</td>
<td>RTMP</td>
</tr>
<tr>
<td>Bridge Enet</td>
<td>Enable</td>
</tr>
<tr>
<td>Bridge FDDI</td>
<td>Enable</td>
</tr>
<tr>
<td>Bridge Token Ring</td>
<td>Enable</td>
</tr>
</tbody>
</table>

### Table A-40. Point-to-Point (PPP) Line Lists Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable (LCP)</td>
<td>Enable</td>
</tr>
<tr>
<td>Restart Timer in s</td>
<td>3 s</td>
</tr>
<tr>
<td>s between Xmit of Echo-Request</td>
<td>0</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-40. Point-to-Point (PPP) Line Lists Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Echo-Reply Acceptable Loss</td>
<td>3</td>
</tr>
<tr>
<td>Max Configure-Requests</td>
<td>1000</td>
</tr>
<tr>
<td>Max Terminate-Requests</td>
<td>2</td>
</tr>
<tr>
<td>Max Configuration Failure Count</td>
<td>10</td>
</tr>
<tr>
<td>Local Authentication Protocol</td>
<td>None</td>
</tr>
<tr>
<td>Local PAP Id</td>
<td>None</td>
</tr>
<tr>
<td>Local PAP Password</td>
<td>None</td>
</tr>
<tr>
<td>Remote PAP Id</td>
<td>None</td>
</tr>
<tr>
<td>Remote PAP Password</td>
<td>None</td>
</tr>
<tr>
<td>Link Quality Protocol</td>
<td>None</td>
</tr>
<tr>
<td>Peer Link Quality Report Timer</td>
<td>Enable</td>
</tr>
<tr>
<td>LQR Reporting Period</td>
<td>3 s</td>
</tr>
<tr>
<td>Inbound Link Quality</td>
<td>90 %</td>
</tr>
<tr>
<td>Outbound Link Quality</td>
<td>90 %</td>
</tr>
</tbody>
</table>

Table A-41. Wellfleet Compression Protocol Circuit Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Compression Mode</td>
<td>Inherit from Line</td>
</tr>
<tr>
<td>History Size</td>
<td>Inherit from Line</td>
</tr>
</tbody>
</table>
Table A-42. Wellfleet Compression Protocol Line Interfaces Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Compression Mode</td>
<td>Continuous Packet</td>
</tr>
<tr>
<td>History Size</td>
<td>32 KB</td>
</tr>
<tr>
<td>Buffer Size</td>
<td>Normal</td>
</tr>
</tbody>
</table>

Bridge Parameters

This section describes the Site Manager default parameter settings for the Transparent Bridge (including Spanning Tree), the Source Routing Bridge, Source Routing NetBIOS Broadcast Reduction, and the Transparent-to-Source-Routing Translation Bridge.

Table A-43. Transparent Bridge Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Bridge Table Size</td>
<td>1024 entries</td>
</tr>
<tr>
<td>Enable Forwarding DB</td>
<td>Enable</td>
</tr>
</tbody>
</table>
Table A-44. Transparent Bridge Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>If you added Bridging either using the Quick Start procedure or the configuring circuits procedure, this parameter defaults to Enable.</td>
</tr>
<tr>
<td></td>
<td>If you previously used this parameter to disable Bridging on this circuit, the parameter defaults to Disable.</td>
</tr>
<tr>
<td>Translation Bridge</td>
<td>Disable</td>
</tr>
</tbody>
</table>

Table A-45. Spanning Tree Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Spanning Tree Protocol Version</td>
<td>IEEE802ID</td>
</tr>
<tr>
<td>Bridge Priority</td>
<td>None</td>
</tr>
<tr>
<td>Bridge MAC Address</td>
<td>None</td>
</tr>
<tr>
<td>Max Age</td>
<td>20 s (expressed in hundredths of a second: 2000)</td>
</tr>
<tr>
<td>Hello Time</td>
<td>2 s (expressed in hundredths of a second: 200)</td>
</tr>
<tr>
<td>Forward Delay</td>
<td>15 s (expressed in hundredths of a second: 1500)</td>
</tr>
</tbody>
</table>
Table A-46. Spanning Tree Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spanning Tree Enable</td>
<td>If you added spanning tree either using the Quick Start procedure or the configuring circuits procedure, this parameter defaults to Enable. If you previously used this parameter to disable spanning tree on this circuit, the parameter defaults to Disable.</td>
</tr>
<tr>
<td>Path Cost</td>
<td>1</td>
</tr>
<tr>
<td>Translation Bridge Enable</td>
<td>Disable</td>
</tr>
</tbody>
</table>

Table A-47. Source Routing Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>SR Bridge Internal LAN ID</td>
<td>0x0</td>
</tr>
<tr>
<td>SR Bridge ID</td>
<td>0x0</td>
</tr>
<tr>
<td>SR Group LAN ID</td>
<td>0xffff</td>
</tr>
<tr>
<td>IP Encapsulation</td>
<td>Disable</td>
</tr>
<tr>
<td>Conn. IP NTWK Ring Number</td>
<td>0x0</td>
</tr>
<tr>
<td>IP Net MTU (bytes)</td>
<td>4562</td>
</tr>
<tr>
<td>NetBIOS Server Name Cache</td>
<td>Disable</td>
</tr>
</tbody>
</table>

continued on the next page
### Table A-47. Source Routing Global Parameters  *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetBIOS Client Name Cache</td>
<td>Disable</td>
</tr>
<tr>
<td>NetBIOS Datagram RIF Cache</td>
<td>Disable</td>
</tr>
<tr>
<td>15-Character Name Cache</td>
<td>Disable</td>
</tr>
<tr>
<td>Create MIB Instance for Cached Name</td>
<td>Enable</td>
</tr>
<tr>
<td>Max Name Cache Entries</td>
<td>100 entries</td>
</tr>
<tr>
<td>Name Cache Age (secs)</td>
<td>300 s</td>
</tr>
<tr>
<td>Hash Entry Count</td>
<td>253</td>
</tr>
<tr>
<td>NetBIOS Query Cache</td>
<td>Disable</td>
</tr>
<tr>
<td>Create MIB Instance for Cached Query</td>
<td>Enable</td>
</tr>
<tr>
<td>Max Number Query Cache Entries</td>
<td>100 entries</td>
</tr>
<tr>
<td>NetBIOS Query Cache Age (secs)</td>
<td>15 s</td>
</tr>
</tbody>
</table>

### Table A-48. Source Routing Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Max Number of RDs</td>
<td>7</td>
</tr>
<tr>
<td>Source Routing Ring Number</td>
<td>0x0</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-48. Source Routing Interface Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound STEs</td>
<td>Accept</td>
</tr>
<tr>
<td>Inbound STEs</td>
<td>Accept</td>
</tr>
<tr>
<td>Frames with IP Ring</td>
<td>Accept</td>
</tr>
<tr>
<td>IP Address</td>
<td>None</td>
</tr>
<tr>
<td>WAN Broadcast Address</td>
<td>-1</td>
</tr>
<tr>
<td>Encapsulation Format</td>
<td>Proprietary</td>
</tr>
<tr>
<td>NetBIOS Server Name Cache</td>
<td>Enable</td>
</tr>
<tr>
<td>NetBIOS Client Name Cache</td>
<td>Enable</td>
</tr>
<tr>
<td>NetBIOS Datagram Name Cache</td>
<td>Enable</td>
</tr>
<tr>
<td>NetBIOS Query Cache</td>
<td>Enable</td>
</tr>
</tbody>
</table>

Table A-49. Translation Bridge Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Virtual Lan ID</td>
<td>0x0</td>
</tr>
<tr>
<td>Max Translation Entries</td>
<td>255 entries</td>
</tr>
<tr>
<td>Aging Value</td>
<td>300 s</td>
</tr>
<tr>
<td>Broadcast Conversion</td>
<td>Enable</td>
</tr>
<tr>
<td>Ethernet Type</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Source Router Explorer Type</td>
<td>Spanning Tree</td>
</tr>
<tr>
<td>SAPs</td>
<td>000408F0F4FC</td>
</tr>
</tbody>
</table>
Native Mode LAN (NML) Parameters

This section describes the Site Manager default parameter settings for Native Mode LAN services.

Table A-50. Native Mode LAN Services

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Enabled</td>
</tr>
<tr>
<td>Add Security Header</td>
<td>Add Security</td>
</tr>
<tr>
<td>SAID Type</td>
<td>INDIVIDUAL</td>
</tr>
<tr>
<td>SAID Value</td>
<td>0</td>
</tr>
<tr>
<td>CUG Value</td>
<td>0</td>
</tr>
<tr>
<td>Security List Action</td>
<td>Forward</td>
</tr>
</tbody>
</table>

IP Parameters

This section describes the Site Manager default parameter settings for the Internet Protocol (IP), the Routing Information protocol (RIP), the Trivial File Transfer Protocol (TFTP), the Revised IP Security Option (RIPSO), the Bootstrap Protocol (BOOTP), the Internet Group Management Protocol (IGMP), the Distance-Vector Multicast Routing Protocol (DVRMP), and NetBIOS over IP.
### Table A-51. IP Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Forwarding</td>
<td>Forwarding</td>
</tr>
<tr>
<td>ARP Forwarding</td>
<td>Forwarding</td>
</tr>
<tr>
<td>Non Local ARP Source</td>
<td>Drop</td>
</tr>
<tr>
<td>Non Local ARP Destination</td>
<td>Drop</td>
</tr>
<tr>
<td>Default TTL</td>
<td>30 hops</td>
</tr>
<tr>
<td>RIP Diameter</td>
<td>15 hops</td>
</tr>
<tr>
<td>Route Cache Interval</td>
<td>60 s</td>
</tr>
<tr>
<td>Routing MIB Table(s)</td>
<td>Route</td>
</tr>
<tr>
<td>Zero Subnet Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>Estimated Networks</td>
<td>0</td>
</tr>
<tr>
<td>Estimated Hosts</td>
<td>0</td>
</tr>
<tr>
<td>Enable Default Route for Subnets</td>
<td>Disable</td>
</tr>
</tbody>
</table>

### Table A-52. IP Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>You specified the subnet mask when you added IP to the circuit.</td>
</tr>
</tbody>
</table>
Table A-52. IP Interface Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast Address</td>
<td>You specified the Broadcast Address parameter when you added IP to the circuit.</td>
</tr>
<tr>
<td>Interface Cost</td>
<td>1</td>
</tr>
<tr>
<td>MTU Discovery</td>
<td>Off</td>
</tr>
<tr>
<td>Addr Mask Reply</td>
<td>Off</td>
</tr>
<tr>
<td>All Subnet Bcast</td>
<td>Off</td>
</tr>
<tr>
<td>Address Resolution</td>
<td>ARP</td>
</tr>
<tr>
<td>Proxy</td>
<td>Off</td>
</tr>
<tr>
<td>Host Cache</td>
<td>Off</td>
</tr>
<tr>
<td>Checksum</td>
<td>On</td>
</tr>
<tr>
<td>MAC Address</td>
<td>None</td>
</tr>
<tr>
<td>TR End Station</td>
<td>OFF</td>
</tr>
<tr>
<td>Redirects</td>
<td>Enable</td>
</tr>
<tr>
<td>Enet Arp Encaps</td>
<td>ARP Ethernet</td>
</tr>
<tr>
<td>SMDS Group Address</td>
<td>None</td>
</tr>
<tr>
<td>SMDS ARP Req Address</td>
<td>None</td>
</tr>
<tr>
<td>FR Broadcast DLCI</td>
<td>0</td>
</tr>
<tr>
<td>FR Multicast DLCI #1</td>
<td>0</td>
</tr>
<tr>
<td>FR Multicast DLCI #2</td>
<td>0</td>
</tr>
<tr>
<td>Slot Mask</td>
<td>Slot-mask bit set to 1 (enabling circuitless IP interface support) for every router slot running IP</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-52. IP Interface Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Forwarding Table Size</td>
<td>128 entries</td>
</tr>
<tr>
<td>Enable Security</td>
<td>Disable</td>
</tr>
</tbody>
</table>

### Table A-53. RIP Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>RIP Supply</td>
<td>Enable</td>
</tr>
<tr>
<td>RIP Listen</td>
<td>Enable</td>
</tr>
<tr>
<td>Default Route Supply</td>
<td>Disable</td>
</tr>
<tr>
<td>Default Route Listen</td>
<td>Disable</td>
</tr>
<tr>
<td>Poisoned Reverse</td>
<td>Poisoned</td>
</tr>
</tbody>
</table>

### Table A-54. TFTP Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Default Volume</td>
<td>2</td>
</tr>
<tr>
<td>Retry Time Out</td>
<td>5 s</td>
</tr>
<tr>
<td>Close Time Out</td>
<td>25 s</td>
</tr>
<tr>
<td>Retransmit</td>
<td>5 retransmissions</td>
</tr>
</tbody>
</table>
### Table A-55. RIPSO Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Security</td>
<td>Disable</td>
</tr>
<tr>
<td>Strip Security</td>
<td>None</td>
</tr>
<tr>
<td>Require Out Security</td>
<td>All</td>
</tr>
<tr>
<td>Require In Security</td>
<td>None</td>
</tr>
<tr>
<td>Minimum Level</td>
<td>Unclassified</td>
</tr>
<tr>
<td>Maximum Level</td>
<td>Top Secret</td>
</tr>
<tr>
<td>Must InAuthority</td>
<td>None</td>
</tr>
<tr>
<td>May InAuthority</td>
<td>None</td>
</tr>
<tr>
<td>Must OutAuthority</td>
<td>None</td>
</tr>
<tr>
<td>May OutAuthority</td>
<td>None</td>
</tr>
<tr>
<td>Implicit Label</td>
<td>Enable</td>
</tr>
<tr>
<td>Implicit Authority</td>
<td>None</td>
</tr>
<tr>
<td>Implicit Level</td>
<td>Unclassified</td>
</tr>
<tr>
<td>Default Label</td>
<td>Enable</td>
</tr>
<tr>
<td>Default Authority</td>
<td>None</td>
</tr>
<tr>
<td>Default Level</td>
<td>Unclassified</td>
</tr>
<tr>
<td>Error Label</td>
<td>Enable</td>
</tr>
<tr>
<td>Error Authority</td>
<td>None</td>
</tr>
</tbody>
</table>
### Table A-56. BOOTP Relay Agent Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Hops</td>
<td>4 hops</td>
</tr>
<tr>
<td>Timeout Secs.</td>
<td>1 s</td>
</tr>
</tbody>
</table>

### Table A-57. IGMP Global Configuration Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Estimated Groups</td>
<td>20 groups</td>
</tr>
</tbody>
</table>

### Table A-58. DVRMP Base Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Full Update Rate</td>
<td>60 s</td>
</tr>
<tr>
<td>Triggered Update Rate</td>
<td>5 s</td>
</tr>
<tr>
<td>Leaf Timeout</td>
<td>200 s</td>
</tr>
<tr>
<td>Neighbor Timeout</td>
<td>140 s</td>
</tr>
<tr>
<td>Route Expiration Timeout</td>
<td>200 s</td>
</tr>
<tr>
<td>Garbage Timeout</td>
<td>340 s</td>
</tr>
<tr>
<td>Estimated Routes</td>
<td>25 routes</td>
</tr>
</tbody>
</table>
### Table A-59. NetBIOS/IP Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>NetBIOS Name Caching</td>
<td>Disable</td>
</tr>
<tr>
<td>15-Character NetBIOS Name Caching</td>
<td>Disabled</td>
</tr>
<tr>
<td>Create MIB Inst for Cached Name</td>
<td>Enabled</td>
</tr>
<tr>
<td>Max Name Cache Entries</td>
<td>100 entries</td>
</tr>
<tr>
<td>Name Cache Age</td>
<td>300 s</td>
</tr>
<tr>
<td>Hash Entry Count</td>
<td>253</td>
</tr>
<tr>
<td>Rebroadcast Packet TTL</td>
<td>5 s</td>
</tr>
<tr>
<td>Rebroadcast Record Route</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

### Table A-60. NetBIOS/IP Interface Table Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Disable</td>
</tr>
<tr>
<td>NetBIOS Name Caching</td>
<td>Enable</td>
</tr>
<tr>
<td>Enable NetBIOS Inbound Broadcasts</td>
<td>Enable</td>
</tr>
<tr>
<td>Enable NetBIOS Outbound Broadcasts</td>
<td>Enable</td>
</tr>
<tr>
<td>Rebroadcast Address</td>
<td>Null</td>
</tr>
</tbody>
</table>
Table A-61. NetBIOS/IP Static Entry Table Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>NetBIOS Scope ID</td>
<td>None</td>
</tr>
<tr>
<td>NetBIOS Station Name</td>
<td>None</td>
</tr>
<tr>
<td>NetBIOS Scope ID</td>
<td>None</td>
</tr>
</tbody>
</table>

SNMP Parameters

This section describes the Site Manager default parameter settings for the Simple Network Management Protocol (SNMP).

Table A-62. SNMP Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Use Lock</td>
<td>Enable</td>
</tr>
<tr>
<td>Lock Timeout</td>
<td>2 min</td>
</tr>
<tr>
<td>Authentication Failure Traps</td>
<td>Enable</td>
</tr>
<tr>
<td>Trap Debug Events</td>
<td>Off</td>
</tr>
<tr>
<td>Trap Trace Events</td>
<td>Off</td>
</tr>
<tr>
<td>Trap Info Events</td>
<td>On</td>
</tr>
<tr>
<td>Trap Warning Events</td>
<td>On</td>
</tr>
<tr>
<td>Trap Fault events</td>
<td>On</td>
</tr>
</tbody>
</table>
Table A-63. SNMP Community Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community Name</td>
<td>None</td>
</tr>
<tr>
<td>Access</td>
<td>Read Only</td>
</tr>
</tbody>
</table>

Table A-64. SNMP Manager Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trap Port</td>
<td>162</td>
</tr>
<tr>
<td>Trap Type</td>
<td>Generic</td>
</tr>
</tbody>
</table>

Table A-65. SNMP Threshold Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polling Interval</td>
<td>60 s</td>
</tr>
</tbody>
</table>

Table A-66. SNMP Threshold Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Threshold Low Value</td>
<td>0</td>
</tr>
<tr>
<td>Threshold Low Event level</td>
<td>Info</td>
</tr>
</tbody>
</table>

continued on the next page
Table A-66. SNMP Threshold Interface Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold Medium Value</td>
<td>0</td>
</tr>
<tr>
<td>Threshold Medium Event Level</td>
<td>Info</td>
</tr>
<tr>
<td>Threshold High Value</td>
<td>0</td>
</tr>
<tr>
<td>Threshold High Event Level</td>
<td>Info</td>
</tr>
<tr>
<td>Threshold Units</td>
<td>Per second</td>
</tr>
<tr>
<td>Threshold Action</td>
<td>Greaterthan</td>
</tr>
<tr>
<td>Threshold Max Successive Alarms</td>
<td>5</td>
</tr>
<tr>
<td>Threshold HoldDown Intervals</td>
<td>1</td>
</tr>
</tbody>
</table>

Table A-67. SNMP Trap Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Code/Event Code</td>
<td>None</td>
</tr>
<tr>
<td>Always/Never Trap</td>
<td>None</td>
</tr>
</tbody>
</table>

**OSPF Parameters**

This section describes the Site Manager default parameter settings for the Open Shortest Path First (OSPF) Protocol.
### Table A-68. OSPF Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Router ID</td>
<td>None</td>
</tr>
<tr>
<td>AS Boundary Router</td>
<td>False (No)</td>
</tr>
<tr>
<td>Hold Down Timer</td>
<td>1 s</td>
</tr>
<tr>
<td>OSPF Slot</td>
<td>All slots</td>
</tr>
<tr>
<td>Ase Metric Support</td>
<td>Disabled</td>
</tr>
<tr>
<td>Backup Enable</td>
<td>Enabled</td>
</tr>
<tr>
<td>Primary Log Mask</td>
<td>All options enabled</td>
</tr>
<tr>
<td>Backup Log Mask</td>
<td>All options disabled</td>
</tr>
</tbody>
</table>

### Table A-69. OSPF Area Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Authentication Type</td>
<td>No Password</td>
</tr>
<tr>
<td>Import AS Extern</td>
<td>Yes</td>
</tr>
<tr>
<td>Stub Metric</td>
<td>1</td>
</tr>
<tr>
<td>Import Summaries</td>
<td>True</td>
</tr>
</tbody>
</table>
Table A-70. OSPF Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Area ID</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Type</td>
<td>None</td>
</tr>
<tr>
<td>Rtr Priority</td>
<td>1</td>
</tr>
<tr>
<td>Transit Delay</td>
<td>1 s</td>
</tr>
<tr>
<td>Retransmit Interval</td>
<td>5 s</td>
</tr>
<tr>
<td>Hello Interval</td>
<td>10 s</td>
</tr>
<tr>
<td>Dead Interval</td>
<td>40 s</td>
</tr>
<tr>
<td>Poll Interval</td>
<td>120 s</td>
</tr>
<tr>
<td>Metric Cost</td>
<td>1</td>
</tr>
<tr>
<td>Password</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-71. OSPF Virtual Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Transit Delay</td>
<td>1 s</td>
</tr>
<tr>
<td>Retransmit Interval</td>
<td>10 s</td>
</tr>
<tr>
<td>Hello Interval</td>
<td>15 s</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-71. OSPF Virtual Interface Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead Interval</td>
<td>60 s</td>
</tr>
<tr>
<td>Password</td>
<td>None</td>
</tr>
</tbody>
</table>

BGP and BGP-3 Parameters

This section describes the Site Manager default parameter settings for the Border Gateway Protocol (BGP).

Table A-72. BGP Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>BGP Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>BGP Identifier</td>
<td>None</td>
</tr>
<tr>
<td>BGP Local AS</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-73. BGP-3 Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Intra AS Routing</td>
<td>Enable</td>
</tr>
</tbody>
</table>

*continued on the next page*
EGP Parameters

This section describes the Site Manager default parameter settings for the Exterior Gateway Protocol (EGP).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Advertisement Timer</td>
<td>5 s</td>
</tr>
<tr>
<td>RIP Rules</td>
<td>Disable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Min BGP Version</td>
<td>3</td>
</tr>
<tr>
<td>Max BGP Version</td>
<td>3</td>
</tr>
<tr>
<td>Remote AS</td>
<td>None</td>
</tr>
<tr>
<td>External Advertisement Timer</td>
<td>5 s</td>
</tr>
<tr>
<td>Connect Retry Timer</td>
<td>120 s</td>
</tr>
<tr>
<td>Holdtime</td>
<td>90 s</td>
</tr>
<tr>
<td>Keepalive Timer</td>
<td>30 s</td>
</tr>
<tr>
<td>Path Attribute Table Switch</td>
<td>Enable</td>
</tr>
</tbody>
</table>
Table A-75. EGP Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Local Autonomous System</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-76. EGP Neighbor Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Gateway Mode</td>
<td>Core</td>
</tr>
<tr>
<td>Acquisition Mode</td>
<td>Passive</td>
</tr>
<tr>
<td>Poll Mode</td>
<td>Both</td>
</tr>
<tr>
<td>Hello Timer</td>
<td>60 s</td>
</tr>
<tr>
<td>Poll Timer</td>
<td>180 hundredths of a second</td>
</tr>
</tbody>
</table>

TCP Parameters

This section describes the Site Manager default parameter settings for the Transmission Control Protocol (TCP).
Table A-77. TCP Configuration Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Min. Retransmission Timeout</td>
<td>250 ms</td>
</tr>
<tr>
<td>Max. Retransmission Timeout</td>
<td>240000 ms</td>
</tr>
<tr>
<td>Max. Window</td>
<td>4096 octets</td>
</tr>
</tbody>
</table>

Telnet Parameters

This section describes the Site Manager default parameter settings for Telnet.

Table A-78. Telnet Configuration Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>TI Line per Screen</td>
<td>24 lines</td>
</tr>
<tr>
<td>TI More</td>
<td>Enable</td>
</tr>
<tr>
<td>TI Prompt</td>
<td>$</td>
</tr>
<tr>
<td>Login Timeout</td>
<td>1 min</td>
</tr>
<tr>
<td>Password Timeout</td>
<td>1 min</td>
</tr>
<tr>
<td>Command Timeout</td>
<td>15 min</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-78. Telnet Configuration Parameters (continued)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Retries</td>
<td>3 login attempts</td>
</tr>
<tr>
<td>Diagnostic Report</td>
<td>Disable</td>
</tr>
<tr>
<td>Diagnostic Exercise</td>
<td>Disable</td>
</tr>
<tr>
<td>Diagnostic Network Data</td>
<td>Disable</td>
</tr>
<tr>
<td>Diagnostic PTY Data</td>
<td>Disable</td>
</tr>
<tr>
<td>Diagnostic Options</td>
<td>Disable</td>
</tr>
</tbody>
</table>

Table A-79. Telnet Client Global Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Verbose Debug Logging</td>
<td>Off</td>
</tr>
<tr>
<td>Remote Port</td>
<td>23</td>
</tr>
<tr>
<td>Prompt</td>
<td>telnet&gt;</td>
</tr>
</tbody>
</table>

**DECnet Parameters**

This section describes the Site Manager default settings for the
DECnet Phase IV and DECnet Phase IV to V Transition parameters.
### Table A-80. DECnet Phase IV Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Broadcast Route Timer</td>
<td>180 s</td>
</tr>
<tr>
<td>Route Max Addr</td>
<td>1023</td>
</tr>
<tr>
<td>Max Broadcast Non Routers</td>
<td>64</td>
</tr>
<tr>
<td>Max Broadcast Routers</td>
<td>32</td>
</tr>
<tr>
<td>Max Circuits</td>
<td>1024 circuits</td>
</tr>
<tr>
<td>Max Cost</td>
<td>1022</td>
</tr>
<tr>
<td>Max Hops</td>
<td>30 hops</td>
</tr>
<tr>
<td>Max Visits</td>
<td>63 visits</td>
</tr>
<tr>
<td>Area Max Cost</td>
<td>1022</td>
</tr>
<tr>
<td>Area Max Hops</td>
<td>30 hops</td>
</tr>
<tr>
<td>Max Area</td>
<td>63 areas</td>
</tr>
</tbody>
</table>

### Table A-81. DECnet Phase IV Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Area ID</td>
<td>None</td>
</tr>
<tr>
<td>Node ID</td>
<td>None</td>
</tr>
<tr>
<td>Cost</td>
<td>10</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-81. DECnet Phase IV Interface Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hello Timer</td>
<td>15 s</td>
</tr>
<tr>
<td>Max Routers</td>
<td>33 routers</td>
</tr>
<tr>
<td>Router Priority</td>
<td>64</td>
</tr>
<tr>
<td>End Nodes MAC</td>
<td>None</td>
</tr>
<tr>
<td>End Routers MAC</td>
<td>None</td>
</tr>
<tr>
<td>Area Routers MAC</td>
<td>None</td>
</tr>
<tr>
<td>Node Hello</td>
<td>Enable</td>
</tr>
<tr>
<td>Router Hello</td>
<td>Enable</td>
</tr>
<tr>
<td>Level 1 Topology Update</td>
<td>Enable</td>
</tr>
<tr>
<td>Level 2 Topology Update</td>
<td>Enable</td>
</tr>
</tbody>
</table>

### Table A-82. DECnet IV to V Transition Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>DECnet 4 to 5 Transition Enable</td>
<td>None</td>
</tr>
<tr>
<td>Area Address Alias 1 (hex)</td>
<td>None</td>
</tr>
<tr>
<td>Route Max Addr</td>
<td>1023</td>
</tr>
<tr>
<td>Max Broadcast Non Routers</td>
<td>64</td>
</tr>
<tr>
<td>Max Broadcast Routers</td>
<td>32</td>
</tr>
<tr>
<td>Max Circuits</td>
<td>1024 circuits</td>
</tr>
<tr>
<td>Max Cost</td>
<td>1022</td>
</tr>
</tbody>
</table>

*continued on the next page*
Table A-82. DECnet IV to V Transition Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Hops</td>
<td>30 hops</td>
</tr>
<tr>
<td>Max Visits</td>
<td>63 visits</td>
</tr>
<tr>
<td>Area Max Cost</td>
<td>1022</td>
</tr>
<tr>
<td>Area Max Hops</td>
<td>30 hops</td>
</tr>
<tr>
<td>Max Area</td>
<td>63 areas</td>
</tr>
</tbody>
</table>

VINES Parameters

This section describes the Site Manager default parameter settings for the VINES protocol.

Table A-83. VINES Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Network ID</td>
<td>0</td>
</tr>
<tr>
<td>Broadcast Class</td>
<td>All</td>
</tr>
</tbody>
</table>
Table A-84. VINES Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>ARP Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>End Station Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>Ethernet Header</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Remote Client Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>Split Horizon Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>Frame Relay Broadcast</td>
<td>0xff_f (not displayed)</td>
</tr>
<tr>
<td>Configured MAC Address</td>
<td>0</td>
</tr>
<tr>
<td>Configured Interface Cost</td>
<td>0</td>
</tr>
<tr>
<td>SMDS Broadcast</td>
<td>0xff_f (not displayed)</td>
</tr>
</tbody>
</table>
AppleTalk Parameters

This section describes the Site Manager default parameter settings for AppleTalk and AURP.

Table A-85. AppleTalk Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
</tbody>
</table>

Table A-86. AppleTalk Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Network Start</td>
<td>0</td>
</tr>
<tr>
<td>Network End</td>
<td>0</td>
</tr>
<tr>
<td>Default Zone</td>
<td>None</td>
</tr>
<tr>
<td>Network ID</td>
<td>0</td>
</tr>
<tr>
<td>Node ID</td>
<td>0</td>
</tr>
<tr>
<td>Interface Cost</td>
<td>0 hops</td>
</tr>
<tr>
<td>Checksum Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>WAN MAC Address</td>
<td>None</td>
</tr>
<tr>
<td>WAN Broadcast Address</td>
<td>None</td>
</tr>
<tr>
<td>Enable Split Horizon</td>
<td>Enable</td>
</tr>
</tbody>
</table>
Table A-87. AURP Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Local IP Address</td>
<td>None</td>
</tr>
<tr>
<td>Remote AURP IP Address</td>
<td>None</td>
</tr>
</tbody>
</table>

Table A-88. AURP Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Command Timeout</td>
<td>3 s</td>
</tr>
<tr>
<td>Command Retries</td>
<td>3</td>
</tr>
<tr>
<td>Update Rate</td>
<td>30 s</td>
</tr>
<tr>
<td>Last Heard from Timeout</td>
<td>90 s</td>
</tr>
<tr>
<td>Remote AURP IP Address</td>
<td>None</td>
</tr>
<tr>
<td>Hop Count Reduction</td>
<td>Disable</td>
</tr>
<tr>
<td>Interface Cost</td>
<td>0 hops</td>
</tr>
</tbody>
</table>

OSI Parameters

This section describes the Site Manager default parameter settings for the Open System Interconnection (OSI) protocol.
### Table A-89. OSI Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Router Type</td>
<td>Level 1 &amp; Level 2</td>
</tr>
<tr>
<td>Router ID</td>
<td>None</td>
</tr>
<tr>
<td>Load Balancing</td>
<td>Disable</td>
</tr>
<tr>
<td>Max # Area Addresses</td>
<td>63 areas</td>
</tr>
<tr>
<td>Max # End Systems</td>
<td>1023 systems</td>
</tr>
<tr>
<td>Max # L1 Intermediate Systems</td>
<td>15 systems</td>
</tr>
<tr>
<td>Max # L2 Intermediate Systems</td>
<td>63 systems</td>
</tr>
<tr>
<td>Max # External Addresses</td>
<td>1 address</td>
</tr>
<tr>
<td>IS Checksum</td>
<td>Enable</td>
</tr>
<tr>
<td>L1 LSP Password</td>
<td>None</td>
</tr>
<tr>
<td>L2 LSP Password</td>
<td>None</td>
</tr>
<tr>
<td>Area Address</td>
<td>490040</td>
</tr>
<tr>
<td>Area Address Alias 1</td>
<td>None</td>
</tr>
<tr>
<td>Area Address Alias 2</td>
<td>None</td>
</tr>
<tr>
<td>Max # Learned End Systems</td>
<td>1024 systems</td>
</tr>
<tr>
<td>Max # Learned L1 Intermediate Systems</td>
<td>64 systems</td>
</tr>
<tr>
<td>Max # Learned L2 Intermediate Systems</td>
<td>64 systems</td>
</tr>
<tr>
<td>CLNP Source Route Support</td>
<td>Enable</td>
</tr>
</tbody>
</table>
Table A-90. OSI Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Routing Level</td>
<td>Level 1 &amp; Level 2</td>
</tr>
<tr>
<td>L1 Default Metric</td>
<td>20</td>
</tr>
<tr>
<td>L2 Default Metric</td>
<td>20</td>
</tr>
<tr>
<td>L1 Designated Router Priority</td>
<td>64</td>
</tr>
<tr>
<td>L2 Designated Router Priority</td>
<td>64</td>
</tr>
<tr>
<td>IIH Hello Timer</td>
<td>8 s</td>
</tr>
<tr>
<td>ISH Hello Timer</td>
<td>30 s</td>
</tr>
<tr>
<td>ESH Configuration Timer</td>
<td>600 s</td>
</tr>
<tr>
<td>Circuit Password</td>
<td>None</td>
</tr>
<tr>
<td>IIH Hold Time Multiplier</td>
<td>3</td>
</tr>
<tr>
<td>ISH Hold Time Multiplier</td>
<td>3</td>
</tr>
</tbody>
</table>

**IPX Parameters**

This section describes the Site Manager default parameter settings for the Internet Packet Exchange (IPX) protocol and for IPX RIP.
Table A-91. IPX Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Multiple Host Address Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Host Number (hex)</td>
<td>If you disable the Multiple Host Address Enable parameter and enter a unique host number, the Configuration Manager assigns this number to all IPX interfaces you configure on the router. If you disable the Multiple Host Address Enable parameter and do not enter a box-wide host ID number for this parameter, the Configuration Manager automatically generates a unique 6-byte host ID number for all IPX interfaces. The generated host ID is based on the serial number of the router's backplane.</td>
</tr>
<tr>
<td>Router Name</td>
<td>None</td>
</tr>
<tr>
<td>Primary Net Number</td>
<td>None</td>
</tr>
<tr>
<td>RIP Method</td>
<td>Tick</td>
</tr>
<tr>
<td>Maximum Path</td>
<td>1 path</td>
</tr>
<tr>
<td>Log Filter</td>
<td>Trace</td>
</tr>
<tr>
<td>Initial Network Table Size</td>
<td>0 table entries</td>
</tr>
<tr>
<td>Novell Certification Conformance</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
Table A-92. IPX Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Cost</td>
<td>1 (for hop- or tick-based routing)</td>
</tr>
<tr>
<td>Host Number (hex)</td>
<td>None</td>
</tr>
<tr>
<td>Configured Encaps</td>
<td>None (media dependent)</td>
</tr>
<tr>
<td>TR End Station</td>
<td>Disable</td>
</tr>
<tr>
<td>NetBIOS Accept</td>
<td>Enable</td>
</tr>
<tr>
<td>NetBIOS Deliver</td>
<td>Enable</td>
</tr>
<tr>
<td>WAN RIP Period</td>
<td>2 (two 30-second intervals)</td>
</tr>
<tr>
<td>WAN SAP Period</td>
<td>2 (two 30-second intervals)</td>
</tr>
<tr>
<td>FR Broadcast (hex)</td>
<td>0xFFFFFFF (not displayed)</td>
</tr>
<tr>
<td>FR Multicast (hex)</td>
<td>0xFFFFFFF (not displayed)</td>
</tr>
<tr>
<td>Split Horizon</td>
<td>Enable</td>
</tr>
<tr>
<td>IPXWAN Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>IPXWAN Common Net (hex)</td>
<td>None</td>
</tr>
<tr>
<td>IPXWAN Time Out</td>
<td>60 s</td>
</tr>
<tr>
<td>IPXWAN Link Retry</td>
<td>5 retries</td>
</tr>
</tbody>
</table>
Table A-93. IPX RIP Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Supply</td>
<td>Enable</td>
</tr>
<tr>
<td>Listen</td>
<td>Enable</td>
</tr>
</tbody>
</table>

XNS Parameters

This section describes the Site Manager default parameter settings for the Xerox Network Systems (XNS) protocol and for XNS RIP.

Table A-94. XNS Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Base Host Number (hex)</td>
<td>None</td>
</tr>
<tr>
<td>Configure RIP</td>
<td>Depends on whether RIP is configured</td>
</tr>
<tr>
<td>Implementation</td>
<td>XNS</td>
</tr>
</tbody>
</table>

Table A-95. XNS Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
</tbody>
</table>

continued on the next page
### Table A-95. XNS Interface Parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost</td>
<td>0</td>
</tr>
<tr>
<td>Xsum On</td>
<td>Enable</td>
</tr>
<tr>
<td>MAC Address</td>
<td>None</td>
</tr>
<tr>
<td>SMDS Group Address</td>
<td>None</td>
</tr>
<tr>
<td>Ext Server</td>
<td>Disable</td>
</tr>
<tr>
<td>Ex Server Network</td>
<td>Enable</td>
</tr>
<tr>
<td>Ex Server Host ID</td>
<td>0</td>
</tr>
<tr>
<td>Ex Serv Pkt Type</td>
<td>None</td>
</tr>
<tr>
<td>Ex Serv SockNM</td>
<td>None</td>
</tr>
<tr>
<td>Frame Relay Broadcast</td>
<td>ffffff</td>
</tr>
<tr>
<td>Frame Relay Multicast</td>
<td>ffffff</td>
</tr>
<tr>
<td>Split Horizon Algorithm</td>
<td>Enable</td>
</tr>
</tbody>
</table>

### Table A-96. XNS RIP Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>None</td>
</tr>
<tr>
<td>Supply</td>
<td>Enable</td>
</tr>
<tr>
<td>Listen</td>
<td>Enable</td>
</tr>
</tbody>
</table>
DLSw Parameters

This section describes the Site Manager default parameter settings for the Data Link Switching (DLSw) service.

Table A-97. DLSw Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>TCP Window Size</td>
<td>16000</td>
</tr>
<tr>
<td>IP Virtual Ring</td>
<td>None</td>
</tr>
<tr>
<td>Max Slot Sessions</td>
<td>200 sessions per slot</td>
</tr>
<tr>
<td>Virtual Ring MTU</td>
<td>2052</td>
</tr>
<tr>
<td>MAC Cache Age</td>
<td>300 s</td>
</tr>
<tr>
<td>NetBIOS Cache Age</td>
<td>300 s</td>
</tr>
<tr>
<td>Reject Unconf Peers</td>
<td>Accept</td>
</tr>
<tr>
<td>Keepalive Time (sec)</td>
<td>0</td>
</tr>
</tbody>
</table>

Table A-98. DLSw Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
</tbody>
</table>
### Table A-99. DLSw SAP Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Window</td>
<td>7 frames</td>
</tr>
</tbody>
</table>

### Table A-100. DLSw Slot Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address for TCP Connection</td>
<td>None</td>
</tr>
</tbody>
</table>

### LNM Parameters

This section describes the Site Manager default parameter settings for the LAN Network Manager (LNM) application.

### Table A-101. LNM Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>LNM Servers</td>
<td>Enable</td>
</tr>
<tr>
<td>Allow IBM LAN Network Manager to Set</td>
<td>Disable</td>
</tr>
</tbody>
</table>
LLC2 Parameters

Table A-102. LNM Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Remote MAC Address</td>
<td>None</td>
</tr>
<tr>
<td>LRM Active</td>
<td>Enable</td>
</tr>
<tr>
<td>REM Active</td>
<td>Enable</td>
</tr>
<tr>
<td>RPS Active</td>
<td>Enable</td>
</tr>
<tr>
<td>CRS Active</td>
<td>Enable</td>
</tr>
<tr>
<td>Control Manager Password</td>
<td>All 0s</td>
</tr>
<tr>
<td>OB (1, 2, or 3) Manager Password</td>
<td>All 0s</td>
</tr>
<tr>
<td>Error Rate Threshold</td>
<td>128</td>
</tr>
</tbody>
</table>

LLC2 Parameters

This section describes the Site Manager default parameter settings for the Logical Link Control (LLC2) service.

Table A-103. LLC2 Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
</tbody>
</table>
### Table A-104. LLC2 Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Maximum UI-PDU Size</td>
<td>5128 octets</td>
</tr>
<tr>
<td>Max Retry</td>
<td>1</td>
</tr>
<tr>
<td>Maximum I-PDU Size</td>
<td>128 octets</td>
</tr>
<tr>
<td>K</td>
<td>7 PDUs</td>
</tr>
<tr>
<td>N2</td>
<td>10 retransmissions</td>
</tr>
<tr>
<td>N3</td>
<td>2 PDUs</td>
</tr>
<tr>
<td>Tx Wait Acknowledgment Timer</td>
<td>15 s</td>
</tr>
<tr>
<td>LLC2 Interface Reject Timer</td>
<td>30 s</td>
</tr>
<tr>
<td>Remote Busy Timer</td>
<td>60 s</td>
</tr>
<tr>
<td>Idle Timer</td>
<td>120 s</td>
</tr>
<tr>
<td>Poll Cycle Timer</td>
<td>30 s</td>
</tr>
<tr>
<td>Max Number of SAPs per Service</td>
<td>255 SAPs</td>
</tr>
<tr>
<td>Maximum Number of End-to-End Connections per SAP</td>
<td>255 end-to-end connections</td>
</tr>
</tbody>
</table>
APPN Parameters

This section describes the Advanced Peer-to-Peer Networking (APPN) default parameter settings.

Table A-105. APPN Global and Advanced Global Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPN Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Local Node Name</td>
<td>None</td>
</tr>
<tr>
<td>Local ID Block</td>
<td>None</td>
</tr>
<tr>
<td>Local ID Number</td>
<td>None</td>
</tr>
<tr>
<td>Route Addition Resistance</td>
<td>128</td>
</tr>
<tr>
<td>Endpoint Session RSCV Storage</td>
<td>Enable</td>
</tr>
<tr>
<td>Max Directory Entries</td>
<td>0</td>
</tr>
<tr>
<td>Max Cached Directory Entries</td>
<td>100</td>
</tr>
<tr>
<td>Network Local Timeout (in s)</td>
<td>60</td>
</tr>
<tr>
<td>TRS Route Tree Cache Size</td>
<td>8</td>
</tr>
<tr>
<td>TRS Route Tree Cache Size Usage Limit</td>
<td>8</td>
</tr>
<tr>
<td>Max NNs in Topology DB (0=Unlimited)</td>
<td>0</td>
</tr>
<tr>
<td>Max TGs in Topology DB (0=Unlimited)</td>
<td>0</td>
</tr>
<tr>
<td>Max Number of ISR Sessions</td>
<td>1000</td>
</tr>
</tbody>
</table>

continued on the next page
### Table A-105. APPN Global and Advanced Global Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISR Congestion Threshold</td>
<td>900</td>
</tr>
<tr>
<td>ISR Decongestion Threshold</td>
<td>800</td>
</tr>
<tr>
<td>Max RU Size for ISR Sessions</td>
<td>1024</td>
</tr>
<tr>
<td>ISR Receive Pacing Window</td>
<td>7</td>
</tr>
<tr>
<td>ISR Session RSCV Storage</td>
<td>Enable</td>
</tr>
</tbody>
</table>

### Table A-106. APPN Interfaces and Ports Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Port Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Port Address</td>
<td>None</td>
</tr>
<tr>
<td>Local Link Station Role</td>
<td>Negotiable</td>
</tr>
<tr>
<td>Port Name</td>
<td>None</td>
</tr>
<tr>
<td>Port Number</td>
<td>None</td>
</tr>
<tr>
<td>Port MAC Address</td>
<td>None</td>
</tr>
<tr>
<td>Port SAP (hex)</td>
<td>None</td>
</tr>
<tr>
<td>Max Receive BTU Size</td>
<td>2057</td>
</tr>
<tr>
<td>Max Send BTU Size</td>
<td>2057</td>
</tr>
<tr>
<td>Max I-Frame Window</td>
<td>7</td>
</tr>
<tr>
<td>Total Link Activation Limits</td>
<td>256</td>
</tr>
</tbody>
</table>

*continued on the next page*
# Table A-106. APPN Interfaces and Ports Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbound Link Activation Limits</td>
<td>128</td>
</tr>
<tr>
<td>Outbound Link Activation Limits</td>
<td>128</td>
</tr>
<tr>
<td>Implicit CP Sessions</td>
<td>Yes</td>
</tr>
<tr>
<td>Implicit Limited Resource</td>
<td>Yes</td>
</tr>
<tr>
<td>Implicit Effective Capacity</td>
<td>133</td>
</tr>
<tr>
<td>Implicit Connection Cost</td>
<td>128</td>
</tr>
<tr>
<td>Implicit Byte Cost</td>
<td>128</td>
</tr>
<tr>
<td>Implicit Security</td>
<td>1</td>
</tr>
<tr>
<td>Implicit Delay</td>
<td>0</td>
</tr>
<tr>
<td>Implicit User-Defined 1</td>
<td>128</td>
</tr>
<tr>
<td>Implicit User-Defined 2</td>
<td>128</td>
</tr>
<tr>
<td>Implicit User-Defined 3</td>
<td>128</td>
</tr>
</tbody>
</table>

# Table A-107. APPN Adjacent Link Station Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Port Name</td>
<td>None</td>
</tr>
<tr>
<td>Adjacent Node Name</td>
<td>None</td>
</tr>
<tr>
<td>Adjacent Node Type</td>
<td>Learned</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-107. APPN Adjacent Link Station Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Address (hex)</td>
<td>None</td>
</tr>
<tr>
<td>Max Send BTU Size</td>
<td>2057</td>
</tr>
<tr>
<td>Target Pacing Count</td>
<td>4</td>
</tr>
<tr>
<td>Adjacent Link Station Name</td>
<td>None</td>
</tr>
<tr>
<td>Adjacent Node Name</td>
<td>Local NETID for NETID portion of name</td>
</tr>
<tr>
<td>MAC Address (hex)</td>
<td>None</td>
</tr>
<tr>
<td>SAP (hex)</td>
<td>None</td>
</tr>
<tr>
<td>Limited Resource TG</td>
<td>No</td>
</tr>
<tr>
<td>Down-level Adjacent Node</td>
<td>No</td>
</tr>
<tr>
<td>Adjacent Node Block Number</td>
<td>None</td>
</tr>
<tr>
<td>Adjacent Node ID Number</td>
<td>None</td>
</tr>
<tr>
<td>CP-CP Session Support</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatic Activation</td>
<td>Disable</td>
</tr>
<tr>
<td>Use Default TG Characteristics</td>
<td>No</td>
</tr>
<tr>
<td>Effective Capacity</td>
<td>133</td>
</tr>
<tr>
<td>Connection Cost</td>
<td>128</td>
</tr>
<tr>
<td>Byte Cost</td>
<td>128</td>
</tr>
<tr>
<td>Security</td>
<td>1</td>
</tr>
<tr>
<td>Delay</td>
<td>0</td>
</tr>
<tr>
<td>Implicit User-Defined 1</td>
<td>128</td>
</tr>
</tbody>
</table>

*continued on the next page*
### Table A-107. APPN Adjacent Link Station Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implicit User-Defined 2</td>
<td>128</td>
</tr>
<tr>
<td>Implicit User-Defined 3</td>
<td>128</td>
</tr>
</tbody>
</table>

### Table A-108. APPN Connection Networks and Ports Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Connection Network Name</td>
<td>None</td>
</tr>
<tr>
<td>Connection Network Port Name</td>
<td>None</td>
</tr>
<tr>
<td>Effective Capacity</td>
<td>133</td>
</tr>
<tr>
<td>Connection Cost</td>
<td>128</td>
</tr>
<tr>
<td>Byte Cost</td>
<td>128</td>
</tr>
<tr>
<td>Security</td>
<td>1</td>
</tr>
<tr>
<td>Delay</td>
<td>0</td>
</tr>
<tr>
<td>Implicit User-Defined 1</td>
<td>128</td>
</tr>
<tr>
<td>Implicit User-Defined 2</td>
<td>128</td>
</tr>
<tr>
<td>Implicit User-Defined 3</td>
<td>128</td>
</tr>
</tbody>
</table>
Table A-109. APPN Directory Services Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enable</td>
</tr>
<tr>
<td>Resource Type</td>
<td>LU</td>
</tr>
<tr>
<td>Parent Name</td>
<td>None</td>
</tr>
<tr>
<td>Parent Type</td>
<td>ENCP</td>
</tr>
<tr>
<td>Resource Name</td>
<td>NETID portion of local node name</td>
</tr>
</tbody>
</table>

Multiline Feature Parameters

This section describes the Site Manager default parameter settings for the Multiline feature.

Table A-110. Multiline Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Path Chooser</td>
<td>Address Based</td>
</tr>
</tbody>
</table>

Switched Access Services Parameters

This section describes the Site Manager default parameter settings for the Switched Access Services.
### Table A-111. Modem Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection When</td>
<td>Available Data</td>
</tr>
<tr>
<td>Connection Time</td>
<td>None</td>
</tr>
<tr>
<td>Call Connection Time</td>
<td>None</td>
</tr>
<tr>
<td>Inactivity Timeout</td>
<td>5 min</td>
</tr>
<tr>
<td>Retry Delay</td>
<td>0 min</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>None</td>
</tr>
<tr>
<td>Maximum Aggregate Channels</td>
<td>0 channels</td>
</tr>
<tr>
<td>Minimum Aggregate Channels</td>
<td>0 channels</td>
</tr>
<tr>
<td>Management Type</td>
<td>None</td>
</tr>
<tr>
<td>Restrict Type</td>
<td>No restriction</td>
</tr>
<tr>
<td>Redial Count</td>
<td>3 attempts</td>
</tr>
<tr>
<td>Force Dial</td>
<td>False</td>
</tr>
<tr>
<td>Force Hangup</td>
<td>False</td>
</tr>
<tr>
<td>Bring Up Hour</td>
<td>None</td>
</tr>
<tr>
<td>Bring Up Minute</td>
<td>None</td>
</tr>
<tr>
<td>Take Down Hour</td>
<td>None</td>
</tr>
<tr>
<td>Take Down Minute</td>
<td>None</td>
</tr>
</tbody>
</table>
Protocol Prioritization Parameters

This section describes the Site Manager default parameter settings for Protocol Prioritization.

Table A-112. Protocol Prioritization Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>High Queue</td>
<td>20 packets</td>
</tr>
<tr>
<td>Normal Queue</td>
<td>20 packets</td>
</tr>
<tr>
<td>Low Queue</td>
<td>20 packets</td>
</tr>
<tr>
<td>Max High Queue Latency</td>
<td>250 ms</td>
</tr>
<tr>
<td>High Water Packets Clear</td>
<td>None</td>
</tr>
<tr>
<td>Prioritization Algorithm Type</td>
<td>Bandwidth Alloc</td>
</tr>
<tr>
<td>High Queue Percent</td>
<td>70 percent</td>
</tr>
<tr>
<td>Normal Queue Percent</td>
<td>20 percent</td>
</tr>
<tr>
<td>Low Queue Percent</td>
<td>10 percent</td>
</tr>
</tbody>
</table>

Console Parameters

This section describes the Site Manager default parameter settings for the console that runs the Technician Interface.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Type</td>
<td>TI</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Modem Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>Lines Per Screen</td>
<td>24</td>
</tr>
<tr>
<td>More Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Prompt</td>
<td>$</td>
</tr>
<tr>
<td>Login Timeout</td>
<td>1</td>
</tr>
<tr>
<td>Password</td>
<td>1</td>
</tr>
<tr>
<td>Command Timeout</td>
<td>15</td>
</tr>
<tr>
<td>Login Retries</td>
<td>3</td>
</tr>
</tbody>
</table>
A

access privileges, 1-8
accessing
  line service parameters, 3-14
adding network interfaces
  configuring circuits, 2-2
  enabling protocols, 2-2
  overview, 2-2
address modes, 4-10
addressing
  point-to-point connections
    conventions, 3-56
    explicit, 3-57
Adjacent Link Station Dialog Box, 2-137, 2-147
alarm signal, 4-34, 5-32
AMI line coding, 4-7, 5-7
ANSI 403, 4-10
AppleTalk
  configuring AURP, 2-88
  configuring default zone, 2-85
  configuring zone list, 2-85
    nonprintable characters, 2-86
  defaults, A-56
  enabling on a circuit, 2-80
  nonseed router
    configuring, 2-81
  parameters
    networks, 2-83, 2-84
    parameters, networks, 2-82
    seed router, configuring, 2-81
APPN
  defaults, A-68, A-70
  enabling on LLC2 using SRB, 2-137 to 2-142
  enabling over LLC2, 2-131 to 2-137
  enabling over SDLC, 2-142 to 2-147
APPN Configuration window, 2-146
APPN Local Node Name Configuration window, 2-133, 2-144
APPN Virtual Ring Number window, 2-141
ARP Address parameter, 2-22
Asynchronous
  defaults, A-6
  parameters
    Baud Rate, 3-83
    Cfg RxQ Length, 3-86
    Cfg TxQ Length, 3-85
    Enable, 3-81
    Idle Timer, 3-83
    Local Port, 3-82
    MTU, 3-81
    Receive Window, 3-83
    Remote IP Address, 3-82
    Remote Port, 3-82
    Start Protocol, 3-81
    TCP Inactive Limit, 3-85
    TCP KeepAlive, 3-84
Asynchronous Transfer Mode Data Exchange Interface. See ATM DXI; ATM FRE2.
AT&T 54016, 4-10
ATM DXI
  adding PVCs, 2-10
  defaults, A-23
  enabling on a circuit, 2-9
  parameters
    VCI Number, 2-13
    VPI Number, 2-13

ATM FRE2
  adding PVCs, 2-14
  defaults, A-24
  enabling on a circuit, 2-14
  parameters
    Cell Insertion, 3-103
    Data Path Notify, 3-96
    Data Path Notify Timeout, 3-97
    Enable, 3-96
    Framing Mode, 3-102
    Loop Back, 3-103
    Maximum Burst Size, 3-101
    Peak Cell Rate, 3-99
    Scrambling, 3-103
    Sustainable Cell Rate, 3-100
    VCI Number, 2-18
    VPI Number, 2-18

ATM WAN protocol, 2-7

AURP
  configuring, 2-88
  defaults, A-57
  parameters
    enable, 2-89
    local IP address, 2-89
    remote IP address, 2-91

AZ, 4-10

B

B8ZS line coding, 4-7
BERT, 4-35, 5-33
BERT mode, 4-31 to 4-40, 5-29 to 5-36

BGP
  defaults, A-47
  parameters
    Identifier, 2-68
    Local Address, 2-70
    Local AS, 2-69
    Peer Address, 2-70
    Peer AS, 2-70
  peers
    configuring, 2-70

BNC connector
  and timing, 5-4

BOFL, 4-25, 5-22
booting
  with a configuration file, 6-12

BOOTP
  defaults, A-40

Border Gateway Protocol. See BGP

Bridge
  enabling on a circuit, 2-51
  parameters
    Bridge MAC Address, 2-53, 2-98
    Bridge Priority, 2-52, 2-97

Bridge (Translation)
  defaults, A-34

Bridge (Transparent)
  defaults, A-30

Bridge ID
  assigning a, 2-139

bridging/routing protocols
  enabling on a circuit, 2-49

BY, 4-10
Cable Type parameter, 2-26
Carrier Sense Multiple Access with
Collision Detection. See
CSMA/CD
changing configuration files, 6-14
channels. See timeslots
circuit name
  MCE1, 5-18
  MCT1, 4-21
circuits
  adding, 2-5
  adding protocols to, 2-160
  and MCE1, 5-10
  and MCT1, 4-13
  assigning additional IP addresses to,
  2-163
configuration
  enabling bridging/routing protocols,
  2-49
  selecting protocols, 2-49
  deleting from the router, 2-158
  deleting protocols from, 2-165
  enabling WAN services for, 2-8
  moving, 2-161
  naming conventions, 2-5, 2-6
  renaming, 2-159
  type designators, Table, 2-6
claim token process, 3-9
Clock Source parameter, 2-24
Configuration Change Utility, 6-14
  AppleTalk Interface Profiles, 6-21
  DECnet Interface Profiles, 6-18
  IP Interface Profiles, 6-16
  IPX Interface Profiles, 6-20
  OSI Profiles, 6-22
  SNMP Manager Profiles, 6-17
  Source Routing Global Profile, 6-15
  Source Routing Interface Profile, 6-15
  Vines Interface Profiles, 6-19
  X.25 Packet Level Profiles, 6-23
  X.25 Service Profile, 6-24
configuration file
  changing dynamically, 1-13
  dynamic mode, 6-5
  existing, 1-7
  implementation of, 6-1
  local mode, 6-2
  new, 1-8
  opening (local), 1-6
  opening (remote), 1-11
  overwriting, 6-4, 6-7
  rebooting a router with, 6-12
  remote mode, 6-3
  saving, 1-9
  configuration mode, 6-2
  selecting router model (local), 1-8
  specifying hardware, 2-3
  transferring to a router, 6-6
Configuration Manager
  router functions, 1-2
Configuration Manager overview, 4-1
Configuration Manager window, 1-9
configuration sequence, 2-111
Configure OSPF parameter, 2-48
Configure RIP parameter, 2-48
console
  parameters
    Baud Rate, 2-168
    Command Timeout, 2-172
    Data Bits, 2-169
    Enable, 2-168
    Enable Modem, 2-170
    Force Use Logout Enable, 2-174
    Initial Search Path, 2-173
    Lines Per Screen, 2-170
    Login Retries, 2-173
    Login Timeout, 2-172
    Manager Auto Script, 2-174
More Enabled, 2-171
Parity, 2-169
Password Timeout, 2-172
Port Type, 2-168
Prompt, 2-171
Stop Bits, 2-169
User Auto Script, 2-174

CSMA/CD, 3-1
cyclic redundancy check, 4-29, 5-26

D

DAS, 3-8
Data compression enabling, 2-147
Data link connection identifier, 2-136 purpose of, 2-136
Data Link Switching. See DLSw
DB9 connector and timing, 4-4
DCE, 3-56
DECnet Phase IV
defaults, A-52
parameters
Area ID, 2-79
Node ID, 2-79
DECnet Phase IV to V Transition
defaults, A-53
default zone configuring for AppleTalk, 2-85
defaults
AppleTalk parameters, A-56
Asynchronous parameters, A-6
ATM DXI parameters, A-23
ATM FRE2 parameters, A-24
AURP parameters, A-57

BGP parameters, A-47
BOOTP parameters, A-40
console parameters, A-76
DECnet Phase IV parameters, A-52
DECnet Phase IV to V Transition parameters, A-53
DLSw parameters, A-64
DVRMP parameters, A-40
EGP parameters, A-49
Ethernet circuit parameters, A-1
FDDI circuit parameters, A-2
Frame Relay parameters, A-14
HSSI circuit parameters, A-13
IGMP parameters, A-40
IP, A-36
IP parameters, A-36
IPX parameters, A-60
ISDN circuit parameters, A-13
LAPB parameters, A-5
LLC2 parameters, A-66, A-73
LNM parameters, A-65
MCE1 parameters, A-10, A-11
MCT1 parameters, A-8, A-9
Modem parameters, A-74
Multiline parameters, A-73
Native Mode LAN (NML) parameters, A-35
NetBIOS over IP parameters, A-41
OSI parameters, A-58
OSPF parameters, A-45
Point-to-Point (PPP) parameters, A-27
Protocol Prioritization parameters, A-75
RIP parameters, A-38
RIPSO parameters, A-39
SDLC parameters, A-16, A-18
SMDS parameters, A-15
SNMP parameters, A-41, A-42
Source Routing parameters, A-32
Spanning Tree parameters, A-31
Synchronous circuit parameters, A-3
T1 circuit parameters, A-7
TCP parameters, A-50
Telnet parameters, A-50
TFTP parameters, A-38
Token Ring circuit parameters, A-7
Translation Bridge parameters, A-34
Transparent Bridge parameters, A-30
VINES parameters, A-54
Wellfleet Compression Protocol, A-29
X.25 parameters, A-19
XNS parameters, A-62
deleting
circuits from the router, 2-158
diagnostics
MCT1 actions, 4-31 to 4-43
directories, 1-7
directories list, 1-7
directory
delete, 1-7
privileges, 1-8
DLCI choice, 2-117, 2-128
DLCI parameter, 2-136
DLSw
and IP, 2-113
and LLC2, 2-113
and Source Routing, 2-113
and TCP, 2-113
defaults, A-64, A-65
enabling, 2-110
parameters
IP Address, 2-120
IP Virtual Ring, 2-115
Peer IP Address, 2-122
SAP, 2-124
Slot, 2-120
DS0s. See timeslots
DS1, 4-8
DSX1, 4-8
DTE, 3-56
Dual Attachment Station. See DAS
DVRMP
defaults, A-40
enabling, 2-71
parameters
Enable, 2-74
Estimated Routes, 2-77
Full Update Rate, 2-75
Garbage Timeout, 2-77
Leaf Timeout, 2-75
Neighbor Timeout, 2-76
Route Expiration Timeout, 2-76
Triggered Update Rate, 2-75
dynamic mode
description of, 1-13
performing, 1-13
specifying router, 1-14

E
E1
editing line details, 3-16
parameters
Enable, 3-17, 3-18
HDB3S Support, 3-17
Mini Dacs, 3-19
Echo Frames, 3-12
Edit SR Interface window, 2-140
editing
line details
Asynchronous, 3-79
E1, 3-16
Ethernet, 3-20
FDDI, 3-24
FDDI MAC attributes, 3-34
FDDI Path attributes, 3-36
FDDI Port attributes, 3-39
FDDI SMT attributes, 3-28
Synchronous, 3-46
T1, 3-86
Token Ring, 3-91

EGP
  defaults, A-49
  enabling on a circuit, 2-65
  parameters
    Gateway Mode, 2-67
    Local Autonomous System ID, 2-66
    Remote Peer IP Address, 2-67
Enabling
  APPN over LLC2 interfaces, 2-131 to 2-137
  APPN over LLC2 interfaces using SRB, 2-137 to 2-142
  APPN over SDLC interfaces, 2-142 to 2-147
error, 1-23
ESF, 4-6, 4-36

Ethernet
  defaults, A-1
  editing line details, 3-20
  overview of, 3-1
  parameters
    BOFL (Breath of Life) Enable, 3-21
    BOFL Timeout, 3-22
    Enable, 3-21
    Hardware Filter, 3-23

Exterior Gateway Protocol. See EGP

F

FDDI
  claim token process, 3-9
  defaults, A-2, A-3
  editing line details, 3-24
    FDDI MAC attributes, 3-34
    FDDI Path attributes, 3-36
    FDDI Port attributes, 3-39
    FDDI SMT attributes, 3-28
  overview of, 3-5
  parameters
    BOFL Enable, 3-25
    Connection Policy, 3-30
    Duplicate Address Protocol, 3-34
    Enable, 3-25
    LER Alarm, 3-41
    LER Cutoff, 3-41
    LLC Data Enable, 3-35
    Requested TTRT (ms), 3-39
    Status Report Protocol, 3-33
    T_Max Lower Bound (ms), 3-38
    T_Notify Timeout, 3-32
    Trace Max Expiration (ms), 3-33
    Tvx Lower Bound (ms), 3-37
    User Data, 3-34
primary ring, 3-6
ring
  architecture, 3-6
  maintenance, 3-10
  node regulation in, 3-9
  operation, 3-8
  wrapping, 3-6
secondary ring, 3-6
SMT
  Connection Policy values, Table, 3-31
  Echo Frames, 3-12
  frame class and type, Table, 3-12
  Neighbor Information Frames, 3-12
  overview of, 3-10
  Parameter Management Frames, 3-12
  Request Denied Frames, 3-12
  Status Information Frames, 3-12
  Status Report Frames, 3-12
standards
  MAC, 3-5
  PHY, 3-5
  PMD, 3-5
  SMT, 3-5, 3-10
station timers
  token rotation timer, 3-9
  token-holding timer, 3-9
valid transmission timer, 3-9
FDL
  mode, 4-10
file
  create privileges, 1-8
File Selection window, 1-7
file system. See volume
files, 1-7
  delete, 1-7
  open, 1-7
files list, 1-7
fractional loopback, 4-26, 5-23
Frame Relay
  and Protocol Prioritization, 2-7
  defaults, A-14
  enabling on a circuit, 2-8
Frame Relay Mapping Add window, 2-117, 2-128
Frame Relay Mappings window, 2-116, 2-127
Frame Relay WAN protocol, 2-7
free space
  and saving configuration files, 6-4
G
  Group Address parameter, 2-21
H
  hardware filters
    enabling on a circuit, 2-6
  hardware specification, 1-9, 2-3
  HDB3 line coding, 5-7
  HDLC
    service type, 4-26, 5-23
  HSSI
    defaults, A-13
    editing line details, 3-41
    parameters
      BOFL, 3-43
      BofL Frequency, 3-44
      CRC Size, 3-46
      Enable, 3-42
      External Clock Speed, 3-46
      MTU, 3-44
      Transmission Interface, 3-45
      WAN Protocol, 3-45
I
  IGMP
    defaults, A-40
    enabling, 2-71
    parameters
      Enable, 2-72
      Estimated Groups, 2-73
  Individual Address parameter, 2-20
  interframe time fill pattern, 4-29, 5-26
  Internal Clock Speed parameter, 2-25
  Internal LAN ID, 2-139
  Internet Packet Exchange. See IPX
  Internet Protocol. See IP
  IP
    and DLSw, 2-113
    defaults, A-36
    enabling on a circuit, 2-53
    parameters
      IP Address, 2-42, 2-44, 2-47, 2-54
      Subnet Mask, 2-42, 2-55
      Transmit Bcast Addr, 2-43, 2-56
  IP addresses
    assigning to a circuit, 2-163
  IPX
    defaults, A-61
    enabling on a circuit, 2-103
    parameters
Cfg Encaps, 2-106
Configure RIP, 2-105
Network Address (hex), 2-104

ISDN
defaults, A-13

K
KG84A, 3-64 to 3-70

L
Lan Network Manager. See LNM

LAPB
defaults, A-5
parameters
   Command/Response Address, 3-78
   Control Field, 3-73
   Enable, 3-72
   Enable Rx/Tx of XID Frames, 3-77
   Idle RR Frames, 3-78
   Initiate Link Setup Action, 3-77
   Max N1 Frame Size, 3-74
   Max N2 Retries, 3-75
   Max T1 Acknowledge Timer, 3-75
   Max T2 Acknowledge Delay Timer, 3-76
   Max T3 Disconnect Timer, 3-76
   Station Type, 3-73
   WAN Protocol, 3-79
   Window Size, 3-74

line coding
   AMI and B8Zs, 4-7, 5-34
   AMI and HDB3, 5-7

line services
   accessing, 3-14

line tests, 4-31 to 4-43
   MCT1, 4-31

Link Access Procedure Balanced (LAPB) protocol
description, 3-71

LLC1, 4-26, 5-23

LLC2
   and DLSw, 2-113
defaults, A-67
   enabling APPN over, 2-131 to 2-137
   enabling on a circuit, 2-125

LLC2 Frame Relay Mapping Add window, 2-117, 2-128

LLC2 Frame Relay Mappings window, 2-116, 2-127

LLC2/SRB
   enabling APPN over, 2-138 to 2-142

LNM
defaults, A-66
   enabling on a circuit, 2-125

color
   description, 1-6
   selecting router mode, 1-8

Local Node Name parameter, 2-134, 2-145
locked message, 1-23

logical line, 4-12

Logical Link Control. See LLC1; LLC2
loop tests, 4-40 to 4-43
loopback, 4-12
   diagnostic, 4-26, 5-23
   fractional, 4-26, 5-23
   loopback mode, 4-11
M

MAC Address parameter, 2-135
maximum transfer unit, 4-6

MCE1
AMI line coding, 5-34
channels, 5-27
defaults, A-10, A-11
defining circuits, 5-10
diagnostics, 5-29 to 5-36
DS0s, 5-27
dynamic mode, 5-29
HDB3 line coding, 5-34
line tests, 5-29
logical lines, 5-9
multiline groupings, 5-12
naming circuit, 5-18
parameters
BERT Mode Enable, 5-32
BERT Send Alarm, 5-32
BERT Test Pattern, 5-33
BOFL Period, 5-22
Breath of Life, 5-22
Clear Alarm Threshold, 5-8
CRC Size, 5-26
Disable Insert Error/K, 5-36
Enable, 5-6
Enable/Disable, 5-21
Fractional Loopback, 5-23
Insert 1 Error/K, 5-36
Insert 1 Error/M, 5-36
Inset 1 Error, 5-35
InterFrame Time Fill Character, 5-26
International Bit Mode, 5-9, 5-33
Line Coding, 5-7, 5-34
Line Type, 5-6, 5-35
Local HDLC Address, 5-24
MTU Size, 5-27
Primary Clock, 5-3
Rate Adaptation, 5-25
Remote HDLC Address, 5-25

Reset BERT Counters, 5-35
Secondary Clock, 5-4
Service, 5-23
Setup Alarm Threshold, 5-8
WAN Protocol, 5-23
port parameters, 5-5
timeslots, 5-27

MCE1 diagnostics, 5-29, 5-36

MCT1
adding circuits, 4-1, 5-1
default parameters, A-9
defaults, A-8, A-9
defining circuits, 4-13
line tests, 4-31 to 4-43
multiline groupings, 4-15
parameters
Accept Local Loopback, 4-11
BERT Mode Enable, 4-34
BERT Send Alarm, 4-34
BERT Test Pattern, 4-35
BOFL Period, 4-25
Breath of Life, 4-25
Clear Alarm Threshold, 4-9
CRC Size, 4-29
Disable Insert Error/K, 4-40
Enable, 4-5
Enable/Disable, 4-24
FDL Configuration, 4-10
FDL Disable All, 4-43
FDL Disable Line Loop, 4-42
FDL Line Loop CI, 4-41
FDL Line Loop IA, 4-42
FDL Payload Loop, 4-41
Fractional Loopback, 4-26
Insert 1 Error/K, 4-39
Insert 1 Error/M, 4-39
Inset 1 Error, 4-39
InterFrame Time Fill Character, 4-29
Line Coding, 4-7, 4-37
Line Type, 4-6, 4-36
Local HDLC Address, 4-27
Loop Down, 4-40
Loop Up, 4-40
Loopback Configuration, 4-12
Maximum Transfer Unit, 4-6
Primary Clock, 4-3
Rate Adaptation, 4-28
Remote HDLC Address, 4-28
Remote HDLC Address Mode, 4-10
Reset BERT Counters, 4-38
Secondary Clock, 4-4
Service, 4-26
Setup Alarm Threshold, 4-9
Signal Level, 4-8, 4-38
WAN Protocol, 4-26

MCT1 port actions, 4-31
modem
defaults, A-74
moving
circuits, 2-161
Multiline
circuit types, 2-149
configuring, 2-152, 2-154
MCE1, 5-12
MCT1, 4-15
synchronous lines, 2-152
configuring MCE1, 5-12 to 5-18
defaults, A-73
description of, 2-148
grouping data paths
guideline, 2-150
media support, 2-149
parameters
Data Path Chooser, 2-157
traffic distribution, 2-151
address based selection, 2-151
uses of, 2-148
Multinet, 2-163

N
Native Mode LAN (NML)
defaults, A-35
Neighbor Information Frames, 3-12
NetBIOS over IP
defaults, A-41
NML (Native Mode LAN) port
creating, 2-102
nonseed router
configuring for AppleTalk, 2-81

O
Open Shortest Path First. See OSPF
Open Systems Interconnection
OSI, 2-100
operating modes
description of, 1-5
identification of on windows, 1-5
overview, 1-4
specifying, 1-5
OSPF
enabling on a circuit, 2-57
OSI
defaults, A-58
enabling on a circuit, 2-100
parameters
Router ID, 2-101
OSPF
defaults, A-45, A-46
parameters
Area Address, 2-65, 2-102
AS Boundary Router, 2-58
Ase Metric Support, 2-60
Backup Enable, 2-60
Backup Log Mask, 2-63
Hold Down Timer, 2-59
OSPF Slot, 2-59
Primary Log Mask, 2-61
Router ID, 2-58

P

Parameter Management Frames, 3-12
parameters
AppleTalk
   Default Zone, 2-84
   Network End, 2-83
   Network Start, 2-82
ARP Address, 2-22
Asynchronous
   Baud Rate, 3-83
   Cfg RxQ Length, 3-86
   Cfg TxQ Length, 3-85
   Enable, 3-81
   Idle Timer, 3-83
   Local Port, 3-82
MTU, 3-81
Receive Window, 3-83
Remote IP Address, 3-82
Remote Port, 3-82
Start Protocol, 3-81
TCP Inactive Limit, 3-85
TCP KeepAlive, 3-84
ATM DXI
   VCI Number, 2-13
   VPI Number, 2-13
ATM FRE2
   Cell Insertion, 3-103
   Data Path Notify, 3-96
   Data Path Notify Timeout, 3-97
   Enable, 3-96
   Framing Mode, 3-102
   Loop Back, 3-103
   Maximum Burst Size, 3-101
   Peak Cell Rate, 3-99
   Scrambling, 3-103
   Sustainable Cell Rate, 3-100
   VCI Number, 2-18
   VPI Number, 2-18
AURP
   enable, 2-89
   local IP address, 2-89
   remote IP address, 2-91
BGP
   Identifier, 2-68
   Local Address, 2-70
   Local AS, 2-69
   Peer Address, 2-70
   Peer AS, 2-70
Bridge
   Bridge MAC Address, 2-53, 2-98
   Bridge Priority, 2-52, 2-97
console
   Baud Rate, 2-168
   Command Timeout, 2-172
   Data Bits, 2-169
   Enable, 2-168
   Enable Modem, 2-170
   Force Use Logout Enable, 2-174
   Initial Search Path, 2-173
   Lines Per Screen, 2-170
   Login Retries, 2-173
   Login Timeout, 2-172
   Manager Auto Script, 2-174
   More Enabled, 2-171
   Parity, 2-169
   Password Timeout, 2-172
   Port Type, 2-168
   Prompt, 2-171
   Stop Bits, 2-169
   User Auto Script, 2-174
DECnet Phase IV
   Area ID, 2-79
   Node ID, 2-79
DLCI, 2-117, 2-128
DLSw
   IP Address, 2-120
   IP Virtual Ring, 2-115
   Peer IP Address, 2-122
   SAP, 2-124
Slot, 2-120

DVRMP
  Enable, 2-74
  Estimated Routes, 2-77
  Full Update Rate, 2-75
  Leaf Timeout, 2-75
  Neighbor Timeout, 2-76
  Route Expiration Timeout, 2-76
  Route Garbage Timeout, 2-77
  Triggered Update Rate, 2-75

E1
  Enable, 3-17, 3-18
  HDB3S Support, 3-17
  Mini Dacs, 3-19

EGP
  Gateway Mode, 2-67
  Local Autonomous System ID, 2-66
  Remote Peer IP Address, 2-67

Ethernet
  BOFL (Breath of Life) Enable, 3-21
  BOFL Timeout, 3-22
  Enable, 3-21
  Hardware Filter, 3-23

FDDI
  BOFL Enable, 3-25
  BOFL Timeout, 3-26
  Connection Policy, 3-30
  Duplicate Address Protocol, 3-34
  Enable, 3-25
  Hardware Filter, 3-27
  LER Alarm, 3-41
  LER Cutoff, 3-41
  LLC Data Enable, 3-35
  Requested TTRT (ms), 3-39
  Status Report Protocol, 3-33
  T_Max Lower Bound (ms), 3-38
  T_Notify Timeout, 3-32
  Trace Max Expiration (ms), 3-33
  TvX Lower Bound (ms), 3-37
  User Data, 3-34
  Group Address, 2-21
  HSSI

BOFL, 3-43
  BofL Frequency, 3-44
  CRC Size, 3-46
  Enable, 3-42
  External Clock Speed, 3-46
  MTU, 3-44
  Transmission Interface, 3-45
  WAN Protocol, 3-45

IGMP
  Enable, 2-72
  Estimated Groups, 2-73

Individual Address, 2-20

IP
  IP Address, 2-42, 2-44, 2-47, 2-54
  Subnet Mask, 2-42, 2-55
  Transmit Bcast Addr, 2-43, 2-56

IPX
  Cfg Encaps, 2-106
  Configure RIP, 2-105
  Network Address (hex), 2-104

LAPB
  Command/Response Address, 3-78
  Control Field, 3-73
  Enable, 3-72
  Enable Rx/Tx of XID Frames, 3-77
  Idle RR Frames, 3-78
  Initiate Link Setup Action, 3-77
  Max N1 Frame Size, 3-74
  Max N2 Retries, 3-75
  Max T1 Acknowledge Timer, 3-75
  Max T2 Acknowledge Delay Timer, 3-76
  Max T3 Disconnect Timer, 3-76
  Station Type, 3-73
  WAN Protocol, 3-79
  Window Size, 3-74

Line Coding, 4-37, 5-34

Local MAC, 2-118, 2-129

MCE1
  BERT Mode Enable, 5-32
  BERT Send Alarm, 5-32
  BERT Test Pattern, 5-33
BOFL Period, 5-22
Breath of Life, 5-22
Clear Alarm Threshold, 5-8
CRC Size, 5-26
Disable Insert Error, 5-36
Enable, 5-6
Enable/Disable, 5-21
Fractional Loopback, 5-23
Insert 1 Error, 5-35
Insert 1 Error/K, 5-36
Insert 1 Error/M, 5-36
InterFrame Time Fill Character, 5-26
International Bit, 5-9, 5-33
Line Coding, 5-7
Line Type, 5-6, 5-35
Local HDLC Address, 5-24
MTU Size, 5-27
Primary Clock, 5-3
Rate Adaptation, 5-25
Remote HDLC Address, 5-25
Reset BERT Counters, 5-35
Secondary Clock, 5-4
Service, 5-23
Setup Alarm Threshold, 5-8
WAN Protocol, 5-23

FDL Line Loop IB, 4-42
FDL Payload Loop, 4-41
Fractional Loopback, 4-26
Insert 1 Error, 4-39
Insert 1 Error/K, 4-39
Insert 1 Error/M, 4-39
InterFrame Time Fill Character, 4-29
Line Coding, 4-7
Line Type, 4-6, 4-36
Local HDLC Address, 4-27
Loop Down, 4-40
Loop Up, 4-40
Loopback Configuration, 4-12
Maximum Transfer Unit, 4-6
Primary Clock, 4-3
Rate Adaptation, 4-28
Remote HDLC Address, 4-28
Remote HDLC Address Mode, 4-10
Reset BERT Counters, 4-38
Secondary Clock, 4-4
Service, 4-26
Setup Alarm Threshold, 4-9
Signal Level, 4-8, 4-38
WAN Protocol, 4-26

Multiline
Data Path Chooser, 2-157

OSI
Router ID, 2-101

OSPF
Area Address, 2-65, 2-102
AS Boundary Router, 2-58
Ase Metric Support, 2-60
Backup Enable, 2-60
Backup Log Mask, 2-63
Hold Down Timer, 2-59
OSPF Slot, 2-59
Primary Log Mask, 2-61
Router ID, 2-58
Remote MAC, 2-118, 2-129
router connection
Identity (Community), 1-17
Node Name/IP address, 1-16
Retries (per request), 1-18
Timeout (seconds), 1-17
Source Routing
Source Routing Ring Number, 2-95
SR Bridge ID, 2-93
SR Bridge Internal LAN ID, 2-93
Synchronous
BOFL, 3-48
BOFL Timeout, 3-49
Burst Count, 3-54
Cable Type, 3-69
Clock Source, 3-50
CRC Size, 3-61
Enable, 3-48, 3-49
Extended Address, 3-70
Extended Control (S and I frames), 3-68
External Clock Speed, 3-52
Idle RR Frames, 3-69
Internal Clock Speed, 3-51
KG84A Cycle, 3-65
KG84A Remote Sync Wait, 3-66
KG84A Sync Loss Interval, 3-66
KG84A Sync Pulse, 3-67
Link Idle Timer, 3-68
Local Address, 3-58
Minimum Frame Spacing, 3-56
Network Link Level, 3-67
Pass Thru Local Address, 3-60
Pass Thru Remote Address, 3-61
Promiscuous, 3-50
Remote Address, 3-59
Remote Loopback Detection, 3-71
Retry Count, 3-68
Retry Timer, 3-70
RTS Enable, 3-53
Service, 3-55
Signal Mode, 3-53
Sync Line Coding, 3-63
Sync Media Type, 3-62
Sync Polling, 3-62
Transmit Window Size, 3-55
WAN Protocol, 3-60
system
System Contact, 2-176
System Location, 2-176
System Name, 2-176
T1
B8ZS Support, 3-88
Clock Mode, 3-89
Enable, 3-87
Frame Type, 3-87
Line Buildout, 3-88
Mini Dacs, 3-90
Token Ring
Early Token Release, 3-94
Enable, 3-92
MAC Address Override, 3-92
MAC Address Select, 3-93
Speed, 3-93
X.25
Bidirectional LCN Start, 2-34
Bidirectional Logical Channel Count, 2-33
Connection ID, 2-38
DDN IP Address, 2-32
Incoming LCN Start, 2-33
Incoming Logical Channel Count, 2-32
Link Address Type, 2-30
Network Address Type, 2-31
Outgoing LCN Start, 2-35
Outgoing Logical Channel Count, 2-34
PDN X.121 Address, 2-31
Remote IP Address, 2-37
Remote X121 Address, 2-37
Type, 2-36
XNS
Base Host Number, 2-108
Configure RIP, 2-109
Implementation, 2-109
Network Address (hex), 2-107
PassThru WAN protocol, 2-7
Passthru WAN service
  enabling on a circuit, 2-8
path list, 1-7
Point-to-Point (PPP)
  defaults, A-27
port actions
  MCT1, 4-31
port parameters, 4-5
power level
  T1 transmit, 4-8
PPP
  and Protocol Prioritization, 2-7
  and synchronous line parameters, 2-8
  enabling on a circuit, 2-8
PPP WAN protocol, 2-7
primary ring, 3-6
Protocol Prioritization
  and WAN Protocols, 2-7
  defaults, A-75
protocols
  adding to a circuit, 2-160
  deleting from a circuit, 2-165

R
rate adaptation
  line, 4-28, 5-25
remote mode
  description of, 1-10
  performing, 1-11
  specifying router, 1-14
renaming
  circuits, 2-159
Request Denied Frames, 3-12
Ring ID
  of source routing circuit, 2-141
RIP
  defaults, A-38
RIPSO
  defaults, A-39
router connection
  parameters
    Identity (Community), 1-17
    Node Name/IP Address, 1-16
    Retries (per request), 1-18
    Timeout (seconds), 1-17
router connection messages, 1-23
router model
  specifying, 1-8

S
SAP (hex) parameter, 2-136
SAS, 3-8
saving
  configuration file (dynamic mode), 6-5
  configuration file (local mode), 6-2
  configuration file (remote mode), 6-3
SDLC
  defaults, A-16, A-18
  enabling, 2-23
  enabling APPN over, 2-142 to 2-147
SDLC Address (hex) parameter, 2-146
SDLC Line Parameters window, 2-143
secondary ring, 3-6
seed router
  configuring for AppleTalk, 2-81
Select (LAN) Protocols window, 2-126
Select Protocols window, 2-132, 2-144
Select Router Model window, 1-9
service type, 4-26, 5-23
set error, 1-23
SF/D4, 4-6, 4-36
Single Attachment Station. See SAS

SMDS
and Protocol Prioritization, 2-7
defaults, A-15
enabling on a circuit, 2-8, 2-19
SMDS WAN protocol, 2-7

SNMP

Source Route Encapsulation Dialog Box,
2-132, 2-138

Source Routing
and DLSw, 2-113
defaults, A-32, A-33
enabling on a circuit, 2-91
parameters
Source Routing
SR Bridge Internal LAN ID, 2-93
Source Routing Ring Number, 2-95
SR Bridge ID, 2-93

Source routing bridge
enabling APPN over LLC2 using, 2-137
to 2-142
Source Routing Ring Number
parameter, 2-141
SR Bridge ID global parameter, 2-139
SR Bridge Internal LAN ID parameter,
2-139
SR BridgeID parameter, 2-139

Source Routing Global Parameters
window, 2-138

Source Routing Ring Number parameter,
2-141

Source Routing Spanning Tree
enabling on a circuit, 2-95

Source Routing Translate/Learning Bridge
enabling on a circuit, 2-98

Source Routing Translate/Learning Bridge
Spanning Tree

enabling on a circuit, 2-99

Spanning Tree
defaults, A-31
enabling on a circuit, 2-51
SR Bridge ID parameter, 2-139
SR Bridge Internal LAN ID parameter,
2-139

Standard WAN protocol, 2-7
station management (SMT), 3-11
Status Information Frames, 3-12
Status Report Frames, 3-12
Switched Multi-Megabit Data Service. See
SMDS
Sync Line Coding parameter, 2-26

Synchronous
defaults, A-3
parameters
BOFL, 3-48
BOFL Timeout, 3-49
Burst Count, 3-54
Cable Type, 2-26, 3-69
Clock Source, 2-24, 3-50
CRC Size, 3-61
Enable, 3-48
Extended Address, 3-70
Extended Control (S and I frames),
3-68
External Clock Speed, 3-52
Idle RR Frames, 3-69
Internal Clock Speed, 2-25, 3-51
KG84A Cycle, 3-65
KG84A Remote Sync Wait, 3-66
KG84A Sync Loss Interval, 3-66
KG84A Sync Pulse, 3-67
Link Idle Timer, 3-68
Local Address, 3-58
Minimum Frame Spacing, 3-56
MTU (Maximum Transfer Unit), 3-49
Network Link Level, 3-67
Pass Thru Local Address, 3-60
Pass Thru Remote Address, 3-61
Promiscuous, 3-50
Remote Address, 3-59
Remote Loopback Detection, 3-71
Retry Count, 3-68
Retry Timer, 3-70
RTS Enable, 3-53
Service, 3-55
Signal Mode, 3-53
Sync Line Coding, 2-26, 3-63
Sync Media Type, 3-62
Sync Polling, 3-62
Transmit Window Size, 3-55
WAN Protocol, 3-60

synchronous line parameters
and PPP, 2-8

system
parameters
System Contact, 2-176
System Location, 2-176
System Name, 2-176

system information
specifying, 2-175

T

T1
defaults, A-7
editing line details, 3-86
parameters
B8ZS Support, 3-88
Clock Mode, 3-89
Enable, 3-87
Frame Type, 3-87
Line Buildout, 3-88
Mini Dacs, 3-90

TCP
and DLSw, 2-113
defaults, A-50

Technician Interface, 1-3
configuring console port to, 2-166

Telnet
defaults, A-50

TFTP
defaults, A-38
using to transfer a config file, 6-6
time fill pattern
interframe, 4-29, 5-26
timed-token protocol, 3-9
timeslots, 4-5, 4-29

Token Ring
defaults, A-7
editing line details, 3-91
overview of, 3-3
parameters
Early Token Release, 3-94
Enable, 3-92
MAC Address Override, 3-92
MAC Address Select, 3-93
Speed, 3-93
token rotation timer, 3-9
token-holding timer, 3-9
TTP (timed token protocol), 3-9

V

valid transmission timer, 3-9

VINES
defaults, A-54
enabling on a circuit, 2-80
Virtual Networking System. See VINES
Virtual Ring Number parameter, 2-142
volume
description of, 6-2
W
WAN Protocols, 2-7
WCP
   enabling, 2-147
Wellfleet Compression Protocol
   Enabling, 2-147
windows
   Choosing frame relay or source routing, 2-126
   File Selection, 1-7
   LLC2 Frame Relay Mapping Add, 2-117, 2-128
   LLC2 Frame Relay Mappings, 2-116, 2-127
   Select (LAN) Protocols, 2-126
wrapping, 3-6
write-access privileges, 1-8

X
X.25
   adding network service records, 2-35
   configuring multiple IP addresses over, 2-39
   defaults, A-19
   enabling bridging/routing protocols on a circuit, 2-38
   enabling on a circuit, 2-8, 2-28
   parameters
      Bidirectional LCN Start, 2-34
      Bidirectional Logical Channel Count, 2-33
      Connection ID, 2-38
      DDN IP Address, 2-32
      Incoming LCN Start, 2-33
      Incoming Logical Channel Count, 2-32
      Link Address Type, 2-30
      Network Address Type, 2-31
      Outgoing LCN Start, 2-35
   Outgoing Logical Channel Count, 2-34
   PDN X.121 Address, 2-31
   Remote IP Address, 2-37
   Remote X121 Address, 2-37
   Type, 2-36
   specifying the packet level, 2-28
X.25 WAN protocol, 2-7
Xerox Network Systems. See XNS
XNS
   defaults, A-62
   enabling on a circuit, 2-107
   parameters
      Configure RIP, 2-109
      Implementation, 2-109
      Network Address (hex), 2-107
Z
zone list
   configuring for AppleTalk, 2-85